
  

Avid

 

®

 

 Film Composer

 

®

 

UserÕs Guide



 

ii

 

Contents

 

Chapter 1 Logging

 

Logging Tips

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  21

 

Logging Preroll

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  21

 

Logging Timecode

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  21

 

Naming Tapes

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  21

 

Double-Checking the Logs

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  22

 

Preparing Logs for Import

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  23

 

Using MediaLog

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  23

 

Transferring Bins from MediaLog for Macintosh

 

. . . . . . . .  24

 

Transferring Bins from MediaLog on the PC

 

. . . . . . . . . . . .  25

 

Converting Logs with Avid Log Exchange

 

. . . . . . . . . . . . . . . . . .  25

 

Drag and Drop Conversion

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . .  27

 

Creating Avid Logs

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  28

 

Using a Word Processor

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  29

 

Using Vantage

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  29

 

Importing Shot Log Files

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  29

 

Logging Directly into a Bin

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32

 

Logging with an Avid-Controlled Deck

 

. . . . . . . . . . . . . . . . . . . .  32

 

Logging with Non-Avid-Controlled Decks

 

 . . . . . . . . . . . . . . . . .  36

 

Logging Film Information

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  38

 

Displaying Film Columns

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  38

 

Entering the Pulldown of the Sync Point

 

. . . . . . . . . . . . . . . . . . .  39

 

Entering Frames-Per-Second Rates for PAL Transfers

 

. . . . . . . .  42

 

Entering Key Numbers

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  42

 

Entering Additional Timecodes (Optional)

 

. . . . . . . . . . . . . . . . .  42



 

iii

 

Entering the Ink Number (Optional)

 

 . . . . . . . . . . . . . . . . . . . . . .  43

 

Entering Additional Film Data

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . .  44

 

Modifying Clip Information

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  44

 

Using the Modify Command

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  45

 

Exporting Log Files

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  48

 

Chapter 2 Preparing to Digitize

 

Selecting Settings

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  51

 

Preparing the Hardware

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  51

 

Audio Requirements for Film Transfers

 

. . . . . . . . . . . . . . . . . . . .  52

 

Entering Capture Mode

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  53

 

Setting Up the Compression Tool

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . .  54

 

About the Color Rate Option

 

. . . . . . . . . . . . . . . . . . . . . . . . . .  55

 

Setting Up the Digitize Tool

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  56

 

Using the Deck Selection Pop-Up Menu

 

 . . . . . . . . . . . . . . . . . . .  56

 

Selecting a Tape

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  57

 

Selecting Source Tracks

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  59

 

Choosing a Resolution in the Digitize Tool

 

. . . . . . . . . . . . . . . . .  60

 

Choosing the Target Bin

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  60

 

Targeting Drives

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  61

 

Targeting a Single Drive

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  61

 

Targeting Separate Drives for Audio and Video

 

 . . . . . . . . .  61

 

Interpreting the Time-Remaining Display

 

 . . . . . . . . . . . . . . . . .  62

 

Preparing for Audio Input

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  63

 

Using the Audio Tool Setup Display

 

 . . . . . . . . . . . . . . . . . . . . . .  65

 

Adjusting the Reference Level

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . .  67

 

Choosing a Peak Hold Option

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . .  68

 

Adjusting Input Levels

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  69

 

Checking Levels in the Console

 

. . . . . . . . . . . . . . . . . . . . . . . . . . .  72

 

Preparing for Video Input

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  73

 

Using the Factory Presets

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  75

 

Calibrating for Video Input

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  76

 

Saving Settings

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  81



 

iv

 

Adjusting Video Levels by Eye

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . .  82

 

Digitize Preparations Checklist

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  83

 

Chapter 3 Digitizing

 

Before You Begin

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  84

 

Preparing Digitize Bins

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  85

 

Special Digitizing Procedures

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  85

 

Using the Avid Media Reader

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . .  86

 

Logging Errors to the Console

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . .  86

 

Creating Subclips On the Fly

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  87

 

Using the Pulldown Flag While Digitizing

 

. . . . . . . . . . . . . . . . .  88

 

Adding Locators On the Fly

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  88

 

Adding Comments On the Fly

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . .  89

 

Digitizing and Logging at the Same Time

 

. . . . . . . . . . . . . . . . . . . . . .  89

 

Digitizing from a Mark IN to a Mark OUT

 

. . . . . . . . . . . . . . . . .  91

 

Setting Both Marks

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  91

 

Setting Only One Mark

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  92

 

Digitizing On the Fly

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  93

 

Autodigitizing

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  95

 

Digitizing from a Non-Avid-Controlled Deck

 

 . . . . . . . . . . . . . .  96

 

Digitizing with Timecode-of-Day

 

 . . . . . . . . . . . . . . . . . . . . . . . . .  97

 

Batch Digitizing

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  98

 

Preparing to Batch Digitize

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  98

 

Resizing the Digitize Tool

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . .  98

 

Preparing Settings for Unattended Batch Digitizing

 

 . . . . .  99

 

Starting the Batch Digitize Process

 

 . . . . . . . . . . . . . . . . . . . . . . . .  99

 

Redigitizing Your Material

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  102

 

Redigitizing Master Clips and Subclips

 

. . . . . . . . . . . . . . . . . . .  103

 

Redigitizing Sequences

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  103

 

Saving Two Versions of a Sequence When Redigitizing

 

.  103

 

Using Decompose When Redigitizing

 

. . . . . . . . . . . . . . . . .  104

 

Redigitizing the Sequence

 

. . . . . . . . . . . . . . . . . . . . . . . . . . .  105



 

v

 

Chapter 4 Importing Files

 

Supported File Types (Import and Export)

 

 . . . . . . . . . . . . . . . . . . . .  108

 

Shot Log File Types

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  109

 

Graphics File Types

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  109

 

Animation File Types

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  110

 

Audio File Types

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  111

 

Clips and Sequences

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  111

 

Preparing Files for Import

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  112

 

Graphics File SpeciÞcations

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  112

 

Animation File SpeciÞcations

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . .  114
QuickTime File SpeciÞcations  . . . . . . . . . . . . . . . . . . . . . . . . . . .  115
OMF File SpeciÞcations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  116

Importing Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  117
Before You Begin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  117

Mixed Resolutions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  118
Limiting the Size of Imported Files . . . . . . . . . . . . . . . . . . .  118

Importing the Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  118
Import File Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  122

Chapter 5 Organizing with Bins

Before You Begin  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  128
Using Audio Timecode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  128
Adjusting Pan Defaults . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  130

Adjusting Default Pan Settings  . . . . . . . . . . . . . . . . . . . . . .  130
Using the Center Pan Command. . . . . . . . . . . . . . . . . . . . . .  131

Setting the Bin Display  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  132
Film Scene Workßow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  134

About Bin Display Modes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  134
Bin Fast Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  137

Basic Bin Procedures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  137
Setting the Bin Font  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  137
Selecting Clips and Sequences . . . . . . . . . . . . . . . . . . . . . . . . . . .  138
Duplicating Clips and Sequences . . . . . . . . . . . . . . . . . . . . . . . .  138



vi

Moving Clips and Sequences . . . . . . . . . . . . . . . . . . . . . . . . . . . .  139
Copying Clips and Sequences  . . . . . . . . . . . . . . . . . . . . . . . . . . .  139
Deleting Clips and Sequences . . . . . . . . . . . . . . . . . . . . . . . . . . .  140
Sifting Clips and Sequences . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  141
Locking Items in the Bin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  143
Selecting Ofßine Items in a Bin . . . . . . . . . . . . . . . . . . . . . . . . . .  144
Selecting Media Relatives for an Object  . . . . . . . . . . . . . . . . . .  145
Selecting Sources Used by an Object  . . . . . . . . . . . . . . . . . . . . .  145
Selecting Unreferenced Clips . . . . . . . . . . . . . . . . . . . . . . . . . . . .  146

Using Text Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  147
About Bin Views . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  148
Customizing Bin Views . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  148

Moving and Rearranging Columns  . . . . . . . . . . . . . . . . . . .  149
Tidying Up Bin Columns . . . . . . . . . . . . . . . . . . . . . . . . . . . .  149
Showing and Hiding Columns . . . . . . . . . . . . . . . . . . . . . . .  149
Deleting a Column. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  150
Duplicating a Column. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  151
Adding Customized Columns to a Bin  . . . . . . . . . . . . . . . .  152
Changing a Custom Column Heading. . . . . . . . . . . . . . . . .  152

Saving a Custom View . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  153
Managing Clip Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  154

Moving Within Column Cells . . . . . . . . . . . . . . . . . . . . . . . .  154
Modifying Clip Information . . . . . . . . . . . . . . . . . . . . . . . . .  155
Copying Information Between Columns  . . . . . . . . . . . . . .  160
Copying Information from Another Cell in the Same 

Column. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  160
Sorting Clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  160

Using Frame Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  162
Changing the Bin Background Color  . . . . . . . . . . . . . . . . . . . . .  163
Enlarging or Reducing Frame Size  . . . . . . . . . . . . . . . . . . . . . . .  163
Rearranging Frames  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  164
Changing the Frame Identifying the Clip  . . . . . . . . . . . . . . . . .  164
Tidying Up Frames in a Bin  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  164



vii

Using Script Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  165
Adding Text in Script Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  166
Rearranging Clips in Script Mode . . . . . . . . . . . . . . . . . . . . . . . .  167
Displaying Clip Information in Script Mode . . . . . . . . . . . . . .  167

Printing Bins . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  167
Gathering Format Elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  169

Preparing Digital Bars and Tone  . . . . . . . . . . . . . . . . . . . . . . . . .  169
Importing a PICT File of Bars . . . . . . . . . . . . . . . . . . . . . . . . . . . .  170
Creating Leader . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  171

Creating Picture Leader  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  172
Creating Sound Track Leader  . . . . . . . . . . . . . . . . . . . . . . . .  173

Storyboard Worksheet . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  174

Chapter 6 Managing Media Files

Using the Media Tool  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  175
Basic Media Tool Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  176
Opening the Media Tool  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  177
Deleting Tracks with the Media Tool  . . . . . . . . . . . . . . . . . . . . .  179

Freeing Storage Space . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  181
Abridging Media Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  181
Converting Media Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  182
Deleting Unreferenced Clips  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  183

Consolidating Media . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  184
About the Consolidate Feature . . . . . . . . . . . . . . . . . . . . . . . . . . .  184
Using the Consolidate Command  . . . . . . . . . . . . . . . . . . . . . . . .  185

Backing Up Media Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  188
Relinking Media Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  188

Relinking to Selected Clips. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  190
Relinking Consolidated Clips  . . . . . . . . . . . . . . . . . . . . . . . . . . .  191
Relinking Moved Projects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  191

Unlinking Media Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  192



viii

Chapter 7 Using Script Integration

Line Script Basics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  194
Explanation of Symbols . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  195
Lining in the Digital Realm  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  196
Script Integration Workßow . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  197
Using Script Integration in Video Projects  . . . . . . . . . . . . . . . .  198

Script Window Basics  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  199
Importing a Script . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  199
Opening, Closing, and Saving the Script Window  . . . . . . . . .  200
Navigating in the Script Window  . . . . . . . . . . . . . . . . . . . . . . . .  201
Adjusting the Script Margins . . . . . . . . . . . . . . . . . . . . . . . . . . . .  201

Manipulating Script Text  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  202
Changing the Font of the Script . . . . . . . . . . . . . . . . . . . . . . . . . .  202
Selecting Text . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  203
Cutting, Copying, and Pasting Script . . . . . . . . . . . . . . . . . . . . .  204
Removing Script Text . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  205

Searching Through Script . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  206
Using Page and Scene Numbers. . . . . . . . . . . . . . . . . . . . . . . . . .  206

Adding a Page or Scene Number  . . . . . . . . . . . . . . . . . . . . .  206
Changing a Page or Scene Number  . . . . . . . . . . . . . . . . . . .  207
Deleting Page or Scene Numbers . . . . . . . . . . . . . . . . . . . . .  208
Searching for a Page and Scene Number  . . . . . . . . . . . . . .  209

Conducting a Text Search  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  209
Linking Clips to the Script . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  210
Manipulating Slates. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  212

Selecting Slates  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  212
Resizing a Slate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  212
Hiding Slate Frames . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  213
Showing One Take Per Slate. . . . . . . . . . . . . . . . . . . . . . . . . . . . .  213
Moving a Slate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  214
Deleting a Slate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  215

Manipulating Takes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  215
Selecting Takes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  216



ix

Adding Takes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  216
Deleting Takes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  216
Displaying Take Numbers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  217
Changing the Representative Frame for a Take  . . . . . . . . . . . .  217
Loading Takes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  218
Playing Takes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  218
Adjusting Take Lines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  219
Indicating Off-Screen Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . .  219
Using Color Indicators . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  220

Using Script Marks  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  221
Placing Script Marks Manually . . . . . . . . . . . . . . . . . . . . . . . . . .  221
Automated Screening and Marking  . . . . . . . . . . . . . . . . . . . . . .  222
Loading and Playing Marked Segments. . . . . . . . . . . . . . . . . . .  224
Moving a Script Mark  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  224
Deleting a Script Mark . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  225

Finding Clips and Script . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  225
Finding Script  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  225
Finding Clips and Bins from the Script  . . . . . . . . . . . . . . . . . . .  226

Editing with the Script Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  226
Script Editing Workßow  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  227
Splicing a Script Range  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  228
Revising the Script  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  228
Interactive Screenings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  228

Chapter 8 First Edits in Source/Record Mode

Entering Source/Record Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  231
Setting Up a New Sequence . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  231

Changing the Sequence Clip Info . . . . . . . . . . . . . . . . . . . . . . . .  233
Setting Up Tracks for the New Sequence . . . . . . . . . . . . . . . . . .  234

User Preferences for Creating Tracks . . . . . . . . . . . . . . . . . .  235
Adding Filler  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  235
Copying Locators from Source Clips. . . . . . . . . . . . . . . . . . . . . .  236

Making the First Edit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  237



x

Creating an Instant Rough Cut. . . . . . . . . . . . . . . . . . . . . . . . . . .  238
Undoing or Redoing Edits  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  240
Editing Additional Shots into the Sequence. . . . . . . . . . . . . . . . . . .  241

Performing a Splice Edit  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  241
Performing an Overwrite Edit  . . . . . . . . . . . . . . . . . . . . . . . . . . .  242
Performing a Replace Edit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  242
Using Single Mark Editing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  243

Using Phantom Marks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  244
Setting One Mark  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  244
Adding a Second Mark  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  244

Lifting, Extracting, and Copying Material. . . . . . . . . . . . . . . . . . . . .  245
Lifting Material . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  245
Extracting Material . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  246
Copying Material  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  246
Using the Clipboard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  247

Preserving Clipboard Contents . . . . . . . . . . . . . . . . . . . . . . .  247
Recovering Material from the Clipboard  . . . . . . . . . . . . . .  248

Adding Comments to Sequence Clips . . . . . . . . . . . . . . . . . . . . . . . .  249
Playing the New Sequence . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  250

Starting a Playback Loop . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  251
Playback Performance Tips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  251

How to Proceed . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  252

Chapter 9 Using the Timeline

Using Segment Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  254
Segment Mode Workßow  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  254
Selecting and Deselecting Segments. . . . . . . . . . . . . . . . . . . . . .  255

Selecting with the Segment Mode Pointer . . . . . . . . . . . . .  255
Lassoing One or More Segments  . . . . . . . . . . . . . . . . . . . . .  256
Deselecting Segments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  257

Performing Segment Mode Edits . . . . . . . . . . . . . . . . . . . . . . . . .  257
About Four-Frame Display  . . . . . . . . . . . . . . . . . . . . . . . . . .  258
Extracting/Splicing Segments . . . . . . . . . . . . . . . . . . . . . . . .  261



xi

Lifting/Overwriting Segments  . . . . . . . . . . . . . . . . . . . . . . .  261
Deleting Segments with Segment Mode. . . . . . . . . . . . . . .  262
Marking Clips and Sequences with Segment Mode  . . . .  263

Using Advanced Timeline Techniques  . . . . . . . . . . . . . . . . . . . . . . .  264
Bin Editing into the Timeline . . . . . . . . . . . . . . . . . . . . . . . . . . . .  264
Cut, Copy, and Paste in the Timeline  . . . . . . . . . . . . . . . . . . . . .  265
Using Full-Screen Timeline. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  265
Editing with the Film Track. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  268
Editing in Heads/Tails View . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  271

Working with Multiple Tracks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  273
About Effects Editing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  273
About Nesting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  274
Using the Track Selector Panel . . . . . . . . . . . . . . . . . . . . . . . . . . .  275
Selecting Tracks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  276
Monitoring Tracks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  277

Monitoring Video. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  277
Monitoring Audio  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  278
Solo Track Monitoring  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  279

Patching Tracks  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  280
Locking and Sync-Locking Tracks . . . . . . . . . . . . . . . . . . . . . . . .  281

Locking Tracks  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  282
Sync-Locking Tracks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  282

Adding a Track. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  283
Deleting Tracks  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  283
Adding an Edit (Match Framing) . . . . . . . . . . . . . . . . . . . . . . . . .  284

Removing Match-Frame Edits . . . . . . . . . . . . . . . . . . . . . . . .  285
Backtiming Edits . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  286
Creating One-Step Overlap Edits  . . . . . . . . . . . . . . . . . . . . . . . .  287

Additional Ofßine Aids  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  288
Detecting Duplicate Frames  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  289
Tracking Color Frame Shifts . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  290

Printing the Timeline. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  292



xii

Chapter 10 Working in Trim Mode

Basic Trim Procedures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  295
Entering Trim Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  295
Exiting Trim Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  297
Toggling Between Big and Small Trim Mode . . . . . . . . . . . . . .  297
Selecting Between Trim Sides  . . . . . . . . . . . . . . . . . . . . . . . . . . .  298
Selecting Additional Transitions . . . . . . . . . . . . . . . . . . . . . . . . .  299
Performing a Basic Trim. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  300
Reviewing the Trim Edit  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  301
Dual-Image Playback During Trims . . . . . . . . . . . . . . . . . . . . . .  302
Trimming On the Fly  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  303
Trimming During a Playback Loop . . . . . . . . . . . . . . . . . . . . . . .  304

Creating Overlap Edits  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  305
Extending an Edit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  305
Slipping or Sliding Shots . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  306

Selecting Segments for Slip or Slide Trimming . . . . . . . . . . . .  307
The Slip/Slide Display . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  308
Performing the Slip or Slide Trim . . . . . . . . . . . . . . . . . . . . . . . .  310
Slipping Shots in Source/Record Mode . . . . . . . . . . . . . . . . . . .  310

Performing a Slide Trim . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  311
Maintaining Sync While Trimming  . . . . . . . . . . . . . . . . . . . . . . . . . .  311

Adding Black When Trimming  . . . . . . . . . . . . . . . . . . . . . . . . . .  312
Trimming with Sync-Locked Tracks . . . . . . . . . . . . . . . . . . . . . .  313

Using the Transition Corner Display . . . . . . . . . . . . . . . . . . . . . . . . .  314

Chapter 11 Working with Audio

About Audio Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  318
Audio Editing Aids  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  318

Using Audio Scrub . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  319
Smooth Scrub Versus Digital Scrub . . . . . . . . . . . . . . . . . . .  319
Selecting Tracks for Scrubbing . . . . . . . . . . . . . . . . . . . . . . .  319

Using Smooth Audio Scrub  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  320
Smooth Scrub Using the J-K-L Keys  . . . . . . . . . . . . . . . . . .  320



xiii

Smooth Scrub Using the Mouse . . . . . . . . . . . . . . . . . . . . . .  321
Using Digital Audio Scrub . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  321

Adjusting Digital Scrub Parameters  . . . . . . . . . . . . . . . . . .  322
Performing the Digital Scrub Procedure . . . . . . . . . . . . . . .  324

Using Waveform Plots  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  324
Displaying Audio Waveforms . . . . . . . . . . . . . . . . . . . . . . . .  324

Muting the Audio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  326
Using the Audio Mix Tool  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  327

Resizing the Audio Mix Tool  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  328
Adjusting One Audio Track at a Time  . . . . . . . . . . . . . . . . . . . .  329
Ganging and Adjusting Multiple Tracks . . . . . . . . . . . . . . . . . .  333
Ignoring Existing Volume and Pan Settings  . . . . . . . . . . . . . . .  334

Using Audio Gain Automation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  335
System Clip Gain  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  336
Real-Time Response of Audio Gain Automation . . . . . . . . . . .  337
Using Audio Gain Automation  . . . . . . . . . . . . . . . . . . . . . . . . . .  337

Deleting Break Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  339
Moving Break Points on the Timeline . . . . . . . . . . . . . . . . .  339

Using the Audio Equalization Tool  . . . . . . . . . . . . . . . . . . . . . . . . . .  341
Audio EQ Tool Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  342
Applying Audio EQ Effects  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  344
Saving Audio EQ Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  347
Audio EQ Examples  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  348

Low Shelf Example  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  349
Small Octave Range Example  . . . . . . . . . . . . . . . . . . . . . . . .  350

Using Audio Punch-In. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  351
Using the Audio Punch In Tool  . . . . . . . . . . . . . . . . . . . . . . . . . .  353
Connecting the Hardware . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  353
Creating the Voice-Over. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  353
Voice-Over Media Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  355

Fine-Tuning Audio Transitions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  356
Fading and Dipping Audio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  357

Fading Audio  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  357



xiv

Dipping Audio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  359
Mixing Down Audio Tracks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  360

Chapter 12 Syncing Methods

Autosyncing Clips  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  362
Resyncing Subframe Audio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  365
Managing Sync Breaks  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  367

Editing to Avoid Sync Breaks . . . . . . . . . . . . . . . . . . . . . . . . . . . .  367
Displaying Sync Breaks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  368
Fixing Sync Breaks  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  369

Fixing Sync in Trim Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . .  369
Fixing Sync in Source/Record Mode  . . . . . . . . . . . . . . . . . .  370
Fixing Sync in Segment Mode. . . . . . . . . . . . . . . . . . . . . . . .  370

Managing Sync with Multiple Tracks  . . . . . . . . . . . . . . . . . . . . . . . .  371
Using Sync Lock  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  371
Using Tail Leader. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  372
Using Locators . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  373
Using Add Edit When Trimming . . . . . . . . . . . . . . . . . . . . . . . . .  375

Using Sync Point Editing (SPE) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  375
Ganging Footage in Monitors  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  377
Using Match Frame  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  378

Performing a Match Frame  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  379
Performing a Reverse Match Frame  . . . . . . . . . . . . . . . . . . . . . .  379
Using the Match Frame to Find Sources . . . . . . . . . . . . . . . . . . .  380

Chapter 13 Multicamera Editing

Developing a Postproduction Model . . . . . . . . . . . . . . . . . . . . . . . . .  381
Tape ClassiÞcation Schemes . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  382
Production Paths . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  382
Managing Audio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  384
Digitizing Workßow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  385
Digitizing Methods. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  386

Storage Tips. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  387



xv

Checking the Bins . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  388
Replacing Missing Clips  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  388
Checking Audio and Image Quality  . . . . . . . . . . . . . . . . . .  389

Additional Ofßine Editing Aids  . . . . . . . . . . . . . . . . . . . . . . . . .  389
Grouping and Multigrouping . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  389

Creating Group Clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  390
Creating Multigroup Clips  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  392

MultiCamera Edit Modes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  393
Full-Monitor Display . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  393
Quad Split. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  395

MultiCamera Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  396
MultiCamera Editing Techniques . . . . . . . . . . . . . . . . . . . . . . . . . . . .  398

Switching Shots with the Arrow Keys . . . . . . . . . . . . . . . . . . . .  399
Cutting on the Fly with Hot Keys  . . . . . . . . . . . . . . . . . . . . . . . .  399
Using the MultiCamera Linecut Option. . . . . . . . . . . . . . . . . . .  400
Using the Add Edit Button  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  401
Using the Quad Split Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  402
Using the Quad Menus  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  403
Using Match Frame in Multicamera Editing . . . . . . . . . . . . . . .  404

Workßow Options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  404
Selective Camera Cutting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  404
Cutting on the Fly . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  405
Combination Cutting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  407

Chapter 14 Output Options for Film

Film List Concepts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  408
Cut Lists Versus Change Lists. . . . . . . . . . . . . . . . . . . . . . . . . . . .  409
Frame Reference Numbers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  410
About Sublists . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  411

Assemble Lists  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  412
A-Roll Versus A/B-Roll Conforming . . . . . . . . . . . . . . . . . .  413
Scene Assemble List  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  414
Optical List  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  415



xvi

Types of Effects Supported by Optical List  . . . . . . . . . . . .  416
Dupe List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  417
Pull Lists  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  418
Change Pull List and Discard list . . . . . . . . . . . . . . . . . . . . .  419
Scene Pull List  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  419
Optical Scene Pull List  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  420

Understanding Icons in Cut Lists and Change Lists . . . . . . . .  421
Creating a List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  424

Preparing Sequences  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  424
Generating the First Cut List . . . . . . . . . . . . . . . . . . . . . . . . .  424
Generating a Change List . . . . . . . . . . . . . . . . . . . . . . . . . . . .  425
Comparing and Combining Cuts and Reels. . . . . . . . . . . .  425
Generating a Final Cut List  . . . . . . . . . . . . . . . . . . . . . . . . . .  426

Opening the Tool. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  426
Getting Sequences  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  428

Clearing the Display . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  430
Recalling a Previous Setting . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  430
Selecting Tracks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  431

Renaming the List  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  431
Selecting Options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  432
Viewing the List. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  435
Changing the Options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  437
Printing or Saving the Lists. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  437

Printing the Lists  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  437
Saving the Lists  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  438

Saving the Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  438
Replacing Saved Option Settings . . . . . . . . . . . . . . . . . . . . .  439

Working with Multiple Cuts and Reels . . . . . . . . . . . . . . . . . . . . . . .  440
Creating a Cut List for Two or More Sequences . . . . . . . . . . . .  440
Creating Change Lists Across Multiple Reels . . . . . . . . . . . . . .  441

Using Reel Numbers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  441
Using Preview Code  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  442
Dupe Checking Across Multiple Reels . . . . . . . . . . . . . . . .  444



xvii

Using the Matchback Option . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  445
About Matchback  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  445
Generating a Cut List with Matchback . . . . . . . . . . . . . . . . . . . .  447

Chapter 15 Output Options for Video and Audio

Preparing for Output . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  449
Digital Cuts and Audio  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  450

Changing the Default Pulldown Frame  . . . . . . . . . . . . . . .  451
Calibrating for Video Output . . . . . . . . . . . . . . . . . . . . . . . . . . . .  451
Basic Output Calibration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  452
Advanced Output Calibration  . . . . . . . . . . . . . . . . . . . . . . . . . . .  453

Displaying Advanced Calibration Controls . . . . . . . . . . . .  453
Using Test Patterns  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  454
Calibrating Site Output Settings  . . . . . . . . . . . . . . . . . . . . .  455

Preparing for Audio Output . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  458
Setting the Calibration Tone  . . . . . . . . . . . . . . . . . . . . . . . . .  458
Calibrating Global Output Levels  . . . . . . . . . . . . . . . . . . . .  459

Generating Four-Channel Audio . . . . . . . . . . . . . . . . . . . . . . . . .  462
Preparing Record Tapes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  463

Frame-Accurate Recording . . . . . . . . . . . . . . . . . . . . . . . . . . .  463
Manual Recording . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  463
Recording Bars and Tone  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  464

Enabling Assemble-Edit Recording  . . . . . . . . . . . . . . . . . . . . . .  465
Recording a Digital Cut  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  467

Previewing a Digital Cut . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  467
Creating a Custom Countdown Display . . . . . . . . . . . . . . .  469

Recording a Digital Cut to Tape . . . . . . . . . . . . . . . . . . . . . . . . . .  470
Using EDL Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  473
VTR Play Emulation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  474

Chapter 16 Exporting and Exchanging Material

Supported File Types for Export . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  476
Preparing to Export  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  477



xviii

Using Video Mixdown . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  478
Exporting PICT Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  480

Before You Begin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  480
How to Export PICT Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  480

Exporting a PICT Frame . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  483
Exporting a PICT Sequence . . . . . . . . . . . . . . . . . . . . . . . . . .  484

Exporting QuickTime Files. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  486
Before You Begin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  486
How to Export QuickTime Files . . . . . . . . . . . . . . . . . . . . . . . . . .  487
Using the Media Composer QuickTime Codec from QuickTime 

Applications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  494
Installing the Codec in QuickTime Applications . . . . . . .  494
Exporting from a QuickTime Application  . . . . . . . . . . . . .  495

Exporting OMF Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  495
About OMF Interchange  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  496
Methods for Exporting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  497
Before You Begin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  498
How to Export OMF Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  498

Transferring OMF Files from Film Composer to AudioVision . . .  503
Before You Begin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  504
Step 1: Making a Digital Cut to Tape of the Edited Picture  . .  506
Step 2: Consolidating the Media Files in Film Composer  . . .  506
Step 3: Exporting the OMF Interchange Composition. . . . . . .  508
Step 4: Relocating the Media  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  510
Step 5: Importing the Composition . . . . . . . . . . . . . . . . . . . . . . .  511

Transferring OMF Files to Pro Tools  . . . . . . . . . . . . . . . . . . . . . . . . .  511
Choosing How to Export the Sequence  . . . . . . . . . . . . . . . . . . .  511
Choosing Whether to Consolidate Your Media Files . . . . . . . .  512

Consolidating Your Media Files . . . . . . . . . . . . . . . . . . . . . .  513
Copying Media Files Manually. . . . . . . . . . . . . . . . . . . . . . .  515

Method 1: Using the OMFI Compositions Only Option. . . . .  515
How to Transfer a Sequence to Pro Tools Using OMFI 

Compositions Only . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  516



xix

Method 2: Using the OMFI Audio and Composition Option  518
How to Transfer a Sequence to Pro Tools Using OMFI Audio 

and Composition  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  519
Transferring Projects and Media Files Between Systems. . . . . . . .  521

Storage Devices for Transferring Media. . . . . . . . . . . . . . . . . . .  522
Transferring a Project to Another Film Composer System . . .  523
Using AvidNet . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  524

Glossary

Index



20

CHAPTER 1

Logging

When you log with a deck or import shot log Þles, you provide the 
Film Composer system with frame-accurate clip information used to 
digitize the source footage. The logs you create form the foundation 
for organizing, tracking, storing, retrieving, and generating lists of edit 
information throughout your project.  Techniques for preparing log 
information prior to digitizing are covered in the following sections:

¥ Logging Tips

¥ Preparing Logs for Import

¥ Importing Shot Log Files

¥ Logging Directly into a Bin

¥ Logging Film Information

¥ Modifying Clip Information

¥ Exporting Log Files

c For Þlm projects, the method used in the Þlm-to-tape transfer has a 
direct bearing on the procedures required for logging and digitizing. 
For more information, see Appendix A in the Avid Film Composer 
Getting Started Guide.



21

Logging Tips

Observe the following important guidelines for preroll, timecode for-
mats, and naming of tapes when logging prior to digitizing.

Logging Preroll

Be sure to  leave adequate preroll with continuous timecode prior to 
IN points when logging your tapes.  The recommended minimum pre-
roll is one second for Betacam playback, and Þve seconds for  3/4-inch 
U-matic playback.

n You set the default preroll for tape playback using Deck Settings.  For more 
information, see the Avid Media Composer Products Reference.

Logging Timecode

Check the timecode format of each tape (drop-frame versus non-drop-
frame timecode) when you are logging without a tape in the deck.  Log 
drop-frame timecode using semicolons (;) between the hours, minutes, 
seconds, and frames.  Log non-drop-frame timecode with colons (:). 

n If you make a mistake and need to change the logged timecode format, you can 
correct the format using the Modify command.   For information, see the sec-
tion  ÒModifying Clip InformationÓ on page 44.

Naming Tapes

When entering tape names in the Digitize tool, consider the following:

¥ Tape names must be alphanumeric characters (A to Z, 0 to 9), with 
no spaces before the name. They can include upper and lowercase. 
The maximum length of a name is 32 characters. 
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¥ It is possible to have a single tape listed as several different tapes if 
you alter the case of the letters. For example, if you type a single 
name as TAPE, Tape, and tape on three different occasions, all three 
names will appear. This can cause signiÞcant problems in keeping 
track of clips when batch digitizing, redigitizing, and generating 
an EDL. Choose a case convention and maintain it throughout a 
project.

¥ It is important that you devise a naming scheme for your tapes. 
For example, tapes with similar names can be easily sorted and 
viewed together in a bin. However, it may be difÞcult to distin-
guish among numerous tapes with similar names when trying to 
locate a speciÞc tape quickly. Name tapes based upon the amount 
and complexity of your source material.

¥ If you are planning to generate an EDL for import into an edit con-
troller for online editing, double-check the controllerÕs speciÞca-
tions beforehand. Some edit controllers will truncate source tape 
names to as few as six characters, while others will eliminate char-
acters and truncate to three numbers. Alterations like these at the 
EDL stage might cause the system to identify different source 
tapes with similar names in the same way, causing you to lose 
track of source material.

Double-Checking the Logs

When importing shot logs for video, the Media Composer system 
compares the video duration to the video out minus the video in. 
When importing Þlm shot logs, the system compares the key number 
out minus the key number in.

If the system detects a discrepancy, it reports the error and does not 
bring the clip into the bin. The best way to ensure that clips are not dis-
carded on import is to double-check the logs for discrepancies in dura-
tion and marks.
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c If you are working on a Þlm project, you must enter shot log infor-
mation into the bin before digitizing. If you intend to automate the 
logging process during digitizing using either the Avid Media 
Reader or the pulldown ßag option, you can skip to Chapter 2.

Preparing Logs for Import

Film Composer provides many useful tools to help you prepare frame-
accurate log information for import into the bin from any number of 
sources. This process may involve one or more of the following meth-
ods, which are described in this section:

¥ To log the material on any Macintosh¨ or PC, use the MediaLogª 
application, and transfer the bins directly into Media Composer 
with minimum effort, as described in ÒUsing MediaLogÓ on 
page 23.

¥ To quickly convert logs (created by other sources) use the Avid 
Log Exchange program, as described in ÒConverting Logs with 
Avid Log ExchangeÓ on page 25.

¥ Use a word processor or standard text editor to create and import 
logs, as described in ÒCreating Avid LogsÓ on page 28.

Using MediaLog 

For information on spe-
ciÞc MediaLog proce-
dures, see the Avid 
MediaLog UserÕs Guide.

MediaLog is a standalone application that speeds the process of creat-
ing and importing log information from any Macintosh or IBM¨-com-
patible computer. MediaLog mirrors the Media Composer interface for 
creating projects, bins, and clip information in the bin, and includes 
serial deck control for logging directly from tape.

n If you purchased Film Composer or Media Composer 1000, 4000, or 8000, the 
MediaLog application is included with your application disks. If you have the 
Media Composer 900 or Ofßine models and would like to purchase MediaLog, 
contact your Avid sales representative for more information.
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Transferring Bins from MediaLog for Macintosh

If you log your source footage using MediaLog for Macintosh, you can 
transfer the bins directly to Film Composer for batch digitizing by 
moving the bin Þles in the Finder.

To transfer bins from MediaLog for Macintosh:

1. Save the MediaLog bins to a 3.5-inch disk.

2. Quit the Film Composer application.

3. In the Finder, open the project folder where you want to store the 
MediaLog bins. This folder is usually located inside the Composer 
Projects folder on the Avid disk.

4. Insert the disk from MediaLog into the diskette drive.

5. Double-click the disk icon.

If your MediaLog folders are available through a server or other 
networked source mounted on your desktop, then locate the 
MediaLog folder there instead.

6. Shift-select the bins in the Disk Directory window and drag them 
into the project folder.

7. Restart  and open your project.

8. Associate the imported bins with your project by doing the follow-
ing:

a. Choose Open Bin from the File menu.

b. Locate the new bin using the Directory pop-up menu.

c. Double-click the bin to open it within your project. 

d. The new bin appears in the Bin scroll list of the Project win-
dow.

The bins you have imported contain master clips only with no associ-
ated media Þles. Before you can view or manipulate these clips, you 
must create the associated media Þles by batch digitizing the source 
material.



25

Transferring Bins from MediaLog on the PC

If you log your source footage using MediaLog on the PC, you can 
import the logs using the same procedure as you would for other 
Avid-compatible log formats, as described in ÒImporting Shot Log 
FilesÓ on page 29.

c To work with PC Þles such as MediaLog on the PC, you must have 
the Macintosh 7.5 or later operating system or the DOS Mounter 
application on your system.

Converting Logs with Avid Log Exchange

Many telecine and other Þlm-to-tape transfer systems can generate a 
log which you can import directly into Film Composer. This is the 
most accurate and the preferred method. You can open some logs 
directly in bins; others must be converted to Avid Log format Þrst 
using the Avid Log Exchange utility, as described in this section.

To convert a Þle:

1. In the Finder, open the utilities folder on the Avid drive and locate 
the Avid Log Exchange application inside the folder labeled ALE f.

2. Double-click the Avid Log Exchange icon to start the application.

The Avid Log Exchange window opens.



26

For speciÞc informa-
tion on the various Þle 
types shown here, see 
the Avid Media Composer 
Products Reference. 

3. Make a selection for Input/Output. 

The default output selection is the Avid Log Exchange (.ALE) for-
mat. This is the required format for import into a Film Composer 
bin.

4. Select the tracks to include in the Tracks column of the log. After 
you import the log into a Film Composer bin, the system digitizes 
all tracks shown in this column when batch-digitizing.

5. Select the Clean option if you want Avid Log Exchange to clean 
the input Þle to eliminate overlapping timecodes for clips.

When you select the Clean option, the utility removes the end 
timecode from any clip that overlaps the start of the next clip.

6. Click the Convert button to open the File Selection dialog box.

7. Open the disk and folder that contain the Þles you want to con-
vert.

Files you 
can gener-
ate 

Files you 
can convert

Clean 

Convert button Quit button

option

Track
selection
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8. Double-click the input Þle name. Only one Þle is converted at a 
time.

Avid Log Exchange stores the converted Þle in the same folder as 
the original input Þle.

The original Þlename extension is replaced by the extension for the 
new format. The .ALE Þles can be imported only into Avid products.

Drag and Drop Conversion

Use this shortcut to convert any type of Þle into an .ALE Þle:

1. Insert the disk in the Macintosh disk drive if the Þles you want to 
convert are stored on a 3.5-inch disk.

2. Open the folder that contains the Avid Log Exchange utility icon.

3. Open the folder that contains the Þles you want to convert, posi-
tioning the folder so the Avid Log Exchange icon is visible.

4. Select Þles for conversion.

Location of the 
files

File to be 
converted

Input file Converted file
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5. Drag the selected Þles to the Avid Log Exchange icon and release.

The system converts the Þles to Avid format, adding the .ALE 
extension to the new Þle names.

Creating Avid Logs

You can prepare an Avid log on any type of Macintosh or IBMÐ
compatible computer using a word processing application or a text 
editor. In either case, to ensure accuracy you must follow closely the 
speciÞcations described in the Avid Media Composer Products Reference.

When logging manually, you should document the following informa-
tion:

¥ Identify the source tape for each shot.

¥ Document each clipÕs name, start timecode, and end timecode.

¥ In the case of NTSC transfer tapes for Þlm projects, you must sup-
ply Pulldown information in the Pullin column of the Film Com-
poser bin before you can digitize

This is the minimum information required to digitize successfully. You 
can also add other information such as comments, auxiliary time-
codes, or key numbers for Þlm projects. You can make a separate log 
Þle for each videotape, or log clips from several different videotapes in 
one log.

Select files, drag to the 
icon, and release.
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Using a Word Processor

If you use a rich-text formatted program like Microsoft¨ Word or 
WordPerfect¨, you must do the following:

1. Enter shot log information according to the speciÞcations 
described in the Avid Media Composer Products Reference.

2. Save your Þle as a text Þle in the Save As dialog box.

c The Film Composer system only accepts text Þles (ASCII format).

Using Vantage

Another alternative is to use a text editor, such as the Vantageª pro-
gram provided with your system. Text editors like Vantage always 
maintain the log information in text Þle (ASCII) format. Vantage also 
provides useful tools for arranging and conforming text to various 
shot log, cut list, and EDL (edit decision list) speciÞcations. The Van-
tage program is located in the Utilities folder. 

Importing Shot Log Files

You can also  import an 
EDL to a bin for use in 
digitizing. For more 
information, see  
ÒUsing EDL ManagerÓ 
on page 473.

You can import any log created or converted to meet Avid log speciÞ-
cations. In the case of Þlm projects, most telecine and other Þlm-to-
tape transfer systems will generate a log which you can import 
directly to the bin, often after conversion to .ALE format using the 
Avid Log Exchange utility. You can also combine or merge events 
while importing a log so that fewer master tapes require digitizing, as 
described in this section.

To import log Þles to the Film Composer system:

1. Open a bin or click an open bin to activate it.

2. Choose Import from the File menu. The import dialog box 
appears.
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3. Choose Shot Log from the File Type pop-up menu. 

4. If appropriate, select an option for combining events on import 
from the list of options in the lower right corner of the dialog box:

¥ Combine events based on scene and automatically create 
subclips. The system combines all events for a scene into a 
single master clip, then links the master clip to subclips that 
represent the original events for that scene. To use this option, 
you must have scene numbers logged in a scene column in the 
bin.

¥ Combine events based on camera roll and automatically cre-
ate subclips. The system combines all the events from a cam-
era roll into a single master clip, then links the master clip to 
subclips that represent the original events for that camera roll. 

Combine events options

File type pop-up menu

Import file scroll list

Source file scroll list

Directory pop-up menu
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To use this option, you must have camera roll numbers logged 
in a camera roll column in the bin for a Þlm project.

¥ Merge events with known sources and automatically create 
subclips. The system automatically creates subclips for those 
events that are merged, or relinked to their source clips upon 
import.  Use this option if you have already entered master 
clips in a bin for each camera roll or master scene, and subse-
quently logged all the events related to those clips for import.

5. Select the folder in which the log is located in one of the following 
ways:

¥ If the Þles are located in another folder on your hard drive, 
click the directory pop-up menu above the source Þle scroll 
list and locate the correct folder. 

¥ If the Þles are located on another drive, disk, or network 
source mounted on the desktop, click the Desktop button, 
then use the directory menu and scroll list to locate the Þle.

6. Select the Þles that you want to import by doing one of the follow-
ing:

¥ Select Þles individually and click Add.

¥ Select all the Þles by clicking Add All.

¥ Remove Þles from the box on the right by clicking Remove or 
Remove All.

The screen displays the Þles you want to import on the right 
side of the window. 

7. When the correct Þles appear in the Import scroll list, click Done. 

The bin Þlls with master clips derived from the information in the 
imported shot log. The system imports any additional information 
logged with each clip. To save this display after importing the log, 
save the bin.
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n The master clips you have imported contain only log information with no 
associated media Þles. Before you can view or manipulate these clips, you 
must create the associated media Þles by digitizing, as described in Chapter 2 
and Chapter 3.

Logging Directly into a Bin

You can log clip information in advance, allowing you to batch digitize 
the clips in one step.  To log the clips in advance, do one of the follow-
ing:

¥ Prepare shot logs using MediaLog, a word processor, or a standard 
text editor, and then import the logs directly into Media Composer 
bins.  For more information see ÒPreparing Logs for ImportÓ on 
page 23.

¥ Log the clip information directly into the bin, as described in this 
section.

You can log clips directly into a bin using the Digitize tool in one of 
two ways described in this section:

For complete informa-
tion on working with 
bin columns and clip 
information, see  
ÒUsing Text ModeÓ on 
page 147.

¥ Log directly into a bin with an Avid-controlled deck for semiauto-
mated data entry.

¥ Log manually during or after viewing of footage ofßine with a 
deck or other source that is not Avid-controlled.

Logging with an Avid-Controlled Deck

For information about 
connecting a compati-
ble deck to your system, 
See the Avid Media Com-
poser Products Connect-
ing Audio andVideo 
Equipment.

When you log with a compatible tape deck controlled from within 
Media Composer, you can automate part of the logging process by 
using buttons to enter frame-accurate timecode information from the 
deck. This method is more accurate than manual entry, because time-
codes are transferred directly from tape to the bin.
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To log clips to a bin using the Digitize tool:

1. Turn on power to the tape deck and make sure the deck is prop-
erly connected.

2. Open the bin where you want to store the clips.

3. Choose Digitize from the Tools menu. The Digitize tool opens and 
the third full-screen monitor displays playback from the deck.

n If you forgot to connect and/or turn on the power to the deck before opening 
the Digitize tool, you can reinitialize deck control after turning it on using 
the Check Decks command in the Deck Selection pop-up menu.

4. If the Digitize tool is not currently in Log mode, click the Digitize/
Log mode button to display the log icon.

5. Load your tape into the deck. The system prompts you for a name. 

The Tape Selection dialog box shows only the tapes previously 
logged for the current project. Deselect the option ÒOnly show this 
projectÕs tapesÓ to select a name from other projects.

Timecode display

Memo field

Deck controls

Mark IN

Log buttonTrack Selection

Erase Mark

Message bar

Deck Selection pop-up

Mark OUT

 (constant)
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For guidelines in nam-
ing tapes, see ÒLogging 
TipsÓ on page 21.

6. Select a tape name from the scroll list or click the New button and 
enter a new tape name into the name entry Þeld that appears at 
the bottom of the dialog box.

7. Press Return. The tape name is displayed in the Digitize tool.

8. Click the Log Mode button in the Digitize tool.

The Capture Messages bar displays a message that the system is 
waiting for you to mark an IN point. The Log button displays an 
IN mark.

New tape name

Show Tapes option

List of tapes

New Tape Name
text entry field
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9. Set either an IN mark or an OUT mark for the clip you want to log, 
using one of the following methods:

¥ Use the deck controls in the Digitize tool to cue your source 
tape to the start or end point, and click the Mark IN or Mark 
OUT button.

¥ Click the large Log button in the upper right corner of the Dig-
itize tool to enter the mark.

¥ If the footage starts at a known IN or ends at a known OUT, 
type the timecode in the display area next to the mark, press 
the Go To button to scan the tape forward to the mark, or press 
Return to enter it.

After you set the mark, the icon in the Log button changes to the 
corresponding OUT or IN mark, and a pencil appears on the but-
ton.

10. To Þnish logging the clip, do one of the following:

¥ Set the remaining IN or OUT mark on the ßy using the but-
tons.

¥ Type a timecode for the clipÕs IN, OUT, or duration in the 
timecode entry Þeld next to the corresponding icon and press 
Return. 

The system automatically calculates the appropriate timecode for 
the remaining mark IN, mark OUT, or duration, and enters the 
clip into the bin. The clip name, which is chosen and automatically 
numbered by the system, is highlighted and ready to be changed.

c You must enter at least two of the three timecode marks (IN mark, 
OUT mark, or duration) in order to complete the log entry.

11. Name the clip by typing a new name before clicking any of the 
buttons in the Digitize tool. 

Mark IN

Mark OUT



36

n In general, you should change the clip name immediately, because it is very 
easy to forget the contents of each clip among the dozens that you log. You 
can, if necessary, accept the clip name and proceed with the logging process 
and change the clip names in the bin at a later time.

12. Repeat these steps until you have logged all your clips.

While viewing the footage,  you can continuously update your marks 
on the ßy by clicking the Mark button repeatedly before entering the 
second mark.

Logging with Non-Avid-Controlled Decks

You can use the Digitize tool to log clips directly into a bin from a 
source that is not Avid-controlled. For example, you can log clips from 
a deck that is not connected to the system, or from handwritten or 
printed log information for a tape that was previously logged but is 
not currently available.

1. If there is a deck connected to the system, eject the tape from the 
deck.

n When logging within the Digitize tool you should leave the deck empty. If a 
tape remains in the deck, the system will determine drop-frame or non-drop-
frame from that tape whether or not it matches your tapeÕs timecode format.

2. Double-click Deck in the settings scroll list of the Project window 
to open the Deck Settings dialog box.

3. Choose Non-Drop-Frame or Drop-Frame from the When No Tape 
in Deck Log pop-up menu.

4. Click OK to close the dialog box.

5. Open the bin where you want to store the clips.

6. Choose Digitize from the Tools menu. The tool opens.



37

7. Click the Digitize/Log Mode button in the Digitize tool to activate 
Log mode.

8. Click the Tape Name display. A dialog box appears.

9. Click Yes to open the Tape Selection dialog box.

10. Double-click the name of the tape in the dialog box, or click New 
and enter the name of the tape.   Click OK.

11. Select the tracks you want to log in the Digitize tool.

12. Type the start and end timecodes in the mark IN and mark OUT 
displays.

Timecode display

Memo field

Deck controls

Mark IN

Log buttonTrack Selection

Erase Mark

Message bar

Deck Selection pop-up

Mark OUT

 (constant)
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13. Click the Log button, or press the B key.

The clip is logged into the bin.

Logging Film Information

Once youÕve entered or imported the basic log information into a bin, 
you might want to add Þlm-related log information before digitizing. 
This section describes procedures and formats for adding various Þlm 
headings.

The following are some informational requirements for Þlm projects:

¥ The minimum information required for digitizing is the data 
recorded in the Start and End video timecode columns, and the 
Pulldown frame for NTSC transfers, which is noted in the Pullin 
column.

¥ Each reel of Þlm can be logged as a separate clip, and will corre-
spond to a single Film Composer clip, only if the video transfer of 
the Þlm reel has continuous pulldown, in the case of NTSC format, 
and continuous timecode, in the case of both NTSC and PAL. If the 
Þlm reels for your project do not meet this condition, then you 
must log each take on a reel of Þlm as a separate clip, which will 
correspond to a single Film Composer clip.

¥ All Þlm and video reference numbers must be in ascending order.

Displaying Film Columns

To display Þlm columns in the bin, do the following:

1. Choose Film from the Bin View pop-up menu to display all the 
required Þlm column headings.
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2. If you want to log data under optional headings (for example, Ink 
Number, Auxiliary TC1-Auxiliary TC5, or Film TC), choose Head-
ings from the Bin menu and select the speciÞc headings you want 
to add from the headings dialog box.

3. You can also track custom information for the job with special 
headings not included in the standard headings by typing the 
name of a category of information into the headings bar at the top 
of the bin. For more information, see ÒCustomizing Bin ViewsÓ 
on page 148.

Entering the Pulldown of the Sync Point

Unlike PAL transfers that do not use Pulldown, you cannot digitize 
NTSC tapes before you Þrst enter pulldown information into the bin. 
If you are importing a log generated automatically during the telecine 
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transfer, or if you used the pulldown ßag indication, you do not need 
to add this information manually.

By specifying the pulldown frame in the Pullin column, you accom-
plish the following:

¥ You ensure that the clips will start with the A-Þlm frame for the 
pulldown. Otherwise you might experience inaccuracies in key 
number tracking and in the cut lists. 

¥ You tell the system where the pulldown Þelds are located so that 
Film Composer can accurately eliminate the pulldown frames 
during the digitizing process, leaving you with a frame-to-frame 
correspondence between your digital media and the original Þlm 
footage.

To do this, you must indicate whether the sync point at the start of 
each Þlm clip transferred to tape is an A,B,C, or D Þlm frame, as 
described in this section.

n After you digitize an NTSC transfer, the timecode shows a loss of every Þfth 
frame of video. For example, donÕt be alarmed if you Þnd that your timecode 
jumps at one point from 1:00:14:15 to 1:00:14:17. You havenÕt lost a frame, 
just an extra pulldown Þeld.

Pullin column
Start TC (information required for NTSC)
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It is easiest to determine the pulldown of a sync point if you ask your 
Þlm lab to keypunch the sync frame in the original Þlm footage before 
transferring the Þlm to video. Many Þlm labs or transfer houses can 
also provide a pulldown frame indicator displayed at the far right of 
the burn-in key numbers, depending on the equipment available.

If the footage has not been keypunched, you can determine pulldown 
according to clapsticks or any other distinctive frame at the beginning 
of the clip.

To determine the pulldown sync point:

1. While viewing the video transfer on a monitor, go to the key-
punched (or clapsticks) sync point for the beginning frame of the 
clip youÕre logging.

2. Jog past the sync point frame Þeld-by-Þeld, using the jog wheel on 
the tape deck. You will see either two or three keypunched Þelds. 

3. If there are two Þelds, the pulldown is either A or C. Jog through 
the Þelds again, and note where the timecode changes:

a. If the timecode does not change from the Þrst to the second 
Þeld, itÕs an A-Þlm frame.

b. If the timecode does change from the Þrst to the second Þeld, 
itÕs a C frame.

4. If there are three key-punched Þelds, the pulldown is either B or 
D. Jog through the Þelds again and note where the timecode 
changes:

a. If the timecode changes between Þelds 2 and 3, the video came 
from a B-Þlm frame.

b. If the timecode changes between Þelds 1 and 2, the video came 
from a D frame.

5. Enter the information in the Pullin column in the appropriate bin 
before digitizing.
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Entering Frames-Per-Second Rates for PAL Transfers

When logging in advance for PAL transfers, the footage must be 
logged as clips that have a 25-fps play rate, as listed in the FPS column 
of the bin. If you wish, you can digitize the footage on the ßy, without 
logging the clips Þrst. The minimum information required to capture 
the footage is the data logged in the Start and End video timecode col-
umns.

Entering Key Numbers

To add key numbers, in the KN Start column, highlight the default key 
number, then type the key number for the sync point at the start of the 
clip, using one of the following formats.

¥ Keycode Format: Type a two-character manufacturer and Þlm type 
code, a six-digit preÞx for identifying the Þlm roll, a four-digit 
footage count, a two-digit frame offset, then press the Return key. 

Film Composer adds a space, hyphen, and plus sign to format the 
number (for example, to enter KJ 23 6892-1234+20, type 
KJ236892123420).

¥ Other Formats: Enter other Key Number formats in the Ink Num-
ber column. Type up to eight characters for the preÞx, up to Þve 
characters for the footage count, two digits as the frame count, 
then press the Return key. 

c Make sure the correct number appears when you press Return. For 
some Key Number formats, you may need to type the space, hyphen, 
and plus sign to format the number correctly.

Entering Additional Timecodes (Optional)
¥ In one of the Aux TC columns (that is, Aux TC1-AuxTC4) type an 

auxiliary timecode that syncs with the video timecode logged in 
the Start column. You can enter up to four auxiliary timecodes. 
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Only 30 fps drop- or non-drop-frame timecode is supported. Use 
one of the following formats:

- Enter a two-digit format for hours, minutes, seconds, and 
frames. You need not enter a leading zero. (For example, to 
enter 01:23:02:00, type 1230200.)

- When working with drop-frame timecode in the NTSC format 
(not applicable to PAL) enter a semicolon to indicate drop-
frame timecode (for example, to enter 01;23;02;00, type 
01;230200).

¥ In the Sound TC column, enter the Nagra timecode for the original 
audio for the start of the clip. The timecode should sync with the 
video timecode logged in the Start column in the bin. Enter the 
source sound roll identiÞer in the Soundroll column. Only 30 fps 
drop- or non-drop-frame timecode is supported.

¥ In the Film TC column, enter timecode generated by an Arrißex or 
Aaton camera for tracking the picture at the start of the clip. The 
Þlm timecode should sync with the video timecode logged in the 
Start column. Only 24 fps timecode is supported.

Entering the Ink Number (Optional)

To enter ink numbers:

1. Open the Film Settings dialog box by clicking Þlm in the Settings 
list of the Project window.

2. Make sure the correct options are selected for ink number format 
and ink number display, and press Return.

You can log different ink number formats in the same project as long 
as you change the ink number setting to the appropriate format 
before you log each type. Changing the ink number setting affects 
only the next ink numbers you log, not numbers that are already 
logged.
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3. Return to the bin, and enter numbers under the INK Number 
heading.

Use keycode format or use a two-digit preÞx to identify the roll, a 
hyphen, a four- or Þve-digit footage count, a plus sign, and a two-
digit frame count (for example, AA-00924+00).

Entering Additional Film Data

You can continue to log Þlm data into the Labroll, Camroll, Soundroll, 
Scene, and Take columns, or into your own custom columns, as neces-
sary. You can include the information in these columns on the cut lists 
you create for your edited sequence.

Modifying Clip Information

For complete informa-
tion on working with 
bin columns and clip 
information, see  
ÒUsing Text ModeÓ on 
page 147.

You can change or modify the information logged in the bin. This is 
especially useful if you Þnd that some of the data is incorrect, or if you 
need to update the information based on technical needs, such as 
varying timecode formats or Þlm speciÞcations.

For additional bin 
shortcuts, see the 
ÒShortcutsÓ section of 
the Avid Media Composer 
and Film Composer 
Quick Reference.

There are two ways to modify clip information prior to digitizing: 

¥ You can modify the information directly by clicking in a column 
and entering the new information one Þeld at a time.

¥ You can use the Modify command to change selected groups of 
clips  all at once.

w Modifying tape names and timecodes will effect any key numbers 
entered for the selected clips.
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Using the Modify Command

The Modify command gives you specialized control over groups of 
clip information. For example, you can use the Modify command to 
change the name of source tapes for some or all of your clips, to 
change the timecode format from drop- to non-drop-frame, or to incre-
ment or decrement the start and end timecodes by a speciÞed length of 
time for one or several clips at once.

To modify selected clips:

1. Open the bin.

2.  Click a clip icon to select it.  Shift-click each additional clip  you 
want to modify.

3. Choose Modify from the Clip menu.

The Modify dialog box appears.

Selected clips are 
highlighted
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4. Choose an option, such as Set Timecode By Field, from the  pop-
up menu.

Depending on the modiÞcation you select, different options 
appear in the dialog box that allow you to establish the speciÞc 
modiÞcation as shown in Table 1-1.

Click here to display 
pop-up menu
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5. After choosing the type of modiÞcation, select an option or enter 
information into the entry Þelds (timecode values, for example) 
when they appear.

6. Click OK. The modiÞcation takes effect.

Table 1-1 Modify Dialog Box Options

Type of ModiÞcation Options Description

Set Timecode Drop/
Nondrop

Drop, Nondrop radio buttons Changes the timecode format between 
drop- and nondrop-frame

Set Timecode By Field Start or End radio buttons Changes either the Start or End timecode

Fields for Hour, Minutes, Sec-
ond, Frame

Allow you to enter custom timecode

Increment Timecode Start or End radio buttons Changes either the Start or End timecode

Timecode entry Þeld Allows you to enter custom incremental 
timecode

Decrement Timecode Start or End radio buttons Changes either the Start or End timecode

Field for timecode Allows you to enter new incremental time-
code

Set Key Number 
Generic (PreÞx)

Field for Key Number Allows you to enter a custom generic key 
number

Set Pullin Punch frame timecode entry 
Þeld

Sets the timecode location of the punch 
frame for pullin

A, B, C, or D radio buttons Selects the pulldown frame to match to the 
timecode entry

Set Tracks V, A1, A2, A3, A4 track selector 
buttons

Changes the clips conÞguration of tracks

Set Source Opens the Tape Name dialog 
box

Selects another source tape name for the 
clips
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Exporting Log Files

You can export a log Þle from Film Composer in a variety of formats 
for making adjustments apart from the system, or importing into 
another system.

To export a log of the clips in a bin:

1. Open the bin you want to export and change to Text view.

2. Choose Export from the File menu. The Export Format dialog box 
appears.

3. Select an Export format:

¥ Select Avid Log Exchange to export an .ALE log Þle for use in 
another Avid product.
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¥ Select Tab Delimited to export a bin in generic tab-delimited 
text Þle format for use in a text editor, database, or spread-
sheet program.

4. Click OK. The Save dialog box appears.

5. Open the disk and folder where you want to save the Þle for 
exporting, type a Þle name, and click Save.
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CHAPTER 2

Preparing to Digitize

Digitizing is the process of converting source material from analog vid-
eotape to digital form. Before you begin this process Ñ described in 
Chapter 3 Ñ you need to complete the following preparations:

¥ Selecting Settings

¥ Preparing the Hardware

¥ Audio Requirements for Film Transfers

¥ Setting Up the Compression Tool

¥ Setting Up the Digitize Tool

¥ Preparing for Audio Input

¥ Preparing for Video Input
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Selecting Settings

For more information 
on all settings options, 
see  the Avid Media Com-
poser Products Refer-
ence.  For a complete 
description of proce-
dures for locating and 
changing settings, see 
the Avid Film Composer 
Getting Started Guide. 

There are a number of settings that have a direct bearing on the digitiz-
ing process. Before digitizing, review the following options for Gen-
eral Settings, Deck Settings, and Digitize Settings:

¥ Drive Filtering Based on Resolution causes the system to dim all 
drives for which speed capabilities are unknown or untested in a 
particular Avid Video Resolution (AVR). Selected by default in the 
General Settings dialog box.

c The Film Composer system will not prevent you from using non-
Avid drives, but their reliability cannot be assured.

¥ Deck Settings include various options for source deck, sync 
mode, preroll, drop/non-drop-frame preference, and deck control.

¥ Digitize Settings include essential options for digitizing and 
batch-digitizing, including general parameters for capture of the 
source material, and special conditions such as using the pull-
down ßag for NTSC transfers, digitizing across timecode breaks or 
capturing a single video frame.

Preparing the Hardware

Your source material may originate from a videotape, a digital audio-
tape (DAT), a Compact Disc (CD), an in-house router, a tuner, or 
straight off-the-air, with the proper hardware conÞguration.  The fol-
lowing are a few last-minute items to double-check prior to digitizing.

¥ Full-Screen monitor. Before you begin digitizing and editing, set 
up your NTSC or PAL full-screen monitor using a color bar gener-
ator (or house pattern) and lock in those settings, if you havenÕt 
done so already.



52

For more information 
on the 16 x 9 format 
option, see  Avid Film 
Composer Getting 
Started Guide.

¥ 16 x 9 format. You can edit with video in the 16 x 9 wide screen 
format.  To digitize footage shot in the 16 x 9 format, you must 
have a compatible playback deck.   To view the footage full-screen, 
you must have a 16 x 9 compatible full-screen NTSC or PAL moni-
tor.

¥ Remote switch. The deck control switch on the front of the source 
deck must be set to remote rather than local to control the deck 
with the Digitize tool.

¥ Striped drives. If your footage contains complex images that you 
digitize at high resolution, you must use striped drives as 
described in the AVIDdriveª Utility UserÕs Guide.  In addition, var-
ious models and AVRs have different striping requirements.  For 
more information, see the Avid Media Composer Products Reference.

n Media Composer does not support input and output of S-Video. Use the com-
posite input/output to and from your S-Video equipment or a transcoder to 
digitize from S-Video format.

Audio Requirements for Film Transfers

Transferring your Þlm to videotape affects not only the play rate of the 
picture, but the audio as well. In order to compensate, you must use 
the following settings for the pulldown switch on the Video Slave 
Driver:

¥ If digitizing audio from NTSC tapes, set the pulldown switch to 
.99.

¥ If digitizing from simul-DAT tapes created during the telecine 
transfer, set the pulldown switch to .99.

¥ When digitizing from PAL transfers, set the pulldown switch to 
1.00.

¥ If digitizing audio directly from Þeld DAT or Nagra with a normal 
play rate, set the pulldown to 1.00.
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Also, when digitizing from DAT you must choose Digital from the 
Sync Source pop-up menu in the Audio Tool Setup display.  For more 
information, see ÒPreparing for Audio InputÓ on page 63.

n For complete information on audio for Þlm projects, see the Avid Film Com-
poser Getting Started Guide.

Entering Capture Mode

Capture mode provides all the tools and controls you need to capture 
your footage in digital form. When you enter Capture mode, the sys-
tem initializes these tools and establishes an interface with the analog 
playback equipment attached to the system.

1. Make sure the playback deck is turned on and properly connected 
to the system.

2. Open your project and the bin in which you want to store your 
master clips.

3. With the bin active, choose Go To Capture from the Bin menu. The 
Bin monitor displays the Digitize tool, Compression tool, and the 
active bin.
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n In Capture mode, the Client monitor displays the playback footage full screen 
at all times when the video track is selected in the Digitize tool.

Setting Up the Compression Tool

You can choose various compression parameters in the Compression 
tool.  To choose compression settings: 

1. Choose Compression from the Tools menu, or click the Compres-
sion tool icon in the Digitize Tool window if the tool is closed.

The Compression tool appears.
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2. Make sure the proper audio sample rate is indicated under Audio 
Rate. The audio sample rate shown cannot be adjusted within the 
tool, but reßects hardware settings, as follows:

- Systems using  a two-channel audio board support 44100 Hz 
(44 kHz) only, and this setting is reßected by default in the 
Compression tool.

- If your system uses the Digidesign audio interface and a four-
channel audio card, you can set the audio sample rate at either 
44100 Hz or 48000 Hz by adjusting the sample rate switch on 
the front of the Video Slave Driver.

n Settings in both the Compression tool and the audio interface do not affect the 
sample rate of digital audio signals.

3. Choose the desired AVR, detail, color rate, and frame rate from 
each pop-up menu. 

About the Color Rate Option

In addition to the AVR, the Color Options pop-up menu allows you to 
choose Þlter out color from each frame of video with either one of the 
following options: 

¥ Reduced Chroma does not encode as much color information per 
frame.

Audio
settings

Video
compression
settings
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¥ Monochrome removes all of the color information. 

If you are digitizing black-and-white images, storage space will not be 
affected by these settings. 

c If you choose one of these settings and you intend to record profes-
sional-quality digital cuts, you will need to redigitize at Full 
Chroma before recording.

Setting Up the Digitize Tool

The Digitize tool provides controls for cuing, marking, and logging   
footage, and speciÞes digitizing parameters such as source and target 
locations.  Click anywhere in the Digitize tool to activate it.

Using the Deck Selection Pop-Up Menu

The Deck Selection pop-up menu in the Digitize tool contains a list of 
all decks that were connected to the system, powered up, and initial-
ized when you entered Capture mode.  Deck 1 is selected by default.  

Deck control

Source Tape display

Message bar

Track Selection Digitize

 Deck Selection pop-up

Deck Control in the 
Digitize tool operates 
in the same way as the  
in the Deck Controller.

Trash/Abort
Digitize/Log mode

Subclip indicators

Digitize Indicator
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You must have VLAN/
VLX hardware to con-
trol more than one deck 
at a time.  For more 
information on VLAN 
equipment, contact 
your Avid sales repre-
sentative.

To activate playback from another available deck, choose the deck 
from the menu.

The menu also contains the command Check Decks below the list of 
decks.  The check decks command helps you re-establish deck control 
if the power on your decks was turned off or the decks were discon-
nected when you Þrst entered Capture mode.

n Once deck control has been properly initialized, it will remain active for all 
deck controllers throughout the session, until you quit the application.

Selecting a Tape

To select a source tape:

1. Insert a tape into your deck.  The Tape Name dialog box appears.

Check Decks appears at the bottom of the 
Deck Selection pop-up menu
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2. Play the tape brießy so that the system can detect the timecode for-
mat of the tape (drop-frame or non-drop-frame).  Otherwise, the 
system maintains the timecode format set in Deck settings, regard-
less of the format on the tape, and you may get a Wrong Tape mes-
sage.

n Drop-frame timecode appears in the Timecode indicator with semicolons 
between hours, minutes, and seconds, and frames.  Non-drop-frame timecode 
appears with colons.

For information on 
tape naming conven-
tions in Media Com-
poser, see  ÒNaming 
TapesÓ on page 21.

3. Provide the system with a tape name in one of the following ways:

¥ Select the name of the tape from the list displayed in the Tape 
Name dialog box and click OK.

¥ Click New if the tape is not in the list. A new tape name line 
appears at the bottom of the dialog box. Type the new name 
and click OK.



59

Selecting Source Tracks

You can choose the tracks to digitize from the source tape.  Click the 
video and audio track buttons in the Digitize tool to select only those 
tracks that you want to digitize.  

n When using an Avid-controlled deck connected, the TC (timecode) track will 
be selected by default, and the system will digitize the timecode from the 
source tape.  If you deselect the TC button, the system will digitize with 
timecode-of-day.  For more information, see ÒDigitizing with Timecode-of-
DayÓ on page 97.

If you are not seeing the source video or hearing source audio in Cap-
ture mode, toggle these buttons to make sure they are not the cause.

n You can select or deselect all tracks at once by pressing the Option key and 
clicking any track selector.

c When batch digitizing, if the tracks are already logged into the bin, 
this selection will be made automatically, unless you deselect the 
option ÒDigitize the tracks logged for each clipÓ in the Digitize set-
tings.  For more information on Digitize Settings, see the Avid Media 
Composer Products Reference.
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Choosing a Resolution in the Digitize Tool

If you did not already choose a resolution in the Compression tool, or 
the Compression tool is closed, you can use the Resolution pop-up 
menu in the Digitize tool.

To choose a resolution, click the pop-up menu above the deck controls 
in the Digitize tool and make a selection.

n For more information on AVRs, see the Avid Media Composer Products Ref-
erence.

Choosing the Target Bin

You select a target bin as the destination for the master clips created 
when you digitize on the ßy.  Or, you select a target bin containing the 
logged clips you will use to batch digitize your media.

To choose a target bin, do one of the following:

¥ Choose an existing  bin from the pop-up menu.

¥ Activate a previously created bin by choosing Open Bin from 
the File menu, locating, and opening the bin in the Open Bin 
dialog box.

¥ Create a new bin by choosing New Bin from the File menu, 
and then naming and opening the new bin in the New Bin dia-
log box.
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Targeting Drives

Targeting drives for the digitized media is a three-step process:

1. Make sure you are in Digitize mode.  If the tool is in Logging 
mode, click the Digitize/Log button to return to Digitize mode.

For tips on targeting 
media drives for effec-
tive storage and play-
back, see  the Avid 
Media Composer Products 
Reference Guide.

2. Decide whether to digitize audio and video to a single drive, or 
separate drives, as described in the following sections.

3. Choose the speciÞc target drives from the pop-up menus, as 
described in the following sections.

Targeting a Single Drive

By default, the Digitize tool targets a single media drive volume for 
digitizing the audio and video for each clip.   Use this option when 
you are digitizing in a single-Þeld resolution, for instance, and play-
back performance is generally not an issue.

To target a single drive:

1. Click the Single/Dual Drives button to display a single drive icon.

2. Choose a drive volume from the Target Drive pop-up menu.  

The name shown in bold in the menu has the most storage avail-
able.  Time remaining on the selected drive, displayed above the 
menu, is calculated based on your AVR selection.

Targeting Separate Drives for Audio and Video

 Optionally, you can target separate drives for video and audio tracks.  
This option improves performance  because the system is not required 
to address all the information in separate locations on a single disk. 
You can also digitize for the longest continuous amount of time 
because the system is storing material on two disks rather than one.
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To target separate drives for audio and video:

1. Click the Single/Dual Drives button to display a two-drive icon.

2. Choose separate drive volumes for audio and video from each 
Target Drive pop-up menu.  

Names shown in bold in the menus have the most storage avail-
able.  Time remaining on each selected drive, displayed above 
each menu, is calculated based on your AVR selection.

Interpreting the Time-Remaining Display

By default the Digitize tool displays a time-remaining for each clip 
after you select an AVR and target drive or drives for the digitized 
media.

 You can interpret this display based on the following factors:

¥ Each digitized clip is limited by the Macintosh operating system to 
a maximum Þle size of 2 gigabytes.  

¥ When adequate space exists on the chosen drive, the time-remain-
ing displayed in the Digitize tool is based on 2 gigabytes per clip 
at the chosen AVR.   This number will reappear for each clip digi-
tized, as long as there is adequate disk space.

¥ When you choose another AVR, the time-remaining display 
adjusts accordingly.

Time remaining

Single/Dual Drives
button
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¥ When the storage space on the chosen drive is less than 2 
gigabytes,  the time-remaining will begin to decrease for each clip 
digitized, until the drive is full.

You can also press the Option key and click the Single/Dual Drives 
button to show the total time-remaining on the chosen drive at the 
selected AVR.

Preparing for Audio Input

The Audio tool, along with your hardwareÕs audio parameters, allows 
you to do the following in preparation for input:

¥ Check and manage your audio hardware setup

¥ Calibrate system input levels

¥ Set audio levels before digitizing

In addition, controls in the Audio tool allow you to calibrate, set levels, 
and generate customized calibration tone for output to the speakers or 
a record device. For more information on output procedures involving 
the Audio tool, see  ÒPreparing for OutputÓ on page 449.

To open the Audio tool, choose Audio Tool from the Tools menu, or 
click the Audio Tool button in the Digitize tool.

The Audio tool appears. The tool displays meters for either four or 
two channels, depending upon your Media Composer model.

Audio Tool
button

Audio Tool command
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The Audio tool has the following characteristics:

¥ The Output button displays a panel that contains a single slider 
control for raising or lowering global audio output.

¥ The Setup button displays a panel that contains information and 
controls for adjusting various audio hardware parameters.

¥ The Reset Peak button resets the current maximum peak measure-
ments. It also stops the playback of the internal calibration tone.

¥ The In/Out buttons toggle the meter displays for each channel 
between input levels from a source device and output levels to the 
speakers and record devices. I indicates Input, and O indicates 
Output.

¥ The Peak Hold pop-up menu allows you to choose options for 
customizing the meter displays, and setting and playing back the 
internal calibration tone.

¥ The digital scale to the left of the meters displays a Þxed range of 
values from 0 to Ð90 dB (decibels), according to common digital 
peak meter standards.

Reset Peak

Peak Hold pop-up

Meter display

Analog VU scaleDigital scale

Output Setup

In/Out toggle 

Input 
(Two-channel

Two-Channel Audio Board

(adjustable)(fixed)

Four-Channel Audio Board

boards only)
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¥ The VU (Volume Unit) scale to the right of the meters displays a 
range of values that you can conform to the headroom parameters 
of your source audio.

¥ The meters dynamically track audio levels for each channel as fol-
lows:

- Meters show green below the target reference level (default 
reference level is Ð14 dB on the digital scale).

- Meters show yellow for the normal headroom range, above 
the reference level to approximately Ð3 dB.

- Meters show red for peaks approaching overload, between 
Ð3 dB and 0 (zero) dB.

- Thin green lines at the bottom indicate signals below the dis-
play range.

Using the Audio Tool Setup Display

You can use the Audio Setup display in the Audio tool to check the 
current conÞguration of audio hardware, and to choose various input 
options. 

¥ To open the Audio Setup display, click the Setup button in the 
Audio tool.

The screen displays the audio setup controls and information 
about your systemÕs audio hardware and conÞgurations.
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The Þrst four items in the display are informational, and cannot be 
changed from within the Audio tool. These include: 

¥ The type of audio card installed

¥ The slot number where the card is located

¥ The sample rate for audio input, determined by the position of the 
Sample Rate switch on the Digidesign audio interface (four-
channel systems only)

¥ The type of peripheral audio device attached to the system (audio 
interface)

You can make adjustments to any of the Þnal three options from 
within the Audio tool by clicking the option and making a new selec-
tion from the pop-up menu. These selections include:

¥ The Sync pop-up menu, which includes two optional sources for 
audio sync:

- InternalÑThis sets the clock and timing for the sample rate 
internally. If your system is equipped with the Avid 
Digidesign audio interface and black burst generator, set the 
Sync Mode to Internal.

Display for four- 
channel board 
systems
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- DigitalÑIf you are using a digital source that provides a digi-
tal word-clock signal, set the Sync Mode to Digital.  Choose 
digital if you are digitizing from DAT (digital audiotape).

c You must plug a digital source device to the through the Avid 
Digidesign audio interface if you have system with a four-channel 
audio board.

¥ The Input Source pop-up menu, which includes two options for 
the type of input: analog or digital.

¥ The Digital Format pop-up menu (systems with four-channel 
audio boards only), which provides two options for the digital 
input format if you chose Digital as the input source:

- AES/EBU (Audio Engineering Society/European Broadcast 
Union)Ñthe industry format

- S/PDIF (Sony/Phillips Digital Interface Format)Ñthe con-
sumer format

Adjusting the Reference Level

The VU (Volume Unit) scale to the right of the meters is a sliding scale 
relative to the Þxed digital scale displayed on the left. You can adjust 
the VU scale up or down based upon the headroom parameters of your 
playback devices.

To customize the VU scale:

1. Choose Set Reference Level from the Peak Hold pop-up menu.
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The Reference Level dialog box appears.

2. Enter the new value for the reference level (-12, for example), and 
click OK.

The VU meter scale slides to match the new reference level, which 
is displayed on the digital scale.

Choosing a Peak Hold Option

The Peak Hold pop-up menu provides two options for displaying 
peak levels in the meters, as follows:

¥ When you choose Peak Hold, the meters display a normal rising 
and falling volume trail in the meters. This is the default option.

¥ When you choose the InÞnite Hold option, each meter perma-
nently retains a single bar at the peak volume level measured dur-

VU scale slides up to dis-
play less headroom

Digital scale displays 
corresponding reference 
value
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ing playback. The effect is cumulative: the bar continues to rise 
and hold with each new peak, and serves as a record of the highest 
peak for each channel. 

To delete the peaks and start over at any time, click the Reset Peak 
button.

To enable either Peak Hold or InÞnite Hold, click the pop-up menu 
and choose an option.

Adjusting Input Levels

This section describes procedures for calibrating and adjusting audio 
input levels with the Audio tool. The types of adjustments you can 
makeÑand the procedures you useÑvary depending upon whether 
your system is equipped with a two-channel audio board or a four-
channel audio board, as follows:

¥ You can use the calibration controls in the Audio tool to calibrate 
the Avid Digidesign audio interface input levels on systems 
equipped with four-channel audio boards.

¥ You can use input level controls in the Audio tool on systems 
equipped with two-channel audio boards to calibrate and set lev-
els during digitizing.

¥ You can use additional procedures described in this section to 
avoid digitizing over- or under-modulated audio due to variations 
in levels among the source material, playback devices, and the 
Media Composer system.

To adjust input levels:

1. Click the IN/OUT toggle buttons for the appropriate channels to 
display the I for Input.

2. Play back the source audio (from a videotape or DAT, for exam-
ple). If the recording includes reference tone, cue to the tone and 
play it back. 
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n Voice recording serves as a good backup reference. Upper peaks of inßection 
should reach the normal target range (around -14 dB on the digital scale or 0 
dB on the VU scale with playback from videotape, for example).

3. Adjust the output on the playback device so that the deviceÕs vol-
ume meter shows the appropriate level for the reference signal (0 
dB for videotape playback, for example).

4. Adjust the input levels using the following procedures for either 
two- or four-channel systems.

Adjustments for Four-Channel Audio Board Systems

You can use the calibration features of the Audio tool to Þne-tune the 
Trim level settings of the Avid Digidesign audio interface. These 
adjustments should be made when you Þrst install the system, and 
repeated occasionally thereafter (once a month, for example).

To calibrate the audio interface:

1. Choose Calibrate from the Peak Hold pop-up menu. 

The Audio tool changes to Calibrate mode: the scales display a 
range of approximately 2 dB, and the meters indicate levels within 
this range.
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2. Use a jewelerÕs screwdriver to Þne-tune the Input Level Trim pots 
on the Avid Digidesign audio interface until the peaks rest at the 
appropriate value.

3. To return to the default display, choose Calibrate from the Peak 
Hold menu.

To set the input level during digitizing, adjust the level externally until 
the signals fall within the appropriate range on the meters:

¥ Adjust the output level on the playback device.

¥ Put an audio mixer in line, and use it to adjust each of the 
tracks separately.

¥ Put an audio compressor in line. This allows other adjust-
ments of the audio levels as well as overall volume.

c You cannot adjust the levels for four-channel audio board systems 
from within the Audio tool.

Two-Channel Audio Board Systems

To set the input level during digitizing for two-channel audio board 
systems:

1. Click the Input button (microphone icon) to display the input level 
slider. 

VU scale varies, displaying 
custom reference level setting, 
+1 dB above and -1 dB below.
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2. View the meters and adjust the slider to the appropriate level.

Checking Levels in the Console

Once you have played back audio through the Audio tool, you can use 
the Console to view a list of precise information about the peak levels.

To check peak levels in the Console:

1. Click the Reset Peak button to clear the systemÕs record of the 
most recent maximum peaks.

2. Open the Audio tool, and play a sequence or portion of the 
sequence.

3. After playing back the audio, open the Console by choosing Con-
sole from the Tools menu.

4. In the Console command line, type:

DumpMaxPeaks

5. Press Enter. 

Input slider
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A list of peak values appears in the Console.

Preparing for Video Input

Film Composer provides both a Video Output tool and a Video Input 
tool for calibrating either composite or component video. 

If your system is equipped with the Serial Digital card (replacing the 
Betacam card) you can digitize material directly from a D1 or digital 
Betacam VTR without the need of calibration Ñ much like direct input 
of digital audio from DAT or CD.

To open either the Video Input or the Video Output tool, choose one 
from the Tools menu.
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You can also open the Video tool in Capture mode by clicking the 
Video Tool button at the lower right corner of the Digitize tool.

For more information 
on calibrating for video 
output, see  ÒCalibrat-
ing for Video OutputÓ 
on page 451.

 Film Composer supports the SMPTE/EBU component standard, but does 
not support the MII component video standard.

This section provides essential information for input calibration. You 
should proceed as follows:

¥ Make sure your monitor is properly calibrated for displaying foot-
age accurately.  See your monitorÕs hardware documentation for 
more information.

¥ If your systemÕs output settings have not already been calibrated 
according to house standards, use the procedures described in  
ÒCalibrating for Video OutputÓ on page 451.  If you are in a facil-
ity where this is not necessary, leave the output settings at their 
preset values.

Video Input tool Video Output tool
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¥ If you are using footage in the Japanese NTSC format standard, 
deselect the option NTSC Has Setup in the General Settings dialog 
box.  This will enable the appropriate display for the setup portion 
of the signal in the waveform monitor.

¥ Proceed to calibrate the input levels for each videotape when you 
digitize in order to ensure continuity of picture quality between 
tapes, as described in ÒCalibrating for Video InputÓ on page 76.

n If your system is equipped with the Serial Digital card for input from a D1 or 
digital Betacam VTR, you do not need to calibrate input signals.  Proceed to 
Chapter 3.

Using the Factory Presets

The preset buttons on both the Video Input tool and the Video Output 
tool show the status of each calibration setting as follows:

¥ When you Þrst open the Video Input or Output tools, all preset 
buttons are lit (green), with the factory presets loaded for each 
slider.



76

¥ When you click a lit preset button, the button becomes unlit 
(gray), and the slider returns to the most recent manual level set-
ting.

¥ When you click an unlit preset button, it becomes lit (green), and 
the slider moves to the factory preset level for that parameter.

As you adjust levels in the Video Input or Output tools, you can toggle 
the preset buttons between the levels you set manually and the factory 
preset levels.

Calibrating for Video Input

To calibrate for videotape input:

1. Choose Video Input Tool from the Tools menu. The Video Input 
tool opens.

Video Input tool Video Output tool

Preset buttons



77

2. Choose the appropriate input channel from the Input menu: Com-
posite or Component.

3. Cue the tape to the section containing bars and tone (usually the 
beginning) and play the tape.

n Always play the tape when calibrating. Signal display is unstable when the 
tape is paused.

The third Full-Screen monitor displays either of the following 
types of bars:

Choose either 
Composite or 
Component to dis-
play the correct 
controls and select 
the proper input 
channel
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4. Open the internal waveform monitor by clicking the icon located 
at the lower right of the tool.

SMPTE standard split bars

Full-field color bars

Full-field bars can 
be either 75% (max-
imum signal ampli-
tude as percentage 
of peak white) or 
100%.

Full-field bars 
(NTSC or PAL)

100% white 

7.5 black level 

Color bars

SMPTE bars 
(NTSC only)

(lines 16 to 182)

(lines 183 to 202)

(lines 203 to 263) 
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5. Adjust the Line Selector slider located below the waveform moni-
tor to display the appropriate line of the test pattern, then adjust 
the luminance values based on Table 2-1.

NTSC waveform values

PAL waveform values
(volts)

(IRE)

Black level at 7.5 IRE

White level at 100 IRE
(100% bars)

White level at 1 volt
(100% bars)

Black level at 0.3 volts

Line Selector

(White level is at 77 IRE
 for 75% bars)

(Setup level falls at 0 IRE
for Japanese NTSC)
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6. Close the waveform monitor, and open the vectorscope monitor 
by clicking the Vectorscope button.

Table 2-1 Luminance Settings 

Parameter SMPTE bars Full-Þeld bars at 
75% signal level

Full-Þeld bars at 
100% level

Japanese NTSC

Black level (setup) Adjust Line Selector 
to approx. 183

Adjust Line Selector 
to approx. 150

Any line Any line

Adjust Black slider 
to 
7.5 IRE (NTSC)

Adjust Black slider 
to
7.5 IRE (NTSC), 
0.3 volts (PAL)

Adjust Black slider 
to
7.5 IRE (NTSC), 
0.3 volts (PAL)

Adjust Black 
slider to 
0.0 IRE

White level (gain) Adjust Line Selector 
to 203

Adjust Line Selector 
to 150

Adjust Line Selector 
to 150

Adjust Line Selec-
tor to 203

Adjust Gain/Y 
Gain slider to 
100 IRE (NTSC)

Adjust Gain/Y 
Gain slider to 
77 IRE (NTSC), 
.825 volts (PAL)

Adjust Gain/Y 
Gain slider to 
100 IRE (NTSC), 
1.0 volts (PAL)

Adjust Gain/Y 
Gain slider to 
92.5 IRE (NuVista 
card systems) or 
100 IRE (ABVB 
card systems)
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7. Adjust the Line Selector to display the signal for color bars at 
around line 150 (this applies to all formats and all types of bars). 

8. Adjust the Sat and Hue sliders (composite) or the RY Gain and BY 
Gain sliders (component) until the angle and amplitude of the six 
color vectors fall within the target boxes on the vectorscope.

n There is no hue adjustment for PAL video.

Saving Settings

You can also color cor-
rect shots by applying 
the Color effect to seg-
ments in the Timeline 
and making adjust-
ments in Effect  mode. 
For more information, 
see the Avid Media Com-
poser and Film Composer 
Effects Guide.

You can save the settings for an individual tape each time you cali-
brate bars.   For example, you may have one or a series of shots that 
require color correction (the shots are dark, too bright, or were not shot 
with the proper color balance or Þltering).  You can make corrections 
using the Video Input tool now, or at any time during or after editing 
in order to match shots in the sequence.

To save the calibration settings for an entire tape:

Vectorscope button
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1. After calibrating as described in the previous section,  choose Save 
As from the Settings pop-up menu.  The Save As dialog box opens.

2. Type a name for the settings.

3. Click OK.

n If you give the settings the same name as the tape name, Film Composer will 
apply the settings automatically when that tape is loaded into the deck in the 
future (for example, when redigitizing).

Whenever you batch digitize or redigitize, the system recalls the saved 
settings as follows:

¥ The system looks for a tape setting.   If the setting exists, the sys-
tem recalls it.

¥ If no tape setting exists, the system uses the default Video Input 
tool settings.

Adjusting Video Levels by Eye

Color bars are the best way to set the video levels consistently. How-
ever, if you have a tape or series of tapes with no color bars, you may 
need to adjust levels by eye. To do this, use the following criteria:

¥ Blacks should not seem ßat and lacking detail. Find the blackest 
region of an image (shadows work better than black objects) and 
adjust the setup.

¥ Whites should not be washed out or lacking detail. Find the whit-
est region of an image (bright, well-lit regions work better than 
white objects) and adjust the gain.

¥ Skin colors should be realistic. Find a skin color and adjust both 
hue and saturation as necessary.

¥ Pure yellows should be a rich gold and not reddish or greenish in 
tone. Find a pure yellow and adjust both hue and saturation as 
necessary.
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Digitize Preparations Checklist

Make sure you have the desired options selected in the General Set-
tings, Deck Settings, and Digitize Settings dialog boxes.

Check your hardware conÞgurations: power on switches, cable con-
nections, pulldown switch on the Video Slave Driver, and remote 
switch on the source deck for deck control.

Consider striping your drives in advance according to the AVIDdrive 
Utility UserÕs Guide if you are working on a complex project with mul-
tiple streams of video and high-resolution images.

Insert a tape into the deck and set up the Digitize tool for track selec-
tion, target bin, target drives, source tape, and source deck.

Set up the Compression tool for audio sample rate, AVR, detail and 
color compression, and frame rate.

Use the Audio tool to set the audio input levels.

Use the Video tool to set the video input levels for  setup, gain, satura-
tion, and hue; save your video settings for future use.
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CHAPTER 3

Digitizing

When you digitize, you convert source material from videotape into 
master clips that contain reference information.  You also create associ-
ated media Þles that contain the digital audio and video.  Once you 
prepare the capture tools as described in Chapter 2, you can digitize 
the source material in one of several ways, as described in the follow-
ing sections:

¥ Before You Begin

¥ Special Digitizing Procedures

¥ Digitizing and Logging at the Same Time

¥ Batch Digitizing

¥ Redigitizing Your Material

Before You Begin

Depending upon your immediate needs, use the following guidelines 
for working through this chapter based on a  chosen digitizing 
method:

¥ If you would like to use the Avid Media Reader, the pulldown ßag 
indication, add locators, create subclips, or log errors to the con-



85

sole during digitizing, read ÒSpecial Digitizing ProceduresÓ on 
page 85.

¥ If you have no logs and would like to begin digitizing right away, 
see  ÒDigitizing and Logging at the Same TimeÓ on page 89.

¥ If you have logs already entered in a bin and would like to auto-
mate the digitizing process with playback  from an Avid-
controlled deck, see  ÒBatch DigitizingÓ on page 98.

¥ If you are redigitizing deleted media or have imported a sequence 
that lacks the associated media Þles, see   ÒRedigitizing Your 
MaterialÓ on page 102.

Preparing Digitize Bins

If you have not already prepared a structure of bins for your project as 
described in the Avid Film Composer Getting Started Guide, consider the 
following tips before digitizing:

¥ You can create one bin for each dayÕs worth of dailies transfers. 
This helps avoid slowing the system with large bins, associates 
each bin with a source tape for better organization, and simpliÞes 
redigitizing.

¥ You can name the bin after the tape, so that when you autodigitize 
or digitize on the ßy without noting a tape name, the system will 
automatically name each clip or take after the bin (tape) and num-
ber them sequentially for easy reference.

Special Digitizing Procedures

This section describes several optional procedures that you can use 
during the digitizing process.
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Using the Avid Media Reader

If your system has the 
Media Reader, see your 
Avid Media Reader Setup 
and UserÕs Guide before 
digitizing. If you are 
interested in learning 
more about the Media 
Reader, contact Avid for 
details.

The Avid Media Reader is a powerful and ßexible external standalone 
LTC/VITC timecode reader and encoder.  It enables the Film Com-
poser system to decode up to three lines of VITC (vertical interval 
timecode) or one line of VITC and one line of LTC (longitudinal time-
code) while digitizing. It  automatically adds the information to the 
bin while creating subclips based on timecode breaks in any or all of 
the VITC lines.

Logging Errors to the Console

The Console is useful during the digitizing process for logging digitize 
errors, as described in  the Avid Film Composer Getting Started Guide.  

To open the Console, choose Console from the Tools menu.

For more information 
on Digitize Settings, see 
the Avid Media Composer 
Products Reference.

¥ If the option ÒLog errors to the console and continue digitizingÓ is 
selected in the Digitize Settings dialog box, when you batch digi-
tize and the system encounters an error it will abort the clip, enter 
error comments into the console, and continue digitizing the next 
clip.

¥ If the option ÒLog errors to the console and continue digitizingÓ is 
not selected in the Digitize Settings dialog box, an alert message 
will appear and the system will pause if an error occurs while dig-
itizing. If this happens, do the following:

a. Click Try Again to retry the operation. The clip may digitize 
successfully. 

b. If the clip does not digitize the second time you try, the error 
message appears again. Click Next Clip to skip the clip that 
caused the error, and continue batch digitizing any remaining 
clips, or Click Abort to cancel the entire Batch Digitize process.
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c. Make note of all errors, messages, and steps that youÕve taken 
and decide whether to troubleshoot the problem on your own 
or contact Avid Support.

Creating Subclips On the Fly

For information about 
creating subclips after 
digitizing, see the Avid 
Film Composer Getting 
Started Guide.

Subclips are marked sections of a longer master clip that you can view 
and edit  like any other object in a bin.  This section describes a short-
cut method for creating subclips on the ßy during digitizing.  The 
maximum number of subclips you can generate while digitizing a clip 
is 50.   

To create a subclip on the ßy:

1. Start digitizing as usual.

2. At the point where you want to begin the subclip, press the F1 key.

This highlights the subclip IN mark indicator in the Digitize tool.

3. While the system is digitizing, you can enter a name for the sub-
clip by typing the name. Press the Tab key to enter comments 
about the clip.

4. When you want the subclip to end, press the F2 key.  This high-
lights the subclip OUT mark in the Digitize tool.  

n You can press the F2 key repeatedly as you search for the end point of the sub-
clip. The system accepts the last occurrence as the end point.  You can also 
press the F1 key again remove the previous subclip marks.

The subclip appears in the target bin when you press the F1 key 
again to mark another subclip, or when you stop digitizing.

As you continue to mark subclips while digitizing, a number 
appears between the subclip indicators to show the number of 
subclips created so far.

Subclip
indicators
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Using the Pulldown Flag While Digitizing

If you are digitizing on the ßy for a Þlm project with an NTSC Þlm-to-
tape transfer prepared with the white ßag option (transfers which 
incorporate the Òwhite ßagÓ or white bar indication in the blanking 
interval of every A-frame), you can select the ÒUse pulldown ßag 
while digitizing without an IN pointÓ option in the Digitize Settings to 
automate the selection of the pulldown frame of the sync point. 

This option does not affect batch-digitizing, only the procedures 
described in the the sectionÒDigitizing and Logging at the Same 
TimeÓ on page 89. When you cue the tape or mark a chosen inpoint 
and start the digitize process, the system will automatically begin dig-
itizing at the Þrst white ßag or A-frame for calculating the pulldown of 
the sync point.

To enable the pulldown ßag option:

1. Click the Settings button in the Project window.

2. Double-click Digitize.

3. Check ÒUse pulldown ßag while digitizing without an IN point.Ó

4. Press the shadow box and select the correct line from the list.

5. Click OK or press Return.

When you are ready to digitize, use any of the methods described in 
the section ÒDigitizing and Logging at the Same TimeÓ on page 89, 
and the sync point will be automatically calculated based in the white 
ßag indication.

Adding Locators On the Fly

For more information 
on speciÞc uses for loca-
tors, see the Avid Film 
Composer Getting 
Started Guide. 

Locators mark a single frame within a clip or sequence so that you can 
attach a note or Þnd the frame at a later time.   This section describes a 
shortcut method of adding locators on the ßy while digitizing.
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To add a locator mark to a frame while digitizing, watch the playback 
of the footage in the Edit monitor and press the F3 key when you see 
the appropriate shot or frame.

Adding Comments On the Fly

Film ComposerÕs annotate feature allows you to type comments dur-
ing the digitizing of a clip.  These comments are saved in the clip Com-
ments column.   You can add comments about such things as color 
correction or directions for editing.

n To carry your comments over to the sequence so that they will appear in the 
Timeline, in EDLs, or in cut lists, you must add the comments again when 
creating the sequence using the Add Comments command in the Monitor 
menu.

To add comments on the ßy, start typing at any time during the digitiz-
ing of a clip.  The annotate window will appear on screen, allowing 
you to see the text as you type.  You cannot edit the text until after the 
digitizing is complete, but you can backspace and retype the informa-
tion.

Digitizing and Logging at the Same Time

When you digitize without entering log information in a bin ahead of 
time, the system creates clips and associated media Þles while you dig-
itize. Digitizing in this manner involves manually cuing source foot-
age with an Avid-controlled deck using the deck controls in the 
Digitize tool.

There are several ways to digitize and log at the same time:

¥ Digitizing from a mark IN to a mark OUT. This method lets you 
specify the exact timecode location to begin and end digitizing. 
You can also specify only a mark IN or mark OUT, and enter the 
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other mark on the ßy.  These procedures are described in  ÒDigi-
tizing from a Mark IN to a Mark OUTÓ on page 91.

¥ Digitizing on the fly. This method is easier than setting marks, but it 
is more  imprecise. It involves using the deck controls in the lower 
left corner of the Digitize tool to cue, play, and stop the source 
footage manually while digitizing.  These procedures are 
described in  ÒDigitizing On the FlyÓ on page 93.

¥ Autodigitizing. This method requires the least amount of supervi-
sion and effort, but usually calls for more digitizing time and disk 
storage space.  It involves playing each source tape from a cue 
point near the beginning and letting the system digitize the entire 
tape, automatically naming and entering each cut into the bin.  
These procedures are described in   ÒAutodigitizingÓ on page 95.

Two additional techniques you can use when digitizing and logging at 
the same time are described in ÒDigitizing from a Non-Avid-Con-
trolled DeckÓ on page 96 and ÒDigitizing with Timecode-of-DayÓ on 
page 97.

You can log and digitize at the same time with both PAL and NTSC 
transfers as the source, but when digitizing an NTSC transfer you 
must observe the following basic rules:

¥ Specify the Pulldown of the sync point frame before digitizing.

¥ Alternatively, select the ÒUse pulldown ßag while digitizing with-
out an IN pointÓ option in the Digitize Settings window.

¥ The mark IN must be an A frame, and you cannot digitize with a 
mark OUT only.

n When you capture footage from an NTSC Þlm-to-tape transfer with pulldown 
for a Þlm project, the playback ßickers in the full-screen monitor during digi-
tizing  because the system is dropping occasional frames due to the pullin pro-
cess.  The footage will play back smoothly in Film Composer, however, once 
the pullin conversion is complete.
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Digitizing from a Mark IN to a Mark OUT

Digitizing from a mark IN to a mark OUT lets you specify exactly 
where to begin and end digitizing. You can specify only a mark IN or 
mark OUT, and the system enters the other mark on the ßy.  Use this 
method in the following circumstances:

¥ If logs exist in written or printout form but not in the proper for-
mat for quick import into the system

¥ If the IN and OUT marks are rough and need to be double-
checked for accuracy 

¥ If you are familiar enough with the source material to estimate the 
timecode for the mark IN, the mark OUT, or both, quickly and 
accurately.

Setting Both Marks

To digitize by specifying a mark IN and a mark OUT:

1. Set either an IN mark or an OUT mark for the clip you want to 
digitize, using either of the following methods:

- Use the deck controls in the Digitize tool (or on the MUI or 
Steenbeck controller).   Cue your source tape to where you 
want to start or end the clip, and click the Mark IN or Mark 
OUT button.

- If the material starts at a known IN or ends at a known OUT, 
you can type the timecode in the display area next to the 
mark. Press Return to enter the mark.

If you need to double-check the accuracy of the IN or OUT mark, 
click the Go To button.  The system cues the tape and pauses the 
deck at the mark.  You can play the tape and reset the mark, if nec-
essary.

2. To Þnish logging the clip, use either of the following methods:

- Set the corresponding IN or OUT mark.

Mark IN

Mark OUT
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- Type a timecode for the clipÕs duration in the display area next 
to the Duration mark (below the OUT mark).

The system automatically calculates the appropriate timecode for 
the corresponding mark IN, mark OUT, or duration. 

3. Click the Digitize button in the Digitize tool, or press the B key on 
the keyboard.

The Digitize tool automatically rewinds the tape to the preroll 
point before the IN point of the clip, and the tape begins to play. 
The Digitize button becomes bright red, and the Message bar dis-
plays the message that Film Composer is digitizing.

4. While the system is digitizing, you can type a clip name. To enter 
comments about the clip, press the Tab key after typing a clip 
name. The information that you type does not appear on the 
screen until you have completed digitizing. (After you log clips, 
you can modify information to correct input errors or to add infor-
mation.)

When the tape reaches the clipÕs OUT point, digitizing stops, and 
the system creates a new clip in the bin.

Setting Only One Mark

To set only one mark and enter the other mark on the ßy:

¥ Set an IN point, and click the Digitize button to begin digitizing. 
Then, click the Digitize button again to stop digitizing on the ßy 
and set a mark OUT.

This method is useful if you donÕt need a precise mark OUT. You 
save time because you donÕt have to shuttle to locate the mark 
OUT before digitizing.

¥ Set a mark OUT only, then move to the position on the tape where 
you want to start digitizing. Click the Digitize button to begin dig-
itizing on the ßy. When the tape reaches the clipÕs OUT point, dig-
itizing stops.
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This method is useful if you donÕt need a precise mark IN, but do 
need to stop at a precise out point, for example, just before a time-
code break.

Digitizing On the Fly

If you are digitizing 
from a source that can-
not be controlled by the 
system, see  ÒDigitizing 
from a Non-Avid-Con-
trolled DeckÓ on 
page 96 for additional 
steps.

Use this digitizing method in any of the following circumstances:

¥ If you are eager to begin editing immediately and no adequate 
logs exist for importing into the system or setting marks 

¥ If you are digitizing from a source deck that cannot be controlled 
by the Digitize tool or a VLX/VLAN unit

¥ If your source tape does not have timecode

¥ If you are digitizing from a digital source such as a CD or DAT 
player

¥ If you are digitizing from a live source, such as a studio feed, or an 
in-house router

n There is a slight delay of several frames after you manually select a spot both 
to start and to stop digitizing.  Therefore use this method when you donÕt need 
precise beginning and end points in your clip.

To digitize on the ßy:

1. Make sure you have selected the proper Digitize settings and set 
up the capture tools, as described in Chapter 2.

2. Click the Digitize/Log Mode button on the left side of the Digitize 
tool until the Dig icon appears.

3. Use the deck controls in the bottom left corner of the Digitize tool 
to locate the position on the tape where you want to start digitiz-
ing.
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4. To begin digitizing, play the deck and when it gets up to speed, 
click the red Digitize button.  

n Make sure you have cleared any previous marks so that the deck does not 
begin cuing to the previous location.

Digitizing begins within a few frames, and the timecode for the 
clipÕs IN point appears. The horizontal LED above the Digitize 
button ßashes on and off.  The title bar displays a message that 
Film Composer is digitizing.

5. While the system is digitizing, you can type a clip name. The 
Annotate window appears with the new clip name typed into the 
Name Þeld. 

 If you want comments 
to appear in EDLs or cut 
lists, add them during 
editing using the Add 
Comments command.  
For more information, 
see  ÒAdding Com-
ments to Sequence 
ClipsÓ on page 249.

6. Press the Tab key after typing a clip name to enter comments 
about the clip.  You cannot edit the text during digitizing, but you 
can backspace to retype the comments.

7. Click the Pause button at any time to pause play. You can also 
abort the digitize procedure by clicking the Trash button.  The clip 
will be discarded.

8. To stop digitizing and enter the OUT point of the clip, click the 
Digitize button, or press the Escape key on the keyboard.

The system creates a new clip in the bin. It also enters basic log 
information for each clip, consisting of the mark IN, the mark 
OUT, the duration, and any other information typed in during the 
digitize procedure.

9. If you did not enter a clip name while digitizing, type it now while 
the clip name is highlighted in the bin.  If you return to the Digi-

Fast forward/Rewind

Shuttle Single-frame stepEjectPlay

Stop

Pause



95

tize tool and begin another clip, the default clip name remains in 
the bin until you change it.

In some circumstances the digitized material may exceed the logical 
Þle size of the Composer application. For example, the maximum size 
of a media Þle cannot exceed the size of a 2 gigabyte partition. A 2 
gigabyte Þle at a high resolution, such as AVR 71, consists of approxi-
mately 10 to 18 minutes of footage. In such a case, consider digitizing 
the shot in shorter overlapping pieces, breaking it at points that are 
likely to be cut out during editing.

Autodigitizing

Autodigitizing can save you time by allowing you to bypass both the 
logging process and the time it takes to cue each shot.  However, this 
process requires the most storage space, and more time is spent while 
the system is actually digitizing entire reels.

When you autodigitize, you mount and cue your tape to a starting 
point and launch the digitizing process through the Digitize tool.  If 
you follow the tips and techniques described in this section, you can 
allow the system to complete the digitizing process unattended.

The following tips apply to autodigitizing entire reels:

¥ Select the ÒDigitize across timecode breaksÓ option in the Digitize 
Settings dialog box prior to digitizing. For more information, see 
the Avid Media Composer Products Reference.

¥ Select the ÒLog errors to the console and continue digitizingÓ 
option in the Digitize Settings dialog box. For more information, 
see the Avid Media Composer Products Reference.

¥ Under Deck Settings, turn off the Fast Cue option and set the pre-
roll to approximately four seconds. For more information, see the 
Avid Media Composer Products Reference.
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¥ You should have accurate notes on the number and content of takes 
on each reel in order to identify the content of each clip when nec-
essary.

To autodigitize:

1. Create one bin for each reel. This keeps bins to a manageable size 
and automatically names all clips from each reel after the name of 
their respective bins.

2. Name each bin after the source reel number: by default all clips are 
named after the reel and numbered incrementally beginning with 
the sufÞx Ò.01.Ó

3. Enter capture mode and open the bin for the Þrst reel.

4. Load the source tape and cue past any false starts.

5. Play the tape, and wait four seconds before clicking the Digitize 
button.

When you have long continuous shots (for example, footage from a 
live event) the digitized material for a single clip may exceed the logi-
cal Þle size of the Composer application. For example, the maximum 
size of a media Þle cannot exceed the size of a 2 gigabyte partition. In 
such cases, consider digitizing the shot in shorter overlapping pieces, 
broken at points that are likely to be cut out during editing.

c The  Film Composer system can digitize across timecode breaks and 
control track breaks, but it cannot digitize across breaks in the 
recording (that is, if the recorded footage breaks up into noise 
between shots).  If such breaks in recording exist on your tape, con-
sider using the methods described in  ÒDigitizing On the FlyÓ on 
page 93.

Digitizing from a Non-Avid-Controlled Deck

If you have a deck that cannot be controlled directly by the system, 
you can digitize with manual deck control as follows:
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1. Enter Capture mode and set up the tools.

2. Click the Deck Ofßine button in the Digitize tool to disable the 
deck controls and leave only the Source Tape Name display.

n Notice that the TC button also disappears.  The footage will be digitized with 
timecode-of-day generated by the system.

3. Click the Source Tape Name display to open the Tape Name dialog 
box and identify the source tape.

4. Play the tape manually and click the Digitize button to stop and 
start the digitizing of each clip.

Digitizing with Timecode-of-Day

When digitizing with an Avid-controlled deck, you can digitize your 
footage with timecode-of-day rather than source timecode.

To digitize with timecode of day:
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1. Enter Capture mode and set up the tools.

2. When selecting tracks, deselect the TC button.

3. Digitize by using any of the techniques described in  ÒDigitizing 
On the FlyÓ on page 93.

Batch Digitizing

You can also use the 
batch digitize process to 
redigitize existing clips. 
The redigitizing pro-
cess is described in  
ÒRedigitizing Your 
MaterialÓ on page 102.

Once you have imported a log or manually logged a group of clips 
into a bin, you can automate the digitize process using Film Com-
poserÕs batch digitizing capabilities.  In order to batch digitize, source 
tapes must have timecode.

When you capture footage from an NTSC Þlm-to-tape transfer with 
pulldown for a Þlm project, the playback ßickers in the full-screen 
monitor during digitizing  because the system is dropping occasional 
frames due to the pullin process.  The footage will play back smoothly 
in Film Composer, however, once the pullin conversion is complete.

Preparing to Batch Digitize

Preparing for batch digitizing involves optional procedures for resiz-
ing the Digitize tool, and establishing settings that allow you to batch 
digitize with a minimum of supervision.

Resizing the Digitize Tool

Because your clips are already logged in the bin, you can simplify the 
interface during batch digitizing by hiding the deck controller and log-
ging window in the Digitize tool.

To resize the Digitize tool during batch digitizing, click the Zoom but-
ton in the upper right of the tool.
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Preparing Settings for Unattended Batch Digitizing

Unattended batch digitizing allows you to digitize a large number of 
clips with a minimum of supervision by selecting  Digitize settings 
that avoid a pause in the digitize process. 

For more information 
on all Digitize settings, 
see the Avid Media Com-
poser Products Reference.

To prepare for unattended batch digitizing,  select the following 
options in Digitize settings:

¥ Log errors to the console and continue digitizing

¥ Switch to the emptiest drive if current drive is full

¥ Digitize across timecode breaks

c You cannot batch digitize clips that contain timecode breaks 
between the logged IN and OUT marks.   Also, you cannot digitize 
across breaks in the recording (that is, if the recorded footage breaks 
up into noise between shots).  If such breaks in recording exist on 
your tape, consider using the methods described in  ÒDigitizing On 
the FlyÓ on page 93.

Starting the Batch Digitize Process

To batch digitize clips:

1. Make sure you have selected the proper Digitize settings and set 
up the capture tools, as described in Chapter 2.
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2. Open the bin that stores the logged clips.

3. Select the clips to batch digitize:

¥ Choose Select All from the Edit menu, or press kÐA to select 
all the clips.

¥ Shift-click to select speciÞc clips.

4. Choose Batch Digitize from the Clip menu. A dialog box appears.

n If the logged clips that you want to batch digitize are not highlighted in the 
active bin, Batch Digitize is dimmed in the Clip menu.

5. Select options in the dialog box:

¥ If the bin contains some clips that are already digitized and 
you do not want to redigitize those clips, click the check box 
next to the phrase ÒDigitize only those items for which media 
is currently unavailable.Ó  If this option isnÕt selected and 
some of the selected clips have media Þles, the system deletes 
the media Þles and redigitizes new media Þles.

Handle length options 
appear only when a 
sequence is selected
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For more information 
on handle lengths  
when redigitizing, see  
ÒRedigitizing 
SequencesÓ on 
page 103.

¥ If your selections include a sequence for batch digitizing, the 
dialog box prompts you for handle length information, 
because the system will create new master clips based on the 
length of edited clips in the sequence.

n If you are batch digitizing the original source master clips used in the 
sequence, the sequence will automatically be updated and therefore you may 
want to deselect the sequence during this procedure.

6. Click OK.

If you havenÕt loaded a tape, the system prompts you to insert the 
Þrst tape.

7. Insert the tape into the tape deck and click Mounted.

A conÞrmation dialog box opens.

8. Click OK to conÞrm the tape and deck entries and begin the digi-
tizing process.  The system digitizes each clip from the tape, in 
start timecode order. 

9. If the system needs another source tape, the system prompts you 
for the tape.  At this point you have several options:

¥ Insert the new tape and click Mounted to continue the digitiz-
ing process.

¥ Click Skip this clip to skip just the Þrst clip from the tape and 
continue digitizing the remaining clips.
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¥ Click Skip this tape to skip all the clips from the mounted 
tape.  The system then prompts you for the next tape.

¥ Click Abort to end the batch-digitizing process.  You can also 
stop  digitizing at any time by clicking the Trash button  in the 
Digitize tool.

n To skip speciÞc clips in the process of batch digitizing a particular tape, you 
must abort each clip manually by clicking the Trash button, then click next 
clip in the Abort window to continue.

10. When the system has Þnished batch digitizing, a dialog box noti-
Þes you that the process is complete.

Redigitizing Your Material 

Redigitizing is the process of capturing previously digitized source 
footage based on existing clips and sequences. Redigitizing uses the 
batch digitize process and does not require extra logging time because 
the clip information for such things as source tracks, timecodes, and 
compression settings already exists in the bin.

There are several situations in which you may want to redigitize:

¥ You can quickly redigitize selected clips if  you make an error 
while digitizing the Þrst time (for example if you forget to check 
audio levels or set the correct AVR).

¥ You can redigitize clips if you accidentally delete media Þles.

¥ You can redigitize a sequence after you transfer it to another sys-
tem.

¥ You can redigitize low-AVR clips at a higher AVR setting after they 
have been edited into a sequence.

c Redigitizing requires your original source footage. Do not delete the 
media Þles if the source footage is no longer available, unless you 
will not need the material again.
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Redigitizing Master Clips and Subclips

The procedure for redigitizing master clips and subclips is identical to 
the process for batch digitizing logged clips. See  ÒBatch DigitizingÓ 
on page 98.

Although the procedure is the same, the result is slightly different, as 
follows:

¥ Master clips are linked to entire media Þles and serve as sources 
for subclips and sequences.  Therefore, when you redigitize a mas-
ter clip, changes in compression settings and levels affects all sub-
clips and sequences created from the master clip.

¥ Subclips are smaller sections of master clips.  When you redigitize 
a subclip, the system creates a new, smaller master clip that is 
linked to new media Þles and reßects the shortened length of 
material.  Therefore, redigitizing subclips streamlines the digitiz-
ing process.

Also, redigitizing breaks the link from the subclip to the original 
master clip.   But if you edit the subclip into a sequence, the 
sequence will reßect any changes in the newly digitized subclip.

Redigitizing Sequences

Redigitizing a sequence creates new master clips and associated media 
Þles based on the length of each shot edited into the sequence. It 
breaks any links to the original source clips, and only the sequence and 
its new master clips are linked to the newly digitized media Þles. 
Redigitizing a sequence can involve any of the procedures described 
in the following sections.

Saving Two Versions of a Sequence When Redigitizing

If you want to save the original version of your sequence before redig-
itizing,  you can create a duplicate.  For example,  use this method if 
you create a sequence at a low AVR to save storage space and want to 
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redigitize the sequence at a higher AVR while retaining the Þrst ver-
sion.   This is recommended if you intend to use the Decompose fea-
ture.

To make a duplicate of the sequence:

1. Select the sequence in the bin and choose Duplicate from the Edit 
menu.

2. Create a new bin by choosing New Bin from the File menu and 
move the duplicate sequence into the bin. This step is optional, but 
saves you the confusion of mingling new sequences and master 
clips with existing ones, especially when using Decompose.

Using Decompose When Redigitizing

Decompose creates new master clips in the bin for each shot in the 
sequence prior to digitizing. Using Decompose gives you greater con-
trol during the redigitizing process.  Because you create new master 
clips before you digitize, you can use this procedure to sort clips in the 
bin, modify them, and then redigitize selected clips in the sequence.

For Þlm projects, clips created with Decompose retain all the informa-
tion from the original master clips, including Pullin column informa-
tion, key numbers, ink numbers, or any other information formerly 
entered in the bin.

Use Decompose as follows:

1. Activate the bin that stores the sequence.

2. Choose Decompose from the Clip menu. 

The Decompose dialog box appears.
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3. If you want to preserve clips that already have existing media 
Þles, select the option ÒDecompose only those items for which 
media is currently unavailable.Ó  Deselect this option if you plan 
to decompose and redigitize the entire sequence.

4. Click the Handle Length box and type the number of additional 
frames you want to digitize at the heads and tails of the new mas-
ter clips. This provides enough overlap for trimming and adding 
transition effects.

c If you attempt to trim or add effects with no handles, you will get an 
error message notifying you that there is ÒinsufÞcient media.Ó

5. Click OK. The new master clips appear in the bin.  You can now 
sort and select these clips like all other objects in the bin.

6. Proceed with the redigitizing procedures described in the follow-
ing section.

Redigitizing the Sequence

When you redigitize the sequence without using Decompose, the digi-
tize process creates media Þles for each shot in the sequence during 
the digitizing process. Skipping the Decompose procedure saves only 



106

a small amount of time, and you cannot make changes after the media 
Þles are created without repeating the entire procedure.  Therefore, 
review  ÒUsing Decompose When RedigitizingÓ on page 104 before 
proceeding.

Use the following procedure to redigitize a sequence:

1. Choose Go To Capture Mode from the Bin menu.

2. Open or activate the bin that stores the sequence or decomposed 
clips.

3. Select one or more desired sequences, or the desired decomposed 
clips:

¥ Choose Select All from the Edit menu to select all the clips in 
the bin.

¥ Shift-select speciÞc clips.

4. Choose Batch Digitize from the Clip menu.  The Batch Digitize 
dialog box appears.

5. If you want to preserve clips that already have existing media, 
select the option ÒDigitize only those items for which media is cur-
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rently unavailable.Ó  Deselect this option if you plan to redigitize 
the entire sequence.

6. Click the Handle Length box and type the number of additional 
frames you want to digitize at the heads and tails of the new mas-
ter clips. This provides enough overlap to allow for trimming and 
transition effects.

c If you attempt to trim or add effects with no handles, you will get an 
error message notifying you that there is ÒinsufÞcient media.Ó

7. Click OK. The system prompts you to insert the Þrst tape.

8. Insert the tape into the tape deck if you have not already done so.

9. Click Mounted to indicate to the system that the correct tape is 
loaded and ready for digitizing.

A conÞrmation dialog box opens.

10. Click OK to conÞrm the tape and deck entries. The system digi-
tizes each clip from the tape, in start timecode order. If another 
source tape is needed, the system prompts for the tape.

11. You can stop the Batch Digitize process at any time by clicking the 
Trash icon in the Digitize tool. 

When batch digitizing is Þnished, an alert box notiÞes you that the 
process is complete. The new master clips appear in the bin, and 
associated media Þles exist on the targeted drive or drives.
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CHAPTER 4

Importing Files

The Film Composer system allows you to import shot logs, complete 
sequences, or selected graphics, animation, and audio Þles in compati-
ble formats. The various options and procedures are described in the 
following sections:

¥ Supported File Types (Import and Export)

¥ Preparing Files for Import

¥ Importing Files

Supported File Types (Import and Export)

This section describes Þle types you can use to exchange of graphics, 
animation, audio, clips, and sequences, with a brief description of var-
ious contexts in which you might use them. Some Þle types are avail-
able for import only. Film Composer supports the following Þle types:

¥ Shot logs (ASCII and ALE)

¥ PICT

¥ Photo CD

¥ Chyron iNFiNiT!ª

¥ Alias PIX
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¥ PICS

¥ QuickTime¨

¥ AIFF

¥ Sound Designer IIª

¥ Open Media Framework¨ (OMF¨) Interchange

Shot Log File Types

The following Þle types apply to shot logs:

¥ ASCII text Þles: You can import logs created using word proces-
sors or text editors, provided the logged information conforms to 
the Avid log speciÞcations described in the Avid Media Composer 
Products Reference.

¥ ALE text Þles: You can import ASCII text Þles with the .ALE exten-
sion, converted from a list of compatible formats using the Avid 
Log Exchange application. 

For more information on log Þles and Avid Log Exchange, see ÒCon-
verting Logs with Avid Log ExchangeÓ on page 25.

Graphics File Types

The following Þle types apply to still graphics and images:

¥ PICT (import and export): You can import individual graphics 
and still images in the form of PICT Þles generated by many com-
mon paint or image-processing applications. Your PICT Þle import 
can include an alpha channel. You can also export individual 
frames, titles, or graphics objects created in the Film Composer 
system as PICT Þles for treatment in other applications before 
reimporting. (Exporting does not support the alpha channel.) For 
more information on exporting, see ÒExporting PICT FilesÓ on 
page 480.
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¥ Photo CD (import only): You can import photo-CD-quality 
images for use in your sequences with the proper CD player and 
QuickTime driver installed on your system.

¥ Chyron iNFiNiT! (import only): You can import titles pages cre-
ated in the Chyron iNFiNiT! graphics/character-generator. This is 
useful in a broadcast or postproduction facility where the charac-
ter generator is in use.

Animation File Types

The following Þle types apply to animation:

¥ PICT sequence (import and export): You can import a PICT 
sequence generated from various 3D graphics, multimedia author-
ing, and animation applications. When you import a PICT 
sequence, the system incorporates all Þles in the sequence into a 
single clip in the bin. Your PICT Þle import can include an alpha 
channel. When you export a clip or sequence as a PICT sequence, 
the system breaks the series of frames into a sequence of individ-
ual PICT Þles. (Exporting does not support the alpha channel.) For 
more information on exporting, see ÒExporting PICT FilesÓ on 
page 480.

¥ Alias PIX (import only): You can directly import Þles created in 
the native format of Alias PIX, a 3D-animation application. The 
Þles are converted to standard clips in the bin. When using an 
alpha channel for matte-key effects, you must import the alpha 
channel as an extra Þle and nest or stack the two clips to achieve 
the effect.

¥ PICS animation (import only): You can import PICS animation 
Þles and edit with them much like a PICT sequence described 
above. After import, you can edit and play back imported PICS 
animations in real time like any other clip. Note that PICS anima-
tion import does not support the alpha channel.

¥ QuickTime (import and export): You can easily exchange clips 
and sequences between the Film Composer system and Quick-
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Time effects applications such as Adobe¨ After Effectsª and Avid 
Elastic Reality¨ for the addition of special effects over multiple 
frames of video. QuickTime import supports alpha channel for use 
in matte-key effects, but export does not support the alpha chan-
nel. For more information on exporting QuickTime Þles, see 
ÒExporting QuickTime FilesÓ on page 486.

¥ OMF Interchange (import and export): many animation applica-
tions support the OMF Interchange¨ Þle format, so you can easily 
and quickly exchange sequences of animation frames. See 
ÒExporting OMF FilesÓ on page 495.

Audio File Types

The following Þle types apply to audio Þle exchange:

¥ Audio Interchange File Format (AIFF) (import only): You can 
import audio tracks that have been saved as a standard AIFF Þle. 
This is especially useful when exchanging audio tracks for your 
sequence between the Film Composer system and compatible dig-
ital audio workstations for audio sweetening.

¥ Sound Designer II (import only): You can directly import audio 
Þles created in the native format of Sound Designer II, a digital 
audio editing and sweetening application. Film Composer audio 
Þles are SD II Þles, so there is no need to export. They can be 
opened by any application that can open SD II Þles.

¥ OMF Interchange: You can quickly and easily exchange audio 
between various compatible platforms and applications using the 
Open Media Framework (OMF) Interchange format. Two applica-
tions are Avid AudioVision¨ and Digidesign Pro Tools¨. For more 
information, see ÒExporting OMF FilesÓ on page 495.

Clips and Sequences

The following Þle types apply to clips and sequences:
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¥ QuickTime: You can easily exchange whole clips and sequences 
between the Film Composer system and QuickTime-compatible 
applications for playback within documents or multimedia pro-
grams, or for treatment in a third-party application before reim-
porting to the Film Composer system.

You can convert your material directly into the QuickTime Þle for-
mat, or you can save time and maintain high resolution in your 
export using the Avid Media Composer codec, which accelerates 
the conversion process. For more information, see ÒExporting 
QuickTime FilesÓ on page 486.

¥ OMF Interchange: You can quickly and easily exchange media 
and sequences between various platforms and compatible appli-
cations using the OMF Interchange format. OMF Interchange pro-
vides a single, open Þle format for:

- Editing information for sequences

- All types of digital media data: audio, video, animation, 
graphics, character generator

- Source information for Þlm, video, and audio clips

For more information, see ÒExporting OMF FilesÓ on page 495.

Preparing Files for Import

The following sections describe speciÞcations that your graphics, ani-
mation Þles, QuickTime, and OMF Þles must meet prior to import.

Graphics File Specifications

Use these speciÞcations when creating a graphics Þle for import into 
the Film Composer system.
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Graphics File
Import SpeciÞcation

Explanation

Compatible File Formats PICT, Photo CD, and Chyron iNFiNiT! 

Image Size Choices for the full-screen image size include:

- 640 x 480 pixels for NTSC images (square pixels)
- 640 x 576 pixels for PAL images (square pixels)
- 720 x 486 pixels for NTSC images (non-square pixels)
- 720 x 576 pixels for PAL images (non-square pixels)

Film Composer Release 5.6 and earlier displays 640 x 480 and 640 x 576 
images. Film Composer 6.0 and later displays 720 x 486 and 720 x 576 
images.

Overlay/Keyed Graphic Use the alpha channel to set the transparency level of each region in the pic-
ture. To store the transparency information, save the graphic as a PICT Þle 
with an alpha channel (that is, set the resolution to 32 bits per pixel).

When you key the graphic, the background video shows through the white 
part of the alpha channel, foreground through the black. Gray areas deter-
mine transparency levels between the two.

Opaque Graphic To create an opaque image to edit into a video sequence, do not use an alpha 
channel (that is, set the resolution to 24 bits or fewer per pixel).

Note: If you want to use the imported graphic as an overlay instead of an 
opaque graphic, you can key the image over video using the chroma, luma, 
or matte key effects within the system or pick a transparent key color when 
you import the graphic. However, images with their own alpha channel have 
the best results.

Smooth Edges To eliminate jagged edges in the image, use the graphics applicationÕs anti-
alias or high-quality option. If you will be keying the image over video, you 
also need to create an alpha channel by setting the resolution to 32 bits per 
pixel.

Photo CD Files If you are importing Photo CD Þles, you must install QuickTime software 
and a compatible QuickTime Photo CD driver.

If the photo has a portrait orientation, the image will be automatically 
rotated upon import. To avoid this, use a paint or image processing program 
to crop or resize the image before importing.
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Animation File Specifications

Use these speciÞcations when creating an animation Þle for import 
into the Film Composer system.

Animation File
Import SpeciÞcations

Explanation

Compatible File Formats PICS Animation, sequenced PICT, and sequenced Alias PIX.

Alias PIX File If you use Alias to create a series of PIX Þles, you have the option of generat-
ing a matte Þle to key the animation over video. If you use this option, 
remember to import the matte images as well as the PIX animation images. 
In the Film Composer system, edit the video onto track V1, the animation 
onto track V2, and the matte key onto track V3.

Sequenced PICT Files You can create a sequential series of single-image PICT Þles, then import 
them as an animation. Name each Þle Namen, with Name identifying the 
animation and n indicating the Þle order (for example, Image1, Image2, 
Image3). The numbering can start at any number or use any numbering for-
mat, for example Image010, Image012, or Imagef28, Imagef29.

Overlay/Keyed Anima-
tion

To create an animation PICT sequence to key over video, use the alpha chan-
nel to set the transparency level of each region in each picture in the 
sequence.

When you overlay the animation onto a video track, the background video 
shows through the white part of the alpha channel. The foreground video 
shows through black. Gray areas form a blend between the two.

Frame Rate Media Composer assumes a 30 fps frame rate (25 fps for PAL). Film 
Composer assumes a 24 fps rate. Therefore, set the appropriate frame rate for 
the project (30 fps for NTSC, 25 fps for PAL, 24 fps for Þlm) when you export 
from the third-party application.
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QuickTime File Specifications

Use these speciÞcations when using QuickTime Þles with the
Film Composer system.

QuickTime File
Import SpeciÞcations

Explanation

QuickTime Þles For QuickTime import and export, you must install QuickTime software, 
Version 1.5 or later. Avid recommends Version 2.0 or later.

Resolution The Avid Video Resolution (AVR) of the import is determined when you 
export from the third-party QuickTime application.

Media Composer
QuickTime Þles

The Media Composer QuickTime codec lets you import QuickTime Þles at a 
rate of three to four times real time. To use the codec in a third-party Quick-
Time application, you must Þrst install the codec in the System FolderÕs 
Extensions folder. See ÒUsing the Media Composer QuickTime Codec from 
QuickTime ApplicationsÓ on page 494.

Image Size To take advantage of the codec speed, you must export the Þles from the 
QuickTime application at one of the following frame sizes:

- 640 x 480 pixels for NTSC images (square pixels)
- 640 x 576 pixels for PAL images (square pixels)
- 720 x 486 pixels for NTSC images (non-square pixels)
- 720 x 576 pixels for PAL images (non-square pixels)

Film Composer Release 5.6 and earlier displays 640 x 480 and 640 x 576 
images. Film Composer 6.0 and later displays 720 x 486 and 720 x 576 
images.

File extension After you import a QuickTime Þle, the Þle maintains the .MooV extension, 
which is visible in a bin.

QuickTime alpha To save a QuickTime movie with alpha channel in a third-party QuickTime 
application, use a codec that supports a color depth of Òmillions +.Ó 
Film Composer does not support matte key or alpha channel for QuickTime 
export; it does import alpha channel when there is one.
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OMF File Specifications

In general, check the documentation for the application you are 
importing from for speciÞc information on preparing OMF Þles. 

Use these speciÞcations when creating an OMF Þle for import into the 
Film Composer system.

OMF File
Import SpeciÞcations

Explanation

AVR (Avid Video Resolu-
tion)

For fastest import of AVR media, set the resolution in the Import dialog box 
to the AVR that is in the OMF Þle, so that the Film Composer system does not 
try to convert the media. Simple OMF tools that report the AVR of an OMF 
Þle are available on the OMF Web site (http://www.avid.com/omf). To 
optimize your import speed and quality, export from the source application 
at the AVR that your Film Composer project is expecting.

Edit rate You must import sequences and clips to projects that have the same edit rate 
(30 fps for NTSC, 25 fps for PAL, 24 fps for Þlm). If the edit rates do not 
match, you will get an error message.

OMFI version Film Composer Release 6.5 supports import of both OMF 1.0 (composition 
and media) and OMF 2.0 (composition) Þles. Film Composer now supports 
the following OMF 2.0 effects:
- video effects: dissolves, wipes, freeze-frame, Þlm pulldown, slow motion, 
fade to black
- audio effects: pan and volume, audio dissolves

Film Composer automatically recognizes if a Þle is formatted as OMF 1.0 or 
2.0 and imports it appropriately.

Additional effects will be supported in future releases. See the Avid Film 
Composer Release Notes for current details.

Film pulldown To import audio media into Film Composer, you must have the pulldown 
switch set to 1.0. 

Audio sample rate Audio media is imported at the sample rate that is set on the Film Composer 
system.
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Importing Files

For information on 
importing Shot Logs, 
see ÒImporting Shot 
Log FilesÓ on page 29.

When you import, the imported graphics, animation, audio, Quick-
Time, and OMF Þles are converted into objects in a bin. You can 
manipulate and edit these objects like any other clip or sequence. Any 
corresponding media Þles are stored on a target drive that you specify.

Before You Begin

Before you begin the import, check the speciÞcations in the previous 
section for the Þle type you are importing. In addition, decide on the 
following: 

¥ AVR resolution for the imported media

¥ Render settings

MCXpressª for Win-
dows NT Þles

If you are importing OMF compositions from MCXpress for Windows NT, 
you may get an error if the sequence includes video or audio effects. If so, 
create a cuts-only version of the sequence in MCXpress and export it again. 
You cannot import video media from MCXpress for Windows NT; if you 
import a composition you must redigitize the media.

Avid Media Fusionª OMF compositions and audio import correctly from Avid Media Fusion but 
OMF 2.0 video media (RGBA or CDCI) currently does not. 

File transfer If you are transferring an OMF Þle over a network, make sure to transfer it as 
a binary Þle.

Reimporting Media 
Composer media Þles

If you import OMF Þles that contain media that you exported from the same 
Media Composer system, you need to delete the original media. Otherwise 
the new media will not overwrite the original media. To locate the original 
media for a sequence, see ÒSelecting Media Relatives for an ObjectÓ on 
page 145.

OMF File
Import SpeciÞcations

Explanation
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These settings are described in the following sections.

Mixed Resolutions

For more information 
on resolutions, see the 
Avid Media Composer 
Products Reference.

Beginning with Release 6.0 of the Film Composer system, you can 
work with mixed resolutions in the same sequence. This feature allows 
you to import your graphics at the highest resolution you will be 
using.

For example, assume that you want to do your initial work at a low 
resolution such as AVR 12 and then redigitize your media at AVR 77 
for the Þnal version. In this case you should import the graphics at 
AVR 77. Then when you redigitize your material, you will not have to 
reimport the graphics.

If you plan to redigitize your media at a higher AVR, the lower AVR 
must be from the same family (single-Þeld or two-Þeld). For example, 
if you plan to Þnish at AVR 77, you could start the project at AVR 12.

Limiting the Size of Imported Files

You can limit the size of an imported Þle to Þt a playable range by 
changing the projectÕs Render settings. The system always defaults to 
100 percent of the frame size limit for each new project. Avid recom-
mends that you check these settings before importing, especially when 
importing complex graphics and animation, because the settings 
apply during the import process. For more information, see the Avid 
Media Composer and Film Composer Effects Guide.

Importing the Files

You can access Þles for import from any folder or drive source 
mounted on the desktop, such as a 3.5-inch diskette, Þxed drives, 
removable magnetic (RMAG) drives, or from a network server.
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You can import more than one Þle, but all Þles must use the same Þle 
format.

Import one or more Þles as follows:

1. Open the bin in which you want to store the imported Þle. Click 
anywhere in the bin to select it.

2. Choose Import from the File menu, or hold down the Option key 
and choose Import.

n If you do not see the Þle you want to import in the folder you selected, hold 
down the Option key and choose Import. This action displays all Þles in the 
speciÞed folder and may be necessary when you import Þles created on plat-
forms other than Macintosh. Otherwise the Þles may not appear in the Import 
dialog box.

The Import dialog box appears.
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3. Choose an import Þle type from the File Type pop-up menu.

Source File selection box

Media Disk pop-up menu

Import File selection boxFile Type pop-up menu Directory pop-up menu

Resolution pop-up menu

Aspect Ratio pop-up menu

RGB/CCIR pop-up menu
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4. The options in the dialog box change, depending on the Þle type 
that you selected. 

¥ If you choose PICT, Photo CD, PICS, or QuickTime, complete 
the options as described inÒImport File OptionsÓ on 
page 122.

¥ If you choose OMF Interchange, you see a checkbox labeled 
Show All Files. Select this checkbox to display all Þles in a cho-
sen folder, regardless of Þle type.

5. Choose a destination disk for the imported Þle from the Media 
Disk pop-up menu.

6. For graphics and video Þles, choose a resolution for the imported 
media from the Resolution pop-up menu.

For optimum speed when importing an OMF Þle, set the resolu-
tion to match the resolution of the OMF Þle you are importing.

If you are using mixed resolutions, choose the highest AVR that 
you will be using for the Þnal version of the sequence. See ÒMixed 
ResolutionsÓ on page 118.

7. Use the Directory pop-up menu to locate the folder containing the 
source Þles.

8. In the Source File selection box, click the Þle or Þles you want to 
import.

You can import multiple Þles in the same process, but they must 
be the same Þle type. 
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9. Click the Add button or double-click the Þlename to add the Þle to 
the Import File selection box on the right. Alternatively, click the 
Add All button to select all the Þles in the Source File selection box 
for import. If you make a mistake, use the Remove or Remove All 
buttons.

n The Source File selection box only shows the Þrst Þle in a sequenced series of 
PICT Þles when you select the Import PICT Sequence checkbox. If you are 
importing a sequenced series of PICT Þles, you only need to add the Þrst Þle 
in the series to the Import File selection box.

10. Click Done.

The imported images, clips, or sequences are available in the bin 
you selected.

n If you import an OMF Þle with a stereo sound track, Film Composer creates a 
new master clip that contains the right channel of the sound track. The origi-
nal master clip contains the left channel. Both clips appear in the bin you 
selected.

Import File Options

PICT, Photo CD, PICS, and QuickTime Þle types have their own 
options, as shown in the following table.

Aspect 
Ratio

RGB/CCIR Import 
PICT 
Sequence

Ignore/
Invert 
Alpha

Use Key 
Color 
Picker

Single 
Frame 
Import

PICT x x x x x x

Photo CD x x

PICS x

QuickTime x x
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The following list describes these options, as they appear on the 
Import dialog box. Some options are described further in the following 
sections.

¥ Aspect ratio: Choose either Maintain Aspect Ratio or Force to Fit 
Screen. See ÒChoosing an Aspect RatioÓ on page 123.

¥ RGB/CCIR: Choose RGB Graphics Levels for most graphics. 
Select CCIR Video Levels for graphics created at CCIR-601 levels, 
including Avid color bars (available on the Avid drive in Media 
Composer:Supported Files:Test Patterns).

¥ Import PICT Sequences: Select this option to import a sequenced 
series of PICT Þles.

¥ Ignore Existing Alpha: Select this option if you will be using the 
Þle as an opaque graphic. The alpha channel information stored 
with the PICT Þle will not be imported.

¥ Invert Existing Alpha: Select this option to reverse the black and 
white elements of the alpha channel if they differ from the matte-
key requirements of the system: a white background, a black fore-
ground, and a gray transparency blend between the two.

¥ Use Key Color Picker: Select this option if you want to choose a 
key color for each Þle while it is being imported. Note that if you 
use this option when you import a large batch of Þles, importing 
takes more time. See ÒSelecting a Key ColorÓ on page 125.

¥ Single frame import: Choose whether to import the PICT Þle as a 
single frame slide or as a media Þle of a speciÞc duration. See 
ÒSelecting Single Frame Import OptionsÓ on page 126.

Choosing an Aspect Ratio

When importing a single still image, you can choose either Maintain 
Aspect Ratio or Force to Fit Screen from the Aspect Ratio pop-up 
menu.

¥ Choose Maintain Aspect Ratio if you want Film Composer to use 
the existing aspect ratio for the imported frames. 
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c Do not use this option if you are importing images in the 720 x 486 
non-square pixel dimensions used by Film Composer.

If the height or width of the images in square-pixel terms does not 
match the 3:4 aspect ratio used by Film Composer, the system Þts 
the longest dimension to the screen size, and Þlls the missing pix-
els in the shorter dimension with black. 

¥ Choose Force to Fit Screen if you want Film Composer to convert 
the existing pixel dimensions so that the entire image Þlls the 
screen.

c Choose this option if you are importing images with the 720 x 486 
non-square pixel dimensions used by Film Composer.

If the aspect ratio of the frames does not match the 3:4 aspect ratio 
used by Film Composer, the imported frames might be distorted.

Image before import

3

4

Image after import

Image before import

3

4

Image after import
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Selecting a Key Color

If you select Use Key Color Picker, the Graphic Key Color dialog box 
appears so you can select a transparent key color for the graphic. The 
system uses the key color to create an alpha channel for the graphic 
through which the video is visible. 

n This feature is primarily for use in ofßine contexts: for online quality, apply 
the chroma key in Effects mode.

1. Use one of the Key Color options.

- To keep the image opaque, click None.

If you do not select a key color, you can still key the image 
over video using the Film ComposerÕs Key effects after editing 
the graphic into a sequence.

- To use white or black as the key color, click the Key Color 
name.

- To select a key color from the graphic, drag the cursor to the 
thumbnail image. The cursor becomes an eyedropper. Click 
the color you want.

- To use the standard Macintosh Color Wheel, click the Key 
Color swatch, then select a key color from the dialog box that 
appears.

Key Color
Thumbnail
representation
of the graphic

Key Color swatch

Eyedropper
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2. Click OK to close the Graphic Key Color dialog box.

Selecting Single Frame Import Options

When importing a single still image, you can select one of two options, 
each with different advantages:

¥ Importing as a media Þle creates digital media for the PICT similar 
to the media created when you digitize footage. You can also des-
ignate the duration of the media. This method ensures that you 
can play the clip in real time, even at a high resolution such as 
AVR 75 or 77. The import process will take close to real time. For 
example, a PICT import of 25 seconds takes about 25 seconds to 
import and creates a media Þle that takes up 25 seconds of disk 
space.

¥ Importing as a slide takes less time and requires less storage, but is 
more limited in terms of real-time playback capabilities, particu-
larly at high AVRs. This is because the system handles a slide by 
loading the frame into memory and transferring it through the 
compression technology of the system in real time, rather than 
playing back from disk.
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CHAPTER 5

Organizing with Bins

Film Composer provides powerful database tools for organizing and 
managing your digitized material. You can view bins in three different 
display modes. You can rename, sort, sift, duplicate, and delete clips 
and sequences. You can also print out single clip frames or whole bins. 
A worksheet at the end of this chapter provides guidelines for using 
these techniques to create and print storyboards for your project. 
These topics are covered in the following sections:

¥ Before You Begin

¥ About Bin Display Modes

¥ Basic Bin Procedures

¥ Using Text Mode

¥ Using Frame Mode

¥ Using Script Mode

¥ Printing Bins

¥ Gathering Format Elements

¥ Storyboard Worksheet
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Before You Begin

There are several procedures you may want to perform before you 
begin organizing your project, because they affect the display of infor-
mation in bins or the way the clips play back during screening:

¥ If you digitized clips using LTC (longitudinal timecode) recorded 
on an audio track, and would like to instruct the system to address 
this timecode during editing, see the following section ÒUsing 
Audio Timecode.Ó

¥ If you would like to center the pan between left and right speakers 
for some or all of the clips in a bin, see  ÒUsing the Center Pan 
CommandÓ on page 131.

¥ If you would like to customize the types of objects (clips, subclips, 
and so on) displayed in a bin, see  ÒSetting the Bin DisplayÓ on 
page 132.

¥ If you digitized some of your video and audio clips separately, 
and need to synchronize them for editing, see  ÒAutosyncing 
ClipsÓ on page 362.

¥ If you sync audio and video clips and Þnd that the audio needs to 
be slipped slightly at the perforation level to achieve true sync, see  
ÒResyncing Subframe AudioÓ on page 365.

¥ If you need to group or multigroup material, see  ÒGrouping and 
MultigroupingÓ on page 389.

Using Audio Timecode

Film Composer can read audio timecode (LTC or longitudinal time-
code recorded on an audio track). If you captured the LTC as an audio 
track during the digitizing process, then use the Read Audio Timecode 
command. This instructs the system to address this track for timecode 
information to be displayed in the bins and used in editing.

1. In the bin, select the appropriate clips, then choose Read Audio 
Timecode from the Special menu. 
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The Read Audio Timecode dialog box appears.

2. To read timecode stored in the User Bits of the LTC, click the check 
box next to User Bit Timecode. If this option is not selected, the 
system reads the LTC timecode.

c Information contained in the User Bits of the LTC must be timecode 
only.  Other data stored in the User Bits will not appear in Media 
Composer unless you use the Avid Media Reader.  For more infor-
mation about the Avid Media Reader, contact your Avid sales repre-
sentative.

3. Choose the audio track containing the timecode from the Audio 
Timecode Source pop-up menu. A1 is the default.

4. Choose the target auxiliary timecode bin column for recording the 
audio timecode from the Destination Track pop-up menu. Aux 1 is 
the default selection.

5. Choose Fill Undecodable Frames to instruct the system to Þll in 
any timecode breaks with continuing timecode. This is the default.

For example, in a three-minute master clip, the audio timecode 
starts at 1:00:20:20. At 1:00:22:10, the timecode ends. With the Fill 
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Undecodable Frames option selected, the system assigns 1:00:22:11 
to the next frame and continues assigning timecode.

Deselect this option if you do not want to Þll timecode breaks.

6. Click OK to complete the procedure. The timecode appears in the 
bin in the auxiliary timecode column that you chose.

Adjusting Pan Defaults

For information on 
using the Audio Mix 
tool to adjust pan for 
individual clips in a 
sequence, see  ÒUsing 
the Audio Mix ToolÓ 
on page 327.

The way your footage was recorded in the Þeld, and digitized in 
Media Composer, will affect the way sound pans between the speak-
ers. By default, the system pans audio tracks 1 and 3 to the left speaker 
output and pans tracks 2 and 4 to the right speaker output. 

You can set global pan settings before or during editing using the 
Audio Settings dialog box and the Center Pan command, as described 
in this section. 

Adjusting Default Pan Settings

The Audio Settings dialog box provides options for adjusting the 
default audio pan when editing with new clips, and digital audio 
scrub parameters for monitoring and analyzing audio tracks and tran-
sitions.



131

By default, the audio tracks for clips alternate with track 1 on the left 
and track 2 on the right speaker for monitoring and output. The All 
Tracks Centered option instructs the system to center the pan of all 
tracks between the two speakers for monitoring and output.

Using the Center Pan Command

You can use the Center Pan command on source material in bins. Use 
it prior to editing, or at any time during the editing process.

As opposed to adjusting pan on individual clips using the Audio Mix 
tool, Center Pan allows you to create a standard distribution of audio 
between left and right speakers. You can adjust the pan on selected 
clips or all clips with a single command. This is especially useful when 
you have clips with Þeld audio recorded (and subsequently digitized) 
variably between A1 and A2. Panning all of the audio to center elimi-
nates the distraction of having to listen to left and right speakers in 
turn. It also smooths the playback of the edited sequence, with all 
shots panned to center.
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1. In a bin, select the clips you want to pan to the center.

2. Choose Center Pan from the Clip menu. 

A dialog box appears and asks you to conÞrm the pan.

3. Click OK. The system pans all of the selected clips to the center.

Setting the Bin Display

By default your bins display all existing media objects except Source 
clips and Rendered Effects. To reduce crowding in the bin and to dis-
play only those objects that you need to organize your project, you can 
display selected media objects.

To set the bin display:

1. Choose Set Bin Display from the Bin menu.

The Display Bin Selector dialog box appears.
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2. Select the object types that you want to see: master clips, subclips, 
sequences, and so on.

3. The option ÒShow clips created by userÓ is selected by default. 
Deselect this option only if you want to hide all objects except 
those created by the system.

4. Select the option ÒShow reference clipsÓ to automatically display 
those objects that are referenced by sequences in the bin, whether 
those clips were previously in the bin or not.

5. Click OK. The bin displays objects according to your speciÞca-
tions.
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Film Scene Workflow

During the organizing phase, common practice on Þlm productions is 
to organize the digitized clips according to scene. This helps to sim-
plify the work environment for the editor, and keeps crowded bins to a 
minimum.

Use the various procedures described in this chapter to organize scene 
bins according to the following basic workßow:

1. Create one bin for each scene, using procedures described in the 
Avid Film Composer Getting Started Guide.

2. Gather clips according to scene using one of the following optional 
procedures:

¥ Copy clips for each scene from the digitize bins into the appro-
priate scene bin, using procedures described in ÒCopying 
Clips and SequencesÓ on page 139.

¥ Duplicate the clips and then move the duplicates into the 
appropriate scene bin, using procedures described in ÒDupli-
cating Clips and SequencesÓ on page 138.

3. Proceed to sort, sift, and organize the clips within each scene bin, 
according to the editorÕs preferences.

It is best to copy or duplicate clips as you reorganize them in bins, so 
that all the original source clips will remain in the appropriate dailies 
bin if you ever need to redigitize according to source tape.

About Bin Display Modes

There are three display modes for viewing and working with clips in a 
bin: Text mode, Frame mode, and Script mode, as follows.

¥ In Text mode, clips are displayed in a database text format using 
columns and rows, with icons representing the various objects. 
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You can save various arrangements of columns, text, and objects 
as customized views. 

For information on spe-
ciÞc Text mode features, 
see  ÒUsing Text ModeÓ 
on page 147.

To enter Text mode, click the Text Mode button (labeled T) in the 
lower left portion of the bin.

¥ In Frame mode, each clip is represented by a single picture frame, 
with the name of the clip. You can play back the footage in each 
frame, and change the size of frames. You can also rearrange the 
frames in any order within the bin.

Bin fast menu

Text mode button

Object icons

Bin View menu

Column headings

Clip frame

Clip name
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For information on spe-
ciÞc Frame mode fea-
tures, see  ÒUsing 
Frame ModeÓ on 
page 162.

To enter Frame mode, click the Frame Mode button (labeled F) in 
the lower left portion of the bin.

¥ In Script mode, the system combines the features of Text mode with 
Frame mode, and adds additional space for typing notes or script. 
The frames are displayed vertically on the left side of your screen 
with a text box to the right of each clip. Clip data is displayed 
above the text box. You cannot change the size of the frames dis-
played in Script mode. 

For information on spe-
ciÞc Script mode fea-
tures, see  ÒUsing 
Script ModeÓ on 
page 165.

To enter Script mode, click the Script Mode button (labeled S) in 
the lower left portion of the bin.

Clip informationScript text box
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Bin Fast Menu

All Bin menu commands are also available in the Bin Fast menu 
located in the lower left corner of every bin.

To open the Bin Fast menu, click the Fast Menu button in any of the 
three display modes.

The Fast menu is especially convenient when you are working with 
several open bins and need to access Bin menu commands quickly.

Basic Bin Procedures

There are some basic procedures that you can use in any of the three 
Bin Display modes for manipulating clips in the bin. These include 
selecting, deleting, duplicating, moving, copying, and sifting clips and 
sequences.

Setting the Bin Font

You can change the bin font by following these steps:

1. Choose Set Font from the Edit menu.

The Select Font and Point Size dialog box appears.

Fast Menu button
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2. Click the Font pop-up menu and choose from the list of available 
fonts. 

n Any font loaded in the Fonts folder in the Macintosh System Folder appears 
in the list.

3. Enter another point size for the font in the Size entry Þeld.

4. Click OK.  The new font appears in all bin display modes.

Selecting Clips and Sequences

Use one of the following procedures to select clips in a bin:

¥ Click the clip icon (Text mode), or click the picture area of the clip 
(Frame mode).

¥ Select multiple clips by Shift-clicking additional items, or by click-
ing and dragging a lasso around several clips.

To reverse your selection, choose Reverse Selection from the Bin menu. 
The clips that you previously selected are deselected and those clips 
that were previously deselected are selected.

Duplicating Clips and Sequences

When you duplicate a clip or sequence, the system creates a separate 
clip linked to the same media Þles. You can move, rename, and manip-
ulate this clip without affecting the original clip.
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To duplicate a clip or sequence:

1. Select the clip or sequence that you want to duplicate, or Shift-
select multiple clips.

2. Choose Duplicate from the Edit menu.

A copy of the clip or sequence appears in the bin, with the original 
clip or sequence name followed by the extension .Copyn, where n 
is the number of duplicates created from the original clip or 
sequence.

Moving Clips and Sequences

You can move clips and sequences to other bins in order to group and 
organize various types of material based on project needs.

To move clips from one bin into another:

1. Create or open another bin. Give the bin a name that represents its 
purpose or contents.

2. Position and/or resize the original bin and the new one so that 
you can see both of them at the same time.

3. Select the clip that you want to move, or Shift-select multiple clips.

4. Drag the clips to the new bin.

n If the destination binÕs display has been set to show reference clips, the refer-
enced object types do not appear until you save the bin. For more information 
on setting the bin display, see  ÒSetting the Bin DisplayÓ on page 132.

Copying Clips and Sequences

When you copy clips and/or sequences, you are essentially cloning 
the same clip or sequence in another bin. In other words, any change 
you make to the copy will affect the original as well. The system does 
not add the .Copy extension to the clip or sequence as it does when 
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duplicating, You cannot copy clips to the same bin, and you cannot 
return a clip copy to the same bin where the original resides.

To copy clips from one bin into another bin:

1. Position the bins so that you can see both of them at the same time. 
You may need to resize the bins to do this.

2. In the original bin, click the clip that you want to copy, or Shift-
select multiple clips.

3. Press the Option key and drag the clips to the destination bin and 
release.

The clips appear in the new bin, displayed in the destination binÕs cur-
rent display mode (Script, Frame, or Text), and the originals remain in 
the Þrst bin. If the destination binÕs display has been set to show refer-
ence clips, the referenced object types do not appear until you have 
saved the bin.

When you copy clips from one bin to another, the custom columns that 
you created in the Þrst bin are also copied to the second bin. The cus-
tom columns appear in the order in which you created them.

Deleting Clips and Sequences

Delete clips from a bin as follows:

1. Select the clips and sequences that you want to delete.

2. Choose Clear from the Edit menu, or press the Delete key on the 
keyboard.

A dialog box appears, showing information about the selected 
items.
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In this example, two subclips and two master clips (along with 
their media Þles) are highlighted for deletion. 

3. Click the check boxes to select the items highlighted for deletion. 
Do not select those items you do not want to delete.

4. You also have the option of deleting the associated media Þles for 
master clips and effect clips. You can select both clips and media 
Þles for deletion, or you can select only the media Þles if you want 
to retain the clips for later redigitizing.

5. Click OK.

A dialog box asks you to conÞrm the deletion.

6. Click Delete.

Sifting Clips and Sequences

When you sift clips, the bin displays only those clips that meet a spe-
ciÞc set of criteria. For example, you can do a custom sift to display 
only those clips containing the word Òclose-upÓ in the heading col-
umn. The custom sift dialog box provides you with six different levels 
of criteria.



142

To sift clips and sequences:

1. Choose Custom Sift from the Bin menu.

The custom sift dialog box opens.

2. Move the cursor to the box containing the word Òcontain.Ó This is 
called the Operator menu box. Click and hold to display a pop-up 
menu.

3. Select one of the sifting options.

4. Click the Þrst Sift criteria Þeld and enter the text that you want to 
use as a sift criterion.

5. Click the column pop-up menu and select a column heading to 
which you want to apply the criterion.

Operator menu Sift criteria field Column specification box

Pop-up menu
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6. Enter additional sift criteria, and make additional column selec-
tions, as necessary.

Only the clips that meet your criteria remain in the bin, with the 
word ÒpartialÓ added to the bin name.

After you have sifted the clips in a bin, you can display the bin in a 
sifted or an unsifted state.

¥ To view the entire bin, choose Show Unsifted from the Bin menu.

¥ To view the sifted bin, choose Show Sifted from the Bin menu.

The word ÒpartialÓ after the bin name appears or disappears to indi-
cate the current state of the bin you are viewing.

Locking Items in the Bin

You can lock any item in the bin Ñ including  source clips, master 
clips, subclips, and sequences Ñ to prevent deletion.  When you lock 
clips in the bin, their associated media Þles are locked at the Finder 
level as well.

To lock selected items:

1. Click a clip, subclip, or sequence to select it.  Shift-select additional 
clips if necessary.

2. Choose Lock Bin Selection from the bottom of the Clip menu.
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For more information 
on displaying columns, 
see  ÒAbout Bin ViewsÓ 
on page 148.

A lock icon appears for each locked clip in the Lock column of the 
default Statistics Bin view.

To unlock previously locked items:

1. Select the items in the bin.

2. Choose Unlock Bin Selection from the Clip menu.

n You can use the clip locking feature along with archiving software such as 
Cheyenne to automatically archive all locked media Þles.  For more informa-
tion on archiving locked Þles, see your archiving softwareÕs documentation.

Selecting Offline Items in a Bin

Ofßine items are those clips, subclips, or sequences that are missing 
some or all of their media Þles. 

To identify ofßine items, choose Select Ofßine Items from the Bin 
menu.

The bin highlights all items that are missing media Þles.

Lock icon
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Selecting Media Relatives for an Object

When you identify the media relatives of a selected clip or sequence, the 
system highlights all other clips linked to the selected clip, such as 
subclips or other sequences.

Identify media relatives as follows:

1. Open the bin that contains the chosen clip or sequence.

2. Open any other bins that may contain the media relatives that you 
want to Þnd.

3. Resize and position the bins so that you can see their contents. 
Text mode is best for viewing as many objects as possible.

4. Select the chosen clip or sequence, and choose Select Media Rela-
tives from the Bin menu.

The system highlights all related objects in all open bins.

Selecting Sources Used by an Object

Use the Select Sources command to identify all of the sources used by 
a particular object. For example, if you select a sequence as the object, 
you use the Select Sources command to identify every master clip, 
subclip, tape, and media Þle that is a source for that sequence.
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Identify sources for a clip or sequence as follows:

1. Select one or more objects in a bin.

2. Choose Select Sources from the Bin menu.

All sources for the selected objects in all open bins are highlighted.

Selecting Unreferenced Clips

When you select unreferenced clips, the system highlights all clips that 
are not currently referenced by clips or sequences that are present in 
the open bins. Any master clips, subclips, or effect clips you have 
edited into a sequence in the bin are not highlighted. This command is 
effectively the reverse of the Select Media Relatives command.

Identify unreferenced clips as follows:

1. Open the bin containing the sequence or clip that is referenced.

2. Open all other bins containing clips that were used during editing.

3. Choose Select Unreferenced Clips from the Bin menu.

An alert box warns you that unreferenced clips will be highlighted 
in open bins only (items in closed bins will not be shown).

4. Click OK.

All unreferenced clips are highlighted in the open bins.
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Using Text Mode

Text mode provides the most complete view of clip information. It 
uses database columns that you can rearrange and customize to suit 
your needs. 

To enter Text mode, click the Text Mode button (labeled T) in the lower 
left corner of the bin.
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About Bin Views

For complete informa-
tion on all Film and Sta-
tistical column 
headings, see the Avid 
Media Composer Products 
Reference.

To the right of the Display Mode buttons, you will Þnd a pop-up menu 
of titles for different Bin views. This option is available only in Text 
mode. Bins have three default views that are automatically loaded:

¥ Statistics view uses the standard statistical column headings 
derived from information established during capture, such as 
Start and End timecodes, Duration, Resolution, and so on.

¥ Film view has Þlm-related column headings, including key num-
ber, ink number, pull in, and so on. If you are working on a non-
Þlm-related project, and select the Film bin view, a dialog box 
informs you that only the nonÞlm-related columns will be dis-
played.

¥ Custom view allows you to create and save customized views. 
The only required heading is the clip name, displayed by default. 
You can customize the view by adding, hiding, or rearranging col-
umn headings.

If you import a log Þle from your telecine transfer, much of this infor-
mation will be placed in the bin when you import the log. If you do 
not have a Þlm log, then you can enter this information manually by 
highlighting the Þeld in the bin and typing the information.

Customizing Bin Views

There are several ways to customize views of the bin:

¥ Alter the arrangement of existing columns in the standard Statis-
tics view or Film view to suit your needs, without adding or hid-
ing columns. These arrangements will be recalled each time you 
choose Statistics view or Film view.

For more information 
on working with set-
tings, see the Avid Film 
Composer Getting 
Started Guide. 

¥ Add or hide columns of information to create customized Statis-
tics or Film views. These will be saved as additional view settings 
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in numerical order, for example Statistics.1, Statistics.2, unless you 
choose another name.

¥ Add, hide, copy, or rearrange standard or customized columns in 
any combination to create your own custom views. You can name 
and save these to suit your needs.

When you create a new Bin view, the system saves the settings for this 
view so that you can later access and alter, copy, or delete these set-
tings.

Moving and Rearranging Columns

To move a text column in a bin:

1. Click the heading of the column that you want to move.

The entire column is highlighted.

2. Drag the column to the desired position and release the mouse 
button.

The column appears in the new position, and columns to the right 
are moved down to make room.

Tidying Up Bin Columns

When you tidy up bin columns, the system maintains the same order 
of columns from left to right, but spaces them according to the length 
of contents. This is especially useful for removing spaces left after 
moving or rearranging columns.

To tidy up bin columns, choose Tidy Up Columns from the Bin menu, 
or press kÐT.

Showing and Hiding Columns

You can select individual or multiple headings to display or hide in 
the bin. To choose column headings using the Headings dialog box:
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1. With a bin in Text mode, choose Headings from the Bin menu. You 
can also double-click a Bin View setting in the Settings list of the 
Project window.

A dialog box appears.

You can also display a 
frame for each clip 
along with statistical 
information in Text dis-
play mode by display-
ing the Frame column.  
For information, see  
ÒAdding Customized 
Columns to a BinÓ on 
page 152.

2. Select the headings you want to add to the bin:

¥ Click the name of a heading to select it. 

¥ Click a highlighted heading to deselect it.

¥ Click Select All to highlight all the headings in the bin.

¥ Click Deselect All to deselect all the headings.

3. Click OK. Only the headings highlighted in the headings dialog 
box appear in the bin or bin view.

Deleting a Column

Deleting a statistical column is the same as hiding the column; in other 
words, you can restore the column at any time using the headings dia-
log box as described in  ÒShowing and Hiding ColumnsÓ on 
page 149. When you delete a Custom column, however, you must 
re-create the column.
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To delete a column:

1. Click the column heading.

2. Choose Clear from the Edit menu, or press the Delete key.

The column disappears from the view and surrounding columns 
close to Þll the space.

Duplicating a Column

You can duplicate existing columns containing timecode information 
in other compatible columns that you target in a dialog box.

Duplicate a timecode column as follows:

1. Select the column you wish to duplicate by clicking its header. 

2. Choose Duplicate from the Edit menu. 

A dialog box appears.

In the example, the user has selected the Duration column to dupli-
cate; thus ÒCopy Duration to:Ó appears at the top of the dialog box. 
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Select a column name from the list. The column must be of the same 
type of data for the copy to occur. For example, you can copy start 
timecodes to the Aux TC column, but you cannot copy timecodes to 
the Pullin column. 

The column of information appears in the column you designated.

Adding Customized Columns to a Bin

In addition to the standard statistical or Þlm headings, you can add 
your own column headings to describe information about clips and 
sequences. For example, you might want to add a column heading to 
describe what kind of shot (closeup, wide shot, master shot, extreme 
closeup, and so on) is used in a clip.

Use the following procedure to add a new column:

1. Click an empty area to the right of the current headings in the 
headings box.

2. Move any existing column to the right or left in order to create an 
empty area.

3. Type the column heading you want and press Return. Column 
headings must contain fewer than 30 characters, including spaces.

This puts the cursor in the data box, beside the Þrst clip in the bin.

4. Use the Tidy Up Columns command after you have entered the 
new column heading.

5. Type the information and press Return to move to the next line.

Changing a Custom Column Heading

You can only change the heading name of custom columns. You can-
not change any of the standard statistical or Þlm column headings.

To change the name of a custom column:

1. Hold down the Option key and click the heading to highlight it. 
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2. Type the new text for the heading and press Return.

Saving a Custom View

Any time you add, hide, or delete a column, the bin view name 
changes to an italicized name to indicate that it no longer matches the 
original view. If you try to select a new bin view setting while the cur-
rent setting is untitled or italicized, a dialog box appears and queries if 
you want to discard the current setting.

To save a bin view:

1. Add or hide columns according to preference. The bin view name 
becomes italicized.

2. Choose Save As from the Bin View pop-up menu.

The view name dialog box appears.

3. Name the custom view:



154

¥ To keep the default view name, click OK or press Return.

¥ To create a new name for the custom view, type the name and 
click OK or press Return.

Managing Clip Information

For additional bin 
shortcuts, see the 
ÒShortcutsÓ section of 
the Avid Media Composer 
and Film Composer 
Quick Reference.

There are several ways to manage clip information in Text mode col-
umns. These methods include copying information between cells, 
moving information between whole columns, sorting clip information, 
and modifying clip data, as described in this section.

Moving Within Column Cells

Use the keyboard shortcuts to move from cell to cell in bin columns:

¥ Tab: Moves the cursor to the parallel cell in the next column. You 
can continue to press the Tab key to scroll through the cells to the 
right until the cell in the last column is highlighted. The next time 
you press the Tab key, the cell in the Þrst column is highlighted.

¥ Shift-Tab: Moves the cursor to the left to the cell in the previous 
column. You can continue to press the Shift-Tab keys to scroll 
through cells to the left until the cell in the Þrst column is high-
lighted. The next time you press Shift-Tab, the cell in the last col-
umn is highlighted.

¥ Return: Enters any new information typed into the cell, and 
moves the cursor down to the cell in the next row. You can con-
tinue to press the Return key to scroll down the column until the 
last cell in the column is highlighted. The next time you press the 
Return key, the Þrst cell in the column is highlighted.

¥ Shift-Return: Moves the cursor up to the cell in the previous row. 
You can continue to press the Shift-Return keys until the cell in the 
top row is highlighted. The next time you press the Shift-Return 
keys, the cell in the last row is highlighted.
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Modifying Clip Information

You can change or modify the information for your master clips, sub-
clips, tapes, and other objects stored in the bin. This is especially useful 
if some of the data is incorrect, or if you need to conform information 
for organizational purposes.

The following conditions apply to modifying clip information:

¥ When you modify a clipÕs information, related objects are auto-
matically updated to reßect the new data. For example, if you 
change the name of a clip, the updated name appears in the 
sequences that use the clip. 

¥ Some data cannot be modiÞed after digitizing because changes 
would prevent you from playing back and editing the material 
successfully.

¥ Sequence data cannot be changed even though it appears in your 
bin. The only way to modify sequence data is to edit the sequence 
itself.  You can, however, change the name and start time for the 
master timecode track, as described in  ÒChanging the Sequence 
Clip InfoÓ on page 233.

There are two ways to modify data: 

¥ You can modify some data directly for master clips, subclips, and 
other objects stored in a bin.

¥ You can use the Modify command to change speciÞc information 
for clips only.

Modifying Data Directly

When you modify information directly, you click a cell and type the 
new information. For example, you can type a new name for a clip, or 
correct the start and end timecodes.



156

You can directly modify any data in the bin prior to digitizing. After 
the footage is digitized, however, you can directly modify only 
selected headings, with restrictions as shown in Table 5-1.

Table 5-1 Direct Modification Headings 

Heading Restrictions

(Clip) Name No restrictions.

Start (timecode) Altering the start timecode also alters the end timecode in order to maintain 
the duration of digitized material. This may also cause discrepencies with 
any auxiliary timecode information that you enter manually.

Mark IN Altering the mark IN also alters the IN to OUT duration. This replaces any 
previous mark.

Mark OUT Altering the mark OUT will also alter the IN to OUT duration. This replaces 
any previous mark.

Color Framing Must be according to tape speciÞcations. See ÒTracking Color Frame ShiftsÓ 
on page 290.

Auxiliary timecodes, 1Ð5 No restrictions.

KN (key number) Start Only for Þlm projects; altering the starting key number will also alter the 
ending key number to maintain the duration. This may also cause discrepen-
cies with any auxiliary timecode information that you entered manually.

KN (Key Number) End Only for Þlm projects. Altering the KN end also alters the KN Start to main-
tain the duration. This may also cause discrepencies with any auxiliary time-
code information that you entered manually.

Pullin Pullin data imported from a telecine-generated list can only be altered using 
the Modify command. See ÒUsing the Modify CommandÓ on page 157

Pullout Pullout data imported from a telecine-generated list can only be altered 
using the Modify command. See ÒUsing the Modify CommandÓ on 
page 157
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c Modifying tape names and timecodes will effect any key numbers 
entered for the selected clips.

To modify the clip data directly:

1. Enter Text mode.

2. Click the cell that you want to modify. Select only one item at a 
time. In this example, the timecode data is highlighted.

3. Click the cell again to enter text.

If the cursor does not change to an I-Beam, you may be attempting 
to modify a column that cannot be directly modiÞed.

4. Type the new information and press Return.

Using the Modify Command

The Modify command gives you specialized control over information 
in speciÞc headings. For example, you can use the Modify command 
to change the name of source tapes, or to increment or decrement the 
start and end timecodes by a speciÞed length of time for one or several 
master clips at once.

For a complete descrip-
tion of the Modify dia-
log box options, see  
ÒUsing the Modify 
CommandÓ on page 45.

You can apply changes with the Modify command to master clips  
only; subclips and sequences cannot be altered in this way.  In addi-
tion, you can only perform modiÞcations that alter the end timecodes 
or the tracks before digitizing, as described in Table 5-2.
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To modify selected data:

1. Open the bin.

2.  Click the small Þlm clip icon to the left of the clip, sequence, or 
other object you want to modify. Shift-click each additional object 
you want to modify.

Select objects in the bin: master clips, subclips, sequences, tapes, 
audiotapes, Þlm reels, effects, group clips, or rendered effects. 

3. Choose Modify from the Clip menu.

Table 5-2  Modify Command Options 

Option Restrictions

Set Timecode Drop/Non-
drop

Setting must match the timecode format of the 
tape

Set Timecode By Field Only start timecode can be altered after digitiz-
ing

Increment Timecode Only Start timecode can be incremented after 
digitizing

Decrement Timecode Only Start timecode can be decremented after 
digitizing

Set Key Number Generic 
(PreÞx)

Only for Þlm projects

Set Pullin Only for Þlm projects

Set Tracks Only for Þlm projects

Set Source Should match the original source tape name

Pullin Only for adjusting Pullin information from an 
imported telecine list for a Þlm project

Pullout Only for adjusting Pullout information from an 
imported telecine list for a Þlm project
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The Modify dialog box appears.

4. Choose an option, such as Set Timecode By Field, from the Modify 
options pop-up menu.

5. After choosing the type of modiÞcation, select an option or enter 
information into the entry Þelds (timecode values, for example) 
when they appear.

Click here to display pop-up menu
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6. Click OK. The modiÞcation takes effect.

Copying Information Between Columns

The following steps describe how to copy information in one column 
to another. To demonstrate these steps, you will copy timecode infor-
mation in one column to a new column. 

1. Select the timecode column that you want to copy.

2. Choose Duplicate from the Edit menu, or press kÐD.

A dialog box prompts you to target a timecode column for the 
data.

3. Select the target column for the data and click OK.

Copying Information from Another Cell in the Same Column

To copy information from another cell in the same column:

1. Hold down the Option key while you click in the destination cell 
to reveal a pop-up menu of all items entered in that column. 

2. Select the desired text from the menu. The text appears in the cell.

You can also use the following two shortcuts to move information 
between cells in a column:

¥ Press Option-Tab to load the text from the cell below into the cur-
rent cell, then select the cell to the right of the current cell.

¥ Press Option-Shift-Tab to load the text from the cell below into the 
current cell, then select the cell to the left of the current cell.

Sorting Clips

Sorting clips arranges them in either numerical or alphabetical order, 
based on the data in the column you select as the sorting criteria. You 
can sort clips in several different ways, including an ascending sort, a 
descending sort, and multilevel sorting.
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n You can sort clips and sequences in Text mode only. If you need to view sorted 
clips in Script or Frame mode, sort them in Text mode Þrst and then return to 
Script or Frame mode.

Sorting Clips in Ascending Order

To sort clips in ascending order:

1. In Text mode, click the heading of the column that you want to use 
as the criterion.

The column is highlighted.

2. Choose Sort from the Bin menu, or press kÐE.

The objects in the bin are sorted.

n If the Sort command is dimmed in the menu, you have not selected a column.

If you want to reapply the last sort, choose Sort Again from the Bin 
menu with no column selected. This step is especially useful after you 
have added new clips to a sorted bin.

Sorting Clips in Descending Order

To sort clips in descending order:

1. Click the heading of the column that you want to use as the crite-
rion.

The column is highlighted.

2. Hold down the Option key while you choose Sort Reversed from 
the Bin menu, or while you press kÐE.

Sort Reversed displays the column in descending order.

Multilevel Sorting with Columns

You can select multiple columns in a bin and perform a multilevel sort 
using the information in the columns.
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To do this, rearrange the columns in the bin to establish the primary 
column. The column that appears farthest to the left in Text mode 
becomes the primary criterion for the sorting operation. 

Using Frame Mode

In Frame mode, each clip is represented by a single frame, with the 
name of the clip displayed below the frame. The system uses the head 
frame as the default, but you can play back the footage within any clip 
and select any frame to represent the footage. You can make the pic-
tures larger to see more detail, or smaller to see more clips in the win-
dow. You can also rearrange the frames in any order.

To enter Frame mode, click the Frame mode button (labeled F) in the 
lower left portion of your screen.

Each frame appears on your screen with its assigned name directly 
below it, as shown.
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Changing the Bin Background Color

You can customize the background color of the bin behind the frames. 
Changes affect one bin at a time. However, changes you make in 
Frame mode appear in Script mode as well.

To change the bin background color:

1. Activate the bin you want to change and make sure you are in 
Frame mode (or Script mode).

2. Choose Set Bin Background from the Edit menu, and select a color 
from the pop-up palette.

The bin color changes based on your selection.

Enlarging or Reducing Frame Size

You can enlarge and reduce the size of the frames appearing on the 
screen to Þve available sizes. You must enlarge or reduce all frames 
together. You cannot change the size of individual frames.

¥ To enlarge the frame size, choose Enlarge Frame from the Edit 
menu. The display size increases each time you choose this option, 
up to Þve times.

¥ To reduce the frame size, choose Reduce Frame from the Edit 
menu. The display size decreases each time you choose this 
option, up to Þve times.
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Rearranging Frames

Frame mode allows you to rearrange the display of the frames in the 
bin by moving them. 

To rearrange frames:

1. Click and drag a single frame to its new position.

To rearrange more than one frame at a time, Shift-select or lasso 
multiple frames and drag them to a new position in the bin.

2. Click the background area of the bin to deselect the clips.

Changing the Frame Identifying the Clip

If you have Group or 
MultiGroup clips in the 
bin and want to change 
the displayed frame, 
you must use controls 
in Source/Record 
mode. For more infor-
mation, see  ÒMulti-
Camera Editing 
TechniquesÓ on 
page 398.

By default, Frame mode displays the Þrst frame of each clip in the bin. 
However, you can choose a different frame.

To change the frame identifying the clip:

1. Select the clip that you want to change.

Hold the K key on the keyboard (Pause) and press the L key (Play) 
to roll the footage within the frame forward at slow speed. To 
move backward through the footage, hold the K key and press the 
J key (Reverse Play).

2. When you see the frame that you want use, release the keys.

When you Þnd the frame you want to use, Media Composer saves 
your choice as part of the bin conÞguration.

Tidying Up Frames in a Bin

To realign or tidy up the frames in a bin after you have changed their 
display, use one of the following procedures:
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¥ To align all frames to an invisible grid, choose Align to Grid from 
the Bin menu.

¥ To align only selected frames, choose Align Selected to Grid from 
the Bin menu.

¥ To spread out the frames evenly to Þll available space in the bin 
window, choose Fill Window from the Bin menu.

¥ To arrange frames in the order in which they are sorted in Text 
mode, choose Fill Sorted from the Bin menu.

Using Script Mode

Script mode combines the features of Text mode with Frame mode, 
with an added script box next to each frame. The frames are displayed 
vertically on the left side of your screen with the script box next to 
each. Clip data matching the column headings in Text mode appears 
above each text box.

To enter Script mode, click the Script Mode button (labeled S) in the 
lower left portion of the bin.
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Adding Text in Script Mode

To type text into the script box, click the box and begin typing. This 
text does not appear in sequences edited from the clips, only in print-
outs of the bin in Script mode.

You can use basic wordprocessing procedures to highlight, delete, cut, 
copy, and paste text between script boxes.

If the notes or script you type extend beyond the size of the text box, 
you can use the Page Up or Page Down keys on the keyboard to scroll 
through the text.
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Rearranging Clips in Script Mode

You can rearrange the order of clips in Script mode in two ways:

¥ You can drag each clip up or down to a new location in the bin.

¥ You can sort and sift clips in Text mode, then return to Script mode 
to display selected clips in the desired sort order.

Displaying Clip Information in Script Mode

Script mode allows you to display the clip information that appears in 
Text mode. To display selected clip information:

1. Enter Text mode by clicking the Text Mode button (labeled T in the 
lower left corner of the bin).

2. Hide nonessential information, leaving only selected columns of 
information displayed, by clicking the Heading for each nonessen-
tial column of clip information, and choosing Hide Column from 
the Bin menu.

3. Click the Script Mode button to re-enter Script mode. The selected 
clip information appears above the text box for each clip.

Printing Bins

Media Composer allows you to print entire bins or individual frames 
in hardcopy form.

To print entire bins in Text, Script, or Frame mode:

1. Install the correct printer driver in the System Folder on the Avid 
disk.

Directions for installing the printer driver are included in the man-
ual for your printer and in the Macintosh system documentation.

2. Select the printer using the Chooser.
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Directions for selecting the printer are included in the Macintosh 
system documentation.

3. Click the T (Text mode), S (Script mode), or F (Frame mode) button 
in the lower left corner of the bin to select the view you want to 
print.

n To print a Frame in Script or Frame mode, you must use a printer capable of 
rendering graphics or PICT Þles.

4. Choose Page Setup from the File menu. A Page Setup dialog box 
appears, reßecting speciÞc options for the type of printer you 
have.

5. Select the appropriate options from the Page Setup dialog box, 
then click OK.

6. Choose Print Bin from the File menu. The print dialog box 
appears, reßecting speciÞc options for the type of printer you 
have.

7. Set the print options in the print dialog box, then click Print.

The system prints the frame currently displayed in the active mon-
itor.

To print a single frame of a clip or sequence:

1. Load a clip or sequence into the Source or Record monitor.
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2. Select the frame you want to print.

3. Choose Print Frame from the File menu, or press kÐP.

4. Make any needed adjustments to the print setup and click Print.

The system prints the frame currently displayed in the active mon-
itor.

Gathering Format Elements

While organizing your project, you can gather various format ele-
ments into a single bin that you can open and use later during editing. 
Some useful format elements might be:

¥ Bars and tone

¥ Head and tail leader

¥ Repeated titles

¥ Countdowns

¥ Graphic elements (repeated animations, and so forth)

This section describes techniques for creating digital bars and tone, as 
well as leader clips for use in sequences. For information on creating 
or importing graphic elements and titles, see the Avid Media Composer 
and Film Composer Effects Guide.

Preparing Digital Bars and Tone

If you expect to output your Þnal sequence as a digital cut that 
requires calibration before playback (a digital cut that will be broad-
cast, for example), then in most cases you need a clip of color bars. You 
can add the clip to the front of the sequence in Film Composer, or you 
can output the clip separately as an assemble or insert edit onto tape 
during recording of a digital cut.
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There are several ways to acquire a clip of bars, each with different 
advantages:

¥ Digitize bars and tone from a house generator. This method 
requires the least effort with good results, because you capture 
high-quality bars and tone simultaneously, with a minimum of 
calibration. Not all facilities, however, have a house generator.

¥ Digitize bars and tone from a videotape. This method allows you 
to capture bars and tone simultaneously, but you must calibrate 
carefully to ensure accuracy. In addition, the Þnal clip reßects the 
quality of the source tape recording.

¥ Digitize bars from an external color bar generator. This method 
provides good results, but you must have a color bar generator 
available, and you must rearrange your system inputs to attach 
the generator. In addition, you must acquire tone separately and 
sync it with bars within Film Composer.

¥ Import a PICT Þle of bars. This method provides the highest qual-
ity results, because the source image is already digital. If the PICT 
Þle is accurate, the quality of the clip is ensured. You must, how-
ever, acquire tone separately, and sync it with bars within Film 
Composer.

Importing a PICT File of Bars

The following procedure describes the method for importing a PICT 
Þle. This method is available to all users because your Film Composer 
system includes a set of test pattern PICT Þles. You can choose the type 
of test pattern you want to use and import it into the system at any 
time.
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When you are ready to 
output a digital cut, you 
can generate tone to go 
along with bars using 
the Calibration tone fea-
tures of the Audio tool.  
For more information, 
see  ÒPreparing for 
Audio OutputÓ on 
page 458.

To import bars using a Film Composer test pattern:

1. Open an existing bin, or create a new one for the test pattern.

2. Choose Import from the File menu to open the Import dialog box.

3. Using the directory pop-up menu on the left side of the Import 
dialog box, locate the SMPTE  bars  PICT Þle in Test Patterns 
folder.  The Test Patterns folder is located in the Supporting Files 
folder inside the Film Composer folder on the Avid (internal) 
drive.

4. Import the Þle using options described in  ÒImporting FilesÓ on 
page 117.

5. Digitize a section of tone from a videotape into the same bin.   
Make sure you digitize for at least one minute.

n Consider digitizing tone at both 44 kHz and 48 kHz for use in various 
projects. Match the resolution of the tone to the audio resolution of the 
sequence.

6. Load the new color bars clip into the Source monitor, and create a 
subclip of appropriate length for use in sequences (one minute is a 
common standard).

7. Select the new subclip and the audio clip containing the tone, and 
choose Autosync from the Bin menu.

A new subclip containing bars and tone appears in the bin.

8. Rename the clip as necessary.

Creating Leader

Film editors traditionally use standard head and tail leaders for cuing 
and syncing material. You can use digital leader in Film Composer to 
mark the beginning and ending of tracks, and to help you maintain 
sync, as described in  ÒManaging Sync with Multiple TracksÓ on 
page 371.  You can create your own leader for video or Þlm, as 
described in this section. Whatever your choice for speciÞcation, be 



172

sure to make all your leader clips the same length, with common sync 
points.

Creating Picture Leader

To create leader for picture tracks:

1. Create a black screen in the Title tool for tail leader, or a white 
screen for head leader. See the Avid Media Composer and Film Com-
poser Effects Guide for information on using the Title tool.

Optionally, you can type a title onto the screen that says ÒTail 
LeaderÓ or ÒHead Leader.Ó

2. Name this clip Head Leader or Tail Leader when you save the title.

3. Subclip an appropriate length of the clip, according to your chosen 
speciÞcations.

4. (Option) Mark a sync frame in the subclip as follows:

a. Load the clip into the Source monitor. 

b. Find an appropriate sync point, and add a locator.

c. (Option) Double-click the locator in the Source monitor to add 
a sync point notation that appears on the monitor.

For information on 
placing Add Edits, see  
ÒAdding an Edit 
(Match Framing)Ó on 
page 284.

d. (Option) To make the sync point visible within the Timeline, 
step one frame back and place an Add Edit before the sync 
frame, then step two frames forward and place an Add Edit 
after the sync frame.

Once the leader is prepared, you can splice the leader during editing 
onto the tracks that you want to keep in sync. You can use the sync 
points for visually aligning tracks.
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Creating Sound Track Leader

To create tail leader for audio tracks:

1. Load a clip that includes a section of digitized tone into the Source 
monitor.

2. Subclip an appropriate section of the clip, according to your cho-
sen speciÞcations.

3. Name this new subclip Head Leader or Tail Leader.

4. Load this subclip into the Source monitor.

5. Prepare the sound levels using one of the following options:

¥ For leader without a sync point (no audio pop), open the 
Audio Mix tool and bring the audio level all the way down for 
the entire clip.

¥ For leader that includes a sync point (audio pop), do the fol-
lowing:

a. Find the appropriate sync point.

For information on 
placing Add Edits, see  
ÒAdding an Edit 
(Match Framing)Ó on 
page 284.

b. Step one frame back and place an Add Edit before the sync 
frame, then step two frames forward and place an Add Edit 
after the sync frame.

c. Place the position indicator before the Þrst Add Edit, and open 
the Audio Mix tool.

d. Bring the audio level all the way down.

e. Place the position indicator after the second Add Edit, and use 
the Audio Mix tool to bring the level all the way down.

Once the leader is prepared, you can splice the leader during editing 
onto the audio tracks that you want to keep in sync. You can use the 
sync points for visually aligning tracks.
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Storyboard Worksheet

Make preliminary preparations such as synchronizing picture and 
sound, converting audio timecode, and modifying clip data.

Set the bin display to show only the media objects you will use for 
your storyboard.

Narrow down the clip selection by deleting, moving, copying, sorting 
and sifting clips.

Select either Script mode or Frame mode to display your storyboard in 
the bin with or without a text box.  Enter information into the Script 
box if necessary.

Rename clips to include additional information such as numbered 
ordering, or enter this information into the Script box in Script mode.

Use the keyboard to jog through each clip and display the reference 
frame you want to use for each clip.

Rearrange the clips in sequential order by selecting and dragging one 
or several clips at a time to a new location.

Enlarge or reduce the size of the frames as necessary.

Tidy up the rearranged frames along invisible grid lines when using 
Frame mode.

Change the font and background color for the storyboard, if desired.

Choose Save Bin from the File menu when the storyboard is complete.

Choose Print from the File menu to print the storyboard in its Þnal 
form.
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CHAPTER 6

Managing Media Files

When you digitize footage, the system creates digital media Þles for 
the video and audio tracks on the media drives attached to your sys-
tem. In addition to the bin tools that allow you to organize the clips 
that reference these media Þles, Film Composer provides useful tools 
and features for directly managing media Þles for storage and play-
back efÞciency, backup, and transfer between systems. These proce-
dures are described in the following sections:

¥ Using the Media Tool

¥ Freeing Storage Space

¥ Consolidating Media

¥ Backing Up Media Files

¥ Relinking Media Files

¥ Unlinking Media Files

Using the Media Tool

The Media tool is your window onto the digitized video and audio 
data Þles stored on your media drives. As an important counterpart to 
the bins, the Media tool provides similar database tools for manipulat-
ing digital media Þles in tandem with your organization of clips and 
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sequences. Unlike bins, however, the Media tool gives you access to 
separate video and audio portions of each clip. 

Basic Media Tool Features

The Media tool provides many of the same controls for viewing and 
managing information that you use with bins, including the following:

¥ Three display modes in the Media tool function like those in bins: 
Text mode, Script mode and Frame mode.

¥ The Media Tool Fast menu gives you quick access to all the same 
commands available in the Bin Fast menu.

¥ You can highlight, move, copy, duplicate, delete, and sift clips. You 
can also select media relatives, sources, and unreferenced clips, as 
described in  ÒBasic Bin ProceduresÓ on page 137.

¥ You can use Text mode headings and display options for columns 
of clip and media Þle data. You can also use procedures such as 
customizing the display of columns, moving within columns, and 
sorting information, as described in  ÒUsing Text ModeÓ on 
page 147.

Media file for video 
portion of a clip

Media files for each 
track of audio
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¥ You can use the same Frame mode display options described in  
ÒUsing Frame ModeÓ on page 162.

¥ You can use the same Script mode display options described in  
ÒUsing Script ModeÓ on page 165.

¥ You can print Media tool data using the same procedures for 
printing bins, described in  ÒPrinting BinsÓ on page 167.

In addition to the procedures just described, the Media tool has a num-
ber of unique functions, described in this section. These include the 
following:

¥ Unlike bins, the Media tool displays all the tracks digitized for 
each clip as separate media Þles. Therefore, when you view, delete, 
and manipulate Þles, you have the added option of specifying 
individual video and audio tracks.

¥ The Media tool does not display sequences and subclips. Only 
master clips, precompute (rendered effect) master clips, and asso-
ciated media Þles are displayed.

¥ The following Bin and Clip menu commands do not apply to the 
Media tool: Modify, Select Ofßine Items, and Relink. You must 
perform these functions from the bin.

¥ The Media tool database and display options are not saved as they 
are with bins. Instead they are re-created each time you open the 
tool. Likewise, when you close the Media tool, any customization 
of columns or other views elements is deleted.

Opening the Media Tool
1. Choose Media Tool from the Tools menu. The Display Media 

Selector dialog box appears.
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2. Select the desired display options:

¥ You can display Þles for just the current project, or all other 
projects.

¥ You can display digitized master clips, precompute (rendered 
effect) master clips, individual media Þles, or all three.

3. Click OK. The Media Tool window appears.
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Deleting Tracks with the Media Tool

You can use the Media tool to delete selected media Þles without 
harming the related master clips, subclips, and sequences. Depending 
on your needs you can do one of the following:

¥ Delete selected audio or video tracks and retain other tracks from 
a clip.

¥ Delete entire sets of media Þles and related clips from within the 
Media tool.

¥ Delete all unrelated media upon completion of a project, and 
retain only the media required for playback of a Þnished sequence 
as described in  ÒConsolidating MediaÓ on page 184.

Delete selected media Þles as follows:

1. Open the Media tool. In the Display Media Selector dialog box, be 
sure to select the types of Þles you want to delete.

2. Select one or more media Þles (audio, video, or both) or master 
clips whose media Þles you want to delete. 

3. Choose Clear from the Edit menu, or press the Delete key to open 
the Delete Media Files dialog box.
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4. Select the media objects that you want to delete:

¥ Audio media Þle (A1, A2, A3, A4). The master clip linked to 
that Þle will be silent. Subclips and sequences created from the 
master clip are affected in the same way.

¥ Video media Þle (V1). The master clip linked to that Þle will 
be black, with the message ÒMedia OfßineÓ displayed. Related 
subclips and sequences are affected in the same way.

¥ Precompute media Þle (V, A). The section of the sequence 
with the effect becomes black with the message ÒMedia 
OfßineÓ displayed.

¥ Audio Mixdown File (A). The section of the sequence with 
the mixdown becomes silent.

5. Click OK.

A conÞrmation dialog box appears.

6. Click Delete.
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Freeing Storage Space

To quickly view remain-
ing storage on your 
media drives at any 
time, open the Hard-
ware tool as described 
in the Avid Film Com-
poser Getting Started 
Guide.

Unlike the bin Þles stored in project folders on the Avid drive, media 
Þles require considerable storage space. In order to maximize your use 
of storage during larger projects, you can abridge and/or convert 
media Þles. You can perform these procedures on clips selected in 
either the Media tool or in bins.  

In addition, you can delete unreferenced media Þles for a Þnished 
sequence.  This procedure is performed on clips selected in bins only.

Abridging Media Files

The Abridge command deletes all of a master clipÕs video data except 
for a single representative frame. The audio tracks are unchanged. Use 
this option when you want to free up the maximum amount of media 
drive space without completely deleting the associated media Þles of a 
master clip.

n The Abridge command applies to video only. You cannot abridge audio media 
Þles. You cannot abridge sequences or subclips because they have no media of 
their own.

Use the following procedure to abridge the video media Þles for 
selected clips:

1. Select a master clip in the bin.

2. Click the picture area of the video media Þle or master clip that 
you want to abridge. 

3. Use the keyboard to move to the frame you want to save to repre-
sent the video media data: hold the K key (Pause) and press the L 
key (Play) or J key (Play Reverse) to shuttle slowly through the 
clip. Release the keys when you cue to the right frame.

4. Choose Abridge from the Clip menu. The abridge dialog box 
appears.
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5. Click Abridge.

Converting Media Files

When you convert a clip, the system reduces the number of digitized 
frames for each second of video, thus reducing the amount of storage 
space required. The video media Þle for a converted master clip has a 
changed CFPS (capture frames per second) rate. When you play back 
the converted media, motion appears jerky with fewer frames per sec-
ond. The video duration of the clip remains the same.

Keep the following restrictions in mind when converting your media 
Þles:

¥ You can convert only master clips. You cannot convert subclips or 
sequences.

¥ You can convert only video media Þles that were captured at the 
full frame rate (that is, 30 fps NTSC, or 25 fps PAL).

¥ EDL creation is not affected because the system retains the correct 
timecode information.

¥ If you want to return to the full frame rate after you have con-
verted media Þles, you must redigitize the material.

¥ The Convert command affects video media Þles only. Audio Þles 
associated with the clip are unchanged.
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To convert media Þles:

1. Click the bin to activate it, and select one or more master clips 
whose media Þles you want to convert. 

2. Choose Convert from the Clip menu. The convert dialog box 
appears.

3. Choose a new selection from the New Frame Rate pop-up menu.

4. Click Convert. The Þle is converted to the selected frame rate.

Deleting Unreferenced Clips

When you Þnish either a rough cut or a Þnal version of a sequence, 
you can quickly free storage space by deleting the media and clips that 
are not referenced by the sequence.

To delete all unreferenced clips and media Þles:

1. Choose Select Sources from the Bin menu.  All source clips for the 
sequence are highlighted in the bin.

2. Click the bin containing the highlighted clips to activate it.

3. Choose Reverse Selection from the Bin menu.  All the clips in the 
bin that are not source clips for the sequence are now highlighted.

4. Press the Delete key, and click the check boxes in the Delete dialog 
box to delete the clips and/or the media Þles.
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Consolidating Media

When you consolidate media Þles, the system Þnds the media Þles or 
portions of media Þles associated with selected clips, subclips, or 
sequences. It then makes copies of them, and saves the copies on a tar-
get disk that you specify. Because the Media tool displays only master 
clips, you cannot consolidate subclips or sequences with the Media 
tool. You can consolidate master clips, subclips, and sequences in the 
bin.

About the Consolidate Feature

For illustrations of the 
different types of con-
solidation, see the Avid 
Media Composer and Film 
Composer Quick Refer-
ence.

The Consolidate feature operates differently depending upon whether 
you are consolidating master clips, subclips, or sequences. There are 
also different advantages in each case, as follows:

¥ Master clips: When you consolidate a master clip, the system cre-
ates exact copies of the media Þles. If you link the original master 
clip to the new Þles, the system creates a master clip with the 
extension .old that remains linked to the old Þles. If you choose to 
maintain the link between the original master clip and the old 
media Þles, the system creates a new master clip with the exten-
sion .new that is linked to the new Þles. The new clips are also 
numbered incrementally beginning with .01.  Consolidating mas-
ter clips does not save storage space because the system copies the 
same amount of media for each clip.

¥ Subclips: When you consolidate a subclip or group of subclips, 
the system copies only the portion of the media Þles repre-
sented in the subclip, and creates a copy of both the master 
clips and the subclips. The sufÞx .new is attached, along with 
incremental numbering beginning with .01.

¥ Sequences: When you consolidate a sequence, the system copies 
only the portions of media Þles edited into the sequence, and cre-
ates new master clips for each shot in the sequence. The sufÞx 
.new is attached to the master clips, along with incremental 
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numbering beginning with .01. The sequence is not renamed, 
but is automatically relinked to the new media Þles.

n Because a consolidated sequence is linked to the new Þles by default, consider 
duplicating the sequence each time you consolidate if you need to maintain 
links to the original Þles.

Using the Consolidate Command

To consolidate master clips, subclips, or sequences:

For more information 
on rendering effects, see 
the Avid Media Composer 
and Film Composer 
Effects Guide.

1. If you are consolidating a sequence, duplicate the sequence to 
maintain links to the original Þles, if necessary, and render any 
unrendered effects.

2. With the bin open, select the clips or sequence to consolidate.

3. Choose Consolidate from the Clip menu. The Consolidate dialog 
box appears.
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4. Select one of the following:

¥ ÒDelete original media Þles when doneÓ to delete original 
media Þles automatically.

¥ ÒSkip media Þles already on the target diskÓ if some related 
media Þles are already located on the target disk.

¥ ÒRelink selected clips to target disk before skippingÓ to ensure 
that all selected clips are linked to media on the target drive. 
This option appears when you select ÒSkip media Þles already 
on target disk.Ó

5. Select a target disk from the pop-up menu.

Make sure that you choose a target disk with enough storage 
space for all the consolidated media Þles.

6. Enter a handle length for the new clips in the entry Þeld, or leave it 
at 60 frames to accept the default.
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For more information 
on group clips, see 
ÒGrouping and Multi-
groupingÓ on page 389.

7. If you are consolidating a group clip or a sequence that contains 
group clips, select the option ÒConsolidate all clips in a group 
editÓ to copy media for all the clips in the group. This option is 
dimmed if there are no group clips in your selection.

8. Click OK. If you did not choose to delete the original media Þles, a 
second dialog box appears and offers you a choice.

9. Link the original master clips to the new or old media Þles, accord-
ing to preference.

10. Click OK.

Another way to back up media Þles is to copy them directly onto 
another hard drive in the Finder. You cannot, however, take advantage 
of the storage-saving features of the Consolidate command, and it is 
more difÞcult to identify particular media Þles when searching 
directly through folders.

w Do not make copies of media Þles in the Finder while Film Com-
poser is running. Also, do not keep duplicate copies of media Þles 
online; either delete the originals, take the backups ofßine, or store 
the backups in a folder with a different name.
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Backing Up Media Files

The MediaFiles folders on your external media drives contain the indi-
vidual media Þles created when you digitize source material.  Unlike 
the smaller Composer Project and Avid User folders, these folders are 
too large to back up onto diskettes.

The following are the options for backing up media Þles:

¥ You can use the Consolidate feature, described in the previous sec-
tion, to make copies of selected media Þles on a target hard drive 
connected to the system.

For information on 
archiving procedures, 
see your AVIDdrive 
DLT documentation.  
For information on pur-
chasing AVIDdrive 
DLT, contact your Avid 
sales representative.

¥ You can back up smaller projects digitized at low AVRs (AVR 1sÐ
3s, for example) to optical drive cartridges.

¥ You can archive larger media Þles and folders to a dedicated mass-
storage system, such as AVIDdrive DLT (digital linear tape).

¥ You can consolidate or make copies of media Þles for transfer to 
another system.  For more information, see ÒTransferring Projects 
and Media Files Between SystemsÓ on page 521.

Relinking Media Files

Sometimes after you consolidate or move material between systems, 
the clips and/or sequences lose their link to the original media Þles. 
When a clip becomes unlinked, it displays the message ÒMedia 
Ofßine.Ó If appropriate media exists online, you can use the Relink 
command to reestablish the link. 



189

When you select subclips, or sequences and choose the Relink com-
mand, the system searches for master clips that contain the same mate-
rial included in the selection.  

You can also choose to relink master clips to appropriate media Þles.  
The system compares information such as source tape name, timecode 
information, and channels digitized. If the search is successful, the sys-
tem establishes new links to the available media Þles.  You can instruct 
the system to search speciÞc drives, or all available drives.

To relink clips, subclips, or sequences:

1. Select the unlinked object or objects.

2. Choose Relink from the Clip menu.

The Relink dialog box appears.

Media Offline 
message indicates 
a clip with no link to 
media files
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3. Choose an option from the Volume pop-up menu:

¥ Choose All Available Disks to search across all drives that are 
online.

¥ Choose a speciÞc drive volume if you know the location of the 
media, or want to relink to media on a speciÞc drive.

4. Select the option Relink to Selected to direct a relinking of related 
subclips and/or sequences to the highlighted clip in the bin.

5. Select the option Relink Master Clips to relink master clips to asso-
ciated media Þles.

6. Click OK. The system searches the selected drives and relinks if 
possible.

The system disregards capture rate and audio resolution when match-
ing media Þles.

n If you want to be sure to maintain the original capture settings for a subclip 
or sequence, use the Batch Digitize command; do not use the Relink com-
mand.

Relinking to Selected Clips

You can also use the Option key to modify the Relink command for 
connecting subclips or sequences to selected master clips and subclips.

To relink to selected master clips and subclips:

1. Place the subclips and/or sequences that you want to relink into 
the bin containing the clips.

2. Select the clips targeted for relinking.

3. Press the Option key and choose Relink from the Clip menu.

4. The subclips and/or sequences are linked to the selected clips 
and/or subclips.
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Relinking Consolidated Clips

If the appropriate media exists online, you can reconnect consolidated 
clips, subclips, or sequences to the new or old media Þles by choice.

For example, if you consolidated a sequence and forgot to create a 
duplicate, and later Þnd that you want to use the original media Þles 
instead of the consolidated media Þles, you can break the new link and 
reestablish the old link to the original Þles.

n Because subclips and sequences do not point directly to the media Þles, you 
can only perform this procedure using the source master clips.

To relink consolidated subclips or sequences:

1. Select the new master clips for a consolidated subclip or sequence 
(the clips will have the sufÞx .new attached), and unlink them.

2. Choose Relink from the Clip menu, and target the volume contain-
ing the original media Þles in the Relink dialog box.

The clips are relinked to the original media.

Relinking Moved Projects

If you move projects between systems with similar media existing at 
each site, but digitized separately, your clips and sequences will dis-
play the message ÒMedia Ofßine.Ó You can use Unlink and Relink 
commands to reconnect the Þles at either site.

For example, if you have a project that requires sharing work repeat-
edly between two different sites, you can digitize the source material 
once at each site, and exchange only the project folder at each stage, 
rather than moving large media drives back and forth. The project 
folder can be exchanged on 3.5-inch disk, or instantly across a net-
work. Because the media Þles maintain slightly different parameters at 
each site, you must relink the material each time.
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To relink a moved project:

1. Select the sequences and unlink.

2. Select existing clips in the bin.

3. Choose Option-Relink from the Clip menu.

The sequences are relinked to the local media.

Unlinking Media Files

You can use the Control and Shift keys to modify the Relink command 
for unlinking clips from their media Þles.  

To unlink master clips from their current links:

1. Select master clips to unlink.

2. Press Control-Shift and choose Unlink from the Clip menu.

The clips are unlinked, and display the message ÒMedia Ofßine.Ó

n Because subclips and sequences do not point directly to the media Þles, you 
can only perform this procedure using the source master clips.

If you have similar material from different sources, you can unlink a 
set of clips, duplicate them, and redigitize using the new source mate-
rial.

For more information 
on working with multi-
camera material, see 
Chapter 13.

For example, if you are working with multicamera material, you can 
digitize one reel, unlink the clips, duplicate them several times, and 
rename their source tapes to batch digitize the remaining reels.
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CHAPTER 7 

Using Script Integration

The lined script is traditionally used as a tool for managing scene and 
take information during postproduction on a dramatic feature Þlm or 
television production.   In Media Composer and Film Composer, script 
integration allows you to adapt the lined script to the digital realm for 
use in any type of production, from drama to documentary to spot 
advertising. These methods are described in the following sections:

¥ Line Script Basics

¥ Script Window Basics

¥ Manipulating Script Text

¥ Searching Through Script

¥ Linking Clips to the Script

¥ Manipulating Slates

¥ Manipulating Takes

¥ Using Script Marks

¥ Finding Clips and Script

¥ Editing with the Script Window
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Line Script Basics

The conventional lined script Ñ which evolved during decades of trial 
and error in Hollywood Ñ provides assistant editors and chief editors 
with a road map that helps them Þnd the coverage they need to edit 
scenes in a Þlm or television show. 

Traditionally, the continuity person creates the lined script on the set at 
the time of shooting. All notes are handwritten. The following is an 
example of a scene from a lined script:

88/1

88A/1 88A/2

88B/188B/2 88B/3

88C/1 88C/2
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Explanation of Symbols

Each vertical line drawn through the scene represents a single take 
from the moment the director says ÒActionÓ to the moment the direc-
tor says ÒCut.Ó Each scene might require several camera angles and 
positions, with one or more takes, all of which are lined and identiÞed 
alphanumerically. 

The following is a brief summary of the lining techniques and num-
bering system shown in the previous example:

¥ Master shot: The long line drawn through the middle of the scene 
labeled 88/1 is the master shot that usually covers all the action in 
a wide shot. The Þrst number in the label indicates the scene num-
ber as written on the script (scene 88). The number following the 
slash indicates that this is the Þrst take captured on Þlm for the 
master shot. A second take of the master shot, for example, would 
be labeled 88/2.

¥ Additional setups: The lines for each subsequent camera setup 
within the scene are labeled with the scene number (88 in our 
example) followed by a letter for each setup (A, B, C, and so forth), 
followed by a slash and the number of the take within that setup. 
These lines can be any length, depending upon what portion of 
the script is covered by the particular shot.

¥ Off-screen dialog: The jagged lines in the script represent the 
parts of dialog where the actor is off screen. For example, the char-
acter Amanda is off camera during the action described in the sec-
ond paragraph (when the character Laurel enters), so a jagged line 
is drawn through the shots that cover Amanda (88A/1 and 2).

When the scene is recorded on videotape Ñ in a sitcom shoot, for 
example Ñ the line script can also include timecode notes written next 
to speciÞc lines of dialog that represent a sync point between the dia-
log on the page and the recorded dialog on tape. These sync points 
provide assistant editors or chief editors with a quick path to speciÞc 
points in the source material. 
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Lining in the Digital Realm

Script integration in Media Composer and Film Composer provides a 
number of enhancements to this traditional system. These enhance-
ments allow you to shorten dramatically the distance between the con-
cepts captured on the page and the source materials used to assemble 
a Þnished program.

Unlike the traditional lining of a script, digital script integration is 
usually performed after the shoot Ñ by the assistant editor, for exam-
ple Ñ using the notes of the continuity person. The following is an 
example of the script shown in the previous section, prepared and 
lined using script integration:

Slates

Takes

Script mark

Color
indicator

Off-screen
indicator

Tool bar
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In addition to the standard lining conventions, script integration 
includes the following enhancements:

¥ Slates: Takes are organized into slates that display a representative 
frame and clip name for the take that is currently selected.

¥ Takes: The nodes and lines extending from the bottom of each 
slate indicate the number of takes for that scene. Click on a node to 
select the take.

¥ Indicators: You can apply off-screen dialog indicators or colors to 
indicate such things as preferred takes, takes used in the current 
active sequence, or line changes in dialog.

¥ Script marks: The double arrows marking the takes at various 
points represent marked lines of dialog in the script that have been 
synchronized to matching dialog in the source clip.   Script marks 
are especially effective during editing, allowing the editor to 
quickly locate dialog and piece together parts of a scene.

The script window provides additional controls for matching back to 
clips in the source bins, loading and playing back takes, and searching 
for takes and script text.

Script Integration Workflow

The basic workßow for script integration is as follows:

1. The continuity person or an assistant creates the lined script in 
hardcopy form on the set during shooting.

2. Source footage from the shoot is prepared and digitized using 
methods described in Chapter 2 and Chapter 3.

3. The assistant editor uses the lined script from the shoot, a text Þle 
of the script itself, and methods described throughout this chapter 
to import and line the script, link clips to the script, place script 
marks, and customize the display of takes prior to editing.

4. The editor uses the fully prepared script window to edit the pro-
gram.
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Using Script Integration in Video Projects

Script integration can be an effective tool for editing any type of pro-
duction, not just feature Þlms and television drama. For example:

¥ You can adapt many of the procedures described in this chapter 
for use in audio/visual scripts for documentaries, corporate spots, 
news magazine segments, and spot advertisements.

¥ You can turn script integration into a quick storyboarding tool by 
positioning selected slates in the script window and printing out 
storyboard bins that include your script.

The following is an example of an audio/visual script for a news mag-
azine piece, imported into the script window, with most of the basic 
features of script integration applied.

Narration track is 
synced to the script.

All possible B-roll 
shots are ready to be 
loaded and cued. 
Color indicates pre-
ferred shots.

Music cuts are linked 
to appropriate sec-
tions of the script.
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Script Window Basics

This section describes basic procedures for creating and manipulating 
script windows, including importing script text; navigating through 
the script; opening, closing and saving windows; and adjusting mar-
gins. 

n Before you begin creating script windows, make sure you have established the 
proper defaults in Script Settings for font, margin, and display of frames and 
takes, as described in the Avid Media Composer Products Reference. These 
parameters can also be changed manually, as described throughout this chap-
ter.

Importing a Script

The Þrst step in script integration is importing a script in the correct 
format.

c Script integration requires the imported script to be in ASCII text 
format. However, to maintain the original formatting, export the 
script from your word processor by using the Òtext with layoutÓ 
option. If you export the script as ÒtextÓ only, the formatting will be 
lost.

To import a new script:

1. Place the Þle in a directory that is available to your system in one 
of the following ways: 

¥ Transport the Þle on a diskette, and copy it to your internal 
hard drive.

¥ Place the Þle in a network location that you can access from 
your system.

2. From within the Media Composer application, choose New Script 
from the File menu.

A directory dialog box opens.
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3. Locate the Þle and double-click it, or select the Þle and click Open.

The system creates a new bin named after the project by default. 
The script, with its original layout, appears in the bin.

4. Change the name of the script bin by clicking on the title in the 
Project window and typing a new name.

Opening, Closing, and Saving the Script Window

The script window behaves in many respects like a bin:

¥ When you make changes in the script window, a small diamond 
icon appears in the title bar to indicate that the changes have not 
yet been saved.

¥ You perform a save by choosing Save Script from the File menu.

¥ Auto-save functionality also applies to the script window, based 
on parameters established in the Bin settings.

¥ Script window Þles are saved in the folder for the project along 
with bins, and backup copies are automatically stored in the Attic 
folder.

¥ You can use the Open and Close commands in the File menu to 
open additional script windows and add them to the project win-
dow, or to close script windows.
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Navigating in the Script Window

After importing a script, you can navigate to any point in the text 
using basic techniques available in most word processors:

¥ Use the scroll bar on the right to scroll up or down.

¥ Resize the window by dragging the size box in the lower right cor-
ner.

¥ Press the Page Down or Page Up key to move a screen at a time.

¥ Press the Home or End key to move to the beginning or end of the 
script.

¥ Press the Up Arrow or Down Arrow key to move your line selec-
tion up or down by one line.

n You can also use several search features, as described in ÒSearching Through 
ScriptÓ on page 206.

Adjusting the Script Margins

You can resize a script window at any time to show more script or to 
enlarge the right margin by dragging the size box in the lower right 
corner.

The default size of the left margin is established on import, based on 
the current Script settings. You can also override the margin setting 
and adjust the left margin after importing the script.

To adjust the left margin of an imported script:

1. Choose Left Margin from the Script menu.

The margin dialog box opens.

Scroll bar

Size box
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2. Type a new margin size, in pixels, into the entry box and click OK.

The script window reßects the new setting.

Manipulating Script Text

After importing a script, you can customize its appearance by chang-
ing the font and font size. You can also cut, copy, paste, or remove lines 
of script to reßect changes that might occur in the course of a project.

Changing the Font of the Script

The default font and font size used in the script are established on 
import, based on the current Script settings. You can also override the 
settings and change the font and size after importing the script.

To change the font and size of imported script:

1. Choose Set Font from the Edit menu.

The font dialog box opens.
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2. Choose a new font from the pop-up menu. The menu includes all 
fonts currently installed in the Fonts folder of the Macintosh Sys-
tem Folder.

3. Type a new font size into the entry box and click OK.

The script window reßects the new settings.

n As you enlarge font size, the available sizes for the slate frames also increase. 
This can be useful for presentation or screening purposes, when you need to 
display extra-large text and slate frames for a large audience or across a room. 
For information on enlarging slate frames, see ÒResizing a SlateÓ on 
page 212.

Selecting Text

Selecting text in the script window is similar to making selections in a 
word processor, except that the smallest unit you can select is an entire 
line of text. 

To select a single line of script, click anywhere in the line to highlight 
it.

Selected lines are 
highlighted.
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To select several lines of script, use one of the following methods:

¥ Lasso the Þrst line of the selection and drag through the text. As 
you drag, a box appears to outline your selection.

Release the mouse button when you Þnish lassoing the chosen 
lines. The text is highlighted.

¥ Click the Þrst line of the selection, then press the Shift key and 
click the last line. The entire block of text is highlighted.

n You can also extend a selection by pressing the Shift key and clicking a line of 
text preceding or following the current selection.

Cutting, Copying, and Pasting Script

You can cut, copy, and paste text in the script just as you would in a 
normal word processor. However, because you cannot select individ-
ual words or characters, you can only move lines or paragraphs. 

c You cannot undo cut, copy, or paste procedures in the script window.

To cut or copy and paste lines of script:

Lasso a portion of 
script to select it.
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1. Select the lines.

2. Press kÐC to copy, or kÐX to cut, depending on your needs.

3. Select the line below the location where you want to insert the text.

4. Press kÐV to paste the text.   

If only one line is selected at the insertion point, an alert message 
asks if you want to replace the selected line.

5. Make a choice, based on your needs:

¥ Click Yes if you selected lines at the insertion point that you 
want to overwrite.

¥ Click No if you want to insert the text above the selected line.

The text is pasted into the script.

n To rearrange or rewrite individual words or characters in the script, you 
should make the changes in a word processor before importing them into a 
separate script window. You can then use the procedures in this section to 
copy and paste the new lines into the existing script window, overwriting the 
incorrect lines.

Removing Script Text

You cannot delete lines of text from the script window using the Delete 
key as you would in a normal word processor. Use the Cut command 
to remove the text instead.

To remove lines of script:
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1. Select the lines of script you want to delete.

2. Press kÐX to cut the text from the script.

Unlike a normal deletion, the text remains in the Macintosh clipboard 
until the next time you copy or cut a selection.

Searching Through Script

You can use the Find 
Bin and Find Script but-
tons to match back and 
forth between script 
and clips. For more 
information, see ÒFind-
ing ScriptÓ on 
page 225.

Script integration provides a number of search tools you can use dur-
ing the preparation phase, during editing, or during screenings. You 
can apply and search for page or scene numbers, or you can conduct a 
full-text search.

Using Page and Scene Numbers

When you add page and scene numbers to the script window, you 
gain the ability to search for them during preparation of the script and 
during editing. You can customize page and scene numbering by add-
ing, changing, and moving the numbers as necessary.

Adding a Page or Scene Number

To add a page or scene number:

1. Select the line of the script at the beginning of the scene or page:

2. Click the Add Scene or the Add Page button in the script window 
tool bar, or choose Add Scene or Add Page from the Script menu.

The Add Scene or Add Page dialog box opens.
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3. Type the number for the scene or page, and click OK.

In the case of a scene, the number appears in the left margin next 
to the Þrst line of the selected region.

Scene and page numbers both appear in the status bar at the bot-
tom of the script window, and reßect your current position within 
the script. Each scene or page number will continue throughout 
the script until you mark another line as the beginning of a new 
scene or page.

Changing a Page or Scene Number

You use the process of changing a scene or page number both to cor-
rect any errors that occur when adding numbers, and to reposition 
scene and page numbering to match script changes during postpro-
duction.

New scene number

Scene/page status bar
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To change a page or scene number:

1. Select the beginning line of the previous scene or page.

2. Click the Add Scene or Add Page button in the script window tool 
bar, or choose Add Scene or Add Page from the Script menu.

The Change Scene or Change Page dialog box opens.

3. Type a new number for the scene or page, and click OK.

4. If the renumbering affects page or scene numbers that precede or 
follow the current change, then repeat these steps as necessary.

Deleting Page or Scene Numbers

To delete a page or scene number:

1. Select the Þrst line of the scene or page.

n You can also delete all page or scene numbering throughout a range of the 
script by selecting the range of lines, or the entire script.

2. Press the Delete key.

The Delete dialog box appears.
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3. Select the options for Delete scene or Delete page break(s), as 
appropriate, then click OK.

The numbering is deleted from the script window.

Searching for a Page and Scene Number

Once you have added scene and page numbers, you can search for 
them quickly during editing.

To search for a page or scene number:

1. Choose Goto Page or Goto Scene from the Script menu. 

n You can also click on the page or scene display in the status bar at the bottom 
of the script window.

A dialog box opens.

2. Type the number of the scene or page, and click OK.

The script window scrolls to the page or scene, and the Þrst line of 
script is highlighted.

Conducting a Text Search

To search for text in the script:

1. With the script window active, choose Find from the Edit menu.
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The Find dialog box opens.

2. Type the text you are looking for.

3. Select one of the optional search parameters, when appropriate:

¥ Choose Ignore case if you do not want the search to be case 
sensitive.

¥ Choose Whole word if you do not want the search to highlight 
instances where your text is one part of another word.

4. Click OK. 

The Þrst occurrence of the text is highlighted in the script window.

5. Choose Find Again from the Edit menu to search for the next 
occurrence of the text.

Linking Clips to the Script

To link clips to the script:

1. Open the script bin.

2. Open the source bin for the clips that you want to link to the script.

3. (Option) Sort the source clips to make the job easier:

¥ You can sort the Scene/Take column for an alphanumeric list 
of clips that matches their relative order in the script.

¥ If you are not working with scene and take information (for 
example, in a video documentary project), you can provide 
your own numbering for the clips in a custom column, or you 
can sort the clips manually in Frame mode according to their 
order in the script.

4. Select and highlight the portion of the script that is covered by the 
Þrst clip or clips.

5. Select the clip or clips in the source bin and drag them to the high-
lighted text.
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A slate frame appears above the text, with one or more of the takes 
covering the scene as lines.

6. Continue to apply clips to additional portions of the script until 
you have Þnished creating all your slates.

Alternatively, you can create slates one at a time, place script 
marks, and Þne-tune the lining of each scene before proceeding to 
the next portion of the script.

Drag a clip or several clips to 
the highlighted text.

The slate appears.
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Manipulating Slates

Once you create a slate by dragging a clip into the script window, there 
are a number of ways you can manipulate its appearance and position, 
as described in this section.

Selecting Slates

There are several ways to select slates:

¥ Click a slate to select it.

¥ Shift-click additional slates to select all the active takes.

¥ Drag a lasso through a region of the script containing slates. All 
slates and takes within the lasso are selected.

n Selecting multiple slates is especially useful when you are adding or deleting 
color or off-screen dialog indicators across takes, as described in ÒManipu-
lating TakesÓ on page 215.

Resizing a Slate

You can resize a slate the same way you resize frames in the bin in 
Frame mode:

¥ To enlarge a slate, select it and press kÐL or choose Enlarge Frame 
from the Edit menu.

¥ To reduce a slate, click on it and press kÐK, or choose Reduce 
Frame from the Edit menu.

n You can enlarge the font size of the script to increase the size of the slate 
frames. This can be useful for presentation or screening purposes, when you 
need a large display for an audience. For information on resizing the font, see 
ÒChanging the Font of the ScriptÓ on page 202.
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Hiding Slate Frames

By default the system displays a representative frame for each take in 
the slates. You can hide this frame display and show only the clip 
name in order to simplify the interface or speed up scrolling and 
movement in a complex script window.

To hide the slate frames, choose Show Frames in the Script menu. The 
script window shows only the clip names for the takes.

To restore the frames, choose Show Frames again.

Showing One Take Per Slate

You can display only one representative take per slate to minimize 
clutter on the screen.

To show one take per slate, choose Show All Takes in the Script menu. 
The script window shows only the Þrst take in each slate.
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To display all the takes, choose Show All Takes again.

Moving a Slate

You can adjust the position of slates to make room for more slates, to 
avoid blocking words, or to display takes over speciÞc lines.

To move a slate, use one of the following methods:

¥ To move a slate horizontally, click the slate and drag it to the left or 
the right.   (If necessary, resize the script window by dragging the 
size box.)

¥ To move a slate vertically without moving the position of the take 
lines in the script, click the slate and drag it up or down. The take 
lines remain Þxed over the text to which they have been previ-
ously linked.

¥ To move the slate and all its take lines vertically to a new location 
in the script, press the Command key, then drag the slate to the 
new location.

A single take is shown
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n As you move the slate, the takes continue to cover the same number of lines in 
the script. To lengthen or shorten the number of lines covered in the takes at 
the new location, see ÒAdjusting Take LinesÓ on page 219.

Deleting a Slate

Occasionally you might need to delete a slate Ñ for example, when 
you Þnd that the takes in the slate are no longer needed.

n When you delete slates and takes from the script window, the digitized source 
clips remain in the source bins.

To delete a slate:

1. Select all the takes in the slate by pressing the Shift key and click-
ing the tab for each take.

2. Press the Delete key.

The Delete dialog box opens, indicating the number of takes to be 
deleted.

3. Click OK to delete the takes.

The slate and all its takes are deleted from the script.

Manipulating Takes

Script integration provides a number of tools and techniques for 
manipulating the relationship between lined takes in the script win-
dow and their source clips, as described in this section.
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Selecting Takes

There are several ways to select takes:

¥ Click any take to select it. The outline of the take becomes bold to 
indicate that the take is active.

¥ Shift-click additional takes in the same slate or across slates to 
select them.

¥ Drag a lasso through an entire region of the script. All takes within 
the lasso are selected.

n Selecting multiple takes is especially useful when adding or deleting color or 
off-screen dialog indicators, as described in ÒIndicating Off-Screen DialogÓ 
on page 219, and ÒUsing Color IndicatorsÓ on page 220.

Adding Takes

To add another take to an existing slate:

1. Select the region of the script that the take covers.

2. Open the bin where the clip for the take is located.

3. Drag the clip to the slate.

The new take appears in the slate and is applied to the selected 
region of the script. 

Deleting Takes

As you screen clips, you might Þnd that a take has been applied to the 
wrong scene and should be deleted from the slate.   Or you might 
decide to delete a bad take altogether to simplify the script interface 
for the editor.
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To delete one or more takes:

1. Click the takes to select them.

2. Press the Delete key.  

The Delete dialog box appears.

3. Click the Delete Takes check box, then click OK.

The takes are deleted.

Displaying Take Numbers

To display take numbers within the tab of each take, enter the numbers 
in the Take column of the source bin for the clips.

Changing the Representative Frame for a Take

To change the representative frame that appears in the slate for a take:

1. Select the take.

Numbers in the Take column 
appear in the tabs for each 
take.
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2. Press the appropriate Step keys on the keyboard to advance the 
footage displayed in the slate forward or back to the desired 
frame.

You can also select multiple takes and advance them all at once.

Loading Takes

You can load individual takes into the Source monitor one at a time, or 
you can load multiple takes, as follows:

¥ Double-click any take to load it into the Source monitor.

¥ Select multiple takes, and double-click any take in the selection to 
load all the takes into the Source monitor.

Playing Takes

There are two ways to play back a take:

¥ Double-click a take to load it into the Source monitor; then click 
the Play button or press the Play key. 

The clip plays back and stops when it reaches the end. 

¥ Click a take once to select it in the script; then click the Play button 
at the top of the script window. 

The clip loads and plays back in a continuous loop until you press 
the Space bar. If you selected more than one take, each take will 
play in sequence.
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Adjusting Take Lines

As you screen clips in the script, you might Þnd that a take or group of 
take lines should begin earlier or end later in the script. You can adjust 
the take lines by moving the beginning mark, the end mark, or both.

To change the length of a take line:

1. Press the Command key. 

Notice the movement icon that appears when you point the cursor 
at either end of the take.

2. Click the end mark or beginning mark of a take and drag it until 
you reach the correct line in the script.

3. Press the Command key and drag the opposite end of the take to a 
new location if necessary.

4. Repeat the procedure for other takes in the slate as necessary. 

Indicating Off-Screen Dialog

In the traditional lined script, you indicate off-screen dialog by draw-
ing a jagged line next to the dialog. You can apply a similar effect to 
lines in the script window.

To indicate off-screen dialog:

1. Select the range of script containing the off-screen dialog.

2. Select one or more takes that you want to mark with the off-screen 
indicators.

3. Click the Off-Screen button in the script window tool bar.

The indicators appear, superimposed on the selected takes.  You 
can toggle the indicators on or off by clicking the button repeat-
edly.  
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To remove one or more off-screen indicators:

1. Select the range of script containing the off-screen indicators.

2. Select only those takes that display the indicators.

3. Click the Off-Screen button.

Using Color Indicators

You can use color to indicate several pieces of information, including:

¥ Preferred takes or takes used in the current active sequence

¥ Picture versus audio track used in the current active sequence

¥ Line changes in dialog

¥ Use of multiple cameras

To apply color to takes:

1. Choose a color from the Color submenu of the Script menu.

2. Select the region of the script that covers the range within the take 
or takes that you want to highlight with color.

3. Select one or more takes.

4.  Click the Color button in the script window tool bar.

The color appears only in the highlighted script region of the 
selected takes. You can toggle the indicators on or off by clicking 
the button repeatedly.

To remove one or more off-screen indicators:

1. Select the range of script containing the color indicators.

The Þrst take in the selected region determines the color indicator 
status displayed in the Color button.

2. Select only those takes that display the indicators.

3. Click the Color button.
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Using Script Marks

Script marks allow you to synchronize individual lines of script with 
matching points in digitized clips. When you place a mark in the 
script, an IN mark also appears in the clip when you load it into a 
monitor for editing. This provides line-by-line control over alternative 
takes that the editor can instantly load and edit into the sequence.

You can place script marks in one take at a time, or you can automate 
the process of screening and marking selected takes in a playback 
loop.

Placing Script Marks Manually

To place script marks manually:

1. Map the Script Mark button from the Master command palette to a 
user-customizable palette, or to the keyboard.

2. Double-click in the script window at the intersection of a take and 
the line of dialog that you want to mark. 

The take is selected in the slate, the chosen line of the dialog is 
highlighted, and the clip loads into the Source monitor.

Double-click at the 
intersection of the take 
and the line in the script 
that you want to sync to 
the source clip.
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3. Click or press Play. The take plays in the monitor.

Alternatively, you can jog or shuttle through the footage, place the 
position indicator on the exact frame, or scrub the audio to Þnd the 
exact line of dialog. The clip does not have to be playing.

4. When the playback reaches the chosen line of dialog, click the 
Script Mark button or key. 

The line is marked in the script window with a small horizontal 
bar, and play stops.

5. Repeat these steps to add additional script marks.

Automated Screening and Marking

The script window provides controls for automating the process of 
screening and placing script marks for a single take or across multiple 
takes.

To use automated screening and marking:

1. Select one or more takes.

2. Click the Record Marks button in the script window tool bar.

The Þrst selected take turns green in the script window, the system 
automatically loads the clip into the Source monitor, and the clip 
begins to play.

The script mark 
appears



223

3. As you hear a line of dialog (or see a particular shot) that you want 
to mark, click on the matching line in the script window.

A script mark appears at that location in the take, and the clip con-
tinues to play.

4. Continue to mark additional sync points as follows:

¥ You can click on a line that already contains a mark to replace 
the previous mark and update the sync point in the clip.

¥ You can click on a line in the script before or after the range of 
the existing take line, and the mark will be added while the 
take line is extended to include the new line.

¥ You can use variable-speed play controls (J-K-L keys on the 
keyboard) to shuttle, jog, or pause during playback.

¥ You can press the Tab or Shift-Tab keys on the keyboard to 
begin playback of the next or the previous take.

¥ You can scroll through the script window without affecting 
playback.

As each take reaches its end, the system automatically loads and 
plays the next take.

5. Continue to place marks until all takes have been screened.

6. To stop the playback loop, press the Space bar.

Current playback is 
highlighted in green.

Several takes are 
selected for automated 
playback.
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Loading and Playing Marked Segments

Once you have placed marks syncing lines in your script to points in 
the source clips, you can quickly load and cue takes for selected lines 
of dialog. You can load a single take, or you can load all the coverage 
for any given range of lines.

To load the marked segment of a take, click on the script mark at the 
line of dialog that you want to cue.

The take is loaded into the Source monitor and cued to the synced line 
of dialog. An IN mark is placed at the sync location.

To load all the coverage for a range of lines:

1. Select the lines in the script window, dragging through all inter-
secting takes.

The script lines and takes are highlighted.

2. Click the Play button in the script window if you want to screen 
the takes for those lines, or click the Record Marks button if you 
want to add script marks.

The takes load and play back one after another. You can use the 
Tab key or J-K-L keys to jump between takes and control playback.

Moving a Script Mark

When you move a script mark up or down, the mark in the source clip 
remains at the same frame, but is resynced to a new line in the script.

To move a script mark:

1. Press the Command key.

Notice the movement indicator that appears when you point the 
cursor at a mark in the script.

2. Click the mark and drag it to the new position.
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Deleting a Script Mark

When you remove a script mark, you do not delete the marked portion 
of the take, only the sync point between the script and the source clip.

To delete a script mark:

1. Click once on the mark. (If you double-click, you will load the clip 
and make the Source/Record window active.)

2. Press the Delete key. 

The Delete dialog box appears.

3. Click OK. The mark is deleted.

Finding Clips and Script

After you have placed script marks synchronizing lines in the script 
window to frames in the source clips, you can use the Find Bin or Find 
Script buttons to search back and forth between the two.

Finding Script

The Find Script button allows you to quickly match back from cur-
rently loaded clips to portions of script in the script window to which 
the clip has been linked.

To Þnd the script linked to a loaded clip:

1. Place the position indicator in the clip at the line of dialog (or 
within a range of dialog) that you want to Þnd.

2. Click the Find Script button.

The script window instantly scrolls to and highlights the portion of 
script that most closely matches the clip location.
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Finding Clips and Bins from the Script

Script integration allows you to search instantly through bins and Þnd 
the source clips for takes that have been linked to the script. You can 
search on a single take, or on multiple takes across several slates.

To Þnd source clips and bins:

1. Select the takes that you want to Þnd.

2. Click the Find Bin button in the script window tool bar.

The system searches through bins linked to the project, opens the 
bin containing the linked clips, and highlights them in the bin.

Editing with the Script Window

Using the script window in combination with the Single Mark Editing 
feature, an editor can conduct a highly streamlined form of editing. To 
use the script window most effectively during a session, make sure:

¥ The script window is fully prepared including preferred takes, 
alternative takes (indicated with colors), and script marks for 
matching lines of text to sync points in the clips.

The system opens 
the bin and high-
lights clips that 
match your search.
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¥ The Single Mark Editing option is enabled in Composer settings. 
This option allows you to skip several steps by performing edits 
on the ßy while playing back clips (without marking OUT points). 
For more information, see ÒUsing Single Mark EditingÓ on 
page 243.

Script Editing Workflow

To quickly assemble a rough cut from the script window:

1. Open the script window for the current cut.

2. Double-click the Þrst preferred take and load it into the Source 
monitor. The IN point is already marked and cued.

3. Play the take until the appropriate OUT point is reached, and click 
the Splice or Overwrite button to make the Þrst edit.

4. Prepare the sequence for the next edit:

a. Create new tracks if necessary.

b. Enable the appropriate source and record tracks.

c. Patch the tracks if necessary. 

d. Mark an IN point in the sequence for the next edit.

5. Double-click the next preferred take to load it.

6. Play the clip until you reach the appropriate OUT point, and per-
form the edit on the ßy.

7. Repeat steps 4 through 6 until you have walked through the entire 
scene or segment.

8. Fine-tune the edits by using normal trimming and editing proce-
dures. Continue to use the script window to quickly load and cue 
alternative takes as necessary.
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Splicing a Script Range

During editing, you can use the Control key to instantly splice clips 
linked to ranges of script directly from the script window into the 
sequence. In order to use this feature with accuracy, you should care-
fully mark the ranges of script during the screening and marking 
phase.

To splice a range:

1. Mark an IN point or place the position indicator at the location in 
the sequence where you want to splice in the segment.

2. Press the Control key. Notice that the Splice-insert arrow appears 
when you point to a take.

3. Double-click on the preferred take within the range of dialog that 
has been marked.

The marked section of the clip is spliced into the sequence.

Revising the Script

During or after each session, or when a scene or segment is completed, 
the editor or assistant editor can update the script window to reßect 
the Þnal edit decisions made during the day.   In this way you can 
maintain a complete record of the elements used to construct the scene 
or segment, as well as all existing alternatives. When further changes 
or repackaging are required, you can quickly retrieve all the source 
material in one window.

Interactive Screenings

In the course of postproduction, the script window can be an invalu-
able tool during screenings of work in progress, allowing you to:

¥ Quickly search for scenes and pages with clips attached for instant 
retrieval.
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Sequences cannot be 
loaded into the Script 
window. Alternatively, 
you can perform a 
video mixdown and 
load the resulting mas-
ter clips instead. For 
more information, see 
ÒUsing Video Mix-
downÓ on page 478.

¥ Match back and cue source material to compare alternative takes.

¥ Quickly Þnd and open bins for retrieval of additional material not 
included in the script window.

¥ Enlarge the script font and slate frames for better viewing by your 
audience.

The script window provides a visual, interactive look at the content of 
the original script versus the elements in the Þnal piece.

Matching colors indicate takes 
used in the preferred cut as 
well as alternative cuts.

You can mix down alternative 
cuts to form master clips and 
place them alongside the script.

All alternative takes are 
available for viewing and 
comparing.
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CHAPTER 8

First Edits in Source/Record 
Mode

After you have viewed and marked your clips or created subclips, you 
are ready to create a sequence. This chapter introduces you to proce-
dures you use in Source/Record mode to build a basic sequence, as 
described in the following sections:

¥ Setting Up a New Sequence

¥ Making the First Edit

¥ Undoing or Redoing Edits

¥ Editing Additional Shots into the Sequence

¥ Using Phantom Marks

¥ Lifting, Extracting, and Copying Material

¥ Adding Comments to Sequence Clips

¥ Playing the New Sequence

¥ How to Proceed

n Illustrations of the Film Composer window show two button rows, two infor-
mation rows, and Center Duration. For information about changing the 
default display, see the Avid Film Composer Getting Started Guide.
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Entering Source/Record Mode

Source/Record mode is the default editing mode, and is composed of 
the screens and controls shown in the Source/Record window within 
the main Composer window on the Edit monitor. 

To enter Source/Record mode from within another mode, click the 
Source/Record Mode button displayed in both the Source/Record 
window and in the Timeline toolbar.

Setting Up a New Sequence

There are two ways to establish a new sequence:

¥ If you have speciÞc parameters in mind for the project that you 
would like to establish Þrst, you can create and name a sequence, 
set the start timecode, and determine the numbers and kinds of 
tracks to use before you make the Þrst edit, as described in this 
section.

¥ If you would like to begin editing right away and build the 
sequence as you go without setting parameters ahead of time, skip 
to ÒMaking the First EditÓ on page 237.

To set up a sequence with the New Sequence command:

Source/
Record 
Mode 
button
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1. Choose New Sequence from the Clip menu. One of the following 
occurs:

¥ If just one bin is open, or several bins are open and you have 
clicked a speciÞc bin to activate it, the new sequence appears 
in the bin. It also appears in the Record monitor and in the 
Timeline, with the generic title ÒUntitled Sequence n.Ó Each 
new sequence is numbered incrementally until you rename it.

¥ If several bins are open but none is activated, the Select a Bin 
dialog box appears.

Select the bin in which to store the new sequence, or click the 
New Bin button to create and open a new bin, and click OK.

An untitled sequence appears in the bin, in the Record moni-
tor, and in the Timeline.

2. To rename the new sequence, immediately type a new name while 
the name Þeld is active in the bin. 
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n If you click anywhere in the interface after creating the new sequence, you 
deactivate the name Þeld. Click the sequence name again to rename the 
sequence.

Changing the Sequence Clip Info

You can also change the 
default starting time-
codes for all new 
sequences using Gen-
eral Settings. For more 
information, see the 
Avid Media Composer 
Products Reference.

The following optional procedure allows you to rename the new 
sequence and set a customized start timecode using the Clip Info com-
mand.

1. With your sequence loaded and the Record monitor active (click it 
to make it active), choose Get Clip Info from the File menu to open 
the Clip Info dialog box.

New Sequence, 
renamed
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2. Drag a cursor across the sequence name in the Name Þeld, then 
type a new name.

3. Drag a cursor across the start timecode then type a new timecode. 

4. Click OK. Enter the starting footage key number information in 
the same way.

Setting Up Tracks for the New Sequence

When you create a new sequence using the New Sequence command, 
and  no material is loaded into the Source monitor, the Timeline dis-
plays only the TC (master timecode) and EC (edgecode) tracks.

You can add any number of audio or picture tracks to the sequence 
before making the Þrst edit, as follows:

¥ Choose New Picture Track from the Clip menu to add a picture 
track.

¥ Choose New Audio Track from the Clip menu to add an audio 
track.

The following illustration shows the Timeline after one video and two 
audio tracks have been added, with no material loaded in the Source 
monitor.
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User Preferences for Creating Tracks

For information on 
opening and changing 
settings, see the Avid 
Film Composer Getting 
Started Guide.

Film Composer provides two options in the Composer Settings dialog 
box that help automate the way tracks are created and enabled as you 
edit. You can adjust these settings in advance based on personal pref-
erence.

The default settings are:

¥ Auto-create New Tracks: Whenever you load new source material 
into the Source monitor, the system automatically creates any new 
tracks in the sequence that match existing tracks on the Source 
side.

¥ Auto-enable Source Tracks: Whenever you load new source 
material into the Source monitor, the system automatically enables 
all existing source tracks.

Alternatively, you can do the following:

¥ Deselect the Auto-create New Tracks option to have the existing 
tracks in the sequence remain the same when you load new source 
material. This allows you to create new tracks selectively as you 
edit, which is often preferable at the more advanced stages of a 
project.

¥ Deselect the Auto-enable Source Tracks option to leave the tracks 
of newly loaded material disabled until you click them. This 
allows you to turn on the source tracks more selectively as you 
edit, which is often preferable at the more advanced stages of a 
project.

Adding Filler

You can add a small amount of black Þller at the start of your sequence 
before making the Þrst edit.  A brief moment of black before the start 
of your sequence is sometimes useful during playback, or when 
recording a digital cut.  You can also add Þller at any time during edit-
ing to another part of the sequence.
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To add Þller:

1. Choose Load Filler from the Source Monitor menu.  The system 
loads a two-minute clip of Þller into the Source monitor.

2. Mark the desired length of Þller, as needed.

3. Click the Splice or Overwrite button to edit the black into the 
sequence.

Copying Locators from Source Clips

You can choose to copy all locators currently placed in source clips 
directly into the sequence as you edit.  The locators and the locator text 
appear in all sequence segments that reference the source clips.

To automatically copy source locators as you edit:

1. Double-click Composer in the settings scroll list of the Project win-
dow to open the Composer Settings dialog box.

Copy 
Source 
Locators 
option
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2. Click the Copy Source Locators checkbox.

Making the First Edit

Whether you establish a new sequence in advance, or do not prepare a 
sequence and wish to begin editing right away, use the following pro-
cedure to begin editing:

1. Load the Þrst clip into the Source monitor. If you have not already 
marked IN and OUT points for the clip in advance or created a 
subclip, view and mark the clip as necessary.

2. Click buttons in the source track selector panel to select the tracks 
you want to include in the edit. Only the tracks that have been dig-
itized for the clip appear as source tracks in the Timeline.

For example, with a talking head you might select tracks V1 (pic-
ture) and A2 (sound), if the voice was recorded on that track. You 
would deselect track A1, which may have unwanted wild sound 
picked up from a second microphone, or it might have no sound at 
all.

Or, as another example, if you are Þrst laying down a music track, 
you would select track A1 or A2 depending upon where the music 
was digitized, and deselect V1.

3. Click the Splice button to add the edit to the sequence in the 
Record monitor.

The Record monitor displays the end of the last frame of the new 
edit. (You can scroll the position indicator in the Timeline or the 
position bar beneath the Record monitor to review the shot.) The 
edit also generates a graphical display of the cut in the Timeline.

Source Tracks
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Creating an Instant Rough Cut

For additional informa-
tion on editing directly 
from the bin into the 
Timeline, see ÒBin Edit-
ing into the TimelineÓ 
on page 264.

As an alternative to creating a new sequence by editing shots one at a 
time, you can quickly create a rough cut by selecting and loading mul-
tiple clips directly from the bin into the Record monitor using the Shift 
or Option keys. You can load clips that have been sorted in a bin in text 

Splice 
button

Source and 
Record tracks

Timeline generated by the edit

The  last frame of the 
first new edit

Marked IN and 
OUT edit points



239

display mode. Or, you can create a storyboard in Frame or Script dis-
play mode and then load these clips directly.

Use the following procedure to create a rough cut from a bin:

1. To create a more accurate rough cut, screen and mark clips in the 
bin in advance, as described in the Avid Film Composer Getting 
Started Guide.

2. In the bin, sort the clips in the order in which you want them to 
appear in the sequence:

¥ In Text mode, alphabetic or numeric sorting of clips might not 
provide you with the clip ordering that you want. You can cre-
ate a new bin column for numbering the clips in the order in 
which you want them to appear, then sort the column numeri-
cally.

¥ In Frame or Script mode, rearrange frames and prepare a sto-
ryboard as described in ÒStoryboard WorksheetÓ on 
page 174.

3. Select the Source and Record tracks for the edit.

4. Shift-select or lasso the clips. Choose Select All from the Edit menu 
if there are no other clips in the bin.

5. Hold the Option key and drag the highlighted clips to the Record 
monitor to splice the clips into place. Alternatively, hold the Shift 
key and drag the clips to overwrite them into an existing 
sequence.

The clips are spliced together to form a new sequence based on the 
order in which they are listed in the bin. If there is a sequence 
already loaded into the Record monitor, the new clips are spliced 
or overwritten in the sequence beginning at the location of the 
position indicator or an IN point marked in the sequence.
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Undoing or Redoing Edits

You can undo or redo up to 32 previous actions listed in the Edit 
menu. You can quickly undo or redo a just completed command, or 
you can search through a submenu to undo or redo all commands 
leading back to a particular command.

¥ To undo only the previous edit or function, select Undo from the 
Edit menu.

¥ To redo only the previous edit or function, select Redo from the 
Edit menu.

¥ To undo or redo everything back to a particular command, choose 
the desired command from the Undo/Redo list in the Edit menu. 
All of the previous commands, back to and including the com-
mand chosen from the submenu, are undone or redone as appro-
priate.

Prior redo commands 
appear in the upper 
portion of the Undo/
Redo List submenu

Prior undo commands 
appear in the lower 
portion of the submenu

Undo/Redo commands
for previous edit
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Editing Additional Shots into the Sequence

You can use two or 
sometimes one mark to 
complete an edit using 
Phantom Marks. For 
more information, see 
ÒUsing Phantom 
MarksÓ on page 244.

The three primary edit functions for adding material to your sequence 
are the splice, overwrite, and replace commands. In most cases you per-
form three-point edits in which you set three marks Ñ two in the 
source material and one in the sequence, or the reverse. The fourth 
mark is determined automatically. The way you set marks depends 
upon the type of edit you perform, as described in this section.

Performing a Splice Edit

A splice edit inserts the material marked in the Source monitor into the 
sequence without replacing material already in the sequence. Existing 
material moves down beyond the spliced material, lengthening the 
overall duration of the sequence.

To perform a splice edit:

1. Load a clip into the Source monitor.

1. Mark an IN and OUT point.

2. Mark an IN point in the sequence as follows:

a. Move the position indicator in either the Timeline or the posi-
tion bar of the Record monitor to the point where you want to 
splice the shot into the sequence. 

b.  Click the Mark IN button or press the Mark IN key on the 
keyboard.

n If you donÕt mark an IN, the system splices the new shot into the sequence at 
the current location of the position indicator.

3. Click the Splice button (yellow) to complete the edit.
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Performing an Overwrite Edit

An overwrite edit replaces a section of the sequence with the material 
you select in the Source monitor.  Unlike a splice edit, an overwrite 
edit replaces existing material and therefore does not lengthen the 
overall duration of the sequence.

To perform an overwrite edit:

1. In the Source monitor, mark an IN or OUT, but not both, to show 
the start or end of the shot you want to use.

2. In the Record monitor, mark both an IN and OUT to select the 
material in the sequence you want to overwrite. Or you can mark 
an OUT and move the position indicator in the Timeline or posi-
tion bar to the IN point.

3. Click the Overwrite button (red) to complete the edit.

Performing a Replace Edit

You use the Replace button (blue) to replace a clip in the sequence 
(video, audio, or both) with new material from the Source monitor, 
while maintaining the original IN and OUT points of the previous 
edit.

To perform a replace edit:

1. Choose a sync frame in the source clip by moving the position 
indicator to display that frame in the Source monitor. 

The sync frame can be an IN point, an OUT point, or any frame in-
between that you wish to sync to a frame in the existing shot in the 
sequence.

2. Choose the sync frame in the Sequence for the edited shot that you 
want to replace by moving the position indicator in either the 
Record monitor position bar or in the Timeline to that frame.
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3. Click the Replace button (blue).

The system calculates IN and OUT points for the source material 
using the sync frames and the existing IN and OUT points in the 
sequence for the previously edited shot that you are replacing.

n If you are replacing a clip in a split edit, and the position indicator falls within 
the overlap, you may end up replacing the wrong material, unless you select 
the entire segment you want to replace. See ÒSelecting and Deselecting 
SegmentsÓ on page 255.

For more information 
on sync point editing, 
see ÒUsing Sync Point 
Editing (SPE)Ó on 
page 375.

Like replace editing, Sync Point Editing allows you to overwrite mate-
rial in the sequence based on alignment of the position indicators in 
the source material and in the Timeline. The difference is that Sync 
Point edits end at the nearest marks in either the source or record 
material, while replace edits always Þll the IN to OUT of the clip in the 
sequence. 

Using Single Mark Editing

Single mark editing (also called mark and park editing) allows you to 
establish a single mark, then use the location of the position indicator 
to determine the second mark when making the edit.  You can use this 
procedure in several ways to save steps:

¥ You can mark an IN point in the Source monitor and then perform 
a splice, overwrite, or replace edit without adding an OUT mark.

¥ You can mark an OUT point, then locate the desired frame for the 
IN mark, and perform the edit without marking the IN point.

¥ You can mark the IN or OUT, play, jog, or shuttle through the clip 
forward or backward, then press the Splice, Overwrite, or Replace 
button to perform the edit on the ßy without adding the second 
mark.

To enable single mark editing, open the Composer settings dialog box 
from the Project window and select the Single Mark Editing option.
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Using Phantom Marks

The Phantom Marks feature provides visual guidance when editing 
according to the three-mark rules described in ÒEditing Additional 
Shots into the SequenceÓ on page 241. When you enable Phantom 
Marks, the system displays gray IN or OUT mark icons in the position 
bars below both the Source monitor and the Record monitor. These 
Phantom Marks may indicate one, two, or sometimes three edit points 
calculated by the system to complete an edit. The following are a few 
sample scenarios.

Setting One Mark

In this example, you set only the IN mark on the Source side. By 
default, the system uses the location of the position indicator as the IN 
mark for the sequence, and calculates both OUT points based on the 
length of the source clip.

You can see the system calculations instantly and can make the edit 
after setting just one mark, when appropriate.

Adding a Second Mark

If you decide that an OUT mark is required Ñ to shorten the source 
clip, for example Ñ then the system recalculates and displays new 
Phantom Marks.

One IN mark Three Phantom Marks
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The Phantom Marks option can help you see the results of marks you 
set before you complete the edit, and is especially useful when doing 
sync-point editing or other complicated replace edits in which two or 
more marks are calculated automatically.

Lifting, Extracting, and Copying Material

Extract/Splice and Lift/
Overwrite are Segment 
Mode functions you can 
also use to remove and 
reposition segments. 
For more information, 
see ÒUsing Segment 
ModeÓ on page 254.

Lifting, extracting, and copying allow you to remove or reposition mate-
rial quickly in your sequence. For example, you can move a clip from 
the end of your sequence to the beginning; or you can remove the 
material from the sequence altogether. Lifting, extracting, and copying 
place the removed material into the Clipboard. You can then paste the 
material elsewhere in the sequence, or in another sequence altogether. 
These procedures are described in this section.

Lifting Material

The Lift function removes selected material from a track in the 
sequence and leaves black Þller or silence to Þll the gap. You can later 
move or Þll this gap with other footage. When you lift material, the 
overall duration of the track (or sequence) remains the same.

To lift material:

1. Mark an IN and OUT at the start and end of the material in the 
sequence that you want to lift.

Additional OUT mark New Phantom Marks
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2. Select the tracks containing the material. The system will perform 
the function on selected tracks only.

3. Click the Lift button to complete the edit.

Extracting Material

The Extract function removes selected material from a track in the 
sequence and closes the gap left by its removal. As a result, when you 
extract material you shrink the duration of the track or sequence.

To extract material:

1. Mark an IN and OUT at the start and end of the material in the 
sequence that you want to extract.

2. Select the tracks containing the material. The system will perform 
the function on selected tracks only.

3. Click the Extract button to complete the edit.

Copying Material

For more information 
on using the Clipboard, 
see ÒUsing the Clip-
boardÓ on page 247.

The Copy to Clipboard function makes a duplicate of selected material 
in the sequence and leaves the material intact. When you copy mate-
rial, the sequence remains unaffected. The material can then be 
inserted into the sequence elsewhere or into another sequence.

To copy material to the Clipboard:

1. Mark an IN and OUT at the start and end of the material in the 
sequence that you want to copy.

2. Select the tracks containing the material. The system will perform 
the function on selected tracks only.
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3. Click the Copy to Clipboard button.

The system copies the selected material to the clipboard, and 
leaves the sequence untouched.

Using the Clipboard

Film Composer systemÕs clipboard is a cut, copy, and paste tool 
adapted to the special needs of the editing environment. You can place 
a marked section of the sequence into the clipboard at any time by 
clicking the Lift, Extract, or Copy to Clipboard buttons.

The Copy to Clipboard function is useful for moving or repeating 
material in a sequence without moving multiple segments in Segment 
mode, or rebuilding the section at another location. The following are 
three examples:

¥ You can copy a portion of a sequence for pasting into another 
sequence.

¥ You can isolate and copy a portion of an audio track for looping 
music or repeating a sound effect.

¥ You can copy graphic elements for repeating at other locations in a 
format cut.

Preserving Clipboard Contents

The Clipboard stores only one clip at a time; each time you copy, lift, or 
extract additional material, you delete and replace the previous con-
tents. 

To keep the clipboard contents throughout a session, do one of the fol-
lowing:
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¥ Choose Clipboard Contents from the Source Monitor menu.

The contents appear as a clip in the Source monitor, and the name 
ÒClipboard Contents.nÓ appears above the monitor and in the 
Monitor menu. The n is an incremental numbering of clips placed 
in the clipboard during the session.

¥ Press the Option key when you copy, lift, or extract the material. 
The contents appear as a clip in the Source monitor, and the name 
ÒSequence name. SubÓ appears above the monitor and in the Moni-
tor menu.

Repeat these procedures each time you want to preserve copied, lifted, 
or extracted material during a session. All the clips remain available in 
the Monitor menu until you choose Clear Menu or close the project.

n Material placed in the Clipboard does not appear as a clip in the bin, and is 
deleted when you close the project. To save a portion of a sequence for future 
use, mark the section and create a subclip.

Recovering Material from the Clipboard

The Clipboard allows you to restore lifted or extracted segments 
quickly. This is especially useful if youÕve performed one or more edits 
since removing the material. In contrast, if you restore the material 
using the Undo function, the system also undoes all edits performed 
in the meantime. The Clipboard provides the beneÞt of restoring the 
material while maintaining subsequent edits.

To restore material from the clipboard:

1. Load the Clipboard contents in one of two ways:

¥ Choose Clipboard Contents from the Source Monitor menu to 
place the contents into the Source monitor and the Monitor 
menu list of clips.

¥ You can also open the Clipboard as a Pop-up monitor by 
choosing Clipboard Monitor from the Tools menu.
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2. Click the Mark Clip button to mark the entire segment.

Optionally, view the sequence segment as a source Timeline by 
clicking the Toggle Source/Record button in the Timeline toolbar 
to mark and select speciÞc tracks.

3. Locate the IN point in the sequence from which the segment was 
removed. Place the position indicator here, or mark an IN.

4. Splice or overwrite the material back into the sequence.

Adding Comments to Sequence Clips

You can add comments to sequence clips to display in the Timeline or 
include in lists that you create, such as an EDL or a cut list.  Comments 
can include such things as instructions for color correction, or for 
adjusting an effect.

To add comments to the sequence:

1. Choose Add Comments from the Monitor menu.  A box appears.
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2. Type your comments into the text box and press return.

n You can display the comments in the Timeline using the Clip Info option in 
the Timeline Fast menu.

Playing the New Sequence

After completing a rough cut, you can play the new sequence to see 
the results of your editing. You can view the sequence in the Record 
monitor or in the Full-Screen monitor.

n If you need to prepare a screening of the current cut away from the system, see 
Chapter 15 for information on preparing a videotape version of the sequence, 
or Chapter 14 for information on preparing a conformed cut or preview reel 
from workprint.

To review your work thus far:

If you have several 
tracks of audio, you 
may need to mix them 
down and adjust levels 
before playback. For 
more information, see 
Chapter 11.

1. Make sure that the picture track monitor icon is located on the 
uppermost picture track in order to display all picture tracks and 
effects during playback.

2. Make sure the audio track monitor icon on the uppermost audio 
track is enabled to ensure proper playback of all audio tracks.

3. Go to the start of the sequence in the Record monitor by clicking 
the left side of the position bar to reposition the position indicator 
at the beginning, or, press the Home key on the keyboard.

4. Use the position indicator, buttons, mouse, or keyboard to play, 
jog, or shuttle through footage.  View the sequence in the Record 
monitor or in the Full-Screen monitor. 
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Starting a Playback Loop

You can play back your sequence in a continuous loop by augmenting 
the Play IN to OUT command with the Control key. You must set 
marks in the sequence to determine the range of the playback loop.  

n You can also use this technique to isolate and continuously play back a small 
portion of the sequence during a difÞcult edit.

To start a playback loop:

1. Place  IN  and OUT marks in the sequence.   If you want to play 
back the entire sequence, place the IN mark at the beginning and 
the OUT mark at the end. 

2. Press the Control key and  the Play IN to OUT key or button.

The playback loop begins and continues until you press the STOP 
key or click anywhere with the mouse.

n You can also press the Control key and the Play to OUT button.  The location 
of the position indicator acts as the IN point for a continuous loop.

Playback Performance Tips 

As you continue to edit, you might Þnd the playback performance of 
the system diminishing as the sequence grows in length and layers.  
This can happen when you are using a great deal of  RAM for play-
back of large and complex sequences.  The following are a few tips for 
improving playback performance:

¥ Check the number of media objects in use for your project in the 
Memory window, as described in the Avid Film Composer Getting 
Started Guide.  If this number is large (more than 50,000 objects on 
a system with 32 MB of RAM, for example), reduce the number of 
media objects by doing one of the following:

- Close bins that are not in use.

control
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- Reduce the number of clips in the open bins.

- Unmount drives that are currently not in use by dragging 
them to the Trash icon.  You can remount the drives at any 
time by choosing Mount All from the File menu.

¥ Restart the computer every few hours to refresh the system mem-
ory.  Frequent opening and closing of Þles, tools, and applications 
can diminish the functional capacity of RAM.

¥ Split the sequence into two or more segments, if possible.

¥ If you cannot split the sequence, limit the length of playback by 
opening the Console, and typing the command PlayLength plus a 
number representing a playback limit in minutes.   

¥ For example, typing PlayLength 5 limits the playback time to Þve 
minutes, after which the system stops.  Press Play again to play 
back the next Þve minutes.

How to Proceed

If you have Þnished a rough cut and are ready to Þne-tune the 
sequence, you can return to Source/Record mode, or you can proceed 
with the following:

¥ To learn about the Timeline and Segment mode editing tech-
niques, see Chapter 9.

¥ To make frame-accurate adjustments to your edits using Trim 
mode, see Chapter 10.

¥ To edit with audio or mix audio tracks in preparation for playback 
or output, see Chapter 11.

¥ To edit with synced tracks, see Chapter 12.

¥ To edit with multicamera material, see Chapter 13.

¥ To add effects to your sequence, see the Avid Media Composer and 
Film Composer Effects Guide.
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CHAPTER 9

Using the Timeline

Film Composer represents each edit and effect in a graphical timeline 
structure to help you track and manipulate the elements of your 
sequence. The Timeline continuously updates as you work, displaying 
an extensive array of icons and information which you can customize 
in various ways.

In addition, the Timeline has its own set of editing tools which you can 
use to create and revise edits and transitions across multiple tracks. 
These features are described in the following sections:

¥ Using Segment Mode

¥ Using Advanced Timeline Techniques

¥ Working with Multiple Tracks

¥ Additional Ofßine Aids

¥ Printing the Timeline

n Illustrations of the Composer window in this chapter show the full set of two 
button rows, two information rows, and Center Duration display, as selected 
in Composer Settings. For more information, see the Avid Film Composer 
Getting Started Guide.
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Using Segment Mode

Segment mode provides editing controls for moving, deleting, mark-
ing, and editing entire segments in the Timeline. A segment is a por-
tion of the sequence that includes two or more transitions. There are 
two modes for editing segments or adding shots: Extract/Splice, indi-
cated by a yellow arrow, and Lift/Overwrite, indicated by a red arrow.

Unlike traditional tape editing, Segment mode allows you to instantly 
reposition entire segments using visual controls as though you were 
physically ÒdraggingÓ portions of your sequence around on a tape. 
You can move shots separately or together, on one track or across 
tracks.

Observe the following guidelines when editing in Segment mode:

¥ Transition effects on either side of a moved selection are deleted. 
Transition effects inside the selection are preserved.

¥ You can track the audio while moving segments by pressing the 
Caps Lock key to enable audio scrub. For more information, see 
ÒUsing Audio ScrubÓ on page 319.

¥ When you are Þnished, Segment mode continues to affect your 
editing in Source/Record mode or Trim mode unless you click the 
active Segment Mode button to deactivate it.

Segment Mode Workflow

The following is the basic workßow for editing segments in Segment 
mode:

¥ Select the segments by clicking with the Segment Mode pointer,  
or by lassoing segments with the mouse, as described in ÒSelect-
ing and Deselecting SegmentsÓ on page 255.

¥ Move, mark, or delete the segments in either Extract/Splice mode 
or Lift/Overwrite mode, as described in ÒPerforming Segment 
Mode EditsÓ on page 257.
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¥ Use Segment mode, if desired, to edit directly from a bin as 
described in ÒBin Editing into the TimelineÓ on page 264.

Selecting and Deselecting Segments

There are two basic methods for selecting segments for moving or 
editing:

¥ Click a Segment Mode button, and select segments with the 
pointer.

¥ Lasso one or more segments on one or more tracks using the 
mouse. 

Once you enter Segment mode using one of these methods, you can 
continue to select or deselect additional segments.  The selected seg-
ment or group of segments becomes highlighted, and remains in its 
original position during the move until you select its new position.

Observe the following guidelines when selecting tracks:

¥ You cannot simultaneously move segments that are separated 
along a track. You can, however,  move segments separated on dif-
ferent tracks.

¥ You cannot overlap the source and destination tracks. For exam-
ple, you can move audio segments from A3 and A4  to A1 and A2, 
but you cannot move them from A3 and A4 to A2 and A3 (A3 
overlaps).

¥ With a group, you can click any one of the selected segments to 
drag the entire group to a new position.

¥ You can select black Þller as a segment.

Selecting with the Segment Mode Pointer

When you enter Segment mode, the cursor becomes an enlarged 
pointer that is yellow to indicate Extract/Splice mode, and red to indi-
cate Lift/Overwrite mode.  Outside of the Timeline, the cursor 
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changes back to the standard arrow or I-beam, allowing you to per-
form other functions while in Segment mode.

To select segments with the pointer:

1. Click one of the Segment Mode buttons located in the Timeline 
toolbar next to the scroll bar. The arrow changes to an enlarged 
pointer.

2. Click a segment in any track to select it. Shift-click additional seg-
ments to select a group.

Lassoing One or More Segments

You can use the mouse to quickly lasso a single segment or a group of 
segments across one or more tracks.

To lasso segments, draw a lasso beginning in the area above the tracks 
in the Timeline. Drag left to right and down to select more than one 
transition.

Extract/Splice Segment mode is enabled by default when you 
draw a lasso. To switch to Lift/Overwrite mode, click the Over-
write button after drawing the lasso.

Observe the following guidelines when lassoing segments:

¥ Be sure to position the cursor above the tracks before dragging. If 
you click within the tracks, you simply relocate the position indi-
cator to that position. To lasso segments in the middle of the Time-
line between multiple tracks, hold the Control key while you click 
and drag.

To select, drag a lasso from left to right and down
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¥ Be sure to lasso at least two transitions, or all transitions included 
in multiple segments. If your lasso surrounds only one transition, 
you enter Trim mode. 

¥ Be sure to drag from left to right. If you drag from right to left, you 
enter Trim mode with slip rollers selected.

Deselecting Segments

To deselect one or more selected segments, do one of the following:

¥ To deselect an entire track, click the track selector. For example, if 
you lasso segments on V1, V2, and A1, you can click the V2 and 
A1 track selectors to leave only the segment on the middle 
track, V1, selected, as shown.

¥ Use the Shift key and the Segment Mode pointer to deselect spe-
ciÞc segments on any track, leaving the remaining tracks selected.

Performing Segment Mode Edits

Once youÕve selected one or more segments and entered Segment 
mode, you can reposition the segments by clicking and dragging with 
the Segment Mode pointer.  You can also delete or mark the segments 
in one step.

Tracks V2, A1 deselected

Only the segment on V1 
remains highlighted
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n You cannot overlap the source and destination tracks. For example, you can 
move audio segments from A3 and A4  to A1 and A2, but you cannot move 
them from A3 and A4 to A2 and A3 (A3 overlaps).

About Four-Frame Display

When you begin to drag the segments, the interface changes to the 
Segment mode four-frame display:

¥ The Source/Record monitors change to a four-frame monitor dis-
play. The two outer frames are updated while you drag the seg-
ment forward and/or backward in the Timeline, indicating the 
frames you pass as you drag the segment. The outer two frames in 
the four-frame display make it easy to view and analyze the 
frames between which you may want to drop the selected seg-
ment.

¥ A centered numeric offset counter appears directly below the 
frame monitors. The counter tracks the number of feet+frames you 
move while you drag the selected segment from its starting point.
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When you drag the segments, the original highlighted segment 
remains in place, while a ÒghostÓ segment enclosed in a dotted white 
box moves along with the pointer until you release it at a new edit 
point.

The two inner frames represent the 
start and end frame of the segment

The two outer frames indicate end-
ing and beginning frames of shots 
before and after the segment
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When you release the segment into its new position, the actual lift 
(Overwrite) or extract (Splice) occurs. The preservation of the segment 
position in the Timeline until then allows you to maintain your per-
spective of the sequence while selecting the new edit point.

Suppressing Four-Frame Display

The four-frame display of incoming/outgoing frames can occasionally 
slow the movement of segments as you drag them through the 
sequence. You can improve the speed of segment editing by using the 
Shift key to suppress the four-frame display.

To suppress the four-frame display:

1. Click either the Extract/Splice button (yellow) or Lift/Overwrite 
button (red) to enter Segment mode.

2. Press the Shift key, then click and drag the segments you wish to 
move.

As you begin to drag, notice that the monitors maintain their 
Source/Record conÞguration, rather than shifting to the four-
frame display. This will remain the default display in Segment 
mode until you repeat the Shift key procedure.

Selected segment is dragged to new position
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Extracting/Splicing Segments

Use Extract/Splice to move the selected segments in the Timeline 
without affecting any of the adjacent material. The total duration of 
the sequence is unaffected.

Like the standard Splice function, the Extract/Splice edit inserts the 
segment into the new position. However, as an additional function, it 
also ÒextractsÓ or removes the segment from its previous position and 
closes the gap.

To perform an Extract/Splice:

1. Click the Extract/Splice button (yellow) in the Timeline toolbar.

2. Select the segments you want to move.

3. Click and drag the segment to its new position. Use the four-frame 
monitor display, the offset counter, and the segment image in the 
Timeline to carefully determine the new position.

4. Release the mouse button. extracts the selected segment from its 
old position, closes the gap left by its removal, then splices the 
material back into the sequence at the newly selected location.

5. Click the Segment Mode button again if you want to leave Seg-
ment mode, or continue to lift and overwrite segments.

n To cancel a segment edit in progress, drag the edit to the four-frame monitor 
display and release the mouse. Alternatively, choose Undo from the Edit 
menu.

Lifting/Overwriting Segments

Use Lift/Overwrite to replace existing material at the new position, 
while leaving blank space in the previous position. The total duration 
of the sequence is unaffected.

Like the standard Overwrite function, the Lift/Overwrite edit deletes 
and replaces underlying material at the new position, effectively creat-
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ing new edits. As an additional function, it also ÒliftsÓ the segments 
from the previous position, leaving black or silence of the same dura-
tion.

To perform a Lift/Overwrite:

1. Click the Lift/Overwrite button (red) in the Timeline toolbar.

2. Select the segments you want to move.

3. Click and drag the segment to its new position. Use the four-frame 
monitor display, the offset counter, and the segment image in the 
Timeline to determine the new position carefully.

4. Release the mouse button. 

lifts the selected segment from its old position, leaving black, then 
overwrites the material onto the sequence at the newly selected 
location.

5. Click the Segment Mode button again if you want to leave Seg-
ment mode, or continue to lift and overwrite segments.

n To cancel a segment move, drag the edit to the four-frame monitor display and 
release the mouse. Alternatively, choose Undo from the Edit menu.

Deleting Segments with Segment Mode

Segment mode allows you to delete whole segments in the Timeline 
quickly without having to mark IN and OUT points Þrst. In addition, 
you can select multiple segments in separate tracks anywhere along 
the Timeline to delete at once.

To delete segments quickly:

1. Click one of the Segment Mode buttons:

¥ Click Extract/Splice (yellow) to delete the segments and close 
the remaining gaps. The total duration of the sequence is 
shortened, and any synchronized tracks lose sync.
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¥ Click Lift/Overwrite (red) to delete the segments but leave 
blank space or silence in their place. The total duration of the 
sequence remains the same, and sync is maintained.

2. Select one or multiple segments.

3. Press the Delete key. The segments are deleted.

Marking Clips and Sequences with Segment Mode

As an alternative procedure to marking sections of the Timeline in 
Source/Record mode for deleting, copying, subclipping, rendering, or 
creating  an EDL or digital cut, you can use Segment mode to mark 
segments quickly, as follows:

1. Click one of the Segment Mode buttons. In this case it does not 
matter which Segment Mode button you click.

2. Click one or more segments to highlight the desired section of the 
sequence.

3. Click the Mark Clip button.

The system marks an IN point at the start and an OUT point at the 
end of the selected segments. If you have more than one track 
selected, the IN and OUT points mark where the edit points across 
tracks line up.

IN point OUT point
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Using Advanced Timeline Techniques

There are several advanced techniques for displaying and editing in 
the Timeline that you can use in any combination, including:

¥ Editing directly from a bin

¥ Cutting, copying, and pasting

¥ Full-screen editing

¥ Editing with the Film track

¥ Editing in Heads and Tails view

Bin Editing into the Timeline

For information on edit-
ing multiple clips 
directly from the bin 
into the Record monitor, 
see ÒCreating an 
Instant Rough CutÓ on 
page 238.

You can use Segment mode to edit clips directly from a bin into the 
sequence in the Timeline.  Bin editing allows you to bypass the process 
of loading clips into the Source monitor, setting marks, and clicking 
the Splice or Overwrite buttons.

To perform a direct edit from a bin into your Timeline:

1. For a more accurate edit, mark IN and OUT points for each clip or 
create subclips, as described in the Film Composer Getting Started 
Guide.  Otherwise, the entire clip is edited into the sequence.

2. Click one of the Segment Mode buttons:

¥ Lift/Overwrite (red arrow) acts as an overwrite edit, causing 
the clip to overwrite material of the same length in the 
sequence, while maintaining the same duration of the 
sequence.

¥ Extract/Splice (yellow arrow) acts as a splice edit, inserting 
the clip into the sequence, moving existing material down, 
and lengthening the total duration.

3. Drag a clip from the bin into the Timeline.  You can only edit one 
clip at a time.



265

The cursor changes to the selected Segment mode icon, and the 
interface changes to the four-frame monitor display.  In this case, 
the numeric offset frame counter displays zero since there is no 
offset.  As you drag, a white outline of the clip indicates the seg-
ment position.  

4. When you Þnd the right placement for the clip, release the mouse 
button.  The Timeline reßects the new edit.

n Once the edit is completed, you remain in Segment mode until you click the 
active Segment Mode button again to deactivate it.

Cut, Copy, and Paste in the Timeline

You can use the traditional Macintosh shortcut keys for cutting, copy-
ing, and pasting segments selected in the Timeline.

To cut, or copy:

1. Select the segment using one of the Segment mode pointers.

2. Press kÐC to copy, or kÐX to cut.

3. Place the position indicator at the new IN point, and press kÐV to 
paste the segment in.

Using Full-Screen Timeline

As an alternative to constantly scrolling through the Timeline window 
or resizing tracks to get a view of the material, you can resize the Time-
line window to full-screen display.

To resize the Timeline window, click the Zoom button at the upper 
right corner of the window.
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Notice that a Timeline with reduced tracks wraps around to show 
more of the sequence. As you reduce tracks in a full-screen Timeline, 
the sequence wraps around up to four times, allowing you to examine 
a long sequence in greater horizontal detail.

Zoom button
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You can also enlarge the tracks to view complex audio or picture lay-
ers in greater vertical detail. To enlarge tracks, select them and press 
kÐL.



268

With the proper controls mapped to the keyboard and a Full-Screen 
monitor connected to your system, you can edit with a full-screen 
Timeline for long periods.

You can also continue to work in Source/Record mode by resizing the 
Timeline window so that the two windows overlap.

You can click on either window to activate it and bring it forward at 
any time. Or you can click on the title bar of the Timeline window and 
drag it to the Bin monitor to place each window in its own monitor.

To restore a resized Timeline to its default position,  choose Home 
from the Windows menu.

Editing with the Film Track

You can use the Þlm track to examine each frame of the sequence in a 
linear display, much as you would when looking at a strand of Þlm on 
a ßatbed or workbench.  Unlike your view of the footage in the moni-
tors, which display one frame at a time, the Þlm track within the Time-
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line allows you to compare individual frames side by side within a 
range of frames.

To display the Þlm track, select Film from the Show Track submenu of 
the Timeline Fast menu.

A row of Þlm frames appears at the top of the Timeline.

To adjust your view of the Timeline  quickly for frame-by-frame view-
ing and editing, select Show Every Frame from the Timeline Fast 
menu.

Show Every Frame 
Option

Film track option
in the Show Track 
submenu

The film track displays as many representa-
tive frames as possible within the window.
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n The Þlm track displays frames for the topmost picture track only. You cannot 
display more than one Þlm track at a time.

When you play a sequence with the Show Every Frame option 
selected, the Timeline does not scroll automatically to keep time with 
the playback in the monitors. You must scroll through a Þlm track 
manually by clicking the left or right arrow in the Timeline scroll bar.

To quickly view more frames as you scroll, click the resize button in 
the upper right corner of the Timeline for a full-screen view. You can 
reduce the size of Timeline tracks to wrap the sequence around several 
times.

The position indicator splits to surround each 
frame. The solid blue bar indicates the head, and 
the shadow bar indicates the tail of each frame.
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As you continue to scroll, each strand of the timeline wraparound is 
updated.

Editing in Heads/Tails View

While in the early stages of editing a project, you can easily rearrange 
shots in the sequence visually using Heads View or Heads and Tails 
View.  These display formats are useful for quickly rearranging simple 
straight-cut edits. 
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c If you rearrange a split edit (in which the audio extends beyond the 
video, or the reverse) the system cuts all tracks to the same edit 
point. To rearrange split edits, edits on multiple picture tracks, or to 
move audio and videopicture separately, use Segment mode editing 
techniques described in ÒUsing Segment ModeÓ on page 254.

To edit in Heads view or Heads and Tails view:

1. Choose View Type from the Timeline Fast menu, then choose 
Heads, or Heads and Tails, from the submenu.

The Timeline changes to one of the following displays.

2. Click the record track lights to select the tracks to be edited.

3. Hold down the Option key, click the frames representing the shot 
you want to move, and drag the shot to its new position. The 
sequence is rearranged to match the changes you made.

Head frame for each clip

Head and Tail frame for each clip

Heads view

Heads and 
Tails view
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Working with Multiple Tracks

As your project progresses, you may need to add and edit with addi-
tional audio or picture tracks. The Film Composer system allows you 
to edit up to 4 tracks of picture and 24 tracks of audio. In addition, you 
can step into tracks to create additional tracks for nested effects.

While working with multiple tracks, you can use the Track Selector 
panel to select, manipulate, delete, lock, patch, and monitor your 
tracks. You can use multiple tracks to layer audio effects and sound, 
or to add video titles and other effects, as described in this section.

n Multiple picture tracks do not immediately play back at the same time until 
you apply an appropriate effect that composites the layers. Multiple audio lay-
ers, however, do play back immediately if correctly monitored.

About Effects Editing

Your primary use for multiple tracks of picture is in the use of effects. 
Effects editing techniques in Film Composer fall roughly into the fol-
lowing categories:

¥ Motion effects, such as freeze-frame and slow- or fast-motion 
effects, involve applying frame-motion parameters to selected 
footage, usually on a single picture track.

¥ Transition effects, such as dissolves and wipes, involve transition-
ing from one edited clip to another on the same picture track. 

¥ Segment effects, such as picture-in-picture, keys, or color effects, are 
applied to whole segments. These often require multiple layers of 
video.

In addition, Film Composer provides several effects based on parame-
ters that match Þlm industry standards. These effects are speciÞcally 
designed to capture the ÒÞlm look, Ó and include the superimposition 
effect in the Blend Effects menu, as well as any selection in the Film 
Effects menu.
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All effects in Film Composer are custom made to match existing stan-
dards for preparing Þlm opticals, and can be sent to any professional 
lab for preparing effects.

c If you are creating a 30 fps project in Media Composer with plans to 
match back to create a Þlm cut list, be sure to limit your use of tracks 
and effects to Þlm standards, or conform the effects after making a 
copy of the sequence and prior to generating the list.

n For more information on all types of effects editing, see the Avid Media Com-
poser and Film Composer Effects Guide.

About Nesting

Occasionally, effects editing involves a unique procedure known as 
nesting. This involves stepping into existing tracks to reveal added lay-
ers for combining multiple images and digital video effects. When the 
effect is applied, you can step out to view and render the effect as one 
segment on the track.

Film Composer limits you to four nested layers, so that you can output 
cutlists that match existing standards for layering of effects in opticals.

n For more information on nesting techniques, see the Avid Media Composer 
and Film Composer Effects Guide.

Film effects
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Using the Track Selector Panel

The Track Selector panel provides numerous controls for working 
effectively with multiple tracks. With this one resource you can select, 
delete, monitor, enlarge, reduce, lock, patch, and move any picture or 
audio track.

The Track Selector panel also provides a quick display of track infor-
mation. You can see which tracks are available, active, patched, moni-
tored, or locked on the source and/or record side at any time. The 
conÞguration shown below is just one example. The Track Selector 
panel may look very different depending on the nature of the source 
material or the work underway in the sequence.

The Source side of the panel displays only those tracks available for 
the clip currently loaded and displayed in the Source monitor. For 
instance, a clip that has audio digitized for track A1 only does not dis-
play an A2 track in the Track Selector panel.

The Record side of the panel displays only those tracks currently in 
use for the sequence. However, if you edit source material with a track 
selected that does not yet exist on the Record side (A3 or V2, in the 
previous example), by default the track appears on the Record side 
after the edit takes place.

Source track monitors
Source tracks
Track lock indicators
Record tracks
Record track monitors

Timecode track
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Selecting Tracks

You can select tracks on either the record side or the source side as fol-
lows:

¥ You can edit selected tracks on the source side directly into the 
sequence, assuming you have selected parallel tracks on the 
record side.

¥ You cannot edit deselected tracks on the source side into the 
sequence, regardless of record track selections.

¥ You cannot edit deselected tracks on the record side, regardless of 
Source track selections.

There are four methods for selecting tracks:

¥ Click any deactivated track to select it. Click any activated track to 
deselect it.

¥ Drag a lasso around multiple tracks to select them at once.

¥ With the Timeline window active, choose Select All Tracks from 
the Edit menu to select all tracks on the record and source side.

¥ Click the  Cycle Tracks button to cycle among selection of the pic-
ture tracks, the audio tracks, and all tracks.

For example, you might select the source and record tracks for V1, A1, 
and A2 to edit picture and audio from the source clip into the 
sequence. Select only V1 source and record tracks to edit the picture 
without sound. Or, select only A1 and A2 to edit the sound without the 
picture.

n There are also keyboard equivalents for selecting tracks. Check your keyboard 
or the Keyboard settings in the Project Window Settings scroll list.
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Monitoring Tracks

You determine the monitoring of tracks by clicking the monitor col-
umn of either the source- or record-side tracks to activate or deactivate 
the monitor icons. Picture monitors and Audio monitors behave differ-
ently in some circumstances, as described in this section.

Monitoring Video

The picture track monitor determines whether you see picture during 
playback. You can turn it off at any time to monitor only audio during 
editing. When there are multiple picture tracks, all tracks below the 
monitored track are active during playback.

When you edit with multiple tracks, you can activate the monitor on a 
lower track to monitor only the picture on that track. This is especially 
useful when you have multiple layers of video effects, and need to see 
one track without the additional layers.

n If you reposition the picture monitor, be sure to return it to the topmost track 
to view, render, or record all the tracks together. Unmonitored tracks are not 
included in playback.

Video track monitor

Audio track monitor
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Monitoring Audio

Film Composer allows you to monitor up to eight audio tracks at a 
time.

  The following characteristics apply to audio track monitoring:

¥ The system pans odd-numbered tracks to the left speaker, and 
even-numbered tracks to the right by default.

¥ If your sequence includes more than eight audio tracks, you can 
select any eight tracks to monitor at any  one time by clicking in 
the monitor column of the track panel to display speaker icons in 
the chosen tracks.

¥ To hear more than eight tracks at once, you must mix some of 
them down to a maximum of eight.  For more information, see 
ÒMixing Down Audio TracksÓ on page 360.

¥ The presence of a speaker icon (either solid or hollow) indicates 
that the tracks are monitored for playback and output.  However, 
only the track with the hollow icon is monitored for audio scrub-
bing.

¥ The topmost audio track displays the hollow scrub icon by default 
until you select another track for scrubbing.  To activate audio 
scrub for a particular track, Option-click in the monitor column.  
For more information, see ÒUsing Audio ScrubÓ on page 319.

8 monitored tracks
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¥ When you select Direct Out in the Audio Mix tool, tracks 5 
through 8 play back on channels 1 through 4.  You can also cus-
tomize the output of the tracks, as described in ÒUsing the Audio 
Mix ToolÓ on page 327.

Solo Track Monitoring

You can use the k key to quickly select an individual picture or audio 
track for monitoring during editing.

¥ To select a track for solo monitoring, press the k key and click in 
the monitor column for the chosen track. The monitor icon is high-
lighted in green to indicate solo monitoring.

¥ To deselect solo monitoring, press the k key and click again in the 
monitor column. The monitor icons return to normal functionality.

Solo monitoring provides several advantages:

¥ You can overcome slowed playback and cuing when working with 
a complex sequence by isolating tracks for monitoring.

¥ You can quickly isolate an individual audio track without having 
to click several times in the monitor column to deselect all other 
tracks.

¥ You can monitor the upper layers of a composited effect apart 
from the lower layers.

Video track 
selected for solo 
monitoring

Audio track 
selected for solo 
monitoring
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Patching Tracks

When working with multiple tracks, you occasionally encounter a cir-
cumstance where you must edit source audio or picture onto a track 
other than the parallel track displayed in the Track Selector panel. To 
edit the source material onto another record track above or below it, 
you must patch the source track to the targeted record track.

You can perform only one patch per edit, but there is no limit on the 
number of times you can patch from the same source track. Audio can 
only patch to audio, and picture to video.

¥ To perform a patch, drag from a source track (audio or video) to 
the targeted record track (a white arrow appears during the 
patch).

The screen on the 
left shows a multi-
track matte key effect 
with the upper track 
selected for normal 
monitoring.

The screen on the 
right shows the same 
effect with the upper 
track selected for 
solo monitoring.

An audio patch 
from a source 
track to a record 
track

New source 
track order 
identifies the 
patch

During Patch After Patch
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¥ To undo a patch, click directly in the Record monitor, then select 
the Restore Default Patch command from the Special menu, or, 
you can manually repatch to the previous track.

The selected source track moves beside the record track to which it is 
patched as soon as you draw the arrow and release the mouse. The 
patched track remains highlighted in preparation for your edit. You 
can proceed to select any other tracks required for the edit.

After you make the edit, you can continue to work on the same track 
or patch to a different track as necessary.

c When patching from one picture track to another, the picture track 
monitor icon moves to the track you patch to. Be sure to return the 
icon to the topmost track when necessary to play back and output all 
picture tracks.

Locking and Sync-Locking Tracks

The system provides two ways of locking tracks:

¥ You can lock selected tracks to prevent further editing from being 
performed on them. 

¥ You can sync-lock selected tracks, so that when you trim one track, 
the other track follows.

The middle row of the Track Selector panel displays a slash mark icon 
for sync-locked tracks, and a padlock icon for locked tracks. The pro-
cedure for applying the locks is different in each case.

Slash icon indicates sync-locked tracks

Padlock icon indicates locked tracks
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Locking Tracks

Locking tracks to prevent further editing is especially useful in circum-
stances like the following:

¥ For picture editing, you can lock tracks when you have completed 
a set of complex, multilayer edits and want to avoid making acci-
dental changes while you work on other adjacent tracks.

¥ For audio editing, you can lock audio tracks that contain sync dia-
log that should be maintained while you edit on adjacent picture 
tracks or audio tracks. 

¥ For projects involving multiple editors, you can lock tracks to pre-
vent unnecessary or accidental changes.

To lock tracks:

1. Select the tracks to be locked (Source and/or Record) by clicking 
to select each in turn. 

2. Choose Lock Tracks from the Clip menu. The padlock icon indi-
cates that the selected tracks are locked.

No further editing can occur on locked tracks until you choose 
Unlock Tracks from the Clip menu.

Sync-Locking Tracks

For more information 
on using the sync-lock 
feature in Trim mode, 
see ÒUsing Sync LockÓ 
on page 371.

Sync-locking affects Trim mode only. This feature is especially useful 
when you are working with multiple tracks and want to maintain sync 
between two or more tracks while trimming.

To sync-lock the tracks, click in the center column between track selec-
tors to activate the slash mark icon for each synchronized track. When 
you need to resume editing on individual tracks, click again to remove 
the slash marks.
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Adding a Track

For information on dis-
playing or hiding exist-
ing tracks, including 
timecode and edgecode 
tracks, see the Film Com-
poser Getting Started 
Guide.

To add a new track to a sequence, do one of the following:

¥ With a sequence loaded in the Record monitor, choose New Audio 
Track or New Picture Track from the Clip menu. 

The new track appears in the Timeline.

¥ If you want to manage the numbering scheme of tracks rather than 
use the consecutive numbering default:

a. Hold down the Option key and choose New Audio Track or 
New Picture Track from the Clip menu. A dialog box appears.

b. If you want to switch from the type of new track you chose 
(for example, from a new picture to a new audio track), click 
the track type pop-up menu and select the other option.

c. If you want to select a track number other than the default 
consecutive numbering offered by the dialog box, click the 
track number pop-up menu and choose another number. You 
cannot choose the number of an existing track.

d. Click OK. The new track appears in the Timeline and in the 
Track Selector panel.

Deleting Tracks

You can remove one or more tracks from a sequence if you no longer 
need the tracks.

Track type pop-up menu

Track number pop-up menu
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To delete one or more tracks from the sequence:

1. Click the record-side track selector for the tracks, and press the 
Delete key. A dialog box appears.

2. Click OK. The tracks are deleted.

When you delete a track, it is permanently removed. If you want to 
remove the track temporarily,  hide the tracks as described in the Avid 
Film Composer Getting Started Guide.

Adding an Edit (Match Framing)

The Add Edit function places an artiÞcial edit point between frames of 
a clip. In other words, the edit appears in the Timeline as a transition 
between two clips, but when you play the clip the footage appears 
unchanged because the frames are continuous.

This form of edit is also known as a match frame. In traditional analog 
editing, match framing is used to accomplish speciÞc tasks, such as 
creating a dissolve between two shots.  In Film Composer, however, 

1 2 3 4 6 75

Add edit placed between frames

Footage continues to play back fluidly
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add edits (or match frames) function differently. Use match frames pri-
marily to divide and isolate portions of a clip or sequence in order to 
modify that portion without affecting the rest of the footage. Once you 
make the adjustment, playback of the clip is no longer seamless 
because the two portions of the clip are different.

You can add an edit to a single audio or picture track, or you can place 
the add edit across several tracks at once.

To add a match-frame edit:

1. Place the position indicator at the chosen frame. 

2. Select the tracks where you want to add the edit.

3. Click the Add Edit button. The edit appears in the sequence, with 
an equal sign to indicate a match frame.

Removing Match-Frame Edits

You can also remove 
individual match 
frames by selecting 
them in Trim mode and 
pressing the Delete key. 
For more information 
on Trim mode, see 
Chapter 10.

If you make a mistake when adding an edit, or if you have Þnished 
performing edit functions with multiple add edits and want to remove 
them, you can remove all add edits in the entire sequence, or within a 
selected portion of the sequence.

To remove match-frame edits:

1. Select the entire sequence or a portion as follows:

¥ Select a portion of the sequence by marking an IN point and 
an OUT point surrounding the match-frame edits (add edits)  
you want to remove.

Equal sign indicates 
a match frame
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¥ Select the entire sequence by removing any IN and/or OUT 
points.

2. Select the tracks from which you want to remove the edits.

3. Choose Remove Match Frame Edits from the Clip menu.

Film Composer removes the edits.

c You cannot remove match-frame edits between segments in which 
audio pan levels have been adjusted.

Backtiming Edits

Backtiming an edit is effectively the reverse of the process you nor-
mally use for marking footage: instead of marking from the IN points 
forward, you mark according to the OUT points.

For example, you might have a track of audio (music or voice) that 
ends at a speciÞc point, and you want to synchronize a picture clip to 
end on a particular shot. You can back time the edit to match the end 
points of the tracks. 

Here are a few concepts to keep in mind:

¥ Film Composer needs only three marks to perform a backtimed 
edit when four edits of unequal duration exist in the sequence. 
The IN and OUT points set on the record side always take prece-
dence.

¥ If you do not mark an IN point in the sequence, Film Composer 
uses the position indicator as the IN point.

¥ If you do not mark an OUT point in the clip, Film Composer uses 
the end of the clip as the OUT point.

¥ If you mark OUT points in both the Source monitor and in the 
Record monitor, Film Composer uses the OUT point on the record 
side.
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To backtime an edit:

1. Mark an OUT in the sequence where you want the edit to end. 
Also mark an IN where the edit is to start.

2. Select the appropriate tracks.

3. Load the clip into the Source monitor.

4. Mark an OUT point in the Source monitor to synchronize to the 
Out point in the sequence.

5. Click the Overwrite button. 

The source material is added to the sequence, with the synchro-
nized ending.

Creating One-Step Overlap Edits

For more information 
on creating overlap 
edits in Trim mode, see 
ÒCreating Overlap 
EditsÓ on page 305.

You can quickly create an overlap edit (also known as an  L-cut or 
delay edit) at the end of a sequence by using the Option key while per-
forming an overwrite edit.

To perform a one-step overlap cut:

1. Move the position indicator to the edit point before the end of the 
sequence.

2. Choose record tracks for overlapping either the picture or the 
audio:

¥ To extend the picture beyond the audio, select the audio 
tracks.
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¥ To extend the audio beyond the video, click the picture tracks.

3. Press the Option key while you click the Overwrite (red) but-
ton.

The overlap edit is complete.

Additional Offline Aids

Film Composer provides two features speciÞcally designed to aid the 
ofßine editing process by helping you track and adjust edits to avoid 
extra work in the online suite. These features are Dupe Detection and 
Color Frame tracking.

V1

A1

A2

Position indicator

Before edit

V1 V1

A1 A1

A2A2

V1

A1

A2

After edit

New

New

New

Track Selectors 

Overlapping the video
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A2
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A1 A1

A2A2

V1
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Track Selectors

Overlapping the audio
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Detecting Duplicate Frames

When editing ofßine with plans to generate an EDL, Dupe Detection 
feature allows you to visually track duplicate frames of footage as you 
edit so that you can eliminate or manage the requirements of an online 
dupe reel.

When you activate Dupe Detection, each set of duplicate frames is 
tagged with a different color. (Up to ten color sets can be distinguished 
during a single detection process.) Matching frames have matching 
colors. If the duplicate frames are unnecessary, you can use any of the 
Trim mode options to remove the superßuous frames prior to generat-
ing an EDL. 

The colored bars that distinguish duplicate frames in the sequence are 
automatically drawn above the frames in the Timeline, as shown.

Red  bars mark the Þrst set of duplicate frames; green bars mark the 
second set, and so on. You can use Dupe Detection while you are edit-
ing to locate duplicate frames in order to remove them as the sequence 
evolves. 

To activate Dupe Detection, choose Dupe Detection from the Timeline 
Fast menu.

Two duplicate frames marked above the clip by the auto-
matic Dupe Detection option

Timeline’s 
Fast menu button
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Dupe Detection is instantaneous and retroactive; if duplicate 
frames already exist in your sequence, the colored bars appear 
immediately. As you edit, the system shows duplicate frames as 
they occur.

c The Film Composer system may mark a special effect optical (such 
as a superimposition) as a duplicate frame. Double-check your 
sequence for this possibility before deleting frames.

Tracking Color Frame Shifts

If you are preparing for an online edit using 1-inch reel-to-reel sources, 
you can enable the Color Framing option to track and correct instances 
where an edit cuts between the four Þelds (two frames) required to lay 
down a complete NTSC color sync signal phase. 

When Color Framing is enabled, green bars appear beneath the Over-
write and Splice edit buttons and blink whenever a color sync signal is 
interrupted by an edit. The blinking lights indicate that color framing 
is out of phase at the edit transition.
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Use the following procedure to enable Color Framing while editing:

1. Click the Settings button in the Project window, then double-click 
Composer Settings in the projectÕs settings list.

The Composer Window Settings dialog box appears.

2. Click the Color Framing pop-up menu and choose the appropriate 
option:

¥ For NTSC video, choose the 4-Þeld option

¥ For PAL video, choose the 8-Þeld option

The dialog box displays the setting you selected. 

3. Click OK to complete the setting selection.

To correct color frame interruption as you edit:

1. Note any edits that cause the green lights to blink below the edit 
buttons. You can adjust the edits now, or place locators to return to 
these edits and correct them at a future time. 

2. To adjust the edit, enter Trim mode.

Start Frame color phase indicator

End Frame color phase indicator

Green color frame phase bars 
blink during an interruption

Color Framing 
option



292

In Trim mode,  the Composer system displays small green boxes 
on the top-adjacent frame corners. When the color sync signals are 
in phase, the boxes are aligned horizontally.

3.  Trim one frame at a time on one side of the transition or the other 
until the indicator boxes are aligned, and the indicator lights 
below the Splice and Overwrite buttons stop blinking. 

If you are careful about color framing while editing, you will not need 
to consider the subject again when assembling your master tape. If 
you ignore color framing during the edit session, you may have to 
make adjustments during online editing if your edits interrupted any 
color-frame Þelds in the sequence.

Printing the Timeline

To print the Timeline:

1. Choose Print Timeline from the File menu.  The print dialog box 
appears.

Incoming frame Outgoing frame

Color Framing Indicator Lights

Boxes are out of alignment when color 
sync signal is out of phase
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2. Select printing options, then click Print.

The system prints the current view of the Timeline. You can also 
use the Print Timeline command to print the Timeline in Heads 
view or in Heads and Tails view.

The name of the printer and details of the dialog 
box will vary, depending upon facilities.



294

CHAPTER 10

Working in Trim Mode

Basic editing in Source/Record mode and in the Timeline initially pro-
duces a rough cut, which can be loosely deÞned as a series of straight-
cut edits with many rough edges and few effects. After creating a 
rough cut, you can enter Trim mode and Þne-tune the transitions 
between each shot or between whole segments. You can also trim edits 
as you build a sequence, rather than creating a rough cut Þrst. Trim 
mode procedures are described in the following sections:

¥ Basic Trim Procedures

¥ Creating Overlap Edits

¥ Extending an Edit

¥ Slipping or Sliding Shots

¥ Maintaining Sync While Trimming

¥ Using the Transition Corner Display
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Basic Trim Procedures

For illustrations of the 
various types of trim 
edits you can perform 
in Trim mode, see the 
Avid Media Composer 
and Film Composer 
Quick Reference.

You can enter Trim mode in several different ways, depending on the 
type of trim you expect to perform. Once in Trim mode you can:

¥ Select additional tracks 

¥ Toggle between Big and Small Trim mode

¥ Toggle between trim sides

¥ Perform and play back the trim

Entering Trim Mode

There are four alternative methods for entering Trim mode:

¥ Click the Trim Mode button. By default the system enters Trim 
mode and selects the tracks nearest the position indicator for dual-
roller trimming. This method is useful for selecting straight-cut 
transitions on one track or across video and audio tracks.

When you deselect one or more tracks in the Track Selector panel, 
by default only the transitions in the highlighted tracks are 
selected for trimming. If the transitions are not straight cuts (over-
lap cuts or L-edits), the system highlights the topmost track near-
est the position indicator.

¥ Lasso the transitions in the Timeline. Draw the lasso by clicking 
at a point above the top track in the Timeline and dragging to sur-
round the transitions. This method is useful when you need to 

Default Trim mode selection
for a straight cut
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select multiple transitions staggered across parallel tracks (overlap 
cuts) for simultaneous trimming.

You can drag from right to left, or left to right, and you can lasso 
single transitions across several contiguous tracks. However, 
avoid lassoing more than one transition on a single track, because 
this activates Segment mode.

n If you want to select transitions located below several track layers, you can 
draw a lasso within the Timeline by pressing the Control key while you drag.

¥ Press the Enter Trim at Previous or Next Transition buttons. By 
default the system selects the nearest transition in either direction 
of the selected track for dual-roller trimming. 

If the transition is a straight cut, the system selects all edited 
tracks. If the transition is an overlap edit, with staggered transition 
points, the system selects the topmost track.

¥ Enter Trim mode in a playback loop by clicking the Review 
Transition button on a palette or the keyboard.

This is useful if you like to trim quickly as you edit, going back 
and forth between Trim mode and other edit modes. This method 
is described in ÒTrimming During a Playback LoopÓ on page 304.

Lasso drawn across three tracks

Transitions are selected for dual-roller trim
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n The Review Transition button does not appear in Source/Record mode by 
default. You must map it to the keyboard or a palette in advance.  For infor-
mation on button mapping, see the Avid Film Composer Getting Started 
Guide.

Exiting Trim Mode

You can exit Trim mode at any time in one of several ways:

¥ Click the Source/Record Mode or the Effects Mode button.

¥ Press the Escape key on the keyboard to enter Source/Record 
mode by default.

¥ Click a speciÞc location in the Timecode (TC1) track at the bottom 
of the Timeline to exit Trim mode.   The position indicator moves 
to that location.

Toggling Between Big and Small Trim Mode

When you click the Trim Mode button, by default the system enters 
Big Trim mode. If you click the Trim Mode button again, the interface 
toggles between Big and Small Trim mode. This feature has the fol-
lowing uses:

esc

Click in the TC track at a 
selected location

The system exits to Source/Record 
mode, and relocates the position 
indicator



298

¥ If you prefer the display of Small Trim mode, but need quick 
access to the Playback Duration controls from time to time, you 
can perform most of your work in Small Trim mode. Whenever 
you need the controls, click the Trim Mode button. This saves you 
the extra step of opening the Trim Settings dialog box each time.

¥ If you prefer the larger monitors and controls of Big Trim mode, 
select this as the default. When you need to use the Monitor 
menus to switch between sequences, or have occasion to edit 
source material into the sequence, you can click the Trim Mode 
button to enable Small Trim mode, which includes the Source 
monitor controls.

Selecting Between Trim Sides

There are three ways to select sides of a transition to trim:

¥ In Big or Small Trim mode display, click the outgoing (A-side) or 
incoming (B-side) monitor to deÞne which side of the transition to 
trim. Notice that the pointer changes to a single-roller A-side, sin-
gle-roller B-side, or double-roller icon depending on position.

¥ You can also use the Trim-side keys on the default keyboard (or 
map them onto one of the monitor palettes while in Trim mode) to 
select side A, side B, or both.

¥ You can use the  Cycle Trim Sides button to cycle between selec-
tion of the A side, B side, or both.

The selected parts of the transition are highlighted, and the corre-
sponding rollers appear in the Timeline. Also, one or both of the 
frame counter indicators below the monitors are highlighted to 
reßect the active trim sides: A side, B side, or both.

A side B side A and B

A side
A and B

B side

Highlight indicates

A side B side

Active sides
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Selecting Additional Transitions

While in Trim mode, there are several ways to select additional transi-
tions for trimming in different contexts:

¥ To quickly select additional transitions on contiguous tracks for 
trimming on the same side, click the corresponding record-side 
track selectors in the Track Selector panel. For example, if you 
select a single transition in track V1 for single-roller A-side trim-
ming, and want to add A1 and A2 tracks at the same transition, 
click the corresponding track selectors.

Likewise, you can deselect tracks in the track panel to remove 
transitions on those tracks from the trim procedure.

¥ To select additional transitions for single-roller trimming in vary-
ing locations on different tracks, Shift-click the transitions in the 
Timeline. This method is useful when you are working with stag-
gered transitions across multiple tracks; it also allows you to select 
both A- and B-side transitions for simultaneous trimming in oppo-
site directions (asymmetrical trim). This is not possible with dual-
roller trims.

Notice as you move the cursor back and forth across a transition, 
the roller icon changes from an A-side roller (facing left) to a B-
side roller (facing right) to indicate the type of selection. 

You do not see the dual roller within the Timeline. To select both 
sides, you must Þrst select one side, then Shift-click to select the 
other.

¥ To quickly add multiple transitions to the currently selected transi-
tions, press the Shift key and lasso the additional transitions. Press 
Shift-Control while lassoing tracks that are below other tracks.

Select tracks on 

to add transitions
the record side

Two A sides and one B side selected
for asymmetrical trimming

A side B side
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¥ You can select and trim two heads or tails simultaneously, in any 
combination, for each track in the sequence.  All selected transi-
tions are trimmed the same number of frames. This allows you to 
save time, and in some cases, maintain sync by performing a sin-
gle trim procedure across multiple tracks and transitions.

Performing a Basic Trim

With your transitions and trim sides selected, you can perform a basic 
trim using one of the following alternative procedures:

¥ Use the Trim buttons to trim forward or backward by one- or ten-
frame increments.

¥ Use the numeric keypad at the right side of the keyboard (beneath 
the Num Lock/Clear button), as follows:

- To move the transition a speciÞc number of frames, type a 
plus sign (+) or minus sign (Ð) and the number of frames (from 
1 to 99) you want to move forward or backward. Then press 
Enter. If the number of frames is larger than 99, type an F after 
the number to indicate frame count. For example, to enter 200 
frames, type 200, then F, and press Enter.

- To move the transition to an exact timecode, type a timecode 
number larger than 99, including frames. For example, type 
102 to enter 1 second and 2 frames. 

¥ Use controls in the Timeline by clicking a roller at the selected 
transition and dragging forward or backward in the sequence.

In this example, tail frames 
on both shots are trimmed 
simultaneously  across an 
overlap edit.

1 frame 10 frames



301

¥ For greater control:

- Press the Option key as you drag to move one frame at a time.

- Press the Command key to snap to other transition points.

As you trim, all selected transitions in the Timeline move in unison. 
The Frame counter displays the frame count backward or forward for 
one or both trim sides, and the monitors display the new incoming or 
outgoing frames.

Reviewing the Trim Edit

Use the following procedure to review the most recent trim edit, or to 
play the currently selected transition while in Trim mode.

1. To see the Timeline in a closer view while you review the trim, 
click the Focus button. (Click the button again to return to your 
original view of the Timeline.)

n You can also choose an option in Trim Settings to focus the Timeline automat-
ically when you enter Trim mode.  For more information, see the Avid Film 
Composer Getting Started Guide.

2. To view the playback in Full-Screen mode, press the Full Screen 
(Single Quote) key on the keyboard.

3. Click the Review Transition button.

Click and drag a transition in the Timeline
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The system enters a playback loop. This repeatedly begins at a 
preroll point before the transition and ends at a postroll point, 
pausing brießy before beginning playback again. 

4. In Big Trim mode, you set and alter the length of the preroll, pos-
troll, and intermission intervals by clicking in the appropriate tim-
ing Þeld, and typing a new value.

n To adjust these playback loop parameters in Small Trim mode, enter Big Trim 
mode brießy, or use the Trim Settings dialog box. For more information, see 
the Film Composer Getting Started Guide.

5. Stop the playback loop by clicking the Review Transition button.

6. To leave Trim mode, click the timecode track in the Timeline, or 
click the Source/Record Mode button.

Dual-Image Playback During Trims

Dual-image playback allows you to preview A-side and B-side frames 
in real time while performing a trim.  You can play through the transi-
tion by using any of the standard playback controls, such as the J-K-L 
keys,  or the Play, Transition Loop, Play In to Out, or Play to Out but-
tons. 

c Dual-image playback works with single-Þeld resolutions only.   
Only one side rolls when you attempt to use dual-image playback 
with material digitized at AVRs 12, 70, 71, 75, and 77.

To use dual-image playback during trims:

Preroll timing Postroll timing

Intermission timing
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1. Double-click Trim in the Project Window Settings scroll list to 
open the Trim Settings dialog box.

2. Select the Dual Image Play option and click OK.

3. Enter Trim mode and select a transition for trimming.

4. Press a playback button or key combination.

As the transition plays or loops, notice that both the A side and B 
side of the trim play back in the Trim monitors.

5. When you see or hear the point that you want to trim to, press the 
Space bar to stop playback and update the transition in the 
sequence.

Trimming On the Fly

In both Big and Small Trim mode, you can use the J-K-L keys on the 
keyboard to play through outgoing or incoming material and mark 
trim points. This is similar to the procedure for marking footage on the 
ßy, as described in the Film Composer Getting Started Guide.

For convenience, this method isolates the trim controls to just three 
keys. However, when performing a dual-roller trim, you cannot view 
both sides at once; the monitors play only the A side during the proce-
dure, updating the B side once the trim is completed.

Trim on the ßy as follows:

1. Select one or more transitions for single- or dual-roller trimming.

2. Use the J-K-L keys to jog, play, or shuttle through the footage at 
varying speeds:

¥ Press and hold the K key while pressing J or L to jog slowly 
backward or forward through the footage. When you Þnd the 
frame where you want to relocate the transition, release the K 
key to complete the trim.
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¥ Press the J or L keys once to play at normal speed, or more 
than once to shuttle at higher speeds. When you see the frame 
where you want to relocate the transition, press the Space bar 
or the K key to complete the trim. 

The monitors and the Timeline are updated to reßect the trim.

Trimming During a Playback Loop

An alternative method for trimming is to view the transition continu-
ously in a playback loop, and use the keyboard to adjust the transition 
in one- or ten-frame increments until you achieve the desired trim. You 
can perform this procedure in Big or Small Trim mode, using either 
single-roller or dual-roller trims.

1. Enter Trim mode and select transitions for trimming.

2. Click the Review Transition button to repeatedly play the selected 
transitions.

n To make adjustments to the playback loop for preroll, postroll, or intermission 
intervals, see ÒReviewing the Trim EditÓ on page 301.

3. Press a keyboard equivalent to perform a Trim function. Also, if 
you are having difÞculty determining which side of the transition 
to trim (for example, during a difÞcult audio edit), use the Go to 
IN and Go to OUT keys to review just one side. 

The system performs the trim before the next playback loop, so 
you can view the trimmed transition during playback, then make 
further changes until you are satisÞed with the adjustment.

4. When you are Þnished, exit the playback loop by pressing the 
Space bar or clicking the Review Transition button.
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Creating Overlap Edits

You can use an overlap edit to smooth a transition by giving the 
viewer the subtle illusion that the audio, or video, is shared between 
two separate but adjacent shots.

To create an overlap edit:

1. Perform a straight-cut edit between two shots, including audio 
and video tracks: If the timing of the video edit is crucial, mark 
edit points according to picture. If the timing of the audio transi-
tion is crucial, edit to audio.

2. Perform a dual-roller trim on either the video track or the audio 
tracks, but not both:

- If the video transition occurs at the right place, but you want 
the audio from one shot to linger into the other (or the 
reverse), trim the audio tracks accordingly.

- If the audio transition occurs at the right place, but you want 
the picture to transition either before or after the audio cut, 
trim the video track accordingly.

Extending an Edit

Use Extend Edit to perform dual-sided (A and B side) trims on 
selected tracks from within Source/Record mode.  Using Extend Edit 
allows you to quickly create a split edit without entering Trim mode.  
It also allows you to establish the exact frame that you want to trim to 
by using the position indicator.  (If you enter Trim mode, by default 
the position indicator moves to the nearest transition.)

You can extend edits backward or forward in the Timeline. In either 
case, like a dual-roller trim the Extend Edit function always maintains 
sync relationships.
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To perform an Extend Edit:

1. Select the tracks you want to extend.

2. Find the point in the sequence to which you want to trim. If the 
trim point is before the edit, mark an IN. If it is after the edit, mark 
an OUT.

3. Click the Extend Edit button. The adjustment appears in the Time-
line.

Slipping or Sliding Shots

Slip and slide procedures are two unique Trim mode techniques that 
allow you to make frame-accurate adjustments to a selected clip. 
These occur without affecting the overall duration of the sequence or 
the sync relationships between multiple tracks. Procedures for per-
forming them are described in this section.

Mark IN

audio tracks are 
selected for 
extending back
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Selecting Segments for Slip or Slide Trimming

There are three ways to select segments for either slip or slide trim-
ming:

¥ While in Source/Record mode, make a selection for slipping. Then 
enter Trim mode by dragging a lasso from right to left around a 
segment (two or more transitions). To select for slide trimming, 
press the Option key while you drag.

You can also select two or more contiguous segments within a 
track for slipping or sliding as a whole by dragging the lasso 
around four or more transitions.

c Be sure to draw the lasso from right to left; if you draw from left to 
right, you enter Segment mode.

¥ While in Trim mode, double-click a segment to select it for slip 
trimming. To select it for slide trimming, press the Option key 
while you click.

You can also select two or more segments on different tracks for 
simultaneous slip or slide trimming. To do so, press the Shift key 
as you repeat this procedure. However, you cannot use the Shift 
key to select additional segments on the same track.

¥ While in Trim mode, press the Shift key and select both the head 
and tail of a clip for slipping. Alternatively, select the outgoing tail 
frame of the preceding shot and the incoming head frame of the 
following shot in the sequence to prepare the clip for sliding.

Drag right to left around at least two 

transitions

IN OUT
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You can also use this method to select two or more contiguous seg-
ments on the same track, and/or additional segments on other 
tracks for slipping or sliding as a group.

n You must select all multiple selections for either slipping or sliding. You can-
not perform both functions simultaneously.

You can slip and/or slide the video and audio for a shot together.   
Alternatively, slip and/or slide a single segment of video or audio 
independently from the rest of the shot. You can also slip shots in 
Source/Record mode using the Slip Left and Slip Right buttons.

The Slip/Slide Display

Once you select the clips for slipping or sliding, the Trim mode inter-
face changes to a four-frame display.
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The type of trim you perform (slip or slide) determines which frames 
are updated, as follows:

¥ In slip trimming, the two inner monitors for the head and tail 
frames of the clip change, because only the contents of the clip are 
adjusted. The frames that precede and follow the clip are not 
affected.

¥ In slide trimming, the two outer monitors for the outgoing (A-
side) and incoming (B-side) frames change, because the clip 
remains Þxed while the footage before and after it is trimmed.

Outgoing video (or A side) Tail and head frames of the 
selected clip

Incoming video (or  B side)
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Performing the Slip or Slide Trim

To slip or slide a shot:

1. After selecting the segments, as described in ÒSelecting Segments 
for Slip or Slide TrimmingÓ on page 307, do one of the following:

¥ Click any of the rollers in the Timeline, drag the selected mate-
rial to the left or right, and release.

¥ Use the numeric keypad to enter speciÞc frame-count or time-
code values, and press Enter.

¥ Use the trim keys or buttons to shift the selection by one- or 
ten-frame increments.

2. Monitor the progress of the trim using the monitors, the frame 
counters, and the Timeline. 

When you reach the end of available material while slipping a 
shot, the trim stops. Similarly, when you reach the next transition 
while sliding a shot along a track, the trim stops. A bright white 
line at the transition indicates the limit. After completing the ini-
tial slide, you can perform another slide in the same direction.

3. When you are Þnished, exit slip or slide mode either by clicking 
another transition for trimming, or by clicking either the Source/
Record Mode or Effects Mode button to exit Trim mode.

Slipping Shots in Source/Record Mode

You can use this alternative procedure to slip a shot in Source/Record 
mode using the Slip Left and Slip Right buttons, as follows:

1. In Source/Record mode, select the tracks for the clips to be 
slipped.

2. Place the position indicator within the shot that you want to slip.

3. Slip the shot by doing one of the following:
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¥ Click the Slip Left button to slip the shot one frame left 
(revealing later material from the source clip). 

¥ Click the Slip Right button to slip one frame right (revealing 
earlier material from the source clip).

¥ Hold the Option key while you click the Slip Left or Right but-
ton to trim 8 frames at a time.

n The Slip Left and Slip Right buttons do not appear on the interface or key-
board by default. You must map them from the Master command palette in 
order to use this procedure.

Performing a Slide Trim
1. While in Big Trim mode, press the Option key and double-click a 

shot or a segment of video or audio to select the frames that pre-
cede and follow the shot or segment.

Or hold the Option key, then press the mouse button and drag a 
lasso around the material you want to slip. 

2. In the Timeline, press one of the selected heads or tails, then drag 
the shot to the left or right.

If you slide the shot to the right, the edit before the shot is 
extended to the new IN point for the shot. The edit after the shot is 
trimmed forward to the new OUT point for the shot.

If you slide the shot to the left, the edit before the shot is trimmed 
back to the new IN point for the shot. The edit after the shot is 
extended back to the new OUT point for the shot.

Maintaining Sync While Trimming

For more information 
about  sync relation-
ships, as well as addi-
tional procedures for 
managing sync, see 
Chapter 12.

Film Composer provides two features that you can use in Trim mode 
to ensure that you do not break sync unintentionally between two or 
more video and/or audio tracks when performing single-roller trims.

¥ You can add black to the track while trimming.
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¥ You can sync-lock tracks that maintain a synchronized relation-
ship.

Adding Black When Trimming

If you are trimming a 
video track and need to 
Þll the black, you can 
perform a replace edit 
to add another piece of 
footage.  For more 
information, see ÒPer-
forming a Replace 
EditÓ on page 242.

Because single-roller (A-side or B-side) trims shorten or lengthen the 
duration of the track being trimmed, any relationships that exist with 
other tracks downstream of the trim will be thrown out of sync.  You 
can use the Control key while trimming to add black on either the A 
side or the B side to maintain the overall duration of the track and the 
sync relationships.

To add black while trimming, press and hold the Control key while 
performing any of the A-side or B-side trim procedures.  The system 
adds a black segment to Þll the duration of trimmed frames.

n You can only add black while performing single-roller trims, because dual-
roller trims do not cause sync breaks.

Trimming without 
adding black

Adding black while 
trimming

(Control key + trim)

No black is added and sync 
breaks appear in the Timeline.

Black fills the trim duration, and 
sync is maintained
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Trimming with Sync-Locked Tracks

n Sync-locked tracks aid only single-roller trim functions in Trim mode, 
because dual-roller trims do not cause sync breaks.

Trim with sync-locked tracks as follows:

1. Sync-lock the tracks as follows:

¥ Click the center column next to the tracks you want to keep in 
sync. The sync-lock icon appears.

¥ Option-click in the column next to the TC track to toggle sync-
lock on and off for all tracks.

2. Perform single-roller trims as necessary, with the following 
results:

¥ When you trim the A side of a transition forward, all other 
segments locked in sync move forward with the trim. If the 
transitions are staggered, this might split one or more of the 
segments at the sync point established by the position indica-
tor, leaving Þll.

If you trim the B side of the transition in the same direction, 
the additional sync-locked segments slide back in the 

Sync-lock icon

Before trimming forward, 

After trimming forward,
sync is maintained from 

three tracks are sync-locked

position indicator forward
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sequence to maintain sync until they encounter another seg-
ment in the same track. At this point, you can trim no further 
and the system emits a warning sound.

¥ When you trim back the A side of a transition, additional seg-
ments locked in sync move back as well. If the segments are 
staggered and one of the additional sync-locked segments 
encounters another segment on the same track, you can trim 
no further and the system emits a warning sound.

If you trim the B side of the transition in the same direction, all 
other segments locked in sync move forward to stay in sync. If 
the transitions are staggered, this action might split one or 
more of the sync-locked segments at the sync point estab-
lished by the position indicator.  Fill is added where the split 
occurs.

n Slip and slide trims are not protected for sync. Be sure to select all synced 
tracks for simultaneous slipping or sliding to avoid sync breaks.

Using the Transition Corner Display

The Transition Corner Display is a Trim Mode interface that shows six 
important frames you use as reference points when trimming a transi-
tion effect:

Trim is stopped here

Before the trim, 
three tracks are 
sync-locked

After the trim, sync 
is maintained, but 
the trim stops at 
earlier segment
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Use the Transition Corner Display to trim the transition effectÕs start 
frames, end frames, and duration in feet+frames. As you trim the tran-
sition effect, you will be able to see the corresponding frame adjust-
ments in all six monitors simultaneously. 

c The Transition Corner Display is only applicable to the trimming of 
transition effects (for example, dissolves, wipes, picture-in-picture, 
and so on). It is not designed for trimming Key, Image, or segment 
effects. 

Frames on which the 
transition effect starts

Frames on which the 
transition effect ends

The two frames between 
which a cut point defines 
the transition

Transition Corner 
Display button



316

To trim a transition using the Transition Corner display:

1. Select a transition effect for trimming:

¥ Lasso the effect in the Timeline from right to left. 

¥ Enter Trim mode and click on the transition in the Timeline.

¥ Use the Go to Transition buttons to enter Trim mode and step 
through transitions until you highlight the desired transition. 

2. Click the Transition Corner Display button.

The button turns bright green, and the display is enabled.

3. Trim the transition effect by clicking the outgoing or incoming 
frame you want to trim, then use one of the following three trim 
methods:

¥ Position your mouse on the rollers and drag the transition 
backward or forward. (Hold the Option key to roll forward or 
backward slowly one frame at a time.)

¥ Click the appropriate trim button to trim backward 8 frames; 
trim backward 1 frame, trim forward 1 frame, or trim forward 
8 frames.

¥ Enter the number of frames you want to move forward on the 
numeric keypad, then press Enter. Or, type a minus sign (Ð) 
and enter the number of frames you want to move backward, 
then press Enter.

4. To review your edit, click the Transition Play Loop button.



317

CHAPTER 11

Working with Audio

You edit audio by using many of the same techniques and tools you 
use to edit video, including Source/Record mode, Segment mode, and 
Trim mode functions.  Film Composer also provides several unique 
features that facilitate audio editing, such as audio scrub,  waveform 
displays, and tools for adjusting and mixing audio levels and pan 
between speakers. In addition, you can adjust the high, low, and 
midrange frequency ranges of segments using the Audio EQ tool. 
These procedures are described in the following sections:

¥ About Audio Tools

¥ Audio Editing Aids

¥ Using the Audio Mix Tool

¥ Using Audio Gain Automation

¥ Using the Audio Equalization Tool

¥ Using Audio Punch-In

¥ Fine-Tuning Audio Transitions

¥ Mixing Down Audio Tracks
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About Audio Tools

Film Composer provides a collection of tools for managing and Þne-
tuning audio volume, pan, equalization, and transitions. The general 
purpose of each tool is as follows:

¥ Use the Audio Tool primarily for adjusting and calibrating global 
input and output levels when digitizing from analog sources or 
outputting to tape. For more information, see the sections ÒPrepar-
ing for Audio InputÓ on page 63, and ÒPreparing for OutputÓ on 
page 449.

¥ Use the Audio Mix tool primarily for adjusting pan and volume 
levels on clips or whole tracks within a sequence. For more infor-
mation, see ÒUsing the Audio Mix ToolÓ on page 327.

¥ Use the Audio Gain Automation feature in the Timeline for Þner 
control over volume break points and ramps within a sequence. 
For more information, see ÒUsing Audio Gain AutomationÓ on 
page 335.

¥ Use the Audio EQ tool for adjusting the sound characteristics of 
audio clips in the sequence based on three-band control over high, 
low, and midrange frequencies. For more information, see ÒUsing 
the Audio Equalization ToolÓ on page 341.

¥ Use the Audio Punch In tool to record up to two channels of audio 
directly into the Timeline for voice-over narration. For more infor-
mation, see ÒUsing Audio Punch-InÓ on page 351.

The following section describes two features that help you locate tran-
sitions and monitor audio samples while editing or adjusting sound 
with the tools.

Audio Editing Aids

The Film Composer system provides audio scrub features and wave-
form plots speciÞcally designed for frame-accurate cuing, marking, 
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and editing of audio. You can use these features any time during edit-
ing or while making adjustments with the audio tools.

Using Audio Scrub

The term audio scrub originates in the Þlm industry. It describes the 
process of ÒscrubbingÓ a magnetic audiotape across the playback 
heads to monitor a portion of sound. This process helps isolate por-
tions of audio to accurately mark edit points, or to analyze transitions 
for careful trimming.

Smooth Scrub Versus Digital Scrub

You have two options for scrubbing audio in either the sequence or the 
source material:

¥ Smooth audio scrub mimics the variable pitch playback of tradi-
tional analog tape.

¥ Digital audio scrub takes advantage of the digital environment by 
sampling incoming and/or outgoing frames at normal pitch and 
playback rate.

Each type of scrub has its advantages: smooth scrub makes it easier to 
examine sound at varying speeds; digital scrub allows you to focus 
quickly on individual bits of incoming or outgoing audio for frame-
accurate edits and adjustments. Try both and see which works best in 
different situations.

Selecting Tracks for Scrubbing

By default, the system selects the topmost audio track unless you 
make a selection. Always check the position of the hollow speaker icon 
and select the correct track, if necessary, to avoid marking or trimming 
the wrong track.
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To select a track for scrubbing, hold down the Option key and click the 
speaker icon in the track panel beside the Timeline. 

The speaker icon becomes hollow to indicate that it is selected for 
scrubbing.

Using Smooth Audio Scrub

You perform the smooth audio scrub procedure using either the J-K-L 
keys or the mouse, as described in this section.

Smooth Scrub Using the J-K-L Keys

You can use three-button play with the J-K-L keys to perform smooth 
audio scrubbing of selected tracks of audio at variable speeds. You 
cannot activate digital audio scrub with three-button play. You can 
monitor while jogging one frame at a time, ten frames at a time, or 
while shuttling at Þxed rates up to eight times normal speed.

To monitor audio with three-button play:

1. Make sure you have selected the correct track and adjusted play-
back volume as necessary. 

2. Play the audio using the three-button variable speed playback 
procedures described in the Avid Film Composer Getting Started 
Guide.

Hollow speaker indicates a track 
selected for scrubbing 
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Smooth Scrub Using the Mouse

You can use the mouse to perform smooth audio scrubbing of selected 
tracks. (You cannot activate digital scrub using the mouse.) Like the J-
K-L keys, you can jog and shuttle with the mouse. Unlike three-button 
play, however, playback rates with the mouse are not at Þxed incre-
ments. They can vary all the way from 1 to 300 fps (NTSC), depending 
on manipulation of the mouse.

To monitor audio with the mouse:

1. Select the correct track and adjust playback volume as necessary. 

2. Activate the mouse for jogging or shuttling by pressing the N key 
(Mouse Jog key) or the semicolon key (Mouse Shuttle key).

3. Play the footage with the mouse as described in the Avid Film Com-
poser Getting Started Guide.

n When you use the Steenbeck Controller, smooth audio shuttling is invoked by 
default.

Using Digital Audio Scrub

Digital scrub enables you to sample selected frames of incoming or 
outgoing audio as you move through the footage, without a change in 
pitch or speed. The following are unique characteristics of digital 
scrub:

¥ The frames of audio you hear are always at your point of destina-
tion. For example, if you step forward 10 frames, you hear a 
selected number of audio frames from a point behind the position 
indicator (outgoing frames) to a point in front of the position indi-
cator (incoming frames) as it reaches the new destination point. 

¥ The audio is always sampled in a forward playback direction; 
whether you step back or forward through the material, you hear 
the same audio sampling at each destination frame.
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Adjusting Digital Scrub Parameters

The default parameters for the number of frames you hear as you 
scrub are zero frames of outgoing audio (behind the position indica-
tor), and one frame of incoming audio (ahead of the position indica-
tor). For the common purpose of isolating frames for marking or 
trimming, the default parameters are sufÞcient.

You can increase these settings to include more frames of audio on 
either side Ñ for example, when you want to sample whole words or 
parts of words as you scrub to Þnd edit points within a phrase. Or you 
can reverse the settings, to sample frames behind the position indica-
tor (outgoing frames) as you scrub. In general, you should avoid 
increasing the number of sampled frames on both sides at once, 
because this can make it difÞcult to isolate an edit point or trim point 
based on the location of the position indicator.

To adjust the parameters for digital scrub:

1. Open the audio settings dialog box using one of the following pro-
cedures:

¥ Double-click Audio in the Settings scroll list of the Project win-
dow.

Digital Scrub Example

Selected
Track

Step 10 frames

Outgoing frames Incoming frames
(behind position indicator) (ahead of position indicator)

This entire section is sampled
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For more information 
on displaying two 
information rows, see 
the Avid Film Composer 
Getting Started Guide.

¥ If you have two information rows displayed above the moni-
tors in the Composer window, you can Option-click the digital 
scrub parameters that appear in the top row next to the Fast 
Palette button for each monitor.

The audio settings dialog box appears.

2. Click in an entry Þeld and type a new number of outgoing or 
incoming frames on the source side, the record side, or both.

3. Press Return. The new parameters are now in effect.

Source-side digital 
scrub parameters

Record-side digital 
scrub parameters
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Performing the Digital Scrub Procedure

To locate an audio edit point in either source-side or record-side audio 
using digital scrub: 

1. Select an audio track for scrubbing, and adjust the output volume, 
if necessary.

2. Press the Caps Lock key to activate digital audio scrub.

3. Move through the material in one of the following two ways to 
hear the scrub:

¥ Drag the position indicator.

¥ Click Jog buttons to step through in Þxed increments: one-
frame backward, one-frame forward, ten-frames backward, 
ten-frames forward.

When youÕve found the right frame, mark the location, trim the transi-
tion, or perform any other function you choose.

If you are sampling incoming frames (with the default scrub parame-
ters, for example), you see the position indicator is located at the head 
of the last sampled audio point; if you are sampling outgoing frames, 
you see the position indicator is located at the tail of the last sampled 
audio point.

Using Waveform Plots

You can use waveform plots to help you visually locate points in an 
audio track for editing or trimming. There are two types of waveform 
plots, Energy or Sample, that you choose from the Timeline Fast menu. 

Displaying Audio Waveforms
1. If you are searching for a point in a known section of the tracks, 

zoom in and/or show more detail in the sequence to isolate a sec-
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tion of the audio. With less audio to display, the system draws the 
waveform plot faster.

2. Choose Audio Data from the Timeline Fast menu. A submenu 
appears containing two waveform plot options.

Choice of plot type is a matter of visual preference:

¥ The Energy Plot option displays only the peaks of the audio 
amplitude in the waveform from the baseline. It is a graphical 
representation of the mathematical Energy Function for audio 
waveforms.

¥ The Sample Plot option displays the entire amplitude of the 
audio waveform. This is the same as the sample voltage val-
ues you would see on an analog oscilloscope waveform.

After you make a choice, the waveform appears in the selected 
tracks.

3. To maximize the visibility of your waveform display, use the fol-
lowing optional procedures:

¥ Continue to expand or shrink your view of the Timeline (by 
clicking the Show More or Show Less Detail buttons), effec-
tively spreading out the waveform plots to show detailed 
variations in the audio levels.

Waveform 
Energy Plot

Waveform 
Sample Plot
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¥ Enlarge or reduce the height of selected audio tracks, and sub-
sequently the waveform displays, by pressing kÐL to enlarge 
or kÐK to reduce.

¥ You can also increase or reduce the size of the Sample plot 
image itself (this does not work with Energy plots), without 
enlarging its track, by pressing kÐOptionÐL to enlarge, or kÐ
OptionÐK to reduce.

Audio waveform plots 
can slow your naviga-
tion through the Time-
line. You may want to 
use these selectively. To 
facilitate this, you can 
create a custom Time-
line view, as described 
in the Avid Film Com-
poser Getting Started 
Guide.

4. Move through the audio shown in the waveform using any of the 
playback methods. You hear sound as you track the audio visually. 
When you have the position indicator parked at the desired point 
in the waveform, you can mark, trim, or perform any other func-
tion.

Once youÕve created a customized waveform view, you can simply 
select it from the Timeline View pop-up menu when needed, and 
return to another view when done.

Muting the Audio

The Mute button allows you to quickly turn all sound tracks on and 
off during editing. This is especially convenient when Þne-tuning 
complex audio and video edits, making it possible to shift quickly 
between the two. You can set your audio levels and speaker volumes 
and mute them whenever necessary without changing the settings.

Click the Mute button at any time to mute all audio tracks. Press it 
again to turn them on.
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Using the Audio Mix Tool

For additional informa-
tion on audio levels for 
digital cut output, see 
ÒPreparing for OutputÓ 
on page 449.

The default volume for master clips is set to zero (that is, with no 
attenuation) when you Þrst digitize the media. Pan is based upon the 
tracks recorded in the Þeld, and subsequently digitized into the sys-
tem. 

n The pan option in the Audio Settings dialog box determines how the system 
plays back the default pan. For more information, see the Avid Media Com-
poser Products Reference.

The Audio Mix tool allows you to:

¥ Adjust pan and volume for an individual clip, a whole track, sev-
eral tracks at once, or a whole sequence. 

¥ Adjust the volume and/or pan for one track at a time.

¥ Adjust volume and/or pan for multiple tracks simultaneously by 
ganging them together.

The system uses these adjustments for all playback, including output 
to a digital cut.

n You can also adjust volume levels in the Timeline using Audio Gain Automa-
tion. For information, see ÒUsing Audio Gain AutomationÓ on page 335.

Open the Audio Mix tool by choosing Audio Mix from the Tools 
menu.
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Resizing the Audio Mix Tool

You can simplify the Audio Mix tool display by clicking the Display/
Hide Sliders button to toggle between hiding and displaying the vol-
ume sliders.

With the window collapsed, you can continue to adjust levels by 
selecting a track and typing values using the numeric keypad on the 
keyboard, or by typing a value into the volume level display.

Display/Hide 
sliders

Volume Level display
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Adjusting One Audio Track at a Time

To adjust one audio track at a time in the Audio Mix tool:

1. Load a clip or sequence, and activate the appropriate monitor:

¥ To adjust a track in a source clip, make sure the Source moni-
tor is active. 

¥ To adjust a track in a sequence, make sure the Record monitor 
is active.

2. Select the track or portion of a track to be adjusted:

¥ To adjust the track in a single edited shot in a sequence, place 
the position indicator in the shot.

¥ To adjust an isolated section of audio on a track, mark IN and 
OUT points.

¥ To adjust levels from an IN point through the end of the track, 
mark an IN point only.

¥ To adjust levels globally throughout the track, make no marks.

3. Choose Audio Mix from the Tools menu to open the Audio Mix 
tool.

Output Options

Gang buttons

Track selection 
pop-up menu
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If you have Þve audio 
tracks or more, and 
need to adjust all of 
them, consider mixing 
down to four tracks, as 
described in ÒMixing 
Down Audio TracksÓ 
on page 360.

The Audio Mix tool contains four to eight panels (depending upon 
your system model), one for each audio track you can monitor and 
adjust. The Audio Mix window can only display tracks that exist 
in the sequence, or tracks that were digitized with the source clip.

4. Choose the type of audio output from the Output Options pop-up 
menu:

¥ Choose Stereo Mix to make adjustments for output to left and 
right speakers.

¥ Choose Mono to make adjustments with all levels panned to 
center between speakers.

¥ Choose Direct Out when performing a digital cut for output of 
up to eight source tracks to a maximum of four output chan-
nels. For more information, see ÒGenerating Four-Channel 
AudioÓ on page 462.

5. Select the audio track to be adjusted by choosing the desired track 
from the track selection pop-up menu in a panel.

6. Choose the type of mix you want when applying stereo mix out-
put from the Stereo Mix pop-up menu:

¥ Mix to 1 & 2 sends the stereo mix to output channel one and 
the left speaker, and output channel two and the right speaker.

¥ Mix to 3 & 4 send the stereo mix to output channel three and 
the left speaker, and output channel four and the right 
speaker.

7. With the Audio Mix window active, use any playback method 
(such as the J-K-L keys on the keyboard) to play, shuttle, or jog 
through the audio to check for necessary volume or pan adjust-
ments.

The keyboard controls either the Source or Record monitor, 
depending on which monitor was active when you opened the 
Audio Mix tool. Switch your selection by clicking the appropriate 
monitor.
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8. Decide whether to raise or lower the volume, or pan left or right. 

Use any of the following methods to change a value in the panel:

¥ Click a number along the vertical edge of the volume slider.

¥ Click the slider and type a value.

¥ Values are cumulative until you press Return. For example, if 
you want to enter the value 12, simply type it. However, if you 
enter 1 and then want to change the value to 2, press Return 
before typing the 2.

¥ Click the slider and then drag it.

¥ Click the Volume Slider value box and type a value.

¥ Set a value of zero decibels by clicking the slider and entering 
0, or by clicking 0 along the vertical edge of the volume slider.

¥ Adjust pan by clicking the Pan Value display to reveal the 
pop-up slider, then drag the slider to a new position.

If the sequence is playing, notice that play stops when you make 
an adjustment (the Audio Mix window does not provide real-time 
audio control).

Audio Level Slider

Click gang buttons to select a track or 
to gang multiple tracks.

Pan Value display

Volume Slider 
value box

Pop-up slider for pan
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9. Apply the adjustments to a chosen region of the track using the 
Audio Mix Fast menu located at the upper right of the tool.

Options in the Fast menu are dimmed until you select a track. The 
options vary depending upon the types of marks you set within 
the clip or sequence, as follows:

¥ With IN and OUT marks: Commands in the Fast menu apply 
adjustments to selected tracks between the marks.

¥ With an IN mark (no OUT mark): Commands in the Fast 
menu apply adjustments from the IN point to the end of 
selected tracks.

¥ With no marks: Commands apply globally (across entire 
tracks).

Fast menu Stereo Mix pop-up menu
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There are three ways of applying the adjustments:

¥ The Set commands (Set Pan, Set Level) apply the same pan or 
volume levels currently set in the Audio Mix tool to all seg-
ments in the marked region of the tracks.

¥ The Adjust Pan/Vols command opens a dialog box for adding 
incremental adjustments to all current settings across seg-
ments in the marked region of selected tracks.

For example, when you enter Ð1 into the Gain Adjustment 
Þeld, the various audio level settings across all segments of 
the marked region of selected tracks will be lowered by 
exactly one decibel when you click OK.

¥ The Remove Pan/Vols command deletes all audio mix adjust-
ments that have been applied to segments in the marked 
region of selected tracks. Each audio clip is restored to its pre-
vious pan and volume settings.

10. Play through the audio again using the J-K-L keys. Repeat steps 8 
through 10 until you are satisÞed with the pan and volume levels.

The system uses the new settings whenever you play back or 
record the sequence.

Ganging and Adjusting Multiple Tracks

You can gang multiple tracks in the Audio Mix tool in order to main-
tain the same relative settings between tracks when you make adjust-
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ments. This is useful in a variety of circumstances. For example, you 
can gang tracks to raise the overall volume of a portion of a sequence 
while maintaining variations in level adjustment among tracks.

To gang and adjust multiple tracks:

1. Click the Gang button in the Þrst track panel.

2. Click the Gang button of any additional panels. Click the button a 
second time to deselect it. 

3. Adjust either volume or pan for one of the tracks using any of the 
techniques described in the previous section, and the other tracks 
will maintain the same relative levels.

When you gang two or more panels, you gang both the volume and 
pan sliders. You can also isolate either volume or pan sliders for gang-
ing as follows:

¥ To gang only the volume controls, Shift-click anywhere within the 
volume sliders.

¥ To gang only the pan controls, Shift-click anywhere within the Pan 
Value displays.

To set all ganged sliders to the same value:

¥ For volume, click the number along the vertical edge of the vol-
ume slider or enter a value into one of the Volume Level displays.

¥ For pan, click the pan value display box and enter a value.

Ignoring Existing Volume and Pan Settings

You can have the system ignore the volume settings established with 
the Audio Mix tool when playing back or recording a sequence. You 
can also deactivate the pan settings by choosing Mono or Direct Out-
put from the Output Options pop-up menu.
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To turn off current volume adjustments, click the Ignore Volume check 
box located next to the output options pop-up menu at the top of the 
Audio Mix tool.

The volume controls disappear. Deselect the option to restore the cur-
rent settings.

To turn off pan adjustments:

¥ Choose Direct Out from the output options pop-up menu to play 
back the tracks with their default pan settings.

¥ Choose Mono from the output options pop-up menu to pan all 
tracks to center during output.

When you choose one of these options, the pan controls disappear 
in the Audio Mix tool. Choose Stereo Mix to restore the current 
settings.

Using Audio Gain Automation

Audio Gain Automation (also known as audio volume rubber-band-
ing) allows you to change the volume of a segment by adding and 
manipulating gain break points in the Timeline. The following illustra-
tion shows an expanded audio track containing gain break point infor-
mation.
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The Composer system uses a linear ramp to change the volume from 
one gain break point to the next. The above illustration shows four 
ramps.

System Clip Gain

When you add a break point, the Composer system adds the point at 
the level currently set for that track in the Audio Mix tool.

Values set by the volume sliders in the Audio Mix window are referred 
to as system clip gain values. Audio gain break points are not additive 

Gain values in decibels Graphic representation of break points and gain
ramps in the Timeline

Current
volume 
settings
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to the system clip gain values. When you move a gain break point up 
or down, it cancels the system clip gain for that point in the sequence.

If you move the volume slider for a clip in the Audio Mix window, all 
the break points for that clip move relative to the new value. 

Real-Time Response of Audio Gain Automation

In real time, the Composer system reads the gain value every 2000 
audio samples and linearly ramps between readings. For example, at 
44.1 kHz (44,1000 samples per second), the Composer system checks 
the gain value every 0.0416 seconds. This works well when you use 
gradual ramps.

Using Audio Gain Automation

To use Audio Gain Automation:

1. Select an audio track for adjusting volume.

2. Choose Volume from the Audio Data submenu of the Timeline 
Fast menu.

n You can enable both Volume and Energy Plot or Sample Plot in the Audio 
Data submenu of the Timeline Fast menu to display audio gain meters and 
break point information superimposed over waveform plots in the Timeline.
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A straight line appears in the selected audio track. The line shows 
the current gain level for that track in the Audio Mix tool.

3. (Option) Expand the audio track by pressing k-L, or pressing the 
Option key and dragging in the Track Selector panel.

The following illustration shows the expanded audio track. 

4. Click the Add Key Frame button on the Master command palette 
to add break points along the Timeline. The Composer system 
adds a break point to each enabled track.

By default the Add Key 
Frame button is 
mapped to the double 
quote key ( Ò ).You can 
map the button to 
another key or to exist-
ing button locations in 
the Source/Record 
monitor.

After you add one break point to a segment, you can adjust the gain 
for the entire clip. After you move the point up or down, the corre-
sponding volume slider in the Audio Mix window moves also.

Initially gain is set to the clip gain setting in the Audio Mix tool
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Deleting Break Points

To delete break points, do one of the following:

¥ To delete a single break point, move the cursor over the point. 
When the cursor turns into the pointing hand, press the Delete 
key. If there are identical break points in other active tracks, the 
system deletes them also.

¥ To delete groups of break points, mark an IN to OUT or mark the 
entire segment, then delete any key in the marked area.

Moving Break Points on the Timeline

Move break points using one of the following methods:

¥ Click a break point and drag it up or down to increase or decrease 
the gain at that point. If there is a point at the same position on 
another enabled track, it moves also.

n To snap to the decibel lines, hold the Command key (k) while you drag the 
point.

¥ Move a break point horizontally to move the start or end of a 
ramp. Option-click the point and drag it. You cannot move one 
break point on top of another.
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¥ Move several break points on a track at the same time by placing 
IN and OUT marks to select the desired area. When you move one 
break point within the marked area, all break points within the 
marked area move in relation to each other. This works for all 
enabled audio tracks.

This is similar to ganging sliders on an audio mixing board or in the 
Audio Mix tool.

This example shows how to move break points within IN to OUT 
marks on two tracks.

Notice that the break points outside the IN to OUT marks do not 
move.
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Using the Audio Equalization Tool

The Audio EQ tool supports real-time, segment-based frequency 
equalization on individual clips. This allows you to adjust the high, 
low, and midrange frequency ranges of an audio clip. You can also 
save a variety of audio EQ effects and apply them in different circum-
stances, as described in this section.

You can access the Audio EQ tool in one of two ways:

¥ Choose Audio EQ from the Tools menu.

¥ Click the EQ Window button in the upper portion of the Audio 
Mix window.
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The Audio EQ tool appears.

Audio EQ Tool Features

The Audio EQ tool provides three bands of control:

¥ The Þrst band, the low shelf, has four turnover points (50 Hz, 80 Hz, 
120 Hz, and 240 Hz). A turnover point is the point at which the 
curve starts to return to zero.

A shelf affects all frequency values within the range of the shelf. 
The low shelf affects all frequency values from 20 Hz to the low 
shelf turnover point.

¥ The second band is the parametric midrange. This band has two 
bandwidth values, 1/4 octave and 2 octaves. These control the 
width of the curve.

EQ Window button

Play Loop button

Track Selection 
pop-up menu

Effect icon

Fast menu

3-Band controls

EQ Range Slider
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¥ The third band, the high shelf, has four turnover points (6 kHz, 8 
kHz, 12 kHz, and 15 kHz). The high shelf affects all frequencies 
from the high shelf turnover point to 20 kHz.

The horizontal center line of the graph is zero. As you move the curve 
below the zero line, the corresponding frequencies are deemphasized. 
Above the zero line the corresponding frequencies are emphasized. 
The parametric midrange allows a smooth transition from deempha-
sized frequencies to emphasized frequencies.

You apply Audio EQ like effects:

¥ Audio EQ can only be applied to entire segments. You cannot iso-
late portions of a segment for an Audio EQ effect using IN and 
OUT marks. You must use Add Edits (match frames) to mark off a 
smaller segment.

¥ You can use IN and OUT marks to select a range of complete seg-
ments for applying an Audio EQ effect. Segments that fall within 
the marks, either in part or in whole, will have the effect applied to 
them.

The following illustration shows the Audio EQ tool with the frequency 
response curve displayed and identiÞes the related areas of the win-
dow. The graph displays from 20 Hz to 20 kHz.
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The Audio EQ tool allows you to emphasize or deemphasize audio 
frequencies. The height of the curve shows the amount of emphasis or 
deemphasis (also called boost or cut) that is being applied. The range 
is from +15 db to Ð20 db.

Applying Audio EQ Effects

To adjust audio EQ for a track:

1. Load the sequence containing the audio track.

2. (Option) Isolate a portion of an audio segment by placing Add 
Edits.

3. (Option) Mark off a range of audio segments by adding IN and 
OUT marks in the track.

4. Open the Audio EQ tool.

Turnover point where low 
shelf curve starts moving 
back toward zero.

The current value of the EQ 
parameters.

Turnover point where high 
shelf curve starts moving 
back toward zero.

Bandwidth around the center point 
of the parametric curve – 1/4 octave 
(narrow) or 2 octave (wider).

Low shelf

Center point of the parametric 
midrange curve.

High shelf

Parametric midrange 

Zero line
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5. Select the audio track to be adjusted from the track selection pop-
up menu in the Audio EQ tool.

Notice that the Track Selector panel in the Timeline window is 
updated to reßect your selection.

6. Click the Play Loop button to play the currently selected audio 
clip within the current In/Out range. To stop the loop playing, 
click the button again or click anywhere in the Timeline.

7. Use any of the following methods to change a value in the EQ tool:

¥ Click a number along the vertical edge of the volume slider.

¥ Click the slider and type a value.

Values are cumulative until you press Return. For example, if 
you want to enter the value 12, simply type it. However, if you 
enter 1 and then want to change the value to 2, press Return 
before typing the 2.

¥ Click and drag the slider.

¥ Click the Volume Slider value box and type in a value.

¥ Set a value of zero decibels by clicking the slider and entering 
0, or by clicking 0 along the vertical edge of the volume slider.

Notice that playback stops when you make an adjustment (the 
Audio EQ tool does not provide real-time audio control).

8. Apply the adjustments to a chosen region of the track using the 
Audio EQ Fast menu located at the upper right of the tool.

Track selection pop-up 
menu

EQ Fast menu button



346

The Fast menu on the Audio EQ tool has one entry: Set Eq In/Out. 
This allows you to remove or apply EQ effect to clips included 
within the current IN to OUT range. 

For example, the following illustration shows a segment with one 
EQ applied to the Audio Clip 2 in track A2. If you choose Set Eq 
In/Out, the current EQ effect is also applied to Audio Clip 1 and 
Audio Clip 3 on track A2.

If there is no EQ setting on the currently selected clip, choosing Set 
Eq In/Out deletes the EQ settings on all clips within the IN to 
OUT range. For example, because there is no EQ setting on Audio 
Clip 3 in the following example, Set Eq In/Out deletes the EQ 
effect from Audio Clip 1 and Audio Clip 2.

Before Set EQ In/Out

After Set EQ In/Out – EQ effect is added to Audio Clip 1 and Audio Clip 3.
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Set Eq In/Out applies only to the audio track currently selected by 
the Audio EQ tool. You can change your selected region by elimi-
nating or adding marks in the Timeline, or by selecting a different 
track.

9. Play through the audio again using the Play Loop button. 

10. Repeat steps 8 through 10 until you are satisÞed with the EQ 
adjustments.

Saving Audio EQ Effects

The Film Composer treats an EQ setting as an effect. You can save EQ 
settings in a bin just as you save any other effect template. This makes 
it easy to save EQ settings and apply them whenever you need them. 
The following illustration shows EQ effect icons in a bin and in the 
Timeline.

Before Set EQ In/Out

After Set EQ In/Out – EQ effect is deleted from Audio Clip 1 and Audio Clip 2.
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Use the effect icon to save EQ settings in a bin or to copy the settings to 
another audio clip. Either drag the icon into a bin or drag the icon to 
another audio clip in the Timeline. See the Avid Media Composer and 
Film Composer Effects Guide for more information on using effect tem-
plates.

Audio EQ Examples

The following examples show two different ways to use the Audio EQ 
tool to remove excess bass from an audio track. These examples use 
the sound track from the Rain Forest sequence. The bass in the sound 
track is very pronounced, and we use the Audio EQ tool to deempha-
size it. The main challenge with this particular sound track is that 
there are voices on the same track as the music. The human voice cov-
ers a wide range of frequencies and the challenge is to preserve the 
bass frequencies of the voices while deemphasizing the bass drum 
sound.

EQ effect in the timeline

EQ effect templates in a bin
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Keep in mind that the goal of the adjustments is the Þnal sound. In 
general, you should use small adjustments to preserve as much of the 
original sound track as possible. DonÕt be overly concerned about spe-
ciÞc parameter values.

Low Shelf Example

This example adjusts the low shelf to deemphasize the bass. By drop-
ping the low shelf down Ð20 decibels we are able to deemphasize it. 
However, there are voices on this track and simply dropping the low 
shelf also removes some bass from the voices. So we did the following 
to compensate for this:

1. Use the 2 octave midrange setting to create a wide midrange.

2. Move the midpoint of the parametric curve over to 89 Hz.

3. Boost the midrange of the parametric curve to +7.7 dB.
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Small Octave Range Example

This example isolates the particular frequency that we want to deem-
phasize. In this example we donÕt use the low shelf but instead use the 
parametric midrange to isolate the frequency.

1. Use the 1/4 octave inßuence range.

2. Set the midrange EQ parameter to Ð15 dB.

3. Use the slider to move the midpoint of the parametric curve until 
it isolates the bass frequency. In this case the bass frequency we 
want to deemphasize is right around 80 Hz.

This technique allows you to locate a speciÞc frequency and either 
emphasize or deemphasize it: 

¥ Use the 1/4 octave inßuence range and a large negative decibel 
value. 

¥ Keep both the high and low shelf set to zero.

Use this slider to move the 
center point of the parametric 
curve and locate a specific fre-
quency.
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¥ Use the slider to move the center point of the parametric curve 
along the frequency range while you play the audio track.

Once you locate the desired frequency, you can adjust it as needed.

Using Audio Punch-In

Audio punch-in allows you to record up to two channels of audio 
directly into the Timeline for voice-over narration. This saves the extra 
steps of recording the narration to tape Þrst, digitizing, and then edit-
ing the audio clip into the sequence.

You access the Audio Punch In tool from the Tools menu.

The following illustration identiÞes the various elements of the tool:
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Features of the Audio Punch In tool are as follows:

¥ The Record button starts and stops the recording. 

¥ The Cancel button stops a recording without saving the recorded 
data.

¥ The Recording status light is black when there is no activity, green 
during a preroll, red during recording, and blue during a postroll.

¥ The Display Audio Tool button displays the Audio tool so that you 
can monitor and adjust the audio levels during recording.

¥ The PreRoll text box allows you to provide a visual cue before the 
recording begins. The Composer system backs up the blue posi-
tion indicator for the prescribed number of seconds. 

¥ The PostRoll text box gives the same kind of visual cue at the end 
of the recording.

¥ The Handles text box instructs the Composer system to record 
audio at the beginning and end of the clip. This allows you to per-
form trim edits on the audio.

Timeline Track selection menus
Input channel
selection buttons 
and menus

Bin selection menu

Drive selection menu

Record button
Cancel button

Display Audio Tool
button

Recording status light

Preroll and Postroll boxes

Handles box
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¥ The input channels identify the channels on the audio hardware 
that are used for recording. Click the button to select the channel. 
The button turns pink when it is selected. Option-click the button 
to display a menu and select another channel. 

¥ The Track selection menus allow to specify where the Composer 
system places the audio in the Timeline. Either choose New Track 
or select an existing track. When you choose an existing track, the 
Composer system overwrites the audio on that track between the 
IN and OUT points.

Using the Audio Punch In Tool

This section provides an overview of how to set up and use your Com-
poser system for creating voice-overs in the Timeline.

Connecting the Hardware

Before you can use Audio Punch In, you need to connect a microphone 
or other input device to your system. The following are typical exam-
ples:

¥ Connect a microphone to a mixer and connect the mixer to the 
Audio card or to the Audio Interface on your Composer system.

¥ Connect a microphone to a microphone preamp and connect the 
preamp to the Audio card or to the Audio Interface on your Com-
poser system.

Refer to Avid Media Composer Products Connecting Audio and Video 
Equipment for information on connecting the hardware.

Creating the Voice-Over

You can replace part (or all) of an existing track or you can instruct the 
Composer system to create a new track for the voice-over. The follow-
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ing procedure shows how to use the tool when you want to mark IN 
and OUT points and plan to create a new track for the voice-over. 

1. Mark the IN and OUT points in the Timeline as shown in the fol-
lowing illustration.

2. Choose Audio Punch In from the Tools menu. 

The Audio Punch In tool appears.

3. Choose the channels that correspond to your hardware setup and 
set other values in the dialog as appropriate.

4. To start recording, click the Record button.

Record button Cancel button

Recording status light
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If you started with both IN and OUT points in the Timeline, the 
Composer system automatically stops recording when it reaches 
the OUT point (or after it adds the appropriate audio handle after 
the OUT point). If you only added an IN point, click the record 
button a second time to stop the recording.

The following illustrations show the results after adding a voice-over. 
The system automatically names the voice-over. You can change the 
name as you would any clip (for example, change the name in the bin).

Voice-Over Media Files

The Composer system automatically names the voice-over and stores 
it as an audio clip as shown in the following illustration.

Voice-over adding a new track

Voice-over replacing a portion of a track
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Fine-Tuning Audio Transitions

When making audio level and pan adjustments, Film Composer looks 
at either an individual clip in the Source monitor, a shot in the 
sequence, or entire tracks. To change level or pan settings in an area 
not deÞned by a discrete clip or group of clips, use the Add Edit func-
tion to deÞne your own custom area.

1. Find the start of the area where you would like to change the pan 
or level, leaving your position indicator on that frame as a marker.

2. Turn on the appropriate track in the track panel.

3. Click the Add Edit button.

This places an edit where the position indicator is parked.

4. Find the end of the area where you want to change the pan or 
level, leaving your position indicator on that frame as a marker.

5. Turn on the appropriate track.

6. Click the Add Edit button.

7. Use the process described in ÒCreating the Voice-OverÓ on 
page 353 to change the level or pan within this new segment.
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Fading and Dipping Audio

In traditional analog editing, you manually change volume levels to 
smooth audio transitions between elements in an edited sequence by: 

¥ Fading audio up or down

¥ Dipping to a lower level

¥ Crossfading between audio elements on two separate channels

With the Composer system, these effects are more accurately termed 
audio dissolves because they occur instantly when you apply the same 
dissolve effect that you use for video tracks.

You can use the procedures described in ÒUsing Audio Gain Automa-
tionÓ on page 335 to achieve these effects. If your model does not 
include Audio Gain Automation (releases prior to Release 6.1), you 
must use the procedures described in this section.

This section describes three basic procedures for achieving fades, dips, 
and crossfades with Film Composer. For complete information on 
applying and adjusting effects, see the Avid Media Composer and Film 
Composer Effects Guide.

Fading Audio

To fade or crossfade audio, you can use the procedures described in 
ÒUsing Audio Gain AutomationÓ on page 335. If your model does 
not include Audio Gain Automation (releases prior to Release 6.1), you 
must use the procedure described in this section.

Fading and crossfading audio are easy effects to achieve. The proce-
dure that differs most from analog editing is crossfading. In the analog 
world, unless you are using a mixer you must lay down audio on two 
separate channels and fade one down, then fade up the second on an 
overlapping section. With Film Composer, you simply apply the aural 
equivalent of a visual dissolve.
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To apply a fade or crossfade:

1. Place the position indicator on the desired transition.

2. Click the Add Dissolve button (it appears by default on the second 
row of buttons below the Record monitor).

The add dissolve dialog box appears.

3. Do not choose another effect from the Add pop-up menu at the 
top; only dissolves work with audio tracks.

4. Select a duration for the dissolve, measured in frames (30 frames 
equals one second of NTSC footage; 25 frames for PAL).

5. Choose the location for the dissolve from the Position pop-up 
menu.
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¥ Ending at Cut fades the audio to zero from the A-side segment 
by the cut point.

¥ Centered on Cut, or Custom Start creates a crossfade. Custom 
Start allows you to begin the dissolve off-center Ñ that is, 
closer to the transition and ending later into the B-side, or the 
reverse.

¥ Starting at Cut fades the audio up from the B-side starting at 
the cut point.

6. If you chose Custom Start, enter the number of frames before the 
transition to begin the effect in the ÒStarts x frames before cutÓ 
entry box. Otherwise, leave the default value in the entry box.

7. (Optional) Choose a media drive other than the default Effect 
Source Disk from the Target Disk pop-up menu.

8. Click Add to place the effect at the transition point without ren-
dering. Click Add and Render to do both at once. 

n In most cases you can choose the second option, Add and Render, to allow 
immediate real-time playback of the audio effect (rendering of audio dissolves 
is usually instantaneous).

The effect is completed.

Dipping Audio

To dip audio from a higher level to a lower one Ñ for example, when 
bringing music down and under a voice-over track Ñ you can use the 
procedures described in ÒUsing Audio Gain AutomationÓ on 
page 335. If your model does not include Audio Gain Automation 
(releases prior to Release 6.1), use the procedure described in this sec-
tion.

To apply a dip in audio:

1. Play back the section of the sequence where the dip will take place 
to determine the start point for the dip, and apply an add edit to 
the audio track. 
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2. Do the same for the end point where the audio will dip back up.

3. Place the Position indicator over the new segment of audio, and 
open the Audio Mix tool.

4. Adjust the track to the desired volume level as described in the 
section ÒUsing the Audio Mix ToolÓ on page 327.

5. Apply a Quick Dissolve to both Add Edit points, using the tech-
niques described in the previous section. Be sure to choose ÒCen-
tered on CutÓ or ÒCustom StartÓ from the Position pop-up menu.

After rendering, the audio dips smoothly from the higher levels of the 
adjacent segments of the track to the lower level applied to the middle 
segment.

Mixing Down Audio Tracks

When you work with multiple audio tracks while editing your mate-
rial, you may need to mix the Þnal audio down to two tracks.

After you edit a number of tracks of audio, mix them down to one or 
two tracks of audio by following these steps:

1. Load a sequence into the Record monitor.

2. Click the track selectors to select the audio tracks you want to mix 
down.

3. Mark an IN and an OUT at the start and end of the material you 
want to mix down.

If you do not mark the section of audio you want to mix down, the 
system mixes down all of the selected audio tracks.

4. Choose Audio Mixdown from the Special menu. The top of the 
box displays the source audio tracks and the start and end time-
codes for the section of audio youÕve selected to mix down.
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5. Click Mono and select the target track to which you want to mix 
down the audio.

If you desire stereo, click Stereo and select two target tracks for the 
mixed-down audio. The system mixes down all the odd audio 
tracks to the left track and all the even audio tracks to the right.

6. Select a compression ratio for the mixed-down audio.

Compress the audio at a ratio of 4:1. Select 1:1 if you do not want 
to compress the media for the tracks youÕre mixing down.

7. Choose a target disk.

The target disk is the media disk where the system stores the 
media Þles for the mixed-down audio.

8. Click OK.

The audio is mixed down and ready for two-channel playback.

Selected section of audioCompression ratios Destination track
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CHAPTER 12

Syncing Methods

Film Composer provides special tools that help you establish and 
maintain sync relationships between various clips. This includes man-
aging sync between unrelated clips or clips with the same timecode, 
ganging footage, match-framing footage, and using Sync Point Edit-
ing. These topics are discussed in the following sections:

¥ Autosyncing Clips

¥ Resyncing Subframe Audio

¥ Managing Sync Breaks

¥ Managing Sync with Multiple Tracks

¥ Using Sync Point Editing (SPE)

¥ Ganging Footage in Monitors

¥ Using Match Frame

Autosyncing Clips

For more information 
on tracking sync breaks, 
see ÒDisplaying Sync 
BreaksÓ on page 368.

When you digitize footage that includes both audio and video, the sys-
tem automatically establishes sync when it creates clips in the bin. 
Autosyncing applies to audio and video clips that have been digitized 
separately, usually from two separate sources. Autosyncing creates a 
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new subclip that displays sync breaks in the Timeline as though the 
audio and video were digitized simultaneously.

Autosyncing is often used for Þlm projects in which picture and sound 
are captured separately. These clips are often synced based on com-
mon Þlm timecode, sound timecode, or auxiliary timecode. You can 
also autosync any audio and video clips based on an artiÞcial IN point 
or OUT point relationship you establish with marks.

Use the following guidelines when autosyncing:

¥ You can autosync audio clips with video clips only. To link two or 
more video clips or audio clips, use the Grouping option described 
in ÒGrouping and MultigroupingÓ on page 389.

¥ You can create only one autosynced subclip at a time. You cannot 
autosync numerous pairs of audio and video clips simultaneously.

¥ If the audio and video clips do not have matching source or auxil-
iary timecode, you must establish common sync frames. To do 
this, mark IN points (or OUT points) on both clips before auto-
syncing.

¥ If you are autosyncing clips of different lengths, the longer clip is 
truncated to the length of the shorter clip.

¥ If you autosync according to common timecodes that are stag-
gered (one clip starts later than the other) the later starting time-

Sync break 
displayed in the 
Timeline 
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code becomes the start of the new subclip. The clip with the earlier 
starting timecode is trimmed accordingly.

To create an autosynced subclip:

1. Highlight the two clips in the bin. Choose AutoSync from the Bin 
menu. 

The AutoSync dialog box appears.

2. Select an option, based on the following:

¥ Film TC/Sound TC if you are syncing clips with matching Þlm 
and sound timecode recorded in the Þeld; this option is 
dimmed if you are not working on a Þlm project.

¥ Inpoints if you are syncing according to IN points set in both 
clips.

¥ Outpoints if you are syncing according to OUT points set in 
both clips.

¥ Source Timecode if the two clips have matching timecode.
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¥ Auxiliary TC1-TC5 if the two clips have matching timecode in 
the same auxiliary timecode column. Select an Auxiliary TC, 1 
through 5, from the pop-up menu.

3. Click OK. The subclip is created and named by default after the 
video clip with the sufÞx Ò.sync.nÓ where ÒnÓ is the incremental 
number of subclips created with the same name.

You can change the name according to preference. You can load an 
autosynced subclip into the Source monitor and immediately edit it 
into a sequence.

Resyncing Subframe Audio

Film Composer allows you to adjust the sync between the audio and 
video portion of subclips at the subframe or perforation level (1/4 
frame adjustments) for more exact sync.

When you perform the subframe resync, you can obtain a closer rela-
tionship between audio samples and Þlm frames than that established 
in the Þlm-to-tape transfer process. For example, when a Þlm lab 
punches the correct clapsticks frame to match the audio clap, during 
telecine transfer the process of aligning the sync points is inexact, and 
as a result true sync may be off by one or more perforations.

The following conditions apply to resyncing at the perforation level:

¥ You may adjust the sync between a single video and a single audio 
track within subclips only. These can be the subclips created when 
you autosync, or subclips you create manually from master clips 
in preparation for editing.

¥ You cannot slip beyond the duration boundaries of the source 
master clip.

¥ The sync adjustments you make will be referenced in any cut list 
you output for any sequence that uses the adjusted subclip. 
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¥ The number of perfs you slip appears in the Slip column of the 
project bin when the Slip heading is selected for display in the bin. 

To resync audio for a selected subclip:

1. Load the subclip into the Source monitor.

2. Use one of the audio scrub techniques described in ÒUsing Audio 
ScrubÓ on page 319 to locate the closing-slate frame. 

3. Turn on the Audio Waveform display by selecting Waveform/
Sample Plot from the Timeline Fast menu.

4. Click the Source/Record toggle button in the Timeline toolbar to 
display a timeline for the subclip.

5. Zoom in on the area of the subclip that contains the audio-slate 
frame as follows:

a. Select Zoom In from the Timeline Fast menu 

b. Draw a box around the slate-frame area.

6. Move the audio sync either backward or forward in one-perf 
increments by clicking the Slip Left One Perf or Slip Right One 
Perf buttons

Each click of the selected perf button performs the sync adjust-
ment.

7. Play the subclip in the Source monitor to evaluate your sync 
adjustment. Repeat the steps above to further adjust the sync up to 
8 perfs in either direction.

8. Use the resynced clip to edit into the sequence.

n If you Þnd a subframe sync problem within an edited sequence, be sure to cor-
rect the audio sync in the original subclip used in the edit. The sequence will 
then be updated.
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Managing Sync Breaks

Sync breaks occur when a frame-accurate relationship between two 
clips or between the audio and video tracks within a single clip is off-
set during editing. Often this happens unintentionally when you per-
form one of the following actions:

¥ Selecting only one track in a synced relationship (audio only or 
video only for example) and performing edit functions that 
lengthen the duration, such as Splice, Extract/Splice, or adding 
frames in Trim mode.

¥ Selecting only one synced track and performing edit functions that 
shorten the duration, such as Extract, Extract/Splice, or removing 
frames in Trim mode.

Film Composer provides several features for avoiding, tracking, and 
removing sync breaks, as described in this section.

Editing to Avoid Sync Breaks

One way to avoid breaking sync is to maintain the duration of the 
track when adding or removing material, as follows:

¥ When adding material to a track, use the Replace or Overwrite 
functions instead of Splice, whenever possible.

¥ When removing material from a track, use Lift instead of Extract 
(the Lift function leaves Þller of the same duration when removing 
footage).

¥ When performing Segment mode edits, use the Lift/Overwrite 
function instead of Extract/Splice whenever possible (Lift/Over-
write leaves Þller behind and overwrites material at the new desti-
nation, maintaining sync in both cases).

¥ In Trim mode, you can sync-lock tracks to avoid breaking sync, or 
use the Control-key function for adding black during trims, as 
described in ÒMaintaining Sync While TrimmingÓ on page 311.  
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You can also perform dual-roller trims (that maintain duration) 
instead of single-roller trims.

There are many cases in which you cannot avoid splicing or extracting 
material, or performing single-roller trims that break sync. The follow-
ing sections describe features for tracking and Þxing sync breaks in 
those circumstances.

Displaying Sync Breaks

By default the Timeline displays sync breaks whenever they occur 
during editing. These appear at break points as white numbers indi-
cating negative or positive offset values relative to zero. The Sync 
Breaks option also displays match-frame edits by displaying an equal 
sign (=) on the edits.

You encounter sync breaks and match frames in different circum-
stances:

¥ You can encounter sync breaks in one or several video tracks, 
audio tracks, or both. Sync-break offset numbers appear by default 
only in the affected tracks.

For more information 
on match frames, see 
ÒAdding an Edit 
(Match Framing)Ó on 
page 284.

¥ You encounter match-frame cuts whenever you perform an Add 
Edit or whenever you move a segment up against footage from the 
same clip, and the timecode is continuous across the edit.

Sync Breaks
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You can also customize the Timeline view to display sync breaks and 
match frames in video tracks only, audio tracks only, or none.

To customize the sync break display, choose Sync Breaks from the 
Timeline Fast menu, and choose an option from the submenu.

n This feature applies only to master clips in which audio and video tracks were 
digitized simultaneously, to autosynced subclips, or to any other subclip with 
video and audio tracks.

Fixing Sync Breaks

In general, sync breaks are displayed only when the out-of-sync tracks 
overlap. In other words, if an overlapping portion of one of the tracks 
is deleted, replaced, moved, or trimmed, then the sync break disap-
pears. You Þx sync breaks in one of several ways, based upon the type 
of break and the needs of your sequence.

Fixing Sync in Trim Mode

For more information 
on trimming, see Chap-
ter 10.

In Trim mode, restore the frames to sync by performing one or more 
single roller trims on the out-of-sync tracks. Trim the exact number of 
sync-break frames displayed in the Timeline to reverse the break. 
When using Trim mode, keep the following in mind:



370

¥ Sync lock any additional tracks that are synced to the track you are 
trimming. Otherwise, you might restore sync in one track and 
break it in the others.

¥ Do not perform a dual-roller trim Ñ this does not remove the sync 
break.

¥ Do not perform the trim on the OUT point (A-side transition) of 
the out-of-sync segment. This does not remove the sync break. 
Always perform the trim on the IN point (B-side transition) of the 
segment.

Fixing Sync in Source/Record Mode

For more information 
on editing in Source/
Record mode, see 
Chapter 8.

In Source/Record mode, restore sync by either adding new material or 
extracting material from the out-of-sync track. Add or extract the exact 
number of offset frames displayed in the Timeline, with the following 
considerations:

¥ Do not use the Overwrite or Lift functions. These do not remove 
the sync break. You can, however, overwrite or lift the out-of-sync 
material entirely to eliminate the break.

¥ You can splice in or extract selected frames of Þller when neces-
sary.

¥ You can use the Add Edit function to isolate just a portion of a clip 
or Þller segment in the sequence for extracting or replacing.

Fixing Sync in Segment Mode

For more information 
on editing in Segment 
mode, see ÒUsing Seg-
ment ModeÓ on 
page 254.

In Segment mode, you can restore sync in some circumstances by 
selecting and moving the entire out-of-sync segment. You can move 
the segment forward or backward in the opposite direction of the 
break to reverse it, but with the following considerations:

¥ Use Lift/Overwrite (the red arrow) to leave Þller behind and 
maintain any other sync relationships that might be affected by 
the move.
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¥ Use Lift/Overwrite to delete the entire segment and leave Þll to 
eliminate the break.

¥ Use the Add Edit function to isolate a portion of the clip for mov-
ing or deleting.

¥ Move the out-of-sync track, if possible, beyond the overlapping 
range with the synced material to eliminate the sync break.

Managing Sync with Multiple Tracks

The Sync Breaks display in the Timeline makes it easy to manage sync 
between video and one or two audio tracks. There are a number of 
additional techniques you can use to manage sync when working with 
four or more tracks. These include the sync lock feature, tail leaders, 
and Add Edits.

Using Sync Lock

For more information 
on sync-locking tracks 
in Trim mode, see 
ÒMaintaining Sync 
While TrimmingÓ on 
page 311

The sync lock  feature allows you to maintain sync among several 
tracks while adding or removing frames in Trim mode. For example, if 
you insert an edit into one track that is sync locked to a second track, 
the system automatically inserts Þller in the second track to maintain 
sync between the two.

You activate sync locking by clicking the indicator box in the Track 
Selector panel to display the Sync Lock icon.  You can also toggle all 
locks on or off by Option-clicking in the indicator box of the TC track.

There are several unique aspects to sync-locking:

¥ Sync locking is a Trim mode feature only.  Edits performed in 
Source/Record, Segment, or Effects mode will override sync-
locked tracks.

¥ Sync locking applies to single-roller trims only, because dual-roller 
trims do not break sync.

Sync lock 
indicator
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¥ You can sync lock any number of tracks in any combination. In 
other words, the tracks do not require matching timecode or com-
mon sources, and can include multiple video tracks as well as 
audio tracks.

¥ Sync locking affects entire tracks. This means that parallel seg-
ments in other sync-locked tracks are affected when you trim any-
where in the sequence.

Using Tail Leader

You can add tail leader to the audio or video material in Film Com-
poser to provide a useful visual reference in the Timeline for tracking 
and Þxing sync breaks across any number of tracks.

Film editors traditionally use standard head and tail leaders for this 
purpose. You can create your own leader according to any speciÞca-
tion, as described in ÒCreating LeaderÓ on page 171.

With tail leader added to synchronized tracks, you can go to the end of 
the sequence after making a complicated edit and see whether the 
leaders are lined up. If they are out of line, this indicates a sync break 
that you can measure and eliminate as follows:

1. Place the position indicator in the black segment that follows the 
out-of-sync leader.

2. Select the track, then click the Mark Clip button. You can measure 
the break by checking the IN/OUT duration of the marked seg-
ment.

Tail leaders lined up for multiple

video (vid) and audio (aud) tracks
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3. To restore sync, Þnd the point at which the sync was lost. Add or 
remove frames using the appropriate edit function, as described in 
ÒFixing Sync BreaksÓ on page 369.

As a quick Þx, you can enter Extract/Splice Segment mode by clicking 
the yellow arrow button. Drag the black segment at the end of the out-
of-sync tail leader to the location where the sync was lost. This seg-
ment of black, created when the track went out of sync, is the exact 
length of the sync break.

Using Locators

For more information 
on using locators, see 
the Avid Film Composer 
Getting Started Guide.

Like tail leaders, you can add locators to material in the Timeline to 
track and adjust breaks in sync between any number of tracks. With 
locators, you have the advantage of placing them anywhere in the 
sequence, and adding speciÞc notes.

To mark sync points with locators:

1. Place the position indicator at the point in the sequence where you 
want to maintain sync between two or more tracks.

Mark Clip allows you to 
measure the break

Move the black
segment using

Extract/Splice
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2. Select the Þrst track, and click the Add Locator button.

The system adds a red locator to the track in the Timeline and in 
the Record monitor.

3. To add a note that will appear in the Record monitor whenever 
you park on the locator frame Ñ such as Music sync or Sound Effect 
sync Ñ double-click the locator in the Timeline, type the text into 
the Locator Text box, and click OK.

4. Repeat the procedure for subsequent synchronized tracks. Make 
sure to keep the position indicator in the same location in order to 
line up the locators in sync.

You can use the Find 
procedure to go to a 
locator  quickly with 
text. For more informa-
tion, see the Avid Film 
Composer Getting 
Started Guide.

5. After completing an edit that you think may have affected the 
sync, return to the segment that contains the locators, and click the 
Focus button. If the locators are not lined up, the sync is broken.

To adjust the sync break:

1. Measure the sync break by Þrst placing the position indicator on 
the leftmost locator and clicking the Mark IN button. Then place it 
on the other locators and click the Mark OUT button.

2. Check the IN/OUT duration of the marked section.

3. To restore sync, Þnd the point at which the sync was lost. Add or 
remove frames using the appropriate edit function, as described in 
ÒFixing Sync BreaksÓ on page 369.

Locators in sync
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Using Add Edit When Trimming

When trimming with several audio tracks in sync, you can use the 
Add Edit button to create an edit in the silent or black areas of the 
synced tracks. These occur in line with the track you are trimming, 
and they trim all the tracks at once to maintain sync.

To use the Add Edit button while trimming:

1. Place the position indicator on the edit that you want to trim.

2. Select only the additional tracks that are in sync, and click the Add 
Edit button. 

The system adds a transition at the location of your position indi-
cator in the Timeline.

3. Select the transition and trim (be sure to select all the synced 
tracks).

As you trim, frames are added or removed from the additional 
tracks as well.

4. When you are Þnished trimming, remove the Add Edits from the 
sync tracks by choosing Remove Match Frame Edits from the Clip 
menu.

Using Sync Point Editing (SPE)

Sync Point Editing (SPE) allows you to overwrite material onto your 
sequence in such a way that a particular point in the source material is 
in sync with a particular point in the sequence. For example, you can 

Add Edits in black
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sync an action in the source video with an audio event, such as a musi-
cal beat in the Record monitor, then edit it so that the action occurs on 
the beat.

Like a replace edit, Sync Point Editing uses the relative location of the 
position indicator in both the source and record material as the sync 
point. However, Sync Point Editing determines the duration of the 
new edit according to marks that you set, as opposed to a replace edit, 
which uses the head to tail frame duration already established in the 
Timeline. You can apply these marks across multiple tracks when 
marking a sequence. This allows you to add overlap cuts.

SPE requires two pieces of information:

¥ The sync points: These are the points where the synchronized 
relationship between the source and record material is established.

¥ The duration of the relationship: This is determined by the posi-
tions of the head and tail frames (and sometimes by the position 
indicator). Both marks can be in one monitor, or one mark can be 
in one monitor and the other mark in the other monitor. It is 
important that the duration of the material being edited into the 
sequence is sufÞcient for the size of the edit.

To perform a sync-point edit:

1. Load a clip or sequence into the Source monitor. 

2. Load a sequence into the Record monitor.

3. Mark an IN or OUT point in either the Source or Record monitor, 
leaving the opposite monitor clear of marks. Alternatively, mark 
an IN and OUT in the Source monitor, or an IN and OUT in the 
Record monitor. (If there is no point in the Record monitor, the edit 
occurs at the position indicator.)

4. Move the source position indicator to the sync frame in the clip. 
This establishes the source sync point.

5. Move the record position indicator in the Source/Record window 
to the sync frame in the sequence.
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6. Select Sync Point Editing in the Composer Settings dialog box, or 
choose Sync Point Editing from the Special menu.

Notice the orange box on the Overwrite button that signals that 
Sync Point Editing is active.

7. Select the source and record tracks for this edit. Click the Over-
write button.

The sync-point edit is completed.

To turn off Sync Point Editing, deselect the option from the Composer 
Settings dialog box or from the Special menu.

Ganging Footage in Monitors

The Gang function does not combine tracks into a synced relationship, 
but rather locks monitors in sync so that you can move through foot-
age in two or more monitors simultaneously. This is convenient for 
viewing and marking the sequence and source material simulta-
neously, based on syncing of the position indicators in each monitor.

You can gang the Source monitor and/or any number of pop-up mon-
itors with the Record monitor. For instance, before editing them into a 
sequence, you can gang a music track in a pop-up monitor, source 
footage in the Source monitor, and a sequence in the Record monitor. 
Then you can view the footage, adjust the sync points, and mark them 
before completing the edit.

Use the following procedure to gang monitors:

1. Load a sequence into the Record monitor.

2. Load one or more clips into the Source monitor and/or pop-up 
monitors.

Orange mark 
indicates Sync 
Point Editing
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3. Click the Gang button for each monitor that you want to synchro-
nize (the Record monitor is always ganged). The button turns 
green when enabled.

n The Gang button appears by default in the second row of buttons below the 
Record monitor, and in the second row of information above the Source/
Record monitors.

4. View the footage in any of the monitors using standard playback 
methods. 

Notice as you move through footage in one monitor, the footage in 
all other monitors freezes. The footage is updated when the play 
stops. Simultaneous full-motion playback is not possible, although 
sync is maintained at all times.

Using Match Frame

The Match Frame feature allows you call up and display matching 
footage in the Source monitor from the Record monitor. Reverse Match 
Frame lets you load a source clip and locate its sync frame in the 
sequence.

Like the Gang function, match framing does not create a permanent 
sync relationship between clips, but instead provides you with a con-
venient way of locating, marking, and editing matching material.

Track selection determines the match frame.  If you select a video 
track, the system matches a frame from the video. If you enable several 
tracks, the system matches the frame from the highest selected track 
level, in descending order: V1, A1, A2, and so on.

The Match Frame button appears by default in the second row of but-
tons below the Source monitor. To match frame from footage in the 
Record monitor, you must map the button to the Record monitor pal-
ette.
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Performing a Match Frame

To use Match Frame:

1. Load a sequence into the Record monitor.

2. Select a track for the footage you want to match, and place the 
position indicator on a selected frame.

3. Click the Match Frame button.

The system loads the source clip into the Source monitor, parks on 
the match frame, and marks a new IN point to prepare for making 
an edit.

n Any previous IN or OUT marks are removed when you use match frame. To 
override this, Option-click the Match Frame button.

Performing a Reverse Match Frame

To perform a reverse Match Frame:

1. Place the position indicator on the desired frame in the source 
footage.

2. Make sure the appropriate tracks are selected in the Timeline.

3. Press the Control key and click the Match Frame button under the 
Source monitor.

The system cues the sequence to the matching frame on the record 
side. If the shot exists in more than one place, the sequence cues to the 
Þrst location of the match frame, and continues through the sequence 
to subsequent locations each time you click the Match Frame button.
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Using the Match Frame to Find Sources

The Match Frame function also provides the ability to trace objects 
quickly through their hierarchy of links. For example, you can match 
frame a cut in the sequence to its original subclip, then from the sub-
clip to the original master clip, and Þnally locate the bin in which the 
master clip is saved. 

n For more information on Þnding clips and frames with Match Frame, see the 
Avid Film Composer Getting Started Guide.
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CHAPTER 13

Multicamera Editing

Film Composer multicamera editing tools allow you to incorporate 
multiple camera angles easily into the nonlinear editing process.  Sys-
tems equipped with the Multicamera Play option can also play back, 
in real time, up to four camera angles in a Source monitor quad split, 
along with playback of the sequence in the Record monitor.  Tech-
niques for using these features are described in the following sections:

¥ Developing a Postproduction Model

¥ Grouping and Multigrouping

¥ MultiCamera Edit Modes

¥ MultiCamera Editing Techniques

¥ Workßow Options

Developing a Postproduction Model

As the name indicates, multicamera production multiplies the amount 
and complexity of source material you manage in a project. As a result, 
comprehensive postproduction planning is essential to avoid the haz-
ards of mismatched shots, takes, and entire reels during digitizing and 
grouping.
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This section presents a postproduction model that can help you orga-
nize your material.  While the routines of a typical situation comedy 
are used to illustrate these organizing principles, you can easily adapt 
this model to suit the particular needs of other productions, such as 
sports, theater, and nightclub events.

The guidelines of organizing for a large multicamera project are as fol-
lows:

¥ Choose a tape-numbering scheme and be consistent.

¥ Film the multicamera shoot logically according to ofßine and 
online editing needs.

¥ Manage the production path of both sound and picture for quality 
and efÞciency.

Tape Classification Schemes

Because multicamera production involves both sequential and syn-
chronous recording on numerous reels, a comprehensive classiÞcation 
scheme for reels, takes, and clips can help avoid confusion.

Many multicamera Þlm productions use alphabetical designations for 
classifying source footage. For example, the cameras are referred to as 
A, B, and C, covering the scene from left to right as viewed from the 
camera side. A fourth camera X is often a ßoater, used to grab close-
ups and miscellaneous shots. You can classify the shot rolls with the 
letter of the source camera, then numbered sequentially. For example, 
camera roll A1 is the Þrst roll for Camera A.

Production Paths

In addition to a numbering scheme, you can organize the ßow of 
recorded material throughout postproduction to make efÞcient use of 
resources and maintain the quality of video and audio.
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For multicamera television productions shot on Þlm, the most com-
mon picture path is described in the Avid Film Composer Getting Started 
Guide. This involves simultaneously transferring of the camera rolls to 
both a set of ofßine tapes (3/4-inch cassettes, for example) and a set of 
online tapes (such as Betacam or 1-inch). The primary differences are:

¥ Each take is multiplied by four, therefore all reels require strict 
organization and labeling at all stages to avoid confusion.

¥ Many productions use time -of-day as the audio timecode, synced 
to picture using a smartslate. These audio timecodes can be trans-
ferred to the address track of tapes in telecine, and/or imported 
into the Sound TC column or an Auxiliary TC column.

¥ Alternatively, you can record in-camera timecode both on Þlm and 
on an audio track for autosyncing in Film Composer.

Facilities and formats may vary. The basic model can apply to any 
multicamera production in which high quality output is the goal.

Multicamera filming

Offline work tapes Digitize
Offline Edit

Finished program

Cut list

1”

EDL

Telecine

Simultaneous 
telecine transfer

Online Edit

D2

Online masters
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Managing Audio

The Film Composer MultiCamera features allow you to patch chan-
nels of audio from any source clip to any track during editing.  You can 
strategically designate speciÞc channels of audio to record on speciÞc 
reels or tracks in preparation for editing and generating an effective 
EDL or cut list.

In this example, the goal is to create a Þnished master tape with pro-
duction dialog on channel 1, music and sound effects on channel 2, 
audience left on channel 3, and audience right on channel 4. Your pro-
duction might use a 1/2-inch four-track tape recorder, as follows:

¥ Dialog on track one

¥ Audio timecode on track two

¥ Stereo audience left on track three

¥ Stereo audience right on track four

Ch 1: Dialog

Ch 2: Music & Effects

Ch 3: Audience L

Ch 4: Audience R

tracks in Film Composer
Patch and edit selected

EDL generates
the final mix

Record: Transfer:

 

Offline work tapes

Digitize all tracks

Finished program:

1”

EDL

Telecine

D
2

Online masters

Track 1: Dialog

Track 2: Audio TC

Track 3: Audience L

Track 4: Audience R

(four channel)

Ch 1: Dialog

Ch 2: (clear)

Ch 3: Audience L

Ch 4: Audience R

Address track: Audio TC
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Any music and effects during production can be recorded as wild 
sound and edited into the program on track two along with additional 
effects and music during postproduction. All tracks are transferred to 
tape in telecine, with audio timecode recorded onto the address track 
and used during digitizing and editing.

This is just one example. Choose the right path for your production.

Digitizing Workflow

The organization of the digitize bins helps to avoid slowing the system 
with large bins. It also keeps editing resources free of clutter. The basic 
procedure for using the digitize bins is as follows:

1. When you are ready to digitize, create one bin for each tape (usu-
ally each dayÕs worth of takes will Þt onto a single dailies tape). 
This keeps bins to a manageable size, and when you autodigitize 
the system automatically names each clip (take) after the name of 
the bin (tape), and numbers them sequentially.

2. After digitizing, you can rename the clips to reßect the scene and 
take.

3. Gather the clips for each  take into one bin. This helps avoid acci-
dentally grouping clips with the same timecode from different 
days. Sort the clips by name so they group in the right order.

4. After creating groups, move all the new clips into a separate bin. 
This helps simplify the contents of the bin for editing.

For television productions shot on Þlm, scenes are often referred to as 
Scene A, B, C, and so forth. When the Þlm is transferred to tape for 
ofßine editing, you can import the log of the transfer and batch digi-
tize the reels.
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Digitizing Methods

For more information 
on logging and digitiz-
ing procedures, see 
Chapter 2 and Chapter 
3.

Film productions generally use one digitizing method: import the log 
from the telecine transfer and use this to batch digitize. 

However you choose to digitize, you should have accurate notes on 
the number and content of takes on each reel in order to identify the 
content of each clip when necessary. 

Cam A

Cam B

Cam C

2. Gather takes into one bin,
sort by name, then Group

3. Gather appropriate groups 
into one bin for each Act

1. Digitize each reel separately

Reel 
001

Reel 
002

Reel 
003

Reel 
004

Cam X
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Storage Tips

The following tips can help you make the best use of storage drives:

¥ To save storage space, digitize only the audio channels required 
for ofßine editing.

¥ For the most efÞcient playback of multicamera material, distribute 
the reels in each tape load between drives.

¥ To avoid switching drives while digitizing the same reel, target 
one volume per reel whenever possible.

With a large multicamera production, you can plan the use of drives in 
advance, based on the number of drives available, the chosen AVR, 
and the length of each reel. 

Consider the following example:

¥ You have a four-camera production yielding two tape loads 
(approximately 50 minutes per tape).

¥ You want to autodigitize at AVR 3m.

¥ You need to digitize 2-channel audio at 44.1 kHz from cameras one 
and four.

¥ For storage, you have four 4-gigabyte drives.

With this set of circumstances, you might distribute the media as 
shown in the following illustration.  Storage requirements are based 
on information provided in the Avid Media Composer Products Reference.
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Checking the Bins

Before gathering the digitized clips into bins for grouping, you should 
open the bins in each tape load and compare the clips for inconsisten-
cies. You can take steps to conform the bins now and avoid problems 
during grouping and editing, as follows.

Replacing Missing Clips

If one bin has fewer clips than the others, the  camera may have been 
stopped during a particular take. If you group the take with the miss-
ing camera, the shots shift in the Quad Split to Þll the missing angle, 
which can disorient the editor. Correct this problem by creating a 
dummy clip.

To create a dummy clip:

1. Log a new source clip into the bin.

2. Match the timecode from one of the clips from another camera, 
and use any name.

002 

003 

004 

005 

001

Work tapes Tracks digitized Storage required Targeted drive

3.5 gigabytes

2 gigabytes

2 gigabytes

3.5 gigabytes

2 gigabytesX 2

X 2

X 2

X 2

X 2
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When the clips are grouped and loaded during editing, this dummy 
clip displays the message ÒMedia Ofßine,Ó and maintains the distribu-
tion of camera angles in the Quad Split.

Checking Audio and Image Quality

Check the Audio column to make sure the audio was recorded on the 
correct channels, from the correct source reels, at the correct kHz. You 
cannot play back audio compressed at different rates within the same 
group or multigroup.

You can also spot-check the picture quality by loading two or more 
clips from each bin into the Source monitor and viewing the clips. If 
you Þnd a problem, you can redigitize before the edit session begins.

Additional Offline Editing Aids

Film Composer provides features speciÞcally designed to aid the 
ofßine editing process, including:

For more information 
on these features, see 
Chapter 9.

¥ Color Frame tracking, for avoiding color frame shifts in online 
editing with 1-inch videotape

¥ Dupe Detection, for avoiding duplicate frames in online editing

Grouping and Multigrouping

The grouping and multigrouping procedures both gather selected 
clips into a single unique clip. Both allow you to use special Multi-
Camera editing features, such as Quad Split and cutting on the ßy in 
MultiCamera mode. The difference between the two can be summa-
rized as follows:

¥ Grouping creates a separate group clip out of a single set of master 
clips, from the IN point to the OUT point of the longest clip. Multi-
grouping takes the Group function one step further, literally 
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stringing numerous sequential groups into a rough sequence. For 
this reason, multigroups are also known as sequence clips.

¥ The Group function allows you to sync clips based on common 
source timecode, auxiliary timecode, or marks placed in the foot-
age. Because of the need for complete accuracy in sorting and 
grouping the clips, multigrouping is performed on the basis of 
common source timecode only.

¥ The MultiGroup function is designed primarily for situation com-
edies and similar productions that record multiple takes sequen-
tially on the same source tapes. Multigrouping does not provide 
any beneÞt when you edit with clips that do not share common 
timecode or were not recorded sequentially, and may even cause 
the wrong clips to be grouped together.

Both group clips and multigroup clips are limited to eight clips in each 
synchronized group, although multigrouping can string an unlimited 
number of groups together sequentially.

Creating Group Clips

In addition to the multicamera context, grouped clips can be useful in 
other circumstances. Unlike multigrouping, which requires clips with 
matching source timecode, you can group clips that were shot at dif-
ferent times, on different days, and on completely different source 
tapes. This means that you can:

¥ Use group clips to create montage sequences quickly with fast-cut-
ting between unrelated shots

¥ Use group clips to sync and edit an audio track (music for 
instance) with two or more video tracks (especially useful in 
music-video editing)

¥ Use group clips for multicamera editing when you want to isolate 
each take as a group, and edit selectively, rather than build a larger 
sequence clip
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¥ Use carefully synchronized marks to group selected portions of 
multicamera clips

The last two options are generally for use in smaller multicamera 
projects. Sorting, marking, selecting, and grouping individual takes of 
a larger project can be very time consuming.

To create a group clip:

1. If you are using a sync point, load the clips and mark an IN at the 
sync point at the start of each clip, or mark an OUT at the sync 
point at the end of each clip.

n For multicamera video or Þlm shoots, you typically use a slate for marking IN 
and OUT points. But you can use any visual or aural event that is recorded 
by all cameras simultaneously.

2. In the bin, select all the clips you want to group.

3. Choose Group Clips from the Bin menu. The Group Clips dialog 
box appears.
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4. Select an option, based on the following:

¥ Film TC/Sound TC: If you are syncing clips with matching Þlm 
and sound timecode recorded in the Þeld. This option is 
dimmed if you are not working on a Þlm project.

¥ Inpoints: If you are syncing according to IN points set in each 
clip.

¥ Outpoints: If you are syncing according to OUT points set in 
each clip.

¥ Source Timecode: Select if the clips have matching timecode.

¥ Auxiliary TC1-TC5: If the clips have matching timecode in the 
same auxiliary timecode column.

5. Click OK. A group clip appears in the bin, with the name of the 
Þrst clip in the group, following by the extension Ògrp.n.Ó 

The n is an incremental numbering of group clips with the same 
name in the same bin. You may want to rename this to something 
easier to read, such as name.Group.

Creating Multigroup Clips

Multigrouping is strictly for use in large multicamera productions, 
such as situation comedies, in which all synchronous camera shots are 
recorded with the same timecode. The MultiGroup function is a single 
Bin menu command that eliminates the time-consuming steps of col-
lecting, sorting, grouping, and assembling large volumes of multicam-
era clips.

To multigroup your material, use the following procedure:

1. Sort the clips by name in the bin. 

2. Choose Select All from the Edit menu to select the master clips.

3. Choose MultiGroup from the Bin menu.

The system creates several group clips for each take in the bin, 
then creates a multigroup from the groups. The multigroup has 
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the same icon as the groups, but the icon is preceded by a plus 
sign.

MultiCamera Edit Modes

The three edit modes you use during multicamera editing are Full-
Monitor display, Quad Split, and MultiCamera mode. You can edit 
with either group clips or multigroup clips in all three modes.

Full-Monitor Display

When you Þrst load a grouped or multigrouped clip, the Source moni-
tor displays a single frame from one clip in the group in Source/
Record mode. This is called Full-Monitor display when working with 
group clips, because you can view each angle in full-monitor size as 
you edit. Also, in Full-Monitor display, the third Full-Screen monitor 
also remains full-screen.
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The basic features of Full-Monitor display are as follows:

¥ Provides source-oriented control of multicamera material. In other 
words, you can switch camera angles, cue, and mark material 
without affecting the sequence.

¥ Provides all the same Source monitor controls that are available 
when editing other clips in Source/Record mode.

¥ Provides all the same multicamera editing tools that are available 
in Quad Split and MultiCamera mode. These are described in  
ÒMultiCamera Editing TechniquesÓ on page 398. The only dis-
tinction is that in Full-Monitor display you can view each angle 
full-size as you edit.
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Quad Split

After loading a group clip into the Source monitor, you enter Quad 
Split by clicking the Quad Split button. The Source monitor splits into 
four quadrants. A  green Quad Split Menu icon appears in the second 
row of information above the Source and Record monitors. The third 
monitor displays the Quad Split when the Source monitor is active, 
and full-screen when the Record monitor is active.

Quad Split display Sequence or linecutQuad Split Menu icon
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The basic features of Quad Split are as follows:

¥ Provides source-oriented control of multicamera material, like Full-
Monitor display. In other words, you can switch camera angles, 
playback, cue, and mark material without affecting the sequence.

¥ Provides the same Source monitor controls that are available when 
editing other clips in Source/Record mode.

¥ Provides all the special multicamera editing features that are avail-
able in Full-Monitor and MultiCamera mode, as described in 
ÒMultiCamera Editing TechniquesÓ on page 398.

¥ Provides a list of all group clip video and audio tracks in the Quad 
Split menu for custom selection and patching.

¥ Allows you to toggle the Quad Split button to switch the Source 
monitor between Full-Monitor and Quad Split viewing and edit-
ing (editing functions are the same in both).

¥ Displays whichever monitor is active in the third monitor (you can 
toggle between Quad Split and full-screen as needed).

MultiCamera Mode

After loading a group clip into the Source monitor and editing it to cre-
ate a new sequence, you choose MultiCamera mode from the Special 
menu to activate the features. MultiCamera mode takes the Quad Split 
one step further: it gangs all shots in the group clip displayed in the 
left monitor to the sequence footage displayed in the Record monitor. 
All shots are synchronized and continuously updated during play 
back and editing. The third monitor always displays the Quad Split.
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The basic features of MultiCamera mode are as follows:

¥ Provides sequence-oriented control of multicamera material, in con-
trast to Full-Monitor and Quad Split. In other words, whenever 
you play back, cue, switch camera angles, or mark material, your 
changes take place in the sequence.

¥ Provides only Record monitor controls.

¥ Provides special MultiCamera editing features that are available in 
Full-Monitor display and Quad Split, as described in ÒMultiCam-
era Editing TechniquesÓ on page 398.

Source monitor controls are 
disabled The Gang icon turns green.   

Quad Split Menu icon
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¥ Provides the ability to cut between shots on the ßy during full-
motion playback, as you would during live switching of a show.

¥ Provides a list of all video and audio tracks in the group in the 
Quad Split menu, for custom selection and patching.

¥ Lets you deselect MultiCamera mode in the Special menu at any 
time to switch between source-oriented and sequence-oriented 
multicamera editing.

¥ Lets you deselect MultiCamera mode when you need to play back 
full-screen (the third monitor always displays the quad split in 
MultiCamera mode).

MultiCamera Editing Techniques

When you load a group or multigroup clip into the Source monitor 
and begin editing, the Timeline provides a unique display of the clip 
name to indicate the presence of a group. 

The system uses the name of the clip within the group to identify the 
shot in each cut, but adds a G in parentheses to indicate the group.

Using various keys and functions, you can switch and edit the dis-
played group shot at any point in the sequence, as described in this 
section. These features apply to both group and multigroup clips.

(G) indicates 
a group clip
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Switching Shots with the Arrow Keys

You can switch the display of camera angles using the Up Arrow and 
Down Arrow keys. The angle selection switches in either the Source 
monitor (source material) or in the Record monitor (sequence mate-
rial), whichever is active.

When the Record monitor is active, you can place the position indica-
tor within any segment and use the arrow keys to switch the group 
shot selected for that segment.

n Whenever you switch camera angles, you also switch the frame representing 
the group in the bin. You can use this method to change the representative 
frame for bin display and storyboarding.

Cutting on the Fly with Hot Keys

You can switch the display of up to eight camera angles using hot keys 
on the keyboard. The default hot keys are F9 through F12 for cameras 
one through four. You can map an additional four cameras from the 
Master Command palette to the keyboard for the full eight.
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If  you press a hot key when the footage is stopped, the system 
switches the camera angle and also creates an edit in the sequence. You 
can use this method to walk through one long group or multigroup 
sequence and edit camera angles as you go.

n To switch without creating a cut, hold the Option key when you press a hot 
key.

You can also cut on the ßy during playback using the hot keys. Sys-
tems equipped with the Film Composer Release 6.0 or later can cut on 
the ßy with live playback of all four quadrants, creating a virtual live-
switching environment with the added ability to stop, trim, or adjust 
edits at any time

Using the MultiCamera Linecut Option

The Linecut option in the Composer Settings dialog box allows you to 
edit and playback a linecut (single stream playback of the edited 
sequence) while in MultiCamera Mode. Primarily for systems that 

F10

F11 F12

F9

Key equivalents for quadrants:
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include the Avid MultiCamera Play option, this preference allows you 
to switch between singular and quad-split playback without exiting 
MultiCamera mode. The Linecut option is not selected by default.

To select the Linecut option:

1. Double-click Composer in the Settings scroll list of the Project win-
dow. The Composer Settings dialog box opens.

2. Click the Play MultiCamera Linecut check box to select it.

Using the Add Edit Button

You can use the Add Edit button like a hot key to add edits while step-
ping through a sequence, or on the ßy during playback. The only dif-
ference is that you are not switching camera angles until after you set 
the edit points. 

This method is especially useful when editing to music, since it allows 
you to concentrate on the beats and ignore camera angles until the 
edits are placed.

To use this method, you must Þrst map the Add Edit button onto the 
keyboard. Consider mapping the Add Edit button to a function key 
next to the default hot keys. For more information on mapping keys, 
see the Film Composer Getting Started Guide.

To add edits on the ßy:

1. Load the group or multigroup into the Source monitor and splice 
it into a sequence.

2. Play the sequence. Each time you want to make an edit, press the 
Add Edit key. When you stop the sequence, the edits appear in the 
Timeline.

Play the sequence repeatedly to add more edits, or remove edits 
by lassoing them in the Timeline and pressing the Delete key.
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3. After adding the edits, place the position indicator within each 
segment and use the arrow keys to switch camera angles. 

Using the Quad Split Menu

The Quad Split menu allows you to select video or audio channels 
from any of the clips in the group and patch to the tracks available in 
the sequence. This means that you can potentially have eight camera 
angles and eight or more audio tracks synchronized and available for 
patching at any time.

n The Second Row of Info option must be selected in Composer Settings to dis-
play the Quad Split icon above the Source monitor.

In addition, you can choose the Audio-Follow-Video option from the 
Quad Split menu to instruct the system to switch both audio and video 
for each camera angle together when you cut on the ßy or single-cam-
era style. 

Click the Quad Split icon to 
display the pop-up menu
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Audio-Follow-Video overrides the track selection beside the Timeline 
and switches audio in track A1 only. Audio-Follow-Video edits appear 
in the Timeline as match frames (that is, the transition contains an 
equals sign).

Using the Quad Menus

You can use the Quad menus to  group up to eight clips at a time, and 
select additional shots to display in any of the Source monitor quad-
rants.

To select an additional shot from the group to display in one of the 
quadrants:

1. Press the Control key to activate the display of shot names in the 
Source monitor quad split.

2. Click the name of the quadrant where you want to display the 
new shot. The Quad menu of shots in the group appears. 

Select additional 
angles from the 
Quad menu 
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3. Choose the shot you want to display from the menu. The new shot 
appears in the quadrant.

Using Match Frame in Multicamera Editing

You can use the Match Frame button to call up the matching shot 
within the group when matching from the sequence. Or you can call 
up the original clip when matchframing from the source group. For 
more information on using the Match Frame feature, see ÒUsing 
Match FrameÓ on page 378.

Workflow Options

Film ComposerÕs MultiCamera editing features make possible three 
basic workßow models for cutting multiple-angle shows: selective 
camera cutting, cutting on the ßy, and combination cutting.  Each 
workßow option has its own advantages. When and how to use them 
is a matter of preference.

Selective Camera Cutting

Selective camera cutting involves marking and editing source material 
into the sequence, much as you build a sequence using nongrouped 
clips in a normal session. You can play, cue, and mark clips on the 
source side, then splice, overwrite, and trim shots in the sequence.

You can perform selective camera cutting in two ways: 

¥ Lay down an entire group as a master sequence, then add edits, 
switch camera angles, and trim within the sequence, or cut in new 
shots.
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¥ Edit one clip at a time, without laying down a master sequence 
Þrst, effectively building a sequence as you would with single-
camera material. 

The advantage of selective camera cutting with grouped clips is that 
all the clips are synchronized, for simpliÞed selection of camera 
angles. Selective camera cutting generally requires use of a detailed 
line script, or detailed notes, that enable you to select shots and assem-
ble the sequence one clip at a time.

To perform selective camera cutting:

1. Load the group or multigroup into the Source monitor.

2. Using timecode notes and the numeric keypad, type in the time-
code for the Þrst take to begin the sequence, and press Enter to cue 
the clip in the Source monitor to the take.

3. Mark IN and OUT points for the entire scene.

4. Select the desired camera angle for the Þrst shot, then splice the 
entire scene into a sequence. 

5. Use the arrow keys and/or the Add Edit button to select edit 
points and switch to different angles throughout the master scene 
in the sequence.

6. If you need to replace a portion of the take with a better part from 
another take, use the timecode notes again to cue up the desired 
take, set marks, and perform a replace edit.

7. When you are Þnished with a scene, repeat the procedure for each 
additional scene in the sequence.

Cutting on the Fly

When cutting on the ßy, you use MultiCamera mode in conjunction 
with the hot keys (function keys F9 through F15) to switch between 
Quad Split camera angles ganged to the record sequence. The capabil-
ity of full-motion quad-split playback with the Avid Broadcast Video 
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Board allows you to virtually re-create the live event atmosphere, as 
though you were switching the shots live on location.

While you are cutting on the ßy, the Source monitor controls are dis-
abled. You cannot mark IN and OUT points as you do during selective 
camera cutting. Generally, you are editing from the quads according to 
the action in the Record monitor.

To cut on the ßy:

1. Load the group or multigroup into the Source monitor.

2. Using timecode notes and the numeric keypad, type in the time-
code for the Þrst take to begin the sequence and press Enter to cue 
the clip in the Source monitor to the take.

3. Mark IN and OUT points for the entire scene.

4. Select the desired camera angle for the Þrst shot, then splice the 
entire scene into a sequence.

5. Choose Setup MultiCamera from the Special menu to enter Multi-
Camera mode.

6. Play the sequence from the beginning. Watch the shots in the 
Quad Split and the sequence footage in the Record monitor; then 
use the hot keys to switch to different angles on the ßy.

7. Press the Space bar to stop the sequence and update the Timeline 
to include all the edits you made while cutting. Repeat the proce-
dure until you have the edits you want.

8. When you are Þnished with the scene, repeat the procedure for 
each additional scene in the sequence.

After cutting in various angles, you can adjust transitions and/or edit 
out the superßuous material from the sequence in Trim mode.
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Combination Cutting

Combination cutting involves the use of both selective camera cutting 
and cutting on the ßy interchangeably. Most productions use both 
methods at one time or another. Others use them in combination 
throughout postproduction. The following are two examples:

¥ If you are editing a situation comedy or similar production that 
requires a speciÞc show length for the Þnished master, you can 
begin using selective camera cutting to edit the show for time. 
This often involves emphasizing the audio on the Þrst editing pass 
(also known as a radio edit), and then cutting on the ßy in subse-
quent passes to get the timing of shot transitions and cutaways.

¥ If you are editing a live-on-tape event, such as a concert or comedy 
club performance, you can begin by cutting on the ßy to capture 
transitions spontaneously. However, you have the added beneÞt 
of stopping and returning to a transition if you make a mistake, 
and trimming or adjusting edits in a nonlinear fashion.

The difference in alternative editing styles is a matter of preference. 
Choose the approach that works best for your production.
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CHAPTER 14

Output Options for Film

At various stages of postproduction you need to generate lists that can 
be used to prepare conformed cut previews, optical effects, audio 
tracks, and eventually the Þnal cut. Film Composer and Media Com-
poser with Þlm options provide tools for creating frame-accurate lists 
that can be used to conform workprint, Þlm negative, audio tracks, or 
videotape transfers, as described in the following sections:

¥ Film List Concepts

¥ Creating a List

¥ Working with Multiple Cuts and Reels

¥ Using the Matchback Option

n For information on video output options such as generating a digital cut or 
audio and video EDLs, see Chapter 15.

Film List Concepts

The Cut List and Change List tools allow you to generate detailed 
information for conforming the workprint, the negative, or the audio 
tracks of a Þlm project in various contexts:

¥ For screening of dailies or selects, you can generate lists that the 
lab or an assistant editor can use to prepare work print.
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¥ For screenings of a current cut, you can generate ink number lists 
the assistant editor can use for conforming work print and mag-
netic track.

¥ For developing the Þnal sound tracks, you can generate lists that 
the sound department can use for editing and mixing the original 
audio source reels.

¥ For preparing optical effects, you can generate lists that the optical 
house can use for compositing multilayer Þlm effects.

¥ For screenings of more advanced cuts and reels, you can generate 
lists containing information about multiple sequences that the 
assistant editor can use to combine reels or bring conformed work 
prints up to date.

¥ For the Þnal cut, you can generate key number lists that the nega-
tive cutter can use for conforming the negative.

¥ At all stages, you can also record a digital cut of the sequence or a 
digital cut of the audio tracks for use in screening or as an aid in 
conforming the cuts, as described in Chapter 15.

The following section describes the speciÞc types of lists you can gen-
erate in Film Composer.

Cut Lists Versus Change Lists

Cut lists and change lists provide breakdowns of exactly which frames 
should be cut from the workprint or original negative. Unlike video 
EDLs, which must conform to the speciÞcations and limitations of var-
ious edit controllers, Þlm lists are read by assistant editors or negative 
cutters who can include levels of complexity not possible with EDLs.

Cut lists and change lists serve two basic purposes:

¥ You generate a cut list the Þrst time you conform a work print, 
negative, sound track, or optical effect to match the sequence.
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¥ You generate a change list to simplify the process of updating con-
formed cuts to match future changes in the sequence.

In Film Composer, each cut list uses the existing frame reference num-
bers contained in the bins to represent edit details in a sequence. 
Change lists use the same reference numbers to compare two or more 
versions of a sequence or set of sequences in order to make only the 
changes necessary to bring previously conformed cuts up to date.

When comparing a new sequence with a previous version of the same 
sequence, the change list indicates the following categories of 
sequence changes:

¥ Insertions of new material

¥ Deletions of old material which is no longer needed

¥ Trims to be made to the head and/or tails of the edits

¥ Moves that consist of a matched pair of deletions and insertions

¥ Optional information that details which portions of the sequence 
should not be altered

Frame Reference Numbers

You can generate all of the standard frame-reference information 
required for an assistant editor or negative cutter to conform a cut, 
provided you entered that information in the bin.

.................................................................

Shot X Shot Y Shot Z

New Shot

Shot X Shot Y Shot ZNew Shot

Cut list
................................................

..........................................................

Change
list

.................................................................

................

................

Sequence 1A

Sequence 1B

Conformed Cut 1A

Conformed Cut 1B

Conformed cut is 
combined with 
new material 
through the 
change list
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c If you did not log a category of data during logging and digitizing, 
you can add optional information to the bin at any time before gen-
erating a list. For example, if you add ink numbers in the Ink Num-
ber column after editing, the system will include these in the lists.

In addition, Film Composer allows you to display unique categories 
not normally included in a conventional cutlist, such as:

¥ Head Frames. You can include a Frame column to display a 
selected image from each clip.

¥ Locator comments. You can include any comments you associated 
with a particular clip using locators.

¥ Add comments. you can include any added comments you associ-
ated with a clip in the sequence during editing.

Comments can be very useful. For example, you can use locators to tell 
the composer where the music begins, or you can provide speciÞc 
color correction instructions for a frame or clip, and print these notes 
separately.

About Sublists

Both cut lists and change lists make use of sublists that communicate 
speciÞc tasks to the assistant editor, negative cutter, the sound depart-
ment, or the optical house. For example, these lists can instruct the 
facility to:

¥ Pull or assemble cuts, scenes, or takes in a particular order

¥ Remove takes that are no longer needed

¥ Layer and composite optical effects

¥ Check for duplicate frames and jump cuts

¥ Print or ßag the required duplicate negative

The heart of a cut list or change list is the assemble list, which provides 
a sequential breakdown of the cut into all its required parts. These 
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might include scenes and takes, optical effects, and duplicate frames, 
all of which you can compile in additional, supporting sublists. You 
can also choose to generate pull lists, which literally ÒpullÓ out 
selected elements from the list and display them in various sort orders.

Each type of sublist is described in the following sections.

Assemble Lists

The assemble list shows the order in which a sequenceÕs clips, optical 
effects, or standard dissolves and fades are assembled from start to Þn-
ish. The assemble list also shows where you have dupes (duplicate 
frames), even if you do not choose to generate a dupe list. In addition, 
you can choose to display optional settings and information categories 
such as comments or locators you add to the sequence, or matchback 
information.

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
.

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
.

Shot A

Shot B

Optical

Shot B
(Dupe)

Shot C

Assemble list

1. Shot A

2. Shot B

3. Shot C

4. Optical

5. Shot B - Dupe

Pull list

Optical list

Dupe list
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A-Roll Versus A/B-Roll Conforming

Film Composer assemble lists refer to one of two conforming methods: 
A-roll or A/B-roll. Before generating a cut list or change list containing 
an assemble list, you select one of these methods based on the follow-
ing criteria:

¥ A-roll or single-strand. Used primarily for 35 mm Þlm editing, 
this method requires the compositing of all multilayer effects into 
a single layer (including laboratory-standard dissolves and fades) 
before assembly. A-Roll assemble lists contain information about 
all single layer, straight cut events, with all other information 
about the sequence described in the optical list.

¥  A/B-roll or double-strand. Used primarily for 16 mm Þlm edit-
ing, the limits the amount of optical work by managing most stan-
dard dissolves and fades using two strands of Þlm. A/B roll 
assemble lists contain information about single-layer, straight-cut 

An assemble list as generated for  A-Roll (Single Strand) Conforming
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events as well as laboratory-standard dissolves and fades, with all 
other information in the optical list.

A laboratory-standard dissolve or fade is a multiple of 12 or 16 frames  
and is between 12 and 96 frames long.  All other transition effects, 
titles, graphics, dissolves and fades of nonstandard length appear in 
the optical List.

n Sound Lists are always A/B Roll and describe dissolves of any length.

Scene Assemble List

A variation on the standard assemble list is the scene assemble list, 
which presents the edit events sorted in the following order:

¥ Order of assembly

¥ Scene and take

¥ Reel number

.................................................................................... . . . . . . . . . . . . . . . . . . . . . . . . 

................................................................................... . . . . . . . . . . . . . . . . . . . . . . . . ..

.................................................................................... . . . . . . . . . . . . . . . . . . . . . . . . 

..................................................................................... . . . . . . . . . . . . . . . . . . . . . . ..  

................................................................. . . . . . . . . . . . . . . . . . . . . . .....................

.................................................................................... . . . . . . . . . . . . . . . . . . . . . . .

A-roll or single-strand

A/B-roll, or double-strand
method

method

Optical - complete dissolve

A-side of dissolve

B-side of dissolve

Blended
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c The Scene column must be Þlled in within the bin in order to gener-
ate a scene pull list and/or scene assemble list.  

n If you do not have scene information, you can enter the information quickly 
by copying the Name column, and pasting that information into the scene col-
umn.

Optical List

Optical lists specify the source material required to create special 
effects and any edit event other than a straight cut, such as a dissolve 
or fade. The optical list presents each optical event in the order in 
which it appears in the Film Composer sequence, and includes precise 
speciÞcations about the timing of transitions and the relationship 
between all layers of source material required to recreate the effect.

A sample scene assemble list
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Types of Effects Supported by Optical List

Film ComposerÕs optical lists support the following effects and combi-
nations of effects only: 

¥ All transition effects; such as wipes, dissolves, and fades.

¥ Several blend effects, such as superimpositions, title effects, matte 
key effects, luma and chroma keys, and picture-in-picture effects.

¥ Single-layer segment effect blow-ups

¥ Several Single-layer effects, such as ßips, ßops, ßip/ßops, and 
motion effects

Optical Layers in a Sample optical List

NOTE: The optical layer “Normal” represents the foundation video layer (V1) in the 
sequence.  This is the video track to which additional video tracks or layers were 
added and/or nested when the special effect was created.

Common footage for 
lay-up
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¥ Combinations of single-layer effects, such as a ßipped motion 
effect

¥ Combinations of single-layer effects with Blend effects, such as a 
key effect applied to a motion effect

¥ Transition and Blend effects that appear on two separate video 
tracks

¥ Overlapping Transition effects on two separate video tracks

Film Composer cut lists do not include standard Þlm masks that you 
apply to a clip or sequence to view a different aspect ratio. Masks are 
usually applied only after the conforming of a workprint or negative.

Dupe List

Dupe lists refer to all the source material that the lab must duplicate 
before you conform the Þlm negative. Additionally, dupe lists display 
every instance of unintended duplicate frames you may have edited 
into the digital sequence.

n To avoid including unnecessary dupes in your lists, use the Dupe Detection 
function during editing, as described in ÒDetecting Duplicate FramesÓ on 
page 289.

The listed duplicate frames are organized within sets of dupe groups.  
Each dupe group set provides the IN and OUT points of two or more 
entries that are duplicates of each other in related sections of the 
sequence.

n If you use Dupe Detection in the Timeline while editing Þlm material,  you 
might see unwanted duplicate frames that will not actually appear in cut 
lists.  You can either trim out the frames, or generate a dupe list to see if they 
appear.
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Dupes are also indicated in the assemble and pull lists by default, 
regardless of whether you choose to generate a separate dupe list.

Pull Lists

Pull lists display selected elements of the sequence in various sort 
orders.  The pull lists show dupes, but do not display comments, loca-
tors, or matchback information when these categories are selected 
from the Options window. 

A Sample dupe list containing two Dupe Groups
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Change Pull List and Discard list

When generating a change list, the Options window of the Change List 
tool provides two additional options: The change pull list and the dis-
card list.

¥ The change pull list is similar to the pull list, except that it only 
lists those new clips or effects that you need to insert into the 
updated cut.

¥ The discard list displays each clip that has been removed from the 
updated sequence and should be cut out of the newly conformed 
cut.

Scene Pull List

Scene pull lists show the cuts arranged in the following sort order

¥ Scene and Take

A Sample pull list
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¥ Reel Numbers

The scene pull list contains one entry for each scene and take that was 
referenced in the assemble list; as entered in the Sc/Tk column head-
ing of the bins.  Each entry displays the entire length of the take as 
deÞned by the clip from which it came.

Optical Scene Pull List

Optical scene pull lists show all the source material required to re-create 
the special effects in the sequence. The optical scene pull list actually 
contains the same columnar information as a scene pull list except 
that:

¥ Each optical is listed per scene.

¥ Takes required to re-create the optical are listed by scene number.

A Sample  scene pull list



421

Understanding Icons in Cut Lists and Change Lists

Icons appear in Film Composer cut lists and change lists based on the 
following:

¥ Icons are displayed in cut lists and/or change lists only when you 
select the Icon option in the Cut List or Change List tools.

¥ Icons refer only to standard-length effects. For example, in 24 fps 
projects, the duration of effects must be divisible by 12 frames (a 
seven-frame effect, by contrast, will show up as an optical). 

In A/B-roll cut lists generated in Film Composer, industry-standard 
icons are displayed in the last column. In change lists, icons are dis-
played aside the Footage Column:

A sample optical scene pull list
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The icons described in Table 14-1 are used in cut lists and change lists 
to graphically represent edit events.

Change List

Cut List Cut List icons

Change List icons
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The Bad Clip icon indicates clips that have discontinuity of edge code. 
These discontinuities occur normally between scenes or takes in each 
KEM roll. When you create scene or take subclips from a digitized 
KEM roll master clip, however, each subclip normally includes its own 
continuous edge code.   If a subclip or edited portion of a KEM roll 
master clip accidentally includes a break in edge code between takes, 
then the Bad Clip icon appears in the lists. 

Table 14-1 Change List and Cut List Icons  

Cutlist and Change List Icons Change List Only Icons

 Short Cut  Delete

 Jump Cut  Insert 

 Fade Out  Insert Head 

 Fade In  Insert Tail 

 Dupe  Delete Tail 

 Dissolve  Delete Head

 Optical  Delete Middle

Bad Clip icon
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Creating a List

The Þrst time you use the Cut List or Change List tool, you will typi-
cally follow these basic steps, described in the following sections:

1. Prepare the sequences, if necessary.

2. Open the Cut List or Change List tool.

3. Load the sequences into the tool.

4. Choose a desired cut list setting, if one exists.

5. Select audio and/or video tracks to include in the list.

6. Adjust options for the lists to suit your needs.

7. (Optional) Generate and view the cut lists.

8. (Optional) Continue to adjust the options if necessary.

9. Print or save the lists.

Once you become familiar with the tools and save a variety of custom 
settings, you will typically load a sequence, choose a setting, and click 
the Print button.

Preparing Sequences

Depending on the type of list you are creating, and the stage of your 
project, you may need to prepare the sequences before opening the 
Cut List or Change List tool. A normal workßow for each stage of list 
generation might be as follows.

Generating the First Cut List

To generate the Þrst cut list for conforming a workprint:

1. To prevent accidental editing, lock all the tracks in the sequence by 
selecting the tracks and choosing Lock Tracks from the Clip menu.
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2. Remove any unwanted Add Edits (match frame edits), by choos-
ing Remove Match Frames from the Clip menu.

3. Copy the sequence by choosing Duplicate from the Edit menu, 
and place the original sequence into an archive bin.

4. Keep the copy of your sequence in a current cuts or work-in-
progress bin, and generate lists from the archived original.

For the work in progress, you can keep the sufÞx Ò.Copy01,Ó created 
when you duplicated the sequence, as a way of indicating that it has 
been properly archived. You can also remove the word copy, but be 
sure to maintain the numbering of each successive cut so that you 
donÕt lose track.

Generating a Change List

As you continue working on the sequences, use the Change List tool to 
update the workprint as necessary. 

To generate a change list for a conformed workprint:

1. Lock all the tracks in the new (revised) sequence, remove any 
unwanted add edits, copy the sequence, and place the original 
into the archive bin, as described in the previous section.

2. Use successive versions of the sequence stored in the archive to 
generate the change lists. Try to maintain one sequence version for 
each time you conform the workprint.

Comparing and Combining Cuts and Reels

Often in the later stages of editing, you might need to compare several 
cuts, or combine two or more reels that have already been conformed. 
Tips and techniques for preparing and managing multiple sequences 
are described in ÒWorking with Multiple Cuts and ReelsÓ on 
page 440.
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Generating a Final Cut List

When you are ready for the Þnal cut, you can prepare the sequences 
and generate lists and other reference elements for the negative cutter 
as follows:

1. Lock all the tracks in the Þnal sequences, and remove any match 
frames (Add Edits).

2. Back up your project and bins.

3. Record a digital cut to tape, preferably with burn-in, as described 
in Chapter 15.

4. Prepare assemble lists for each reel by key number.

Opening the Tool

To open the Cut List or Change List tool, choose one from the Output 
menu.
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The tool appears.

The Cut List and Change List tools have the following features:

¥ The Fast menu provides commands for getting sequences, view-
ing, printing, and saving lists.

¥ The Display Options button opens a window of options that are 
available for each type of list.

¥ The Sequence list displays currently loaded sequences.

Sequence list

Fast menu

Get Sequence 

List Selection 

Track Selection list

List Title entry box

Settings pop-up 

Print button

View button

Display Options

pane

menu

button

button
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¥ The Get Sequence button loads the sequence currently displayed 
in the Record monitor.

¥ The List Selection panes allow you to choose which sublist to 
enable for selecting options, and to select the  sublists to include in 
the Þnal list.

¥ The Track Selection list allows you to select the tracks to include in 
the list.

¥ The Print button opens the Print dialog for printing the list.

¥ The View button opens the View window for previewing the list.

¥ The List Title text box allows you to enter a custom name for the 
list.

¥ The Settings pop-up menu allows you to save the current settings 
for future use.

In almost all respects the tools behave the same, with the following 
exceptions:

¥ The Cut List tool has one sequence list pane, while the Change List 
tool has a pair of sequence list panes: one for the old versions of 
the sequences, and one for the new versions.

¥ Because there are old and new sequence lists, the Change List tool 
allows you select assemble or dupe lists separately for each 
sequence to include in the comparison when generating the list.

¥ The Change List Fast menu includes an extra command for getting 
both the old and new sequences to load into the tool.

Getting Sequences

Use one of the following methods to get one or more sequences for the 
list:

¥ Load a sequence into the Record monitor, and click the Get 
Sequence button located below any of the Sequence list boxes 
to load a sequence that is currently in the Record Monitor.
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¥ Load a sequence into the Record monitor, and choose Get 
Sequence from the Fast menu.

If you are getting sequences for the Change List tool, the Fast 
menu provides separate Get Sequence commands for the old 
sequence list and the new sequence list.

If a sequence has already been loaded into the Change List or 
Cut List tool, the menu command changes to Add Sequence.

Drag one or more sequences from a bin and drop them into a 
Sequence list box.

The names of the loaded sequences appear in the Sequence list.
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To add sequences to the current list, hold down the Option key during 
sequence loading. (If you do not hold down the Option key, Film Com-
poser replaces the contents of the Sequence list with the new selec-
tion.)

n Sequences that are dark blue when you drag them onto the Cut List or Change 
List tool will replace the sequences currently loaded.  Sequences that are light 
blue will be appended to the list.

When you load the Þrst sequence, the Film Composer checks to deter-
mine whether the sequence was previously used to generate cut lists. 
If so, the Settings that were last used are automatically displayed.

Clearing the Display

If you close the Cut List Tool window and then reopen it, the window 
retains all of its contents. Closing the Cut List tool does not clear it. 

To clear the contents of the display, choose Clear Change List or Cut 
List Tool from the Fast menu.

Recalling a Previous Setting

The Settings pop-up menu shows the name of  any available list set-
tings previously associated with the current project.  If you are gener-
ating a list for the Þrst time in the project, or do not want to use a 
previous setting, you can skip this section.

n Each setting stores all the current Cut List Tool options.  They do not store the 
track selection or title.

To load another setting, click the Settings pop-up menu and choose a 
setting.
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Selecting Tracks

If you select the Sepa-
rate Lists for Each 
Channel option, you 
can select any combina-
tion of picture tracks. 
For more information, 
see ÒSelecting 
OptionsÓ on page 432.

The Channel Selection box displays the tracks that exist in the 
sequence. The Cut List tool generates lists only for the tracks you 
select.

Click the track button to select or deselect it.

c If the sequence is a 30 fps sequence (that is, a matchback project), 
audio tracks are not shown because matchback applies to picture-
only sequences. Generate a separate EDL for sound, as described in 
Chapter 15.

c The Separate Lists for Each Channel option has no effect on audio 
tracks; you can always select any combination of sound channels.

Renaming the List

When you begin to create your list, Film Composer enters the name of 
the Þrst sequence loaded into the List Title text entry Þeld.



432

This is an editable text Þeld. Whatever title you enter here will appear 
as the name of the list when you print or save it.

Selecting Options

The Options panes contain collections of speciÞc options that apply to 
different types of lists.  There are Þve basic option displays:

¥ Global options affect the overall appearance and content of the 
list. 

¥ Assemble list options include standard Þlm and timecode track-
ing numbers, transition indications, and custom column informa-
tion.

¥ Dupe list options include Þlm and timecode tracking numbers, 
custom column information, tolerance, and handle length infor-
mation.

¥ Optical list options include Þlm and timecode tracking numbers, 
custom column information, key frame, optical footage, and page 
break information.

¥ Pull list options include Þlm and timecode tracking numbers, cus-
tom column information, pop-up menus for three levels of sorting, 
speciÞcations for spooling method and inclusion of opticals and 
Þlm leader.  The same options are available for scene pull lists, 
scene assemble lists, optical pull lists, and optical scene pull lists.
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To select options:

1. Open one of the option displays by doing one of the following:

¥ Click the name in the List Selection pane for the chosen list 
type, then click the Display Options button located in the 
upper right of the tool.

¥ Double-click the name in the List Selection pane.

The Options pane opens, displaying a customized set of options 
for that list type.

 

Select the list type, then click the Display 
Options button.
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2. Click check boxes to select the desired options.

 

n

 

For a complete description of all options in the Þve categories, see the Avid 
Media Composer Products Reference.

 

3. Click the Display Options button, or double-click the list name in 
the List Selection pane to close the Options pane when you are Þn-
ished selecting options.

4. (Option) After selecting assemble list options, you can instantly 
apply the same options to other sublists by opening the options 
for the sublist type, and clicking the Same As Assemble List button 
in the Options pane.

 

List of Options

(Button reads Same as 
Change List in the 
Change List tool) 



 

435

 

5. When you are ready to generate the lists, click the selection but-
tons in the List Selection pane to enable only those list types that 
you want to include.

 
Viewing the List

 

To generate the lists and open the View window, click the View button 
in the lower right of the Cut List or Change List tool.

A window opens displaying a lists.

The Selection button turns purple when the 
list type is selected for including in the list.
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The View window has the following characteristics:

¥ The View Fast menu is located in the bottom left corner of the win-
dow, and contains options for printing or saving the list, activating 
the Cut List tool, opening a new View window, or activating 
dynamic scrolling which updates the list in the window continu-
ously as you drag the scroll bar.
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¥ You can resize the window by dragging its lower right corner.

¥ If you close and reopen this window, it retains its contents. When 
you clear the Cut List tool, the View window is also cleared.

¥ The list in the window displays black characters on a white back-
ground. If you make a change in the source sequences for the list, 
the text in the View window changes to gray as a signal that the 
displayed lists do not match the source sequences.

 

Changing the Options

 You can change the cut list or change list options any time before or 
after generating a list.

To adjust the options and update the list:

1. Click the Options button.

2. Alter your selections.

3. Click the View button. The cut list or change list is updated.

 

Printing or Saving the Lists

 

When the list is ready, you can print it immediately, or save it as a text 
Þle in various formats which you can bring to another location, import 
and use in another system, or open and print at a later time. When you 
save or print, the system uses the list you generated in the List View 
window, or if you bypassed the List View step, generates a new list 
based on the options you selected.

 

Printing the Lists

 

To generate the lists, if you have not already done so, and display the 
standard dialog box for printing, click the Print button in the lower 
right of the Cut List tool.
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This button prints all currently displayed (selected) cut lists, complete 
with all options you selected for information categories and display 
characteristics such as font or icon and frame image columns.

 

n

 

If your lists contain any frame images, select Color/Grayscale in the Print 
dialog box for best printing results.

 

Saving the Lists

 

Film Composer supports the following formats for saving your list as 
a text Þle:

¥ Avid Columnar

¥ Avid Log Exchange

¥ Optical Block

You select one of these formats in the Global Options pane.  For more 
information, see the 

 

Avid Media Composer Products Reference.

 

To save the lists in the chosen Þle format:

1. Choose Save Cut List or Save Change List from the Cut List (or 
View window) Fast menu. (You can also choose these commands 
from the File menu).

The Save As dialog box appears.

2. Name the Þle in the File Name entry Þeld.

3. Choose a destination for the Þle from the File Directory pop-up 
menu.

4. Click OK.

 

Saving the Settings

 

You can save the current settings for the Cut List or Change List tool 
for future use with similar material. Each setting contains the option 
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selections and entered values, their order on the screen, which option 
groups are Òopen,Ó and which options are hidden.

To save your current cut list or change list settings:

1. Click the Settings pop-up menu and choose Save As.

The save setting dialog box appears.

2. Enter the name of the view, then click OK:

 

Replacing Saved Option Settings

 

If your Settings menu list becomes extensive and there are a number of 
saved settings you no longer use and would like to replace, use the fol-
lowing procedure:

1. Hold down the Option key while you click the Settings button to 
view the list of saved-setting names (each appended with the 
Replace command).
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2. Choose one. The current conÞguration of option settings replaces 
the chosen setting.

 
Working with Multiple Cuts and Reels

 
In the advanced stages of a project, you may need to make cut lists or 
change lists for conforming workprint or making comparisons 
between multiple cuts or reels. Film Composer provides speciÞc fea-
tures which allow you to:

¥ Create a single cut list for several sequences in order to compile 
them for a single conformed cut.

¥ Create change lists for multiple screening reels in order to update 
the conformed reels, make comparisions between sequences, or 
adjust breaks between reels in preparation for a Þnal cut.

These techniques are described in the following sections.

 

Creating a Cut List for Two or More Sequences

 

When you load sequences into the Cut List tool, the system sorts the 
sequences according to name. With two or more sequences loaded, the 
system generates one cut list with appended sections for all sequences 
in their listed order.

To create a single cut list for several sequences:

1. Make sure the sequences are named so that they sort in the proper 
order in the Cut List tool.
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2. Shift-select the chosen sequences in the bin, and drag them into 
the Sequences list Þeld.

3. Choose the desired options, and generate the list.

The cut list provides lists for the sequences in order.

 

Creating Change Lists Across Multiple Reels

 

When you load comparable sequences, the system generates consecu-
tive, appended lists for each set of cuts. You can make comparisons 
based on either reel numbers, or based on preview code that you 
assign to each sequence.

Depending on the options you select, the new list notes any of the 
standard change categories across the reels:

¥ Insertions of new material

¥ Deletions of material which is no longer needed

¥ Trims to be made to the head and/or tails of the edits

¥ Moves which consist of a matched pair of deletions and inser-
tions

¥ Optional information that details which portions of the 
sequence should not be altered

In addition, you can generate separate lists for each set of reels, and 
simultaneously generate a single dupe list that describes duplicated 
shots across all the reels. These topics are described in this section.

 

Using Reel Numbers

 

When using reel numbers to generate change lists for multiple reels, 
observe the following conditions:
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¥ For each sequence, the old version and the new version must have 
exactly the same reel number in order for the system to make the 
appropriate comparisons.

¥ The reel numbers must be entered into the Reel # column in the 
bin for each sequence.

¥ The reel numbers must be sequential so that the system can gener-
ate lists that match the appropriate order of the reels.

¥ You must have an equal number of old and new sequences. If nec-
essary, create a dummy sequence to balance the reels.

To generate a change list using reel numbers:

1. Prepare the sequences with the appropriate reel numbering if nec-
essary.

2. Shift-select all of the old sequences in the project bin (each 
sequence must represent a different reel).

3. Drag the selected sequences into the Old Sequences Þeld to load 
them. 

4. Repeat steps 2 and 3 for the new sequences, dragging them into 
the New Sequences Þeld. Each new sequence must represent a dif-
ferent reel that shares the same reel ID as the corresponding old 
sequence.

Add sequences to the lists as necessary by holding down the 
Option key while dragging the selections into the appropriate 
sequence Þeld.

5. Select the desired options and generate the list.

Using Preview Code

Preview code is an optional numbering system that you can use to ink 
each conformed workprint with continuous numbers that you match 
for the corresponding sequence in Film Composer.

Preview code applies to one generation of changes on the workprint 
only. You must re-ink each successive workprint and enter those Pre-
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view Code numbers as KN Start numbers for each new revision of a 
sequence. 

n You can request that the lab differentiate successive generations of preview 
code by applying different colors.

Preview code both supplants comparisons based on reel numbers, and 
provides the advantage of continuous numbering within each genera-
tion of a sequence or cut.

c Because new material edited into the sequence has not yet been 
inked with preview code, you must choose the options for display-
ing key numbers and/or ink numbers for referencing the original 
source footage for these clips in the list.

To track changes with preview code:

1. After re-inking the Þrst workprint with preview code, enter the 
matching start preview code number into the KN START column 
of the bin for the corresponding sequence.

c Change the starting key number for the sequence only. Do not over-
ride KN Start information for the original master clips used in the 
sequence.

Enter the new Preview Code numbers in the KN Start  column 
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2. Duplicate the sequence, and place the original into an archive bin.

3. Rename the duplicate, but be sure to maintain the same reel num-
ber in the Reel # column of the bin.

4. Continue editing the duplicate sequence.

5. When the time comes to generate a new change list, select the Pre-
view Code option from the Information to Display group of the 
appropriate list that you want to generate. 

For example, if you are generating an assemble list, open the Infor-
mation to Display options beneath Assemble List, and select Pre-
view Code.

6. After the workprint is reconformed, ink the new workprint with 
new preview code, and enter matching numbers into the KN Start 
column for the corresponding sequence (the duplicate of the origi-
nal sequence).

7. Duplicate this sequence, and continue the same cycle as often as 
necessary.

Dupe Checking Across Multiple Reels

If your show consists of multiple reels, you probably have a separate 
sequence for each reel. These reels, however, might share footage that 
requires duplication. Film Composer allows you to check for dupes 
across multiple reels within one change list.

To generate a dupe list for multiple reels:

1. Follow the steps described in the previous section for loading 
comparable reels into the Change List tool.

2. When choosing options for the list, select assemble list, dupe list, 
and Reel Numbers options.
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Using the Matchback Option

For more information 
on the matchback pro-
cess and workßow, see 
the Avid Film Composer 
Getting Started Guide.

The Matchback option on a Media Composer system with Film 
Options allows you to generate a 24 fps cut list from a 30 fps video 
project that uses Þlm as the source material. This video-to-Þlm conver-
sion is useful in a variety of matchback circumstances, including the 
following:

¥ Use the matchback option to generate both a videotape master for 
the project along with a Þnal cut on Þlm.

¥ Use the matchback option to generate pull lists for retransferring 
selects at high quality before online editing.

About Matchback

The matchback process refers to the video edit information for your 
sequence and performs a conversion to create a matching 24 fps cut 
list.

Because of the difference in frame rates between a video and Þlm (30 
fps or 25 fps for video versus 24 fps for Þlm), the conversion of video 
edit points may fall within a Þlm frame, requiring the addition or sub-
traction of a frame in that edit event in the resulting cut list. 

For example, with a ratio of 24 Þlm frames to 30 video frames, a seven-
frame video edit corresponds to approximately 5.6 Þlm frames. How-
ever, Þlm cuts cannot include partial frames, so the edit must be 
rounded to Þve or six frames.



446

To make these adjustments, the following occurs during matchback:

¥ If the total video-sequence duration at the end of each cut is a 
frame longer than the Þlm, then the system subtracts a frame from 
the last video edit. If the video is a frame too short, a frame is 
added to the last video edit. 

¥ Where an essential frame was added or subtracted to the begin-
ning or end of each edit, the system adds a message to the cut list 
stating that matchback shortened or lengthened the tail of the clip 
by one frame. The assistant editor or negative cutter can use this 
information to check the edit.

¥ Each track in the sequence must be corrected independently 
because the start and end points for split edits are different for 
each track. As a result, the picture and audio for a matchback 
video edit may be out of sync by no more than one frame.

Matchback is subject to the following limitations:

¥ The Matchback option uses key numbers to conform the negative. 
Therefore, you must have key number information entered into 
the bins for the project.

¥ You can generate cut lists, but not change lists in a matchback 
project.

¥ The matchback information applies to the picture only.  You must 
generate a separate list (an EDL, for instance) for conforming the 
audio source tapes.

..........................................................................................................

Shot X Shot Y Shot Z
NTSC 
video

Film

The matching film edit point falls within a 
frame.

..........................................................................................................
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¥ Be sure to remove unwanted match frames (Add Edits) from your 
sequence before generating the cut list. Otherwise, the calculation 
of matchback frames will include these edits. For more informa-
tion, see ÒPreparing SequencesÓ on page 424.

Generating a Cut List with Matchback

Matchback is automatically enabled when you begin a 30 fps video 
project on a system with the Matchback option.  The system defaults to  
the 35 mm format when you generate the list. 

c If you plan to generate a list for conforming 16 mm or 65 mm Þlm, 
you must specify that format when you Þrst create the project, as 
described  in the Avid Film Composer Getting Started Guide.

To generate a cut list matchback information, do the following:

1. After creating a sequence, use the procedures for getting a 
sequence, selecting tracks, and choosing settings, as described in 
ÒCreating a ListÓ on page 424.

2. When selecting Global options, click the Matchback Info option in 
the Options pane to display the matchback information in the list.
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3. When selecting tracking information for the various lists, click the 
Key Numbers check box.

4. View, print, or save the list containing the matchback (plus or 
minus one frame) information.

Matchback Info option 
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CHAPTER 15

Output Options for Video 
and Audio

Film Composer provides tools for generating output for individual 
tracks or entire sequences to various videotape or audiotape formats. 
In addition, you can generate an edit decision list to be used by the 
sound department for preparing audio tracks, or by editors in a video-
tape suite for preparing a master tape from the Þlm-to-tape transfers. 
You can also use VTR emulation for direct playback of sequences 
using an edit controller in an analog editing suite.  These options are 
described in the following sections:

¥ Preparing for Output

¥ Recording a Digital Cut

¥ Using EDL Manager

¥ VTR Play Emulation

Preparing for Output

Preparing for video output involves the following procedures:

¥ Render all nonreal-time effects, as described in the Avid Media 
Composer and Film Composer Effects Guide.
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¥ Calibrate and adjust video output levels, as described in ÒCali-
brating for Video OutputÓ on page 451.

¥ Calibrate and adjust audio output levels, as described in ÒPrepar-
ing for Audio OutputÓ on page 458.

For more information 
on mixing down audio 
tracks, see ÒMixing 
Down Audio TracksÓ 
on page 360.

¥ Decide whether you want to generate stereo or mono audio.

¥ Mix down multiple audio tracks if necessary.  Systems equipped 
with a two-channel audio board can generate a maximum of two 
channels.  Systems equipped with the Digidesign audio interface 
can generate a maximum of four channels. 

¥ (Optional) Select settings for direct four channel audio output, as 
described in ÒGenerating Four-Channel AudioÓ on page 462.

¥ Prepare the record tapes.

¥ (Optional) Record reference bars and tone to tape.

In addition, you may need to make additional adjustments when 
recording from a 24 fps Þlm project to tape, as described in the follow-
ing sections.

Digital Cuts and Audio

You can use one of the following tape formats for audio output:

¥ You can record a digital cut directly to videotape.

¥ You can output to a mag stock recorder using a patch from the 
Digidesign Audio Interface.

¥ You can record a digital cut directly to digital audio tape (DAT) 
using a patch from the Digidesign Audio Interface conforming to 
the AES/EBU output standard.

Depending on the path you chose for your projectÕs audio (as 
described in the Avid Film Composer Getting Started Guide, and the vid-
eotape format used for transfer (NTSC or PAL), you must set the pull-
down switch on Video Slave Driver as follows:
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¥ If you used the ofßine audio path (digitizing audio from the tele-
cine transfer) with an NTSC Þlm-to-tape transfer involving pull-
down, set the pulldown switch to X 0.99.

¥ If you used the ofßine audio path with a PAL Þlm-to-tape transfer, 
set the pulldown switch to X 1.00.

¥ If you used the online audio path or the all-digital path (digitizing 
directly from the source audio tapes into Film Composer), set the 
pulldown switch to X 1.00.

Changing the Default Pulldown Frame

During a digital cut to 30 fps NTSC videotape, the system defaults to 
an A-frame pulldown conversion. You can change the default A-Frame 
setting by typing a new default in the Pull-In column for the sequence. 

You can change the default Pull-In when appending several sequences 
to the same output tape on which continuous pulldown is required. 
For example, if one cut ends on frame C, then before performing the 
Digital Cut of the next sequence, change the pull-in for the successive 
sequence to the D frame.

Calibrating for Video Output

Read the information in the following sections based on the following:

¥ Calibrating for video output (optional): All users can follow the 
steps for calibrating video output, as described in the following 
section, ÒBasic Output Calibration.Ó

¥ Calibrating/syncing output signals in a production facility: 
Advanced users and house engineers should follow the steps for 
adjusting and conforming output signals to house standards, as 
described in ÒAdvanced Output CalibrationÓ on page 453.
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Basic Output Calibration

You can calibrate using digital bars and tone that you create and edit 
into the sequence, as described in this section.

n If you or your site engineers calibrate the system as a general maintenance 
procedure, or if you do not have an external waveform monitor, leave the 
Video Output tool set to the preset values.

To calibrate for video output:

1. Choose Video Output Tool from the Tools menu. The tool opens.

2. Cue the sequence to bars and tone, and click or press Play  (basic 

calibration requires digital bars and tone).  Color bars are dis-
played on the third Full-Screen monitor, and signal appears on the 
waveform and vectorscope monitors.
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3. Adjust luminance values based on the video format and the type 
of bars in the sequence.

4. Save this setting by choosing Save As from the Settings pop-up 
menu, typing a name, and clicking OK.

Advanced Output Calibration

Advanced users and site engineers can use the following procedures 
to Þne-tune output calibrations using test patterns, genlock options, 
and signal timing controls, as described in this section.

Displaying Advanced Calibration Controls

To display additional controls in the Video Output tool, click the More 
Options button.

Additional options appear, and the More Options button becomes the 
Less Options button.
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Using Test Patterns

The expanded Video Output tool provides a pop-up menu of test pat-
terns you can use to calibrate the system output. To display a test pat-
tern, click the pop-up menu and choose a pattern.

You can add test patterns to the list by doing the following:

1. Close the Film Composer application.

2. Find or create a PICT Þle for a chosen pattern.

n You can create your own test pattern Þles by digitizing the pattern from vid-
eotape, and exporting it as a PICT Þle. You can improve the accuracy of the 
image by correcting colors and removing errors in a third-party application 
such as Adobe Photoshopª.

Test Patterns 

Genlock pop-up menu

Composite output 
settings

Component output 
settings

pop-up menu
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3. Place the Þle into the Test Patterns folder in the Supporting Files 
folder, which is located in the Film Composer folder on the Avid 
drive.

4. Start the Film Composer application. The new pattern appears in 
the Test Pattern pop-up menu on the Video Output tool.

Calibrating Site Output Settings

If you have connected a waveform monitor between the output of the 
Avid system and your video destination, you can use the Video Out-
put tool to adjust the video output levels and timing to reference 
video.

n If you do not have external vectorscope and waveform monitors, leave the cal-
ibration settings at their preset values.

To calibrate the output signal:

1. Choose Video Output Tool from the Tools menu. The tool opens.

2. Click the More Options button if the left side (Output: Composite) 
display shows only two sliders.

Additional options appear, and the More Options button becomes 
the Less Options button.
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3. Choose the appropriate genlocking method from the Genlock 
menu:

¥ Choose External to use a genlock source connected to the Avid 
Broadcast Video BoardÕs genlock input. Make sure a genlock 
source is attached.

¥ If there is no external source, choose Internal to create an inter-
nal reference signal.

4. Choose ColorBars from the Test Patterns pop-up menu.

Standard full-Þeld, 75 percent color bars appear on the third mon-
itor, and on the vectorscope and waveform monitors.

5. Set luminance values  based on the settings in Table 15-1.

Test Patterns 

Genlock pop-up menu

Composite output 
settings

Component output 
settings

pop-up menu
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6. Adjust chrominance levels as follows:

¥ For composite video, set hue by adjusting the SC Phase slider 
until the six color vectors fall within the target boxes on the 
vectorscope. 

n If you do not have separate vectorscope and waveform monitors, you can use 
the third monitorÕs Òblue onlyÓ feature, if available, to adjust SC phase (hue) 
for composite output.

¥ Set subcarrier to horizontal phase timing by adjusting the 
SC/H slider according to house standards.

n SCH phase becomes important only when video signals from two or more 
sources are combined or sequentially switched. If this is not the case, leave the 
SCH slider at the preset value.

¥ Set the horizontal phase by adjusting the H Phase slider 
according to house standards.

Table 15-1 Luminance Settings 

Parameter SMPTE bars Full-Þeld bars at 
75% signal level

Full-Þeld bars at 
100% level

Japanese NTSC

Black level (setup) Adjust Line Selector 
to 183

Adjust Line Selector 
to 150

Any line Any line

Adjust Black slider 
to 
7.5 IRE (NTSC)

Adjust Black slider 
to
7.5 IRE (NTSC), 
0.3 volts (PAL)

Adjust Black slider 
to
7.5 IRE (NTSC), 
0.3 volts (PAL)

Adjust Black 
slider to 
0.0 IRE

White level (gain) Adjust Line Selector 
to 203

Adjust Line Selector 
to 150

Adjust Line Selector 
to 150

Adjust Line Selec-
tor to 203

Adjust Gain/Y 
Gain slider to 
100 IRE (NTSC)

Adjust Gain/Y 
Gain slider to 
77 IRE (NTSC), 
.825 volts (PAL)

Adjust Gain/Y 
Gain slider to 
100 IRE (NTSC), 
1.0 volts (PAL)

Adjust Gain/Y 
Gain slider to 
92.5 IRE
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¥ For component video, use a three-channel waveform monitor 
to calibrate R-Y gain. For NTSC users using 75 percent color 
bars, the R-Y value should have a peak-to-peak deviation of 
700 millivolts. PAL users should have a peak-to-peak devia-
tion of 525 millivolts.

¥ Calibrate B-Y gain by adjusting the slider. For NTSC users 
using 75 percent color bars, the B-Y value should have a peak-
to-peak deviation of 700 millivolts. PAL users should have a 
peak to peak deviation of 525 millivolts.

Save this setting by choosing Save As from the Settings pop-up menu, 
typing a name, and clicking OK.

Preparing for Audio Output

The Audio tool allows you to generate and customize calibration tone, 
and adjust global output levels.  For information on additional audio 
mix procedures such as adjusting volume and pan, mixing down 
selected tracks, or ignoring mix levels, see Chapter 11.

Setting the Calibration Tone

The Audio tool provides an internal calibration tone that you can cus-
tomize and play as a reference signal on a digital cut. You can use the 
recorded reference signal for calibrating the digital cut audio at 
another site. 

The default tone playback is -14 dB (digital scale) with a 1000 Hz sig-
nal. In some cases you might need to customize the signal. For exam-
ple, a common reference signal convention for audio work involves 
recording 30-second segments of 1 kHz, 10 kHz, and 100 Hz tone back 
to back.

To change the parameters for the calibration tone:

1. Choose Set Calibration Tone from the Peak Hold pop-up menu. 
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The calibration tone dialog box opens.

2. Enter new values for the tone level and frequency, and click OK.

To play back the tone, choose Play Calibration Tone from the Peak 
Hold pop-up menu. To check the adjusted tone level in the meters, 
make sure the In/Out toggle buttons are toggled to O for Output.

Calibrating Global Output Levels

You can use the meters and a master attenuator (output slider control) 
in the Audio tool to make global level adjustments for output from the 
system. These adjustments affect levels for all output tracks to both the 
speakers and to record devices. The procedures differ slightly for sys-
tems equipped with a four-channel audio board and systems 
equipped with a two-channel audio board.

c Normally you should leave this setting at the factory preset of 0 dB. 
Adjust the level only when necessary to raise or lower the overall 
volume based on the headroom parameters of the record format, or 
consistently over- or undermodulated source material.
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Adjusting Output on Four-Channel Audio Board Systems

To adjust global output from a four-channel audio board system:

1. Click the In/Out toggle buttons above the meters to display O for 
Output.

2. Click the Output (speaker) button in the Audio tool to display the 
master attenuator. 

A single slider appears for adjusting global audio output for all 
tracks.

3. Play back one of the following sources of reference audio:

¥ Choose Play Calibration Tone from the Peak Hold pop-up 
menu.

¥ Play back a representative sequence or clip containing audio.

4. Adjust the attenuator (slider) to an appropriate level.

5. Close the slider control by clicking the Output button.

Master attenuator

Output button
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Adjusting Output on Two-Channel Audio Board Systems

Systems equipped with two-channel audio boards (MCXpress, Media 
Composer Ofßine, Media Composer 900,  Media Composer 1000) can 
use the Pro Level option to take advantage of the professional audio 
output features of the card. 

By default the ÒproÓ output levels option is not selected, and the vol-
ume scales for output sliders in the Audio tool reßect levels for con-
sumer-grade VCRs and recording devices.

To adjust the levels for recording to professional record decks:

1. Choose Audio Tool from the Tools menu.

2. Click the Speaker icon to display the Output slider and the Pro L. 
check box.

3. Select the Pro L. checkbox to enable professional output levels.

The electrical speciÞcations for the professional audio output are as 
follows:

0 VU level: 2.5 V (+1 dBu)
Max before clipping: 13 V (+15 dBu)

Speaker icon

Pro level check box

Output slider
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The following points relate to the professional audio level output:

¥ All voltages are measured peak to peak.

¥ Use Avid cable #237 for input, which is a special attenuating cable.

¥ 0 VU is deÞned as -14 dB below the point where clipping occurs.

Generating Four-Channel Audio

If your system includes the Digidesign audio interface and a four-
channel audio board,  there are two ways to generate audio when cre-
ating a digital cut:

¥ You can use the systemÕs default pan of odd-numbered tracks to  
output channel 1, and even-numbered tracks to output channel 2.

¥ You can select four audio tracks and send them to four separate 
output channels, for feeding to a four-channel record deck or 
through a mixer.

To enable four-channel output:

1. Load the sequence.

2. Choose Audio Mix from the Tools menu to open the Audio Mix 
window.  

3. (Option) Resize the tool by clicking the Display/Hide Sliders but-
ton.

4. Choose Direct Out from the Output Options pop-up menu.

Display/Hide Sliders 
button

Channel Selection 
pop-up menu

Output Options pop-
up menu
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5. Direct the output of each track (up to eight tracks) to the desired 
channel (up to four channels) by choosing a channel from the 
Channel Selection pop-up menu located at the bottom of each 
track panel.

For example, you could output audio track A1 to physical channel 
1, track A2 to channel 2, A3 to channel 3, and A4 to channel 4. Or 
you could output audio track A5 to physical channel 1, A6 to chan-
nel 2, A7 to channel 3, and A8 to channel 4.

Preparing Record Tapes

There are two basic methods of recording to tape: frame-accurate 
recording using the Digital Cut tool, and manual recording using con-
trols on the record deck.  Each of these methods requires different 
treatment of the record tapes.

Frame-Accurate Recording

Frame-accurate recording involves using the Digital Cut tool to record 
your sequence onto a prestriped  tape (a tape with prerecorded control 
track and timecode), or a partially striped tape.

Before you can record a frame-accurate digital cut, you must prepare 
the record tapes in advance using one of the following options:

¥ If you intend to perform assemble edit recording, you must record 
black with timecode onto the tape including the necessary preroll 
prior to the IN point plus at least 10 seconds.

¥ If you intend to perform insert edit recording, you must stripe the 
record tapes (record black and timecode for the entire duration of 
the tape) in advance.

Manual Recording

Manual recording  (sometimes referred to as crash recording) involves 
bypassing deck control in Media Composer  and using manual opera-
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tion of the record deck.  Because the timing of playback is based on 
manual procedures, the recording is not frame-accurate.  However, 
you do not need to record timecode onto the tape in advance.  You can 
also record onto non-Avid-controlled decks, such as consumer grade 
VHS or Hi8.

To record manually:

1. Set the serial control switch on the record deck to Local.

2. Use the controls on the deck to start the videotape recording.

3. Play the sequence in Film Composer. 

Recording Bars and Tone

You can also record a portion of bars and tone onto the tape before 
recording a digital cut.  There are two methods of recording bars and 
tone to tape:

¥ If your recording must be frame-accurate, than consider adding a 
segment of digital bars and tone to the front of  your sequence, or 
prepare it as a separate sequence that you can record using the 
Digital Cut tool.  For more information,  see ÒPreparing Digital 
Bars and ToneÓ on page 169.

¥ If your recording  does not need to be frame-accurate, you can  
manually record direct output of bars and tone from Media Com-
poser.

To manually record bars and tone:

1. Open the Video Output tool and the Audio tool by choosing them 
from the Tools menu.

2. Choose a color bars pattern from the Test Patterns pop-up menu in 
the Video Output tool.

3. Choose Play Calibration Tone from the Reset Peak pop-up menu 
in the Audio tool.

4. Place the record deck on Local for manual recording.
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5. Record the bars and tone as either an insert or assemble edit 
according to the operation of your record deck and chosen 
method.

Enabling Assemble-Edit Recording

Insert editing is the default setting for the Digital Cut tool.  You can 
also use assemble-edit settings in Media Composer, along with the 
assemble-editing capabilities of your record deck, to quickly record 
frame-accurate digital cuts without striping  entire tapes in advance.

w To avoid accidentally breaking timecode on prestriped tapes during 
Digital Cut recording, enable assemble editing only when in use, 
and disable it during normal insert edit recording.

 To enable assemble editing:

1. Double-click Deck in the Settings scroll list of the Project window 
to open the Deck Setting dialog box.
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2. Select the option Allow Assemble Editing for Digital Cut.

Once assemble editing is enabled, you select additional options in the 
Digital Cut tool when you are ready to record, as described in the sec-
tion, ÒRecording a Digital Cut to TapeÓ on page 470.

These switches are often 
located below the 
machineÕs playback 
control buttons.  For 
more information, see 
your record deviceÕs 
manual.

In addition, make sure the record deck has the following settings:

¥ The free run/rec (record) run switch should be set to record run.

¥ The Ext (external)/Int (internal) sync switch should be set to inter-
nal.

¥ The switch for internal timecode should be set to  Regen (regener-
ate) or Slave Lock, not Preset.

Assemble-editing 
option
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¥ After you record 15 to 30 seconds of timecode onto the record tape 
for jam syncing, return the Local/Remote switch to Remote for 
deck control from within Media Composer.

Recording a Digital Cut

The Digital Cut tool provides frame-accurate control when recording a 
sequence to tape. You can also use the Digital Cut tool to preview the 
sequence with a computer-generated countdown.

Previewing a Digital Cut

You can manually 
record a digital cut 
including countdown, 
but the recording will 
not be frame-accurate. 
For information, see 
ÒPreparing Record 
TapesÓ on page 463.

You can preview a digital cut before recording it to tape to make sure 
your preparations and output settings are correct, or for screening pur-
poses.

To preview a digital cut:

1. Choose Digital Cut from the Output menu.

The Digital Cut tool appears.
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2. Deselect the Record to Tape option.

The With Countdown and Custom Screen options are enabled.

3. Select the With Countdown option to preview the digital cut using 
the default computer-generated countdown containing the Avid 
logo.

4. Select the Custom Screen option to preview the digital cut using a 
customized countdown screen that you create, as described in the 
following section.

5. Select the audio and video tracks you want represented in the dig-
ital cut preview.  The display of tracks in the Digital Cut window 
varies according to the tracks existing in the sequence.

Only those tracks beside and beneath the speaker icon and the 
monitor icon are included in the digital cut.

6. Press Play.

The system plays the digital cut in the Record monitor and the 
third Full-Screen monitor.

7. To stop the playback at any time, press the Space bar.
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Creating a Custom Countdown Display

The Custom Screen option allows you to change the font (type style), 
size, and color of the countdown numbers. You can also import your 
own PICT graphic Þle as a background.

To create a custom countdown:

1. Select both the With Countdown and the Custom Screen options. 
The Custom Screen box appears in the Digital Cut tool.

2. Click the Custom Screen box.  The Digital Cut Countdown Screen 
dialog box appears.

3.  Choose another font, font size, or font color, if desired, from the 
pop-up menus.

n The menus display all currently available fonts, as determined by the contents 
of the Fonts folder in the Macintosh System folder.  For information on add-
ing fonts to your system, see your Macintosh documentation.

4. Click the Import button if you want to import an available PICT 
Þle to use as a custom background. The Directory dialog box 
appears.

Font

Font Size

Font Color
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5. Locate a PICT Þle to serve as the new background image and 
select it.

6. Click OK.  The custom countdown screen is ready for previews.

n The best resolution for imported PICT Þles is 720 x 486 for NTSC and 
720 x 576 for PAL. The resolution cannot be changed after import.

Recording a Digital Cut to Tape

If you have a Media 
Reader connected to 
your system, you can 
create burn-in timecode 
on the digital cut. For 
more information, see 
the Avid Media Reader 
Setup and UserÕs Guide.

The Digital Cut tool provides several options for managing the record-
ing of your sequence. For example, you can:

¥ Record using either assemble or insert edits 

¥ Record a selected portion of the sequence or selected tracks

¥ Record according to different timecode parameters

To record a digital cut:

1. Choose New Deck Controller from the Tools menu.  Use the deck 
controller to cue and the record tape during Digital Cut recording.

2. Load a sequence into the Record monitor. (You cannot access digi-
tal cut options without a sequence loaded.)

3. Choose Digital Cut from the Output menu.

The Digital Cut tool appears.



471

4. (Option) Choose either Insert Edit or Assemble Edit from the pop-
up menu.  This menu only appears if you enabled Assemble Edit-
ing in the Deck Settings dialog box.

5. Select or deselect the Entire Sequence option based upon the fol-
lowing:

¥ Select the Entire Sequence option if you want the system to 
ignore any IN or OUT marks and play the entire sequence 
from start to Þnish.

¥ Deselect this option if you have established IN and/or OUT 
marks for recording a portion of the sequence.

6. Choose an option from the record time pop-up menu as follows:

¥ Choose Sequence Time to start the recording at a timecode 
existing on tape that matches the start timecode of the 
sequence.   If you intend to record several sequences to tape 
one after another, this option requires resetting the start time-
code on each sequence to match appropriate IN points on the 
tape.
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You can change the start 
timecode to match the 
record tape. For more 
information, see  
ÒChanging the 
Sequence Clip InfoÓ on 
page 233.

¥ Choose Record Deck Time to ignore the timecode of the 
sequence, and start the recording wherever the record deck is 
currently cued.

¥ Choose Custom Time to ignore the sequence timecode and 
establish a speciÞc IN point on the record tape.  When you 
choose Custom Time, an entry Þeld appears for typing in the 
new value. 

7. Select the audio and video tracks you want represented in the dig-
ital cut preview.  The display of tracks in the Digital Cut window 
varies according to the tracks existing in the sequence.

Only those tracks beside and beneath the speaker icon and the 
monitor icon are included in the digital cut.

8. If you are working with an NTSC Þlm project using pulldown,  
choose a playback rate from the pop-up menu.

- Film Rate (100%) outputs video synced to a normal Þlm pro-
jection rate for the audio (with no pulldown).  The system 
drops approximately 1 frame for every 1000 frames to simu-
late a full 30 fps (rather than 29.97) playback rate to sync with 
44,1 kHz or 48 kHz audio output. Use this option with the Pull 
Down switch on the Avid Digidesign audio interface set to 
x1.00.

This is useful, for example, in sound stage productions need-
ing to play back 24 fps sound in sync with 24 fps video, when 
outputting a 24 fps Þlm sequence to 25 fps PAL videotape, or 
when outputting video for syncing with full-projection rate 
audio in AudioVision.

Timecode entry field



473

- Video Rate (100%+) simulates the telecine pulldown process 
for NTSC output, slowing the play rate and adding Þelds to 
adapt the 24 fps Þlm rate to a 29.97 fps video rate.  Use this 
option with the Pull Down switch on the Avid Digidesign 
audio interface set to x0.99.

9. Select the audio and video tracks you want represented in the dig-
ital cut.  Only those tracks beside and beneath the speaker icon 
and the monitor icon are included in the digital cut.

The display of tracks in the Digital Cut window varies according 
to the tracks existing in the sequence.

10. Press Play.

The system cues the record deck, then plays and records the digi-
tal cut.  The playback appears in the Record monitor and the Full-
Screen monitor.

11. To stop the recording at any time, press the Space bar.

n After assemble-edit recording, note that a freeze frame is usually added after 
the OUT point for one or more seconds, depending upon the record deck 
model.  This provides several frames of overlap for the next IN point, before 
control track and timecode break up.

Using EDL Manager

An EDL (edit decision list) is a detailed list of the edits contained in a 
sequence, including all the timecode and supported effects informa-
tion required to re-create the sequence in an online videotape suite.  
The EDL is organized into a series of chronological instructions called 
events  which are interpreted by an edit controller that automates the 
assembly of the videotape master.

Your system includes the EDL Manager, an application with powerful 
features and sorting capabilities to help you prepare an EDL.
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To launch EDL Manager, choose EDL from the Output menu.

For more information on speciÞc features and capabilities of EDL 
Manager, see the Avid EDL Manager UserÕs Guide.

VTR Play Emulation

VTR play emulation allows you to control a sequence loaded in the 
record monitor from an edit controller for playback in the edit room 
along with other sources.

n To use VTR play emulation, you must connect a supported controller (any 
controller that uses Sony¨ serial control protocol) to the Macintosh¨ using a 
9-pin to serial cable.

With a controller properly connected, enable VTR play emulation as 
follows:

1. Choose Serial Ports from the Tools menu to open the Serial Ports 
tool.

2. Select the appropriate port (printer or modem) from the VTR 
Emulation pop-up menu.

3. Close the Serial Ports tool. The system saves the setting as a Site 
setting, effective for all projects.

4. Choose VTR Emulation from the Special menu when you are 
ready to use the system for playback.
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A check mark appears next to the command to indicate that the 
system is ready. A yellow outline appears around the Play button 
in the Record monitor to indicate that VTR emulation is active.

n This command behaves like a Local/Remote switch on a playback device, with 
VTR play emulation disabled (in Local mode) by default when you launch the 
system.

Once active, VTR play emulation allows you to control the sequence 
with an the edit controller as follows:

¥ You can shuttle, jog, play, cue, and mark points based on master 
sequence timecode for editing onto another master.

¥ Your control of the Media Composer system is for play only. For 
example, you cannot apply IN or OUT marks, arm tracks, or send 
record commands to the Composer system itself.

¥ Smooth audio scrub is enabled by default, emulating analog audio 
scrub on a VTR.
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CHAPTER 16

Exporting and Exchanging 
Material

At the advanced stages of a production you may need to export or 
exchange material with another system, another application, or 
another platform. Film  Composer provides various tools for export-
ing clips and sequences in various formats, or for transferring projects 
and media between systems, as described in the following sections:

¥ Supported File Types for Export

¥ Preparing to Export

¥ Exporting PICT Files

¥ Exporting QuickTime Files

¥ Transferring OMF Files from Film Composer to AudioVision

¥ Transferring OMF Files to Pro Tools

¥ Transferring Projects and Media Files Between Systems

Supported File Types for Export

There are several reasons why you might want to export video, audio, 
or both from the Film Composer system: 
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¥ You can export audio Þles for audio sweetening in compatible 
applications.

¥ You can export picture Þles for touching up or creating special 
effects in third-party applications.

¥ You can export Þles compatible with CD-ROM for use in multime-
dia projects.

You can export Þles in the following formats: 

¥ Shot log (see ÒExporting Log FilesÓ on page 48)

¥ PICT (see ÒExporting PICT FilesÓ on page 480)

¥ QuickTime (see ÒExporting QuickTime FilesÓ on page 486)

¥ OMF Interchange (see ÒExporting OMF FilesÓ on page 495)

Preparing to Export

If you are exporting part or all of a sequence, you can speed the export 
process by preparing the sequence in advance as follows:

See the Avid Media Com-
poser and Film Composer 
Effects Guide for more 
information on render-
ing.

¥ Render all effects in advance. Although any unrendered effects are 
rendered on export (except for an OMF export), rendering effects 
in advance saves you time. 

¥ Consider mixing down additional tracks in advance, as described 
in ÒUsing Video MixdownÓ on page 478 and ÒMixing Down 
Audio TracksÓ on page 360. 

¥ Check and adjust all pan and audio levels in advance, as described 
in ÒUsing the Audio Mix ToolÓ on page 327. All current pan and 
level settings in the sequence are carried through to the exported 
media. 

¥ If you are exporting an OMF Þle, remember that OMF does not 
mix down the tracks in a sequence during export. OMF maintains 
all editing information in your sequence, allowing changes later. 
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Film Composer mixes down video for PICT and QuickTime for-
mats and audio for PICT formats.

¥ If you are exporting an OMF Þle, consider consolidating the media 
to save time and disk space. See ÒConsolidating MediaÓ on 
page 184 and ÒTransferring OMF Files from Film Composer to 
AudioVisionÓ on page 503.

Using Video Mixdown 

Video mixdown allows you to combine several tracks into a single 
new master clip. This is convenient for building multilayered effects, 
for consolidating media, and for export and exchange.

c When you mix down video tracks, you cannot separate them again to 
work on the tracks individually. Use this function only during the 
last stages of editing when you no longer need to make changes, or 
to make a copy for previewing.

To perform a video mixdown:

1. Make sure the videotrack monitor is in the topmost track that you 
want to mix down. 

Video mixdown works from the monitored track down, regardless 
of track selection.

2. Mark an IN and OUT point around the area to mix down.

3. Choose Video Mixdown from the Special menu.
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The Video Mixdown dialog box appears.

4. Choose a Target Disk for storing the new master clip and click OK.

A progress indicator appears, indicating the progress of the video mix-
down. When the mixdown is completed, a new clip appears in the bin 
along with the sequence, and a new media Þle is created on the target 
disk.
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Exporting PICT Files

You can export a single frame as a PICT Þle, or you can export a clip or 
sequence as a series of PICT Þles (a PICT sequence).

Before You Begin

PICT sequence export involves the following considerations:

¥ A PICT sequence is not one Þle, but a series of still PICT Þles. Be 
sure to transfer all Þles when moving them to another system for 
import.

¥ PICT sequence export has the added advantage that, in the case of 
a power failure or other mishap during export, thereÕs a good 
chance youÕll be able to recover some of the individual frames.

How to Export PICT Files

To export Film Composer system frames, clips, or sequences as PICT 
Þles:

1. Select the material you want to export in one of the following 
ways:

¥ For a single frame, park the position indicator on the frame 
you want to export.

¥ For clips in a bin, select the clip or clips you want to export.

¥ For clips or sequences in a Source, Record, or Pop-up monitor:

- Mark IN and OUT points in the monitor or in the Timeline, 
create a subclip, and then select the clip in a bin.

- Mark an IN point in the monitor or in the Timeline. The sys-
tem exports the material from the displayed frame (the posi-
tion indicator location) to the end of the sequence or clip.
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Make sure you monitor the highest video track, and select the 
proper tracks for export. As a general rule, the system exports 
whatever you see when you play the sequence.

2. Choose Export from the File menu.

n If you do not see Export on the File menu, choose Switch To Long Menus on 
the Special menu.

The Export Format dialog box appears.

3. Select one of the following options:

¥ PICT: Select this option to export a single frame.

¥ PICT Sequence: Select this option to export multiple frames.

¥ Export Full Frame: Select this option if you are exporting any 
of the two-Þeld resolutions (AVR 70 to AVR 77, or AVR 12). 
This option exports both video Þelds for higher resolution.
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4. Click OK.

The File Save dialog box appears.
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5. A default Þlename appears in the Export As text box with one of 
the following default Þle names:

¥ sequence_name.PICT (for a single frame)

¥ sequence_name.PSEQ.n (for a PICT sequence, where n is a sequen-
tial number beginning with 1)

You can change the Þlename.

6. Select the destination folder for the Þle and click Save. 

A new dialog box appears, depending on the Þle or Þles you are 
exporting.

¥ If you are exporting a single frame as a PICT Þle, see the next 
section, ÒExporting a PICT Frame.Ó 

¥ If you are exporting a PICT sequence, see ÒExporting a PICT 
SequenceÓ on page 484.

Exporting a PICT Frame

If you are exporting a single frame as a PICT Þle, the following dialog 
box appears.
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1. Choose the Þle size, in pixels, of the frames to be saved in the Þle 
from the Destination Size pop-up menu.

2. If you want to export the image at CCIR-601 video levels for fur-
ther processing in an application that supports those levels, select 
the Export at CCIR Video Levels check box.

3. Click OK.

The Þles are saved in the destination folder that you selected in the 
File Save dialog box. 

Now you can transfer the Þle or Þles.

Exporting a PICT Sequence

If you are exporting a PICT sequence, the following dialog box 
appears.

These are NTSC frame sizes. 
PAL export displays PAL sizes.
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1. Choose the Þle size, in pixels, of the frames to be saved in the Þle 
from the Destination Size pop-up menu.

2. Choose the number of frames per second to be saved in the Þle 
from the Frames Per Second pop-up menu. To reduce the size of 
the export Þle, select fewer frames per second.

3. Click OK.

The Þles are saved in the destination folder that you selected in the 
File Save dialog box. 

Now you can transfer the Þle or Þles.

These are NTSC frame sizes. 
PAL export displays PAL sizes.

These are NTSC frame sizes. 
PAL export displays PAL sizes.
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Exporting QuickTime Files

You can export a single frame, a clip, or sequence as a QuickTime Þle.

Before You Begin

When you export a QuickTime Þle, you need to choose a codec (com-
pressor/decompressor). Before you begin exporting, review your 
options for choosing a codec. Your choice depends on how you want 
to use the export, as follows:

¥ For quickest exchange between compatible applications, choose 
the Media Composer codec. This software-based codec creates 
encapsulated media Þles for quick export of high-resolution Þles 
that are readable within QuickTime applications that are also 
equipped with the codec. See ÒUsing the Media Composer 
QuickTime Codec from QuickTime ApplicationsÓ on page 494.

The codec allows you to maintain Avid Video Resolutions (AVRs) 
up to AVR 77 when exchanging material between QuickTime-
compatible applications. It also speeds the QuickTime import/
export process to a rate of approximately four times real time or 
better (depending on resolution). The codec provides a vast 
improvement over the standard QuickTime conversion, which can 
take as long as 300 times real time or more with full-size, high-res-
olution clips.

Exporting with the Avid codec does not cause any loss in quality, 
because the codec maintains the identical media data. However, 
the quality cannot be better than the original resolution of the dig-
itized media. 

¥ For high-quality, lossless compression (in which no picture infor-
mation is lost) for In-Out exchange (export-import) between com-
patible applications, choose one of the following methods:

- Animation: Uses the same compression algorithm for PICT 
Þles (run length encoding) and results in Þles that are 70 to 95 
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percent the size of the uncompressed Þle. At the maximum 
quality, this method is lossless compression.

- Component Video: Uses the same algorithm as the Animation 
method, but saves the Þle in YUV RLE format, which sepa-
rates the luminance from the chrominance. All QuickTime 
applications can read this format, but only some can write to 
this format.

- None: Does not compress the Þle, and results in very large 
Þles.

¥ For medium quality, lossy compression (in which some picture 
information is lost) requiring less storage space, choose the follow-
ing:

- PhotoÐJPEG: Uses the Joint Photographic Experts Group algo-
rithm for image compression, and results in Þles that are 20 to 
30 percent the size of the uncompressed Þles. Some data is lost 
during compression, and the export process takes longer to 
complete (typically six times longer than the Animation com-
pression, for example).

¥ For export at low resolution for use in contexts where high quality 
is not an issue, such as presentations or educational uses, or for 
small-screen size play back from CD-ROM or hard drive, choose 
one of the following methods:

- Graphics: Uses a limited color palette version (16 colors) of 
Animation compression.

- Cinepak: Uses CD-ROM playable compression.

- Video: Uses the standard Macintosh compression, which 
takes less time to compress but does not play back as quickly 
as Cinepak.

How to Export QuickTime Files

To export Film Composer system frames, clips or sequences as Quick-
Time Þles:
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1. Select the material you want to export in one of the following 
ways:

¥ For a single frame, park the position indicator on the frame 
you want to export.

¥ For clips in a bin, select the clip or clips you want to export.

¥ For clips or sequences in a Source, Record, or Pop-up monitor:

- Mark IN and OUT points in the monitor or in the Timeline, 
create a subclip, and then select the clip in a bin.

- Mark an IN point in the monitor or in the Timeline. The sys-
tem exports the material from the displayed frame (the posi-
tion indicator location) to the end of the sequence or clip.

Make sure you monitor the highest video track, and select the 
proper tracks for export. As a general rule of thumb, the system 
exports whatever you see when you play the sequence.

2. Choose Export from the File menu.

n If you do not see Export on the File menu, choose Switch To Long Menus on 
the Special menu.

The Export Format dialog box appears.

3. Select one of the following options:

¥ QuickTime Video and Audio: Select this option if, for example, 
you are using an entire clip or sequence in a multimedia 
project.

¥ QuickTime Video Only: Select this option if, for example, you 
are adding effects in a third-party application.

¥ QuickTime Audio Only: Select this option if, for example, you 
are using or enhancing audio in a third-party application. 

¥ Export Full Frame: Select this option if you are exporting any 
of the two-Þeld resolutions (AVR 70 to AVR 77, or AVR 12). 
This option exports both video Þelds for higher resolution.
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4. Click OK.

The File Save dialog box appears.
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5. A default Þlename appears in the Export As text box with the fol-
lowing default Þle name:

sequence_name.MooV

You can change the Þlename.

6. Select the destination folder for the Þle and click Save. 

A dialog box appears.
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n This same sequence of dialog boxes appears in many QuickTime applications. 
Use the following information to prepare QuickTime Þles for export into Film  
Composer.

7. Select additional options for the export as follows:

¥ To create a QuickTime poster for your movie, select the Create 
Movie Preview option (this option slows the export process). 

¥ Select alternative audio settings, when appropriate:

a. Choose a new sample rate, when appropriate, from the pop-
up menu.

The options include the native rate of the chosen media plus 
half and quarter rates for standard Macintosh models (22.254 
and 11.127 kHz) and AV Macintosh models (22.050 and 11.025 
kHz).

b. Choose a new Sample size (16 bit or 8 bit), when appropriate, 
from the pop-up menu.

c. Change the default audio export from stereo to mono, when 
appropriate, by selecting the Mono option.

¥ To create a single-fork, cross-platform compatible movie (one 
that can be opened on both the Macintosh and the PC for use 
in cross-platform multimedia development), select the Cross-
Platform Movie option.

8. Click the Compression Settings button to open the Compression 
Settings dialog box.
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9. Choose a codec from the Compressor pop-up menu. See ÒBefore 
You BeginÓ on page 486.

10. Choose a color compression from the Color pop-up menu.

n Use the Color default if you are using the Media Composer QuickTime codec.

11. Choose the desired frame rate from the pop-up menu. Choose 30 
to maintain full-motion video/animation.

12. Drag the Quality slider to a new position if necessary. 

If you are using the Media Composer QuickTime codec, the AVR 
Selection dialog box appears.
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n Because the Media Composer codec uses the AVR of your original source Þles, 
it ignores what you choose in the AVR pop-up menu. However, if you are 
exporting from a third-party application, select an AVR and click OK to 
return to the Compression Settings dialog box. 

13. Click OK.

The material will be exported with the chosen compression 
parameters and saved in the destination folder you selected in the 
File Save dialog box. 

Now you can transfer the Þle or Þles.

If a power failure or mishap occurs during the export process, the 
entire Þle is unusable. You need to repeat the export process.

n The maximum Þle size that the Macintosh system allows is approximately 2 
gigabytes. If you exceed this limit the system displays an error and the Þle is 
unusable.

AVR pop-up menu



494

n Media Composer QuickTime Þles can be quite large, depending on the AVR, 
and require adequate storage and transfer capacities. Also, if you are having 
trouble opening or playing the export in a third-party application, increase 
the memory allocated to the program. 

Using the Media Composer QuickTime Codec from QuickTime 
Applications

You can speed the process of importing QuickTime Þles by installing 
the Media Composer QuickTime codec in other (third-party) 
QuickTime applications and using it to export QuickTime Þles.

Installing the Codec in QuickTime Applications

After installing Media Composer Release 6.0 or later on your system, 
the new codec is automatically installed in the Extensions Folder 
inside the System Folder. You can copy this extension and install it at 
other workstations where you are using QuickTime compatible appli-
cations. Once the Media Composer codec is installed on the worksta-
tion, you can export Þles from either the Composer system or from the 
third-party application for reimport into the Composer system.

You can install the codec on either a Power Macintosh¨ or non-Power 
Macintosh system. To install the Media Composer codec on the system 
where the third-party application resides:

1. Drag the copy of the extension labeled Avid Codec onto the Sys-
tem Folder and release the mouse button. 

A dialog box asks if you would like to install the Þle in the Exten-
sions folder. 

2. Click OK.

3. Restart your system.

The codec is installed.
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Exporting from a QuickTime Application

Exporting from a third-party QuickTime application using the Media 
Composer QuickTime codec and the default Composer system frame 
size allows you to speed the process of importing back into the Com-
poser system to approximately three to four times real time (video 
only).

To export Media Composer Þles from a QuickTime-compatible appli-
cation for import (or reimport) into the Composer system, do the fol-
lowing:

1. Make sure the Media Composer codec is installed in the System 
FolderÕs Extensions folder.

2. Conduct the export procedure according to the manual included 
with the particular software. In the standard QuickTime Create a 
Movie dialog box, select NTSC (640 x 480 square pixels or 720 x 
486 non-square pixels) as the frame size (768 x 576 square or 720 x 
576 non-square for PAL).

n If you select another frame size, the Composer system will not import the Þle 
quickly using the Media Composer codec.

3. In the Create a Movie dialog box, click Options. The standard 
QuickTime Compression Settings dialog box appears.

4. Complete steps 7 through 13 in the section ÒHow to Export Quick-
Time FilesÓ on page 487. In step 9, choose Media Composer from 
the Compressor pop-up menu.

Exporting OMF Files

The following sections describe Open Media Framework (OMF) Inter-
change and provide a procedure for transferring any OMF Þle. 
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¥ For speciÞc information on transferring Þles to AudioVision, see 
ÒTransferring OMF Files from Film Composer to AudioVisionÓ 
on page 503. 

¥ For speciÞc information on transferring Þles to Digidesign Pro 
Tools, see ÒTransferring OMF Files to Pro ToolsÓ on page 511.

¥ For information on transferring Þles to non-Avid digital audio 
workstations, follow one of the methods described in ÒTransfer-
ring OMF Files to Pro ToolsÓ on page 511 and see the digital 
audio workstationÕs documentation.

About OMF Interchange

OMF Interchange is a platform-independent Þle format that stores 
both the digital media (video, audio, graphics, animation) and the 
ÒrecipeÓ describing how the media ÒingredientsÓ are edited together 
to form a Þnal sequence. This editing information, also called a com-
position, is the OMF representation of a Film Composer sequence. The 
OMF Interchange format is the result of cooperative efforts of many 
industry and standards partners and Avid Technology, Inc.

OMF Þles can be understood by any other program that supports 
OMF, even if the program resides on a different computer platform. As 
a result, OMF lets you transfer among different applications on differ-
ent platforms, without worrying about cross-platform translations. 
This can be very effective for importing animations or audio that have 
been created on proprietary platforms.

Film Composer Release 6.5 supports import and export of both OMF 
1.0 and OMF 2.0 Þles. Film Composer continues to support OMF 1.0 
Þles for use when you are interchanging with an application that sup-
ports only OMF 1.0. 

Release 6.5 support for OMF 2.0 includes:

¥ OMF effects for some of the video effects (dissolves, wipes, freeze-
frame, Þlm pulldown, slow motion, and fade to black)
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¥ Pan and Volume audio effects and audio dissolves

¥ TIFF (AVR) media in OMF 2.0 Þles.

Additional effects will be supported in future releases. See the Avid 
Media Composer and Film Composer Release Notes for current details.

See the Avid Media Composer Products Reference for an appendix that 
lists applications that currently support the OMF Interchange. For the 
latest information, see the Avid OMF web site:

http://www.avid.com/omf 

Methods for Exporting

OMF Interchange, as implemented in Film Composer, provides two 
basic methods for exporting Film Composer Þles:

¥ OMF compositions: Film Composer exports an OMF Þle that con-
tains only the editing information about a selected master clip or 
sequence. It includes references to the source media, but does not 
include the media itself. You then need to transfer both the OMF 
Þle and the media Þles, or redigitize the media on the other sys-
tem. After you have transferred the media once, you can transfer 
revised composition-only Þles (unless you have consolidated 
media Ñ see ÒConsolidating MediaÓ on page 184).

¥ OMF compositions and media: Film Composer exports an OMF 
Þle that contains all the edit information for the selected master 
clip or sequence as well as the media for that master clip or 
sequence. You then transfer only one Þle. However, this Þle can be 
quite large. 

The method you choose depends on the reason for the export and the 
amount of media involved. For speciÞc options and more information 
about them, see ÒHow to Export OMF FilesÓ on page 498.
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Before You Begin

Before you export the OMF Þle, complete the following actions to 
reduce the size of the Þle and cut down the transfer time.

¥ Consider mixing down additional tracks in advance, as described 
in ÒUsing Video MixdownÓ on page 478 and ÒMixing Down 
Audio TracksÓ on page 360. 

¥ Check and adjust all pan and audio levels in advance, as described 
in ÒUsing the Audio Mix ToolÓ on page 327. All current pan and 
level settings in the sequence are carried through to the exported 
media. 

¥ Consider consolidating to save time and disk space, or to place all 
media on a single drive for easier transfer. If you do not need to 
transfer all the source media, consolidating is an efÞcient way to 
transfer only what your edited sequence uses. See ÒConsolidating 
MediaÓ on page 184.

¥ OMF Þles that contain audio media, video media, or both, can be 
very large. Make sure you have enough room on an external disk 
to store a large Þle.

¥ OMF Þles with very complex sequences can fail during import 
into some applications, due to memory limitations. Try one of the 
following solutions:

- Break the sequence into smaller sequences and export the new 
sequences. 

- Add more memory to the application.

- Add more physical memory.

How to Export OMF Files

Use the following procedure for transferring any OMF Þle.
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¥ For speciÞc information on transferring Þles to AudioVision, see 
ÒTransferring OMF Files from Film Composer to AudioVisionÓ 
on page 503. 

¥ For speciÞc information on transferring Þles to Digidesign Pro 
Tools, see ÒTransferring OMF Files to Pro ToolsÓ on page 511.

¥ For information on transferring Þles to non-Avid digital audio 
workstations, follow one of the methods described in ÒTransfer-
ring OMF Files to Pro ToolsÓ on page 511 and see the digital 
audio workstationÕs documentation.

To export clips or sequences as OMF Þles:

To export multiple clips 
in a single OMF Þle, 
select all the clips, 
option-drag them to a 
new sequence, and 
export the sequence.

1. In a bin, select the clips or sequences you want to export. 

You do not need to export both the clips and the sequence that 
contains them. The Þle for the sequence contains all information 
for the referenced clips.

2. Choose Export from the File menu.

n If you do not see Export on the File menu, choose Switch To Long Menus on 
the Special menu.

The Export Format dialog box appears.

3. Select one of the following options:

¥ OMFI Compositions Only: Select this option to export only the 
information about the clip or sequence, without the corre-
sponding media. For example, transfer a composition to a dig-
ital audio workstation such as AudioVision that already has 
the media for the sequence.

¥ SD2 Format Audio: Select this option only if you want to keep 
the audio media in Sound Designer II format and create a pri-
vate SD II descriptor that points to the SD II Þle. Use this 
option if you are going to use the Þle with OMF Tool in Pro 
Tools¨ or in another application that can read Film Composer 
SD II audio Þles. See ÒTransferring OMF Files to Pro ToolsÓ 
on page 511. 
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n You do not need to select the SD2 option to have AudioVision read the origi-
nal Film Composer SD II audio media.

¥ OMFI Video and Audio and Composition: Select this option if 
you are using an entire clip or sequence in an OMFI-
compatible editing or graphics enhancement system. This 
option creates a Þle that includes both editing information (for 
sequences) and the media itself.

¥ OMFI Video and Composition: Select this option if you are 
adding video or Þlm effects in an OMFI-compatible applica-
tion. The exported Þle includes both editing information and 
video media.

¥ OMFI Audio and Composition: Select this option if you are 
using or enhancing audio in an OMFI-compatible application. 
The Þle includes both editing information and audio media.

¥ Export As: From the pop-up menu, choose the OMFI version 
that is supported by the application to which you are export-
ing. If you are not sure, choose 1.0. 

n OMF 2.0 Þles can only be imported by applications that support OMFI 2.0.

OMFI version 
pop-up menu 
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4. Click OK.

The File Save dialog box appears.
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5. A default Þlename appears in the Export As text box with an 
extension that indicates the type of Þle format. For OMF Þles the 
extension is sequence_name.omf. Enter a Þlename of your choice. 
Avoid names that include spaces or special characters. Avid rec-
ommends that you use the .omf extension.

6. Select the destination folder for the Þle and click Save.

If you are exporting a Þle that includes media, make sure there is 
adequate space on the disk you are exporting to. If possible, avoid 
exporting to the system (root) disk.

The Film Composer system creates an OMF Þle in the folder that 
you selected. 

If the sequence contains effects that are not supported by OMFI 
2.0, you see a dialog box asking you if you want to continue. 

Next, transfer the OMF Þle and media, if applicable, to the system 
where the additional editing will be done. See ÒTransferring Projects 
and Media Files Between SystemsÓ on page 521.

n Do not select SD2 Format Audio for projects you are transferring to Audio-

Vision. AudioVision can read Film Composer audio Þles without the SD2 
option. Other audio applications such as Pro Tools require the SD2 option or 
OMFI Audio and Composition.
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Transferring OMF Files from Film Composer to 
AudioVision

After editing in Film Composer, you can export and transfer your 
sequence and media to AudioVision for audio sweetening, using OMF 
Interchange from Film Composer Release 5.11 and later. These instruc-
tions apply to AudioVision Release 3.6 or earlier and OMFI 1.0.
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You can transfer the video from Film Composer to AudioVision by 
making a digital cut of the video, digitizing it into AudioVision, and 
playing the video remotely in AudioStation.

The instructions for transferring are divided into the following sec-
tions:

¥ Before you begin

¥ Step 1: Making a digital cut to tape of the edited picture

¥ Step 2: Consolidating the media Þles in Film Composer

¥ Step 3: Exporting the OMF Interchange composition from Film 
Composer

¥ Step 4: Relocating the media

¥ Step 5: Importing the composition

Before You Begin

To avoid problems, follow these guidelines when exporting from Film 
Composer:

¥ Set the pull-down switch on the Video Slave Driver to 1.00.

¥ Add a head and tail SMPTE (countdown) leader to your Film 
Composer sequence before exporting it, so you have some extra 
material at the head and the tail.

¥ Make sure there is an obvious sync point (such as a beep) so you 
will be able to line up picture and sound in AudioVision.

¥ The audio sampling rate of the sequence must be 44.1 kHz or 48 
kHz. All audio clips in the sequence need to be the same sample 
rate.

¥ Do not modify the start or end timecodes of master clips, and do 
not convert the frame rates. 
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¥ Make sure that the sequence contains video digitized at a single 
AVR level. AudioVision does not display video for sequences that 
contain mixed AVR levels. 

n AudioVision 3.6 or earlier does not display video for sequences exported from 
Film Composer Release 6.0 or later.

¥ If you are transferring a PAL sequence from Film Composer, you 
must bring the sequence into Film Composer using Method 2 
described in the ÒPlanning a Film ProjectÓ appendix of the Avid 
Film Composer Getting Started Guide. Method 2 is summarized 
below:

¥ Transfer the Þlm picture alone to PAL video at a rate of 25 fps, 
then use Film Composer to digitize the picture at 25 fps. 

¥ Digitize the sound separately, either directly from the original 
audiotapes or from DAT transfer tapes, at the rate at which the 
sound was originally recorded. After digitizing, use Film 
ComposerÕs AutoSync command to join each picture master 
clip with its corresponding sync sound master clip.

¥ Play and edit the captured picture at 24 fps and the audio at 
the sync sound rate or the rate at which it was captured. 

¥ Occasionally, AudioVision stops importing and an ÒOut-of-mem-
oryÓ error message appears. This is because the OMF Interchange 
composition is too large, and needs to be exported from Film 
Composer in smaller sections. Divide the sequence into smaller 
segments by duplicating the sequence (perhaps several times), 
and deleting portions of each copy, and export and import each 
segment individually. After the segments are imported, you can 
edit them together easily and accurately.

The size of the OMF Interchange composition is not determined 
by the length of the sequence, but by its complexity. For example, 
a short sequence with many edits and tracks may be larger when 
exported as an OMF Interchange composition than a long 
sequence with only a few edits and only a few tracks of audio and 
video.
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Step 1: Making a Digital Cut to Tape of the Edited Picture
1. Start the Film Composer system.

2. Open the bin containing the sequence you want to export.

3. Select the sequence and place it in the Record monitor. 

4. Set the pull-down switch on the Video Slave Driver to 1.00, if it 
isnÕt already set to this. You must do this to synchronize the video 
and audio successfully in AudioVision.

5. If you are making a digital cut from a PAL sequence, select the 
Film Rate option to play back at 24 fps in the Digital Cut Settings 
window.

6. If possible, match the timecode on the tape to the sequence time-
code, so the digital cut will place the video onto the tape at the 
proper timecode location. You can do this by striping the video-
tape with appropriate timecode before the transfer. If the digital 
cut has the same timecode as the imported audio sequence, syn-
chronizing video and audio in AudioVision will be much easier.

7. Make a digital cut of the sequence to tape. (You only need to 
record the picture onto the tape, because you will be consolidating 
the audio separately.)

Step 2: Consolidating the Media Files in Film Composer

You consolidate the media to reduce the size of the media that must be 
transferred. When Film Composer consolidates, it creates a copy of the 
media, eliminating any sections of media not used in the sequence. 
Consolidation also lets you copy the consolidated media on to a single 
drive, for easier transfer. If you plan to consolidate, you must consoli-
date before exporting the OMF Interchange composition. For complete 
information on consolidating, seeÒConsolidating MediaÓ on 
page 184.

To consolidate media:

1. Select the sequence you want to export.
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2. Duplicate the sequence, and place the copy in a new bin. (This pre-
serves the links from your original sequence to the original media 
disk or disks.)

3. Remove the video track from the copy.

4. Select the copy of the sequence.

5. Choose Consolidate from the Clip menu. The Consolidate dialog 
box appears.

¥ Do not select ÒDelete original media Þles when doneÓ unless 
you want to delete media Þles from your Film Composer 
drive after consolidating.

c If you delete original media Þles, you will not be able to retrieve 
them, even from the original sequence.
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¥ Choose a target disk with enough storage space to hold all the 
consolidated media Þles. (See ÒStorage Devices for Transfer-
ring MediaÓ on page 522 for more information about stor-
age devices.)

¥ Type an adequate handle length. The handle length is the 
number of frames the system includes at the ends of the media 
Þles beyond what is used in the sequence. These frames are 
needed when you do trimming, dissolves, and crossfades. 

6. Click OK. 

Film Composer copies the media Þles to the selected target drive. 

Step 3: Exporting the OMF Interchange Composition
1. Select the sequence you just consolidated.

2. Choose Export from the File menu. 

The Export Format dialog box appears.

n If you do not see Export on the File menu, choose Switch To Long Menus on 
the Special menu.

3. Select OMFI Compositions Only. Select OMFI 1.0 from the pop-up 
menu.
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4. Click OK. 

The File Save dialog box appears.
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5. Move to the disk and folder where you want to save the OMF 
Interchange composition. (The best place to save the Þle is on the 
same storage device on which you saved the media Þles.)

6. Enter a Þle name for the OMF Interchange composition, and click 
Save. The Sequence is exported.

Step 4: Relocating the Media

If you are transferring media on hard drives or RMAGs:

1. Quit the Film Composer and shut down your system.

2. Remove the disk or drives that contain the OMF Interchange com-
position and the consolidated audio media Þles from the Film 
Composer system. (For more information about storage devices, 
see ÒStorage Devices for Transferring MediaÓ on page 522.)

n For information on the correct procedures for disconnecting and connecting 
drives, see the appropriate hardware guide.

3. With the AudioVision system turned off, connect the hard drives 
or RMAGs you removed from the Film Composer system.
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Step 5: Importing the Composition
For information on importing the OMF Interchange composition 
into AudioVision, see the Avid AudioVision UserÕs Guide.

n Occasionally, AudioVision stops importing and an ÒOut-of-memoryÓ error 
message appears. This is because the OMF Interchange composition is too 
large, and needs to be exported from Film Composer in smaller sections. For 
more information see ÒBefore You BeginÓ on page 504.

Transferring OMF Files to Pro Tools

Follow these basic steps to transfer Þles from Film Composer to Pro 
Tools:

1. Export from Film Composer (Release 5.2.1 or later) to an OMFI 
Þle.

2. Use OMF Tool to convert the exported OMFI Þle to a Pro Tools 
Session.

n You can download OMF Tool from the Avid OMF Web site 
http://www.avid.com/omf.

3. Open and save the Pro Tools Session in Pro Tools.

These steps are described in the following sections. For more informa-
tion, see the Pro Tools documentation.

Choosing How to Export the Sequence

There are two methods for converting a Film Composer sequence into 
a Pro Tools session. The difference between the two is how the media 
(audio) Þles are managed during the transfer.
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¥ Method 1: OMFI Compositions Only (with SD II locators): Film 
Composer creates an OMFI Þle that contains all the editing infor-
mation, but leaves the original audio Þles where they are. After 
translating the sequence with OMF Tool, Pro Tools will be able to 
reference these original audio Þles (created in Sound Designer II 
format) from the Film ComposerÕs 5.x or 6.x MediaFiles folder.

¥ Method 2: OMFI Audio and Composition: Film Composer cre-
ates an OMFI Þle that contains all the editing information for the 
selected sequence as well as all of the audio Þles, in essence dupli-
cating the audio Þles in a new format (AIFC).

Choose OMFI Composition Only if you want Pro Tools to reference the 
original Film Composer (Sound Designer II) audio Þles, and if you 
want to avoid duplicating the audio media in the OMF Þle, and then in 
SD II Þles on Pro Tools system. (You will need to transfer or copy the 
audio Þles from the Film Composer system to the Pro Tools system.) 
See ÒMethod 1: Using the OMFI Compositions Only OptionÓ on 
page 515.

Choose OMFI Audio and Composition if you want to simplify the Þle 
management and transfer required by having just one OMFI Þle con-
taining edit and audio information. This method duplicates audio 
media and, therefore, requires more disk space. See ÒMethod 2: Using 
the OMFI Audio and Composition OptionÓ on page 518.

Choosing Whether to Consolidate Your Media Files

Before you export the sequence, you need to decide whether or not to 
consolidate your media Þles.

If you are running Pro Tools and Film Composer on the same com-
puter: You do not need to consolidate your Þles. You can simply shut 
down and reconnect the hard drive with the audio Þles from the Avid 
SCSI bus to the Macintosh SCSI bus. Then start up and open the Pro 
Tools Session. Pro Tools looks for the associated audio Þles in the Film 
ComposerÕs 5.x or 6.x MediaFiles folder. With this method, at no time 
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does any media get copied or converted in any way. The disadvantage 
to this method is that you must move the hard drive from one bus to 
another.

c Pro Tools will only be able to play back audio Þles from drives con-
nected to the Macintosh computerÕs SCSI bus.

If you are running Pro Tools and Film Composer on different com-
puters: You have two options for handling the media that is referenced 
in the sequence that you are converting. 

¥ Use Film ComposerÕs Consolidate feature to consolidate your 
media Þles.

¥ Copy the media Þles manually from one hard disk to another. 

The next sections describe the advantages and disadvantages of these 
two methods and tell you how to use either one.

Consolidating Your Media Files

The Film Composer systemÕs Consolidate feature allows you to create 
copies of the sequenceÕs media Þles to a selected hard disk. This makes 
it relatively simple to move your source Þles with you when you move 
to a different system. Using the Consolidate feature has the advantage 
of copying only the amount of media necessary. For example, it wonÕt 
copy an entire 1-hour audio Þle in order to consolidate a single 10-sec-
ond clip.

For more information on consolidation, see ÒConsolidating MediaÓ 
on page 184.

To consolidate your media Þles:

1. Select the sequence you want to export.

2. Duplicate the sequence, and place the copy in a new bin. (This pre-
serves the links from your original sequence to the original media 
disk.)
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3. Remove the video track from the copy.

4. Select the copy of the sequence.

Choose Consolidate from the Clip menu. The Consolidate dialog 
box appears.

¥ Do not select ÒDelete original media Þles when doneÓ unless 
you want to delete media Þles from your Film Composer 
drive after consolidating.

c If you delete original media Þles, you will not be able to retrieve 
them, even from the original sequence.

¥ Choose a target disk with enough storage space to hold all the 
consolidated media Þles. 
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¥ Type an adequate handle length. The handle length is the 
number of frames the system adds to the ends of the media 
Þles beyond what is used in the sequence. These frames are 
needed when you do trimming, dissolves, and crossfades. 

5. Click OK. 

Film Composer copies the media Þles to the selected target drive.

Copying Media Files Manually

Some users do not like to use the Consolidate feature because it 
changes the way they manage media Þles. Instead, they like to simply 
export the sequence (using Film ComposerÕs OMFI Compositions 
Only export option with the SD2 Format Audio box checked), and 
then transfer the associated media. This will work Þne, with the fol-
lowing differences:

¥ The user is responsible for determining which media is associated 
with the sequence

¥ Either OMF Tool or Pro Tools may present a Where Is dialog box 
to locate the media (by Þle name) after it has been copied. Note 
also that using this method means that ALL the audio is copied 
(not just the 10-second clip from the 1-hour audio Þle, but the 
entire 1-hour audio Þle).

See ÒTransferring OMF Files to Pro ToolsÓ on page 511.

Method 1: Using the OMFI Compositions Only Option

Using this export method for a selected sequence will create an OMFI 
Þle that contains all of the edit information in the sequence and 
includes Sound Designer II locators that reference the media (audio) 
Þles in the Film ComposerÕs 5.x or 6.x MediaFiles folder. You then use 
OMF Tool to convert this OMFI Þle into a Pro Tools Session that refer-
ences the same media Þles. This is possible because both Film Com-
poser and Pro Tools use Sound Designer II as their native audio Þle 
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format. This type of conversion is the fastest, and it uses the least 
amount of hard disk space. 

How to Transfer a Sequence to Pro Tools Using OMFI Compositions Only

To transfer a sequence from Film Composer to Pro Tools using OMFI 
Compositions Only:

1. If desired, consolidate your Film Composer media Þles (see 
ÒChoosing Whether to Consolidate Your Media FilesÓ on 
page 512).

2. In Film Composer, choose Export from the File menu.

The Export Format dialog box appears.

3. Select OMFI Compositions Only, SD2 Format Audio, and OMFI 
1.0.

These options create an OMFI Þle with the sequenceÕs edit data 
only. The Þle includes Sound Designer II locators that refer to the 
original 6.x media Þles. 

n Other audio applications may also be able to read original media Þles with the 
SD2 Format Audio option, or they may require a combined composition and 
media Þle (ÒMethod 2: Using the OMFI Audio and Composition 
OptionÓ on page 518). See the documentation for the particular application.
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4. Click OK

The File Save dialog box appears.
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5. Select the destination folder, supply a Þle name, and click Save. 

The Þles are converted and stored in the destination folder.

6. Copy the Þle from the Film Composer system to the Pro Tools sys-
tem. Then refer to the Pro Tools OMF documentation for informa-
tion on converting the OMF Þles to Pro Tools/SD II.

7. Transfer the media. See ÒTransferring Projects and Media Files 
Between SystemsÓ on page 521. 

Method 2: Using the OMFI Audio and Composition Option

This method produces a single OMFI Þle that contains all the edit 
information for the selected sequence, as well as all of the audio Þles. 
The audio is exported in the form of AIFC data within the OMFI Þle. 
The OMF Tool can then be used to convert this OMFI Þle into a Pro 
Tools Session.

Note, however, that using this method produces a total of three copies 
of the referenced media:

¥ The original in the Film ComposerÕs 5.x or 6.x MediaFiles folder.

¥ The converted version in the OMFI Þle
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¥ The resultant Sound Designer II Þles in the Audio Files folder of 
the Pro Tools Session.

You can discard the intermediate OMFI Þle once the transfer is com-
plete.

This method could take considerably longer as it has to translate the 
Þles from Film Composer to OMFI to Pro Tools. In addition, it requires 
three times as much disk space. It does have an advantage in that all of 
the edit information and media is contained in a single easily managed 
Þle, as opposed to an OMFI Þle and a collection of separate media 
Þles, as in Method 1. It also has the advantage of being more portable 
to other OMF-compatible applications that may not be able to read the 
Sound Designer II Þle format (using instead the more universally sup-
ported AIFC format).

How to Transfer a Sequence to Pro Tools Using OMFI Audio and Composition

To transfer a project from Film Composer to Pro Tools using OMFI 
Audio and Composition:

1. If desired, consolidate your Film Composer media Þles (see 
ÒChoosing Whether to Consolidate Your Media FilesÓ on 
page 512).

2. In Film Composer, choose Export from the File menu.

The Export Format dialog box appears.

3. Select OMFI Audio and Composition. Select OMFI 1.0 from the 
pop-up menu.

This option creates a single Þle with all of the sequenceÕs edit data 
and the audio data, in AIFC format.
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4. Click OK.

The File Save dialog box appears.
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5. Select the destination folder, supply a Þle name, and click Save. 

The Þles are converted and stored in the destination folder.

6. Copy the Þle from the Film Composer system to the Pro Tools sys-
tem. Then refer to the Pro Tools OMF documentation for informa-
tion on converting the OMF Þles to Pro Tools/SD II.

With this method there is no need to transfer media Þles.

Transferring Projects and Media Files Between 
Systems

This section provides information for transferring project Þles and dig-
ital media Þles among systems. Circumstances that require the transfer 
of projects and media Þles include the following:

¥ Transferring a work in progress for editing at another Film 
Composer site without redigitizing the media. This process is 
described in ÒTransferring a Project to Another Film Composer 
SystemÓ on page 523.

¥ Sharing media between networked systems using AvidNetª. This 
process is described in ÒUsing AvidNetÓ on page 524.

¥ Adding effects or other enhancements in an OMF-compatible 
application. This process is described in ÒExporting OMF FilesÓ 
on page 495.

¥ Transferring a sequence to AudioVision for audio sweetening. 
This process is described in ÒTransferring OMF Files from Film 
Composer to AudioVisionÓ on page 503.

¥ Transferring a project to Digidesign Pro Tools for audio sweeten-
ing. See ÒTransferring OMF Files to Pro ToolsÓ on page 511. 

¥ Transferring a project to other digital audio workstations. See 
ÒTransferring OMF Files to Pro ToolsÓ on page 511 and the docu-
mentation for the audio digital workstation.
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Other methods of media transfer include:

¥ AppleShare¨: You can transfer Þles between Macintosh systems 
by using Macintosh Þle sharing or an AppleShare server. See your 
Macintosh documentation for more information.

From UNIX¨ systems to Macintosh systems, you can use pro-
grams such as Xinet¨ K-AShareª to mount UNIX volumes on a 
Macintosh desktop.

¥ Internet File Transfer Protocol (FTP): You can transfer Þles 
between networked systems using TCP/IP and FTP, including 
transfer from UNIX, PC, or other platforms. For transferring from 
Silicon Graphics systems to Media Composer systems using Fetch, 
see the Avid Technical note, ÒUsing Fetch to Transfer OMF Files,Ó 
available through customer service.

Storage Devices for Transferring Media

When you transfer media from Film Composer, in most cases you con-
solidate the material onto a storage device, as described in ÒConsoli-
dating MediaÓ on page 184.

The following is a list of storage devices, and related restrictions, to 
consider for the transfer of media Þles:

¥ Removable hard drive (4 GB and 9 GB): Both the Film Composer 
system and the target system must have compatible RMAG XL or 
MediaDockª chassis. Both systems should be running the same 
version (latest) of the AVIDdrive Utility.

¥ Fixed hard drive (4 GB and 9 GB): Both the Film Composer sys-
tem and the target system must have compatible device drivers. 
Both systems should be running the same version (latest) of the 
AVIDdrive Utility.

¥ Avid DLT (digital linear tape) device: Both the Film Composer 
system and the target system must have compatible versions of 
ARCserve¨ DLT software.
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c If you are transferring media from striped drives, make sure the 
other system supports striped drives. Check the Extensions folder 
for the AVIDstripeª extension.

Transferring a Project to Another Film Composer System

When you transfer a project to another Film Composer system, make 
sure that:

¥ The memory allocation of Film Composer is similar in both sys-
tems.

¥ The AVRs are compatible between systems.

¥ The release of Film Composer on each system is compatible. See 
the Avid Media Composer and Film Composer Release Notes for a com-
plete description of compatibility issues between releases.

To transfer a work in progress and associated media to another Film 
Composer system:

1. Consolidate the media for the project onto an appropriate drive 
for transfer to the other system, as described in ÒConsolidating 
MediaÓ on page 184.

c Do not rename the folders named 5.x MediaFiles or 6.x MediaFiles 
located on the media drive. The target Film Composer system uses 
the folder names to locate the media Þles.

2. Copy the project folder and any settings Þles you would like to 
maintain at the new location onto a 3.5-inch diskette, as described 
in the Avid Film Composer Getting Started Guide.

3. Close the Film Composer application and shut down your system.

4. Remove the drives containing the consolidated media, and take 
these and the 3.5-inch diskette to the new location.

5. With the system turned off at the new location, insert or connect 
the drives and boot the system.
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6. In the Finder, copy the Project folder and any settings to the Avid 
drive, as described in the Avid Film Composer Getting Started Guide.

7. Start the Film Composer application, open the project, and resume 
work.

n Film Composer will reconstruct the MediaFiles database the Þrst time you 
launch the application to incorporate the new media into the systemÕs internal 
directory.

Using AvidNet

If your facility is equipped with AvidNet, you can simplify and speed 
the exchange of media between workstations by sending your mate-
rial over a network using the AvidNet Transfer Tool and the Media 
Inbox located in the Tools menu.

n For more information on AvidNet, see the AvidNet Peer-to-Peer Setup and 
UserÕs Guide. If you would like to purchase AvidNet, contact your Avid sales 
representative.
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Numerics
16 x 9 format 52
3/4-inch U-matic videotape See Videotape
4 x 4 audio interface See Digidesign hardware, 

audio interface

A
Abridge command (Clip menu) 181
Abridge dialog box 181
Add Comments command (Monitor menus) 

249
Add dissolve dialog box 358
Add Edit function 284

for maintaining sync 375
for multicamera editing 401

Add Page button (script window) 206
Add Scene button (script window) 206
Add Scene or Page dialog box 206
Adding

bin columns 152
Color indicators (script window) 220
comments

during digitizing 89
during editing 249
in cut lists 411

edits 284
filler

during a trim 312
to a sequence 235

locators, during digitizing 88
new tracks 283
off-screen indicators (script window) 219
page and scene numbers in the script 

window 206
script marks 221
takes in the script window 216

Adjusting
digital scrub parameters 321
input levels with the Audio tool 69
margins in the script window 201
pan in the Audio Mix tool 327
reference level in the Audio tool 67
take lines in the script window 219
volume

in the Audio Mix tool 327
in the Timeline 335

AES/EBU (Audio Engineering Society/
European Broadcast Union) digital format, 
defined 67

AIFF file format 111
ALE (Avid Log Exchange), converting shot log 

files with 25

Index

A B C D E F G H I J L M N O P Q R S T U V W X 
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Alias Animation (PIX) files 110
import specifications 114

Align Selected to Grid command (Bin menu) 
165

Align to Grid command (Bin menu) 165
Alpha channel

in animation sequences 114
in imported graphics 113, 122
in PICT files 109

Animation files 110, import specifications for 
114

Annotate feature 89
Anti-aliased images, alpha channel in 113
AppleShare for file transfer 522
Applying Audio EQ effects 343
A-roll versus A/B roll 413
ASCII text files, importing to a script window 

199
A-side (outgoing frames), in trims 298
Aspect ratio for imported graphics 123
Assemble edit recording 463

enabling in Deck Settings 465
Assemble list

A/B-Roll conforming 413
A-Roll conforming 413
described 411
options 432
scene 414

Audio
See also Audio Gain Automation, Audio Mix 

tool, Audio tool
calibrating input 70
checking for multicamera 389
crossfading 357
dipping 359
dissolves 357
fading 357
input levels See Audio tool
leader

creating 171
using to maintain sync 372

levels, fine-tuning with Add Edit 356
mixdown 360
multicamera, managing 384, 384
number of tracks supported 273
output

calibrating 458 to 463
four-channel 462
preparing for 458

pan
adjusting in Audio Mix tool 327
centering 131
defaults, setting 130

requirements for film transfers 52
sample rates in the Audio Setup display 66
scrub 319 to 324
Setup, in the Audio tool 65
slipping 128
tracks

mixing down 360
monitoring 277

volume
adjusting

in Audio Mix tool 327
in the Timeline 335

waveform plots, displaying 324
Audio 4 x 4 interface See Digidesign hardware, 

audio interface
Audio Data command (Timeline Fast menu) 

324
Audio downsampling (QuickTime) 491
Audio Engineering Society/European 

Broadcast Union (AES/EBU) digital 
format, defined 67

Audio EQ command (Tools menu) 341
Audio EQ tool 341 to 351

applying EQ effects 343
examples of uses 350
Fast menu options 345
features of 342
opening 341
saving effects 347
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Audio file types 111
Audio Gain Automation

deleting break points in 339
enabling and adding break points in 337
moving break points in 339
real time response for 337

Audio Mix command (Tools menu) 327
Audio Mix tool

adjusting volume and pan
on a single track 329
on multiple tracks 333

Fast menu options 332
Audio Mixdown

media files, deleting 180
procedure 360

Audio Mixdown command (Special menu) 360
Audio Mixdown dialog box 361
Audio Settings dialog box 130, 323
Audio Setup display See Audio tool
Audio solo feature 279
Audio timecode, using in Composer 128
Audio tool

adjusting input levels with 69
Calibrate mode 70
digital scale, defined 64
features, described 63
Peak Hold option, choosing 68
reference level, adjusting 67
Setup options 65
volume meters, defined 65
VU (volume unit) scale, defined 65

Audio Tool command (Tools menu) 63
Audio volume rubber-banding See Audio Gain 

Automation
Audiomedia II card systems

adjusting audio input levels 71
slot number, in Audio Setup display 66

AudioVision, transferring OMF files to 503
Autodigitizing 95, 386
AutoSync command (Bin menu) 364
Autosync dialog box, options in 364

Autosyncing 362
Avid logs See Shot Log files
Avid Media Fusion, importing files from 117
Avid Media Reader, defined 86
AvidNet 524

B
Background color, changing

in bins 163
Backing up media files 188
Backtiming edits 286
Bad Clip icon 423
Bandwidths in Audio EQ tool 342
Bars and tone

for calibrating video output 452
preparing for digitizing 169
recording to tape 464

Batch Digitize command 100, 106
Batch Digitize dialog box 100
Batch digitizing

See also Autodigitizing, Digitizing, 
Redigitizing

preparing for 98
procedure 99
sequences, procedure 103

Big Trim mode, toggling with Small Trim mode 
297

Bin editing in Segment mode 264
Bin Fast menu 137
Bin views

customizing 148
types of 148

Bins
background color, changing 163
Bin View pop-up menu 148
changing the display font in 137
checking for multicamera 388
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Bins, continued
columns in

adding 152
deleting 150
duplicating 151
moving 149
showing and hiding 149
tidying up 149

display modes for 134 to 136
editing from in Segment mode 264
Fast menu 137
finding from the script window 226
locking items in 143
logging directly into 32 to 38
organizing a project with 127 to 169
preparing

for digitizing 85
for film dailies 85

printing 167
rearranging clips in 164, 167
selecting media relatives in 145
selecting offline items in 144
selecting sources in 145
selecting unreferenced clips in 146
setting clip display in 132
shot log information in 23
targeting for digitizing 60
transferring with MediaLog Macintosh 24

Black level, adjusting
for input 79
for output 456

Black segment See  Filler
Blend effects 416
Blue only feature (as substitute for Waveform 

and Vectorscope) 457
B-side (incoming frames), in trims 298
Buttons

See also User selectable buttons
Add Scene and Add Page (script window) 

206
Change List/Cut List tools 427

Color (script window) 220
Digitize/Log mode (Digitize tool) 61
In/Out (Audio tool) 64
Input (Audio tool) 71
Off-Screen (script window) 219
Output (Audio tool) 64
Play (script window) 218
Preset (Video tools) 75
Reset Peak (Audio tool) 64
Setup (Audio tool) 64, 65

B-Y Gain adjustment 458

C
Calibrate command (Peak Hold pop-up menu) 

70
Calibrating

audio input 70
audio output 459

of digital cut 458
video input 76

table of luminance settings 80
with vectorscope 80
with waveform monitor 78

video output 452
advanced procedures 453

Calibrating audio output global levels 458
Calibration tone, setting 458
Camera roll, combining events based on 30
Camera setups, in the lined script 195
Camroll data 44
Capture mode, entering 53
CCIR video levels, for import 123
Center Pan command 131
Change list

across multiple reels 441
compared to cut list 408
creating 424
generating 425
icons in 421
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Change List tool
features of 427
opening 426
options, changing 437

Change pull List 419
Change Scene or Page dialog box 208
Changing

background color
in bins 163

bin font 137
font in the script window 202
frame size 163
list options 437
page and scene numbers in the script 

window 208
representative frame in takes 217
the frame identifying a clip 164

Check Decks command (Deck Selection pop-up 
menu) 57

Chroma keys 416
Chrominance, adjusting for output 457
Chyron iNFiNiT! files 110

import specifications 112
Clear command (Edit menu) 140, 151, 179
Clear Cut List/Change List commands 430
Clip information

displaying in Script mode bin display 167
modifications table 47

Clipboard
copying to 246
preserving contents of 247
recovering material from 247

Clipboard Contents command (Monitor menu) 
248

Clips
See also Master clips, Subclips, Group clips, 

Multigroup clips
autosyncing 362
copying 139
deleting 140
deleting extra multicamera 389

duplicating 138
exporting 476
group, creating 391
linking to script 210
locking 143
modifying information in 44
moving 139
multigroup, creating 392
rearranging

in Frame mode bin display 164
in Script mode bin display 167

replacing 388
selecting 138
sifting 141

Codecs, QuickTime 486
Color frame shifts 290
Color bars

See also Bars and tone
in Dupe Detection 289
types of 77

Color button (script window) 220
Color indicators (script integration)

adding to takes 220
described 197

Color submenu (Script menu) 220
Color Wheel with key color 125
Columns  See Bins
Combination cutting in multicamera editing 

407
Combining

cuts and reels 425
events on import 30

Commands See Menu commands
Comments

adding during digitizing 89
adding to sequence clips 249

Comparing cuts and reels 425
Component output settings 455
Composite output settings 455
Compression Tool command (Tools menu) 54
Conforming, A-roll versus A/B roll 413
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Console, checking peak levels with 72
Console command (Tools menu) 72
Consolidate command (Clip menu) 185
Consolidate dialog box 185
Consolidating media files

defined 184
group clips 187
master clips 184
procedure 185
sequences 184
subclips 184

Control track breaks, digitizing across 99
Convert command (Clip menu) 183
Convert dialog box 183
Converting

clips and media files 182
Shot log files with Avid Log Exchange 25

Copying
clips and sequences 139
in the Timeline 265
locators from source clips 236
text in the script window 204
to Clipboard 246

Countdown
customizing 467
in a digital cut 467

Crash recording (Manual recording) 463
Creating

See also Editing, Deleting
Avid log files 28
cut list for multiple sequences 440
group clips 391
leader 171
lists 424
multigroup clips 392
overlap edits 305

in one step 287
subclips during digitizing 87

Creating an instant rough cut 238
Cross Platform Movie option 491
Crossfading audio 357

Custom bin view, defined 148
Custom countdown display 468
Custom Sift command (Bin menu) 142
Custom sift dialog box 142
Custom Time option (Digital Cut tool) 472
Customizing

bin views 148
Trim mode 294

Cut list
compared to change list 408
creating 424
from two or more sequences 440
generating final 426
generating with Matchback 447
icons in 421
options, changing 437
settings, saving 428
sublists, optical scene pull lists 420
sublists in

assemble lists 412
dupe lists 417
optical lists 415
pull lists 418
scene assemble lists 414
scene pull lists 419

Cut, copy, paste in the Timeline 265
Cuts

comparing 425
multiple, working with 440

Cutting See Editing, specific edit modes
Cutting text in the script window 204

D
D1 VTR

calibrating input from 75
digitizing from 73

DAT (Digital Audio Tape), digitizing from 52
Deck Selection pop-up menu 56
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Deck settings
defined 51
for assemble-edit recording 465

Decompose feature 104
Delay edit (Overlap edit) 287
Delete Clips dialog box 141
Delete dialog box (script integration) 208, 217
Delete Head icon 423
Delete icon 421
Delete Media Files dialog box 179
Delete Middle icon 423
Delete Tail icon 423
Delete Take command (Script menu) 215
Deleting

See also Creating, Editing
Add edits (match frames) 285
bin columns 150
clips and sequences 140
media files

in bins 140
with Media tool 179

page and scene numbers in the script 
window 208

script marks 225
segments, in Segment mode 262
slates in the script window 215
takes in the script window 217
text in the script window 205
tracks 284
unreferenced clips 183

Dialog boxes
abridge 181
add dissolve 358
Add Scene or Page 206
Audio Mixdown 361
Audio Settings 130, 323
Autosync 364
Batch Digitize 100
Change scene or page 208
Consolidate 185
convert 183

custom sift 142
Delete (script integration) 208, 217
Delete Clips 141
Delete Media Files 179
Display Bin Selector 132
Display Media Selector 177
Font 202
Group clips 391
Headings 150
Import 29
Margin 202
Modify 45
Read Audio Timecode 129
Relink 189
Select a Bin 232
Select Font and Point Size 137
Tape Selection 33
View Name (bin) 153

Dialog, in the lined script 195
Digidesign audio interface

Pull Down switch setting for audio input 52
Digidesign hardware

See also Audio
audio interface trim pot adjustment 70

Digital audio scrub
adjusting parameters for 321
compared to smooth audio scrub 319
using 321

Digital bars and tone, preparing 169
Digital Betacam VTR

calibrating input from 75
digitizing from 73

Digital Cut command (Output menu) 470
Digital cuts

previewing 467
Record to Tape options 472
recording 470

Digital scale (Audio tool), defined 64
Digitize settings, defined 51
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Digitize tool
logging with 33
resizing 98
resolution, choosing 60
setting up 56
subclip indicator in 87

Digitize Tool command 33
Digitize/Log mode button (Digitize tool) 61
Digitizing

See also Batch digitizing, Redigitizing
across control track breaks 99
across timecode breaks 95, 99
adding comments (annotating) during 89
adding locators during 88
and logging at the same time 89 to 96
audio 52
autodigitizing 95
bars and tone 169
defined 84
film transfers, minimum information for 38
from a mark IN to a mark OUT 91
from a non-Avid-controlled deck 96
methods for 386
multicamera material 386
on the fly 93
preparing for 50 to 82

Audio tool setup 63 to 72
Compression tool setup 54
deck selection 56
Digitize tool setup 56
hardware considerations 51
resolution selection 60
settings selection 51
source track selection 59
tape selection 57
targeting bins 60
targeting drives 61
video input 73 to 82
video levels, adjusting by eye 82

pulldown flag (white flag) in 84, 88
setting only Mark IN 92

shot logs to bins 23
sources for 51
using Timecode-of-day 97
with Avid Media Reader 86
workflow, multicamera 385

Dipping audio 359
Discard list 419
Display Bin Selector dialog box 132
Display Media Selector dialog box 177
Display Options button (Cut List/Change List 

tool) 427, 434
Displaying

clip information in Script mode bin display 
167

film columns 38
sync breaks 368
take numbers in slates 217

Dissolve icon 423
Dissolves

audio 357
supported in optical lists 416

Drive filtering based on resolution, defined 51
Drives for transferring media 522
Dual-image play during trims 302
Dual-rolling trim 302
Dupe Checking 444
Dupe detection 289
Dupe icon 423
Dupe list

described 417
options 432

Duplicate command (Edit menu) 139, 151
Duplicating

bin columns 151
clips and sequences 138

Dynamic scrolling in the View window 436

E
Edit controller, with VTR play emulation 474
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Editing
See also Edits, Creating, Deleting, specific 

edit modes
16 mm film 413
35 mm film 413
adding new tracks during 283
deleting tracks during 284
effects 273
in Heads (and Tails) view 271
multicamera material 381 to 407
new sequence 231
Sync Point Editing 375
to avoid sync breaks 367
with film track 268
with the script window 226

Edits
See also Editing, Creating, Deleting, specific 

edit modes
Adding (match-framing) 284
backtiming 286
combination cutting (multicamera) 407
copying to clipboard 246
extending 305
Extract 246
Extract/Splice (Segment mode) 261
instant rough cut procedure 238
Lift 246
Lift/Overwrite (Segment mode) 261
on the fly cutting (multicamera) 405
Overlap 287
Overwrite 242
Replace 242
selective cutting (multicamera) 404
Splice 241
undoing or redoing 240

EDL (edit decision list)
creating 473
described 473

Effects
nesting, defined 274
supported by optical list 415

types of 273
Energy Plot in Timeline 325
Enlarge Frame command (Clip menu) 212
Enlarge Frame command (Edit menu) 163
Enlarging and reducing frames in the bin 163
Entering

additional film data 44
ink numbers 43
key numbers 42
optional timecodes 42
pulldown of the sync point 39
Source/Record mode 231
Trim mode 295

Events in an EDL, defined 473
Exchanging material 476 to 524
Exiting Trim mode 297
Exporting shot log files 48
Exporting files 476 to 524

OMF 495
OMF to AudioVision 503
OMF to Pro Tools 511
PICT 480
preparing for 477
QuickTime 486
supported formats for 477

Extend Edit button 305
Extending an edit 305
External drive See Media drive
Extract edits 246
Extract/Splice button 261

F
Fade In icon 423
Fade Out icon 423
Fades 416
Fading audio 357
Fast menus

Bin 137
Change List/Cut List tools 426
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Media Tool 176
Fetch 522
File Transfer Protocol (FTP) 522
File types, supported 108
Files

exporting 476 to 524
OMF 495
OMF to AudioVision 503
OMF to Pro Tools 511
PICT 480
QuickTime 486

importing 108 to 126
AIFF 111
Alias PIX 110
animation 110
audio 111
Chyron iNFiNiT! 110
graphics 109
limiting size 118
mixed resolutions 118
OMF 112
Photo CD 110
PICT images 109
PICT sequences 110
procedure for 119
QuickTime 112
shot log 109
Sound Designer II 111
specifications for 112 to 117

supported formats 108
Fill Sorted command (Bin menu) 165
Fill Window command 165
Filler

adding during a trim 312
adding to a sequence 235

Film
16 mm, editing 413
35 mm, editing 413
columns, displaying 38
data, entering 44
information, logging 38

lists, types of 409 to 438
options for output 408 to 448
scene workflow 134
timecodes, entering 42
transfer

minimum information for digitizing 38
audio requirements for 52

Film bin view, defined 148
Film dailies preparing bins for 85
Film pulldown 116
Film track, editing with 268
Final cut list, generating 426
Find Bin button in the script window 226
Find command (Edit menu) 209
Find Script button 225
Finding

bins from the script window 226
script from marked takes 225
text in the script window 209

Flips and flops 416
Font dialog box 202
Font in bins, changing 137
Fonts in the script window, changing 202
Format elements, preparing 169 to 173
Four-frame display

described 258
suppressing 260

Frame mode (bin display)
defined 135
in Media tool 176
using 162 to 165

Frame Mode button 162
Frame reference numbers 410
Frame size, changing 163
Frame-accurate recording 463
Frames

displaying matching footage for 378
finding

with the Match Frame button 378
identifying a clip, changing 164
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Frames, continued
rearranging

in Frame mode 164
in Script mode 167

tidying up 164
Frames-per-second rates for PAL 42
Frequencies (audio), adjusting 341
FT (Film-to-Tape) transfer, digitizing 88
FTP 522
Full-monitor multicamera display 393
Full-screen Timeline 265

G
Ganging

footage in monitors 377
multiple tracks in the Audio Mix tool 333

Gathering format elements 169 to 173
Genlock options (Video Output Tool) 456
Getting sequences 427, 428
Global options 432
Go To Capture Mode command (Bin menu) 53
Going to scene or page numbers 209
Graphic Key Color selection 125
Graphics files 109

specifications for importing 112
Group clips

consolidating 187
creating 391

Group Clips command (Bin menu) 391
Group Clips dialog box, options 391
Grouping procedures 391

H
Hard recording See  Manual recording
Head frames (cut list) 411
Headings command (Bin menu) 150
Headings dialog box 150

Heads (and Tails) View, in the Timeline 271
Hiding slate frames 213
Hiding bin columns 149
High shelf in Audio EQ tool 343
Home command (Windows menu) 268

I
Icons in lists 421
Ignoring volume and pan settings 334
Import command 29
Import dialog box 29
Importing

a script 199
shot log files 29
test patterns 171

Importing files 108 to 126
See also Files, importing
before you begin 117
procedure for 119

In/Out buttons (Audio tool), defined 64
Indicating off-screen dialog 219
Infinite Hold option (Audio tool) 68
Ink numbers, entering 43
Input button (Audio tool) 71
Input Source pop-up menu (Audio Setup 

display) 67
Insert Head icon 423
Insert icon 421
Insert Tail icon 423
Insert-edit recording 463
Inversion, of color effect, with alpha channel 

123

J
Jump Cut icon 421
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K
K-AShare 522
Key Color Picker 125
Key numbers

entering 42
formats 42

Keycode format 42

L
Labroll data 44
Leader

creating 171
for managing sync breaks 372

L-edit (Overlap edit) 287
Left Margin command (Script menu) 201
Lift/Overwrite button 261
Lifting material 246
Line Selector slider (waveform monitor) 79
Linecut option, for multicam editing 400
Lined script, described 194
Linking clips to script 210
List options

changing 437
selecting 432

List Selection panes (Cut List/Change List 
tools) 428

List Title box (Cut List/Change List tools) 428
Lists

creating 424
custom titles for 428
printing 437
renaming 431
types of 409
viewing 435

Lists, replacing settings for 439
Load Filler command (Monitor menus) 235
Loading takes from the script window 218, 224
Loading filler 235

Locator comments (cut list) 411
Locators

adding during digitizing 88
copying from source clips 236
for managing sync breaks 373

Lock Bin Selection command (Clip menu) 143
Lock Tracks command (Clip menu) 282
Locking

bin items 143
tracks 282

Log files
converting to Avid log format 25
importing from film-to-tape transfer 

systems 25, 148
to bin 23

Logging
and digitizing at the same time 89 to 96
bypassing by autodigitizing 95
directly into a bin

with a non-Avid-controlled deck 36
with an Avid-controlled deck 32

film information 38
guidelines for 21
multicamera material 386
preroll 21, 21
procedures for 20 to 38, 386

Logs See Shot Log files
Longitudinal timecode See LTC
Low shelf in Audio EQ tool 342
LTC (Longitudinal timecode)

decoding with Media Reader 86
reading the User Bits in 129

Luma key 416
Luminance settings

adjusting for video output 453
table of 456
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M
Managing media files 175 to 192
Manual recording 463
Margin dialog box 202
Mark and park editing 243
Marking segments in Segment mode 263
Marks, phantom 244
Master clips

consolidating 184
copying 139
deleting 140
duplicating 138
locking 143
moving 139
redigitizing 103
relinking 188
selecting 138
sifting 141

Master shot, in the lined script 195
Match Frame function

for multicamera editing 404
using 378

Matchback
for creating cut list 447
using 445

Match-framing (Adding edits) 284
Matte key effect 416
MCXpress for Windows NT

importing files from 117
Media drive, targeting 61
Media files

abridging 181
backing up 188
consolidating

defined 184
procedure 185

deleting
in bins 140
in the Media tool 179

managing 175 to 192

manipulating with Media tool 175
relinking 188
transferring 521
unlinking 192

Media Inbox 524
Media Reader, defined 86
Media Relatives, selecting in the bin 145
Media tool

basic features of 176
opening 177

Media Tool command (Tools menu) 177
Media Tool Fast menu 176
MediaLog for Macintosh, transferring bins with 

24
MediaLog for PC

operating system requirements 25
transferring bins with 25

Menu commands
Abridge (Clip menu) 181
Add Comments (Monitor menus) 249
Align Selected to Grid (Bin menu) 165
Align to Grid (Bin menu) 165
Audio Data (Timeline Fast menu) 324
Audio EQ (Tools menu) 341
Audio Mix (Tools menu) 327
Audio Mixdown (Special menu) 360
Audio Tool (Tools menu) 63
Autosync (Bin menu) 364
Batch Digitize (Clip menu) 100, 106
Calibrate (Peak Hold pop-up menu) 70
Center Pan (Clip menu) 131
Check Decks (Deck Selection pop-up menu) 

57
Clear (Edit menu) 140, 151, 179
Clipboard Contents (Monitor menu) 248
Color (Script) 220
Compression Tool (Tools menu) 54
Console (Tools menu) 72
Consolidate (Clip menu) 185
Convert (Clip menu) 183
Custom Sift (Bin menu) 142
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Delete Take (Script) 215
Digital Cut (Output menu) 470
Digitize Tool (Tools menu) 33
Duplicate (Edit menu) 139, 151
Enlarge Frame (Clip) 212
Enlarge Frame (Edit menu) 163
Fill Sorted (Bin menu) 165
Fill Window (Bin menu) 165
Find (Edit) 209
Go To Capture mode (Bin menu) 53
Group Clips (Bin menu) 391
Headings (Bin menu) 150
Home (Windows menu) 268
Import (File menu) 29
Left Margin (Script) 201
Load Filler (Monitor menus) 235
Lock Bin Selection (Clip menu) 143
Lock Tracks (Clip menu) 282
Media Tool (Tools menu) 177
Modify (Clip menu) 45
New Audio Track (Clip menu) 234, 283
New Script (File) 199
New Video or Picture Track (Clip menu) 234
New Video Track (Clip menu) 283
Page Setup (File menu) 168
Play Calibration Tone (Peak Hold pop-up 

menu) 459, 460
Print (File menu) 168
Print Timeline (File menu) 292
Read Audio Timecode (Special menu) 128
Redo (Edit menu) 240
Reduce Frame (Clip) 212
Reduce Frame (Edit menu) 163
Relink (Clip menu) 189
Remove Pan/Vols (Audio Mix Fast menu) 

333
Restore Default Patch (Special menu) 281
Reverse Selection (Bin menu) 183
Search for Scene or Page (Script) 209
Select All Tracks (Edit menu) 276
Select Media Relatives (Bin menu) 145

Select Offline Items (Bin menu) 144
Select Sources (Bin menu) 146
Select Unreferenced Clips (Bin menu) 146
Serial Ports (Tools menu) 474
Set Bin Background (Edit menu) 163
Set Bin Display (Bin menu) 132
Set Calibration Tone (Peak Hold pop-up 

menu) 458
Set Font (Edit menu) 137
Set Font (Edit) 202
Set Level (Audio Mix tool) 333
Set Pan (Audio Mix Fast menu) 333
Set Reference Level (Peak Hold pop-up 

menu) 67
Show All Takes (Script) 213
Show Every Frame (Timeline Fast menu) 

269
Show Frames (Script) 213
Show Track (Timeline Fast menu) 269
Sync Breaks (Timeline Fast menu) 369
Tidy Up Columns (Bin menu) 149
Undo (Edit menu) 240
Unlock Bin Selection (Clip menu) 144
Unlock Tracks (Clip menu) 282
Video Input Tool (Tools menu) 73
Video Output Tool (Tools menu) 73, 452
View Type (Timeline Fast menu) 271
VTR Emulation (Special menu) 474

Merging events on import 31
Meters See Volume meters
Mixed resolutions 118
Mixing down audio 360
Modify command 45
Modify dialog box 45
Modifying clip information 44
Monitor icons 277
Monitoring audio/video tracks 277
Monitors, ganging footage in 377
Mono option (audio) 361
Motion effects, defined 273
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Moving
bin columns 149
clips and sequences 139
frames in the bin 164
script marks 224
slates in the script window 214

Multicamera editing
combination cutting in 407
cutting on the fly in 405
developing a production model for 381
digitizing workflow for 385
grouping 391
managing audio in 384
modes of 393
production paths 382
Quad menus 403
Quad Split menu 402
Quad Split mode 395
selective cutting in 404
switching angles 399
tape classification 382
techniques 398
workflow options 404

Multicamera linecut option 400
Multicamera mode, described 396
Multigroup clips, creating 392
Multilevel sorting of columns 161
Multiple reels

and cuts 440
change lists for 441
combining 425
dupe checking across 444

Multiple tracks, working with 273 to 288

N
Nagra, digitizing from 52
Nested effects, defined 274
Nesting effects 274

New Audio Track command (Clip menu) 234, 
283

New Script command (File menu) 199
New sequence, setting up 231
New Video or Picture Track command (Clip 

menu) 234
New Video Track command (Clip menu) 283
NTSC (National Television Systems 

Committee) video
B-Y Gain, adjusting 458
digitizing audio from 52
logging 90
luminance values 456
PICT resolution 470
R-Y Gain, adjusting 458
transfers

creating Avid log files for 28
digitizing 88, 90

waveform values 80
NTSC frame resolution

for imported files 113
import specifications for 115

O
Offline editing

detecting color-frame shifts during 290
detecting duplicate frames during 289

Offline items, selecting in the bin 144
Off-Screen button (script window) 219
Off-screen dialog

in the lined script 195
indicating in the script window 219

Off-Screen indicators (script integration)
adding to takes 219
described 197

OMF Interchange
described 496
web site 497
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OMF Interchange files 111
before you export 498
exporting 495
exporting to AudioVision 503
exporting to Pro Tools 511
importing 112
methods for exporting 497
procedure for exporting 498

One-step overlap cuts 287
Opacity, of an effect 113

with key color 125
Operator pop-up menu (Custom Sift dialog 

box) 142
Optical icon 423
Optical list

effects supported in 415
options 432

Optical scene pull list 420
Orphans See Offline items
Output

See also Digital cuts, EDL, Playback
calibrating for video 452
options 449
options for film 408 to 448
preparing for 449

Output button (Audio tool), defined 64
Overlap edits 287, 305
Overwrite edits 242

P
Padlock icon in Track Selector panel 281
Page and scene numbers (script window)

adding 206
changing 208
deleting 208
searching for 209

Page Setup command (File menu) 168
PAL (Phase Alternating Line) video

B-Y Gain, adjusting 458

digitizing 90
digitizing audio from 52
frames-per-second rates 42
logging 90
luminance values 456
PICT resolution 470
R-Y Gain, adjusting 458
waveform values 80

PAL frame resolution
for imported files 113
import specifications for 115

Pan adjustment See  Audio Mix tool
Pan adjustments, ignoring 334
Parametric midrange in Audio EQ tool 343
Pasting in the Timeline 265
Patching tracks 280
Peak Hold option (Audio tool) 68
Peak Hold pop-up menu (Audio tool), defined 

64
Perforation level, slipping audio at 128
Phantom Marks, using 244
Photo CD files 110

import options 122
import specifications 112

PICS files 110
import options 122
import specifications 114

PICT files 109, 110
alpha channel in 122
and alpha channel 113
exporting 480
import options 122
import specifications 112, 114
importing for custom countdown 469
importing for test pattern 454
of bars, importing 171

Picture tracks, monitoring 277
Picture-in-Picture effect 416
PIX files 110

import specifications 114
Play button (script window) 218
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Play Calibration Tone command (Peak Hold 
pop-up menu) 459, 460

Playback
improving 251
loop, starting 251
loop, trim during 304
with audio scrub 319

Playing
takes from the script window 218

Postroll in trim mode playback loop 302
Precompute media files, deleting 180
Preparing

shot log files
with MediaLog 23
with text editors 28

to digitize 50 to 82
Preroll

in Trim mode playback loop 302
logging 21

Preset buttons 75
Preview code 442
Previewing digital cuts 467
Print command (File menu) 168
Print Timeline command (File menu) 292
Printing

bins 167
lists 437
the Timeline 292

Pro Tools, transferring OMF files to 511
Production paths for multicamera editing 382
Projects

relinking media files for 191
transferring 521

Pull Down switch (Video Slave Driver) 52
Pull list

described 418
options 432

Pulldown
finding at the sync point 39
flag 84
white flag option 88

Q
Quad menus 403
Quad Split display 395
Quad Split menu 402
QuickTime files 110, 112

codecs for 486
exporting 486
import options 122
import specifications 115
Media Composer codec 494

R
Read Audio Timecode command (Special 

menu) 128
Read Audio Timecode dialog box 129
Real time response, for Audio Gain Automation 

337
Rearranging clips

in Frame mode bin display 164
in Script mode bin display 167

Recalling list settings 430
Record Deck Time option (Digital Cut tool) 472
Recording

digital cuts 470
types of 463

Redigitizing
See also Digitizing, Batch digitizing
master clips and subclips 103
sequences

procedure 103
using decompose 104

Redo command (Edit menu) 240
Reduce Frame command (Clip menu) 212
Reduce Frame command (Edit menu) 163
Reducing and enlarging frames in the bin 163
Reels

multiple, working with 440
numbers for 441
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Relink command (Clip menu) 189
Relink dialog box 189
Relinking

See also Unlinking
consolidated clips 191
media files and clips 188
moved projects 191
to selected clips 190

Remove Pan/Vols command (Audio Mix Fast 
menu) 333

Removing
Color indicators (script window) 220
off-screen indicators (script window) 220

Removing add edits (match frames) 285
Removing text from the script window 205
Render settings for imported graphics 118
Replace edits 242
Replacing list settings 439
Reset Peak button (Audio tool), defined 64
Resizing slates in the script window 212
Resizing the Digitize tool 98
Resolution pop-up menu (Digitize tool) 60
Resolutions, mixed 118
Restore Default Patch command (Special menu) 

281
Reverse Match Frame 379
Reverse Selection command (Bin menu) 183
Review Transition button 297
Reviewing trim edits 301
RGB graphics levels for import 123
Rollers See  Trim mode
Rough cut, creating in one step 238
Rubber-banding See Audio Gain Automation
R-Y Gain adjustment 458

S
S/PDIF (Sony Phillips Digital Interface Format), 

defined 67

SA 4 card systems
calibrating the Digidesign audio interface 70
slot number, in the Audio Setup display 66

Sample Plot in the Timeline 325
Saving

custom bin views 153
list settings 438
lists 437

SC phase (hue), adjusting 457
Scene data 44
Scene and page numbers (script window)

adding 206
changing 208
deleting 208
searching for 209

Scene assemble list 414
Scene pull list 420
Scene, combining events based on 30
Script box, in Script mode 166
Script integration

See also Scripts, Lined script, Script window, 
Slates, Script marks, Takes, Off-Screen 
indicators, Color indicators

described 196
elements of 197
for video projects 198
importing a script for 199
lining conventions in 194
workflow 197, 226

Script Mark button 222
Script marks

adding 221
adding during automatic screening 222
deleting 225
described 197, 221
moving 224
using for playback 224
using to find script 225
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Script mode (bin display)
defined 136
in Media tool 176
using 165 to 167

Script Mode button 165
Script window

adding Color indicators to 220
adding page and scene numbers in 206
adding takes in 216
adjusting margins in 201
adjusting take lines in 219
changing font in 202
changing scene or page numbers in 208
cutting, copying, and pasting text in 204
deleting slates in 215
deleting takes in 217
displaying take numbers in 217
editing with 226
finding bins from 226
hiding slate frames in 213
indicating off-screen dialog in 219
linking clips to 210
loading takes from 218
moving slates in 214
navigating in 201
opening, closing, saving 200
playing takes from 218
removing text in 205
resizing slates in 212
screening and marking in 222
searching through 206 to 210
selecting slates in 212
selecting takes in 216
selecting text in 203
splicing a range of script from 228
using for screenings 228

Scripts
importing into script windows 199
linking clips to 210

Scrubbing (audio) 319 to 323

Search for Scene or Page command (Script 
menu) 209

Searching
for page and scene numbers in the script 

window 209
in the script window 206 to 210

Segment effects 416
Segment effects, defined 273
Segment mode 254 to 265

deleting segments in 262
editing from a bin in 264
extracting/splicing in 261
Four-frame display

described 258
suppressing 260

lifting/overwriting in 261
marking segments in 263
workflow 254

Segments
cutting, copying, and pasting 265
deleting 262
marking 263
selecting 255

Select a Bin dialog box 232
Select All Tracks command (Edit menu) 276
Select Font and Point Size dialog box 137
Select Media Relatives command (Bin menu) 

145
Select Offline Items command (Bin menu) 144
Select Sources command (Bin menu) 146
Select Unreferenced Clips command (Bin menu) 

146
Selecting

clips and sequences 138
list options 432
media relatives in the bin 145
offline items in the bin 144
segments in the Timeline 255
slates in the script window 212
sources in the bin 145
takes in the script window 216
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text in the script window 203
tracks

for audio scrub 320
for digitizing 59
in Cut List tool 431
in the Timeline 276

transitions for trimming 295
trim sides 298
unreferenced clips in the bin 146

Sequence list button (Cut List/Change List 
tools) 427

Sequence Time option (Digital Cut tool) 472
Sequences

adding tracks to 234
consolidating 184
copying 139
deleting 140
duplicating 138
exporting 476
getting 427, 428
making the first edit in 237
moving 139
multiple, cut list for 440
output options for 449
playback loop in 251
playback performance tips 251
playing 250
preparing 424
redigitizing

procedure 103, 105
saving two versions for 103
using Decompose 104

selecting 138
setting up 231
sifting 141

Serial digital
input 73
input, calibrating 75

Serial Ports command (Tools menu) 474
Set Bin Background command (Edit menu) 163
Set Bin Display command 132

Set Calibration Tone command (Peak Hold pop-
up menu) 458

Set Font command (Edit menu) 137, 202
Set Level commands (Audio Mix Fast menu) 

333
Set Pan commands (Audio Mix Fast menu) 333
Set Reference Level command (Peak Hold pop-

up menu) 67
Setting

audio pan defaults 130
the bin display 132

Settings
list

recalling 430
saving 438

Setup button (Audio tool), defined 64
Short Cut icon 421
Shot log file types 109
Shot log files

Avid Log file specifications 28
converting with Avid Log Exchange 25
exporting 48
importing 29
preparing

text editors for 28
with MediaLog 23

Shot logs See Shot log files
Show All Takes command (Script menu) 213
Show Every Frame command (Timeline Fast 

menu) 269
Show Frames command (Script menu) 213
Show Track submenu (Timeline Fast menu) 269
Showing bin columns 149
Sifting clips and sequences 141
Single frame import options 126
Single mark editing 243
Single Mark Editing option (Composer settings) 

243
Single track monitoring 279
Single-layer effects 416
Slash icon in Track Selector panel 281
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Slates (script integration)
creating 211
deleting 215
described 197
hiding frames in 213
moving 214
resizing 212
selecting 212
showing one take in 213

Slipping and sliding shots
in Source/Record mode 310
in Trim mode 306

Slipping audio 128
Small Trim mode, toggling with Big Trim mode 

297
Smooth audio scrub

compared to digital scrub 319
performing 320

SMPTE bars 456
Solo track monitoring 279
Sony/Phillips Digital Interface Format (S/

PDIF), defined 67
Sorting

clips 161
columns, multilevel 161

Sound Designer II file format 111
Soundroll data, entering 44
Source clips, finding with Match Frame 380
Source/Record mode

entering 231
first edits in 230 to 249
slipping shots in 310

Sources, selecting in the bin 145
SPE (Sync Point Editing) 375
Splice edit 241
Splicing a range of script 228
Split edit (Overlap edit) 305
Statistics bin view, defined 148
Storage

devices for transferring media 522
guidelines for multicamera 387

Storyboard worksheet 174
Storyboard editing from the script window 228
Striping record tapes 463
Subclip indicator (Digitize tool) 87
Subclipping on the fly 87
Subclips

consolidating 184
copying 139
creating during digitizing 87
deleting 140
duplicating 138
moving 139
redigitizing 103
selecting 138
sifting 141

Sublists 411
Superimposition effect in optical list 415
Switching multicamera shots 399
Sync

See also Genlock options
autosyncing 362
ganging footage in monitors 377
maintaining

with Add Edit 375
with leader 372
with locators 373
with sync lock 371

maintaining during trim 311
pop-up menu (Audio Setup display) 66
sync-locked tracks in the Timeline 282
sync-locked tracks, trimming with 313
sync-locking tracks 282
using Match Frame 378

Sync breaks
displaying 368
fixing 369

Sync Breaks command (Timeline Fast menu) 
369

Sync Point Editing (SPE) 375
Sync point, finding the pulldown at 39
Sync-locked tracks 282, 371
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T
Takes (script integration)

adding 216
adjusting lines in 219
applying color indicators to 220
applying off-screen indicators to 219
changing representative frame for 217
deleting 217
described 197
displaying numbers for 217
loading 218
loading from script marks 224
playing 218
removing Color indicators from 220
removing off-screen indicators from 220
selecting 216
showing one per slate 213

Tape deck See Videotape deck
Tape Selection dialog box 33
Tapes See Videotape, Audiotape
Target bin, choosing 60
Target Drive pop-up menu 61
Telecine, importing log file from 148
Test patterns

See Also Bars and tone
importing 171
importing new 454
using 454
video 454

Text editors for Avid logs 28
Text in the script window

changing font of 202
cutting, copying and pasting 204
linking clips to 210
removing 205
searching through 206 to 210
selecting 203

Text mode (bin display)
defined 134
in Media tool 176

using 147 to 162
Text Mode button 147
Text search in the script window 209
Text, adding in Script mode 166
Three-point editing, with Phantom Marks 244
Tidy Up Columns command (Bin menu) 149
Tidying up

columns in a bin 149
frames in a bin 164

Timecode
breaks in, digitizing across 95, 99
timecode-of-day, digitizing with 97

Timecodes, entering 42
Timeline

See also Segment mode
adding new tracks 283
deleting tracks in 284
dupe detection in 289
editing with film track 268
first edit displayed in 237
full-screen view 265
Heads (and Tails) view 271
locking tracks in 282
monitoring tracks in 277
nesting 274
patching tracks 280
printing 292
removing add edits in 285
Track Selector panel 275 to 282
using 253
working with multiple tracks in 273 to 288

Time-remaining display (Digitize tool) 62
Tips

logging 21
playback performance 251
storage 387

Title effect 416
Tone, recording to tape 464
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Tools
Audio 63
Audio EQ 341
Audio Mix 327
Compression 54
Digitize 56
Video Input 73
Video Output 452

Track Selection list 427
Track Selector panel

user preferences for 235
using 275 to 282

Tracking color frame shifts 290
Tracks

adding 234, 283
audio, mixing down 360
deleting

in Segment mode 284
with Media tool 179

ganging in the Audio Mix tool 333
locking 282
managing sync in 371
monitoring 277
number supported 273
patching 280
preferences for creating and enabling 235
selecting 276

for audio scrub 320
for digitizing 59
in EDL 431

sync-locked, trimming with 313
sync-locking 282

Transferring
bins

with MediaLog for Macintosh 24
with MediaLog for PC 25

Transferring files 521
OMF to AudioVision 503 to 511
OMF to ProTools 511 to 521

Transferring film
audio requirements for 52

Transferring media
between systems 523
storage devices for 522
with AvidNet 524

Transition Corner Display 314
Transition effects

defined 273
supported in optical lists 415

Transitions
audio, fine-tuning 357
selecting for trimming 295
selecting several for trimming 299
trimming 314

Transparency, of an effect
in graphics

import specifications for 113
Trim

adding filler during 312
during a playback loop 304
edits, reviewing 301
maintaining sync during 311
on the fly 303
sides, selecting 298
slip and slide

procedures 306
with sync-locked tracks 313

Trim mode
basic procedures in 295 to 302
Big Trim mode

toggling with Small Trim mode 297
customizing 294
entering 295
exiting 297
Play Transition Loop parameters in 302
selecting

several transitions in 299
single transitions in 295
trim sides in 298

Small Trim mode
toggling with Big Trim mode 297

Transition Corner Display in 314
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Trim pots, adjusting 71
Trimming See Trim mode, Trim
Trimming two heads or tails 300
Turnover points in Audio EQ tool 342

U
U-matic 3/4-inch videotape See Videotape
Unattended batch digitizing

See also Batch digitizing, Digitizing, 
Redigitizing

setting up for 99
Undo command (Edit menu) 240
Undoing and redoing edits 240
UNIX systems and file transfer 522
Unlinking media files 192
Unlock Bin Selection command (Clip menu) 

144
Unlock Tracks command (Clip menu) 282
Unreferenced clips

deleting 183
selecting in the bin 146

User Bits in LTC, reading 129
User-selectable buttons

See also Buttons
Add Dissolve 358
Add Edit 284, 356
Copy to Clipboard 246
Cycle Tracks 276
Cycling Trim Sides 298
Enter Trim at Next Transition 296
Enter Trim at Previous Transition 296
Extend Edit 305
Extract 246
Extract/Splice (Segment mode) 261
Find Script 225
Lift 246
Lift/Overwrite (Segment mode) 261
Mute 326
Play Transition Loop 301

Replace 242
Review Transition 297
Script Mark 222
Slip Left, Right 310
Splice 237
Transition Corner Display 314
Trim A-side 298
Trim B-side 298
Trim mode 295

V
Vantage text editor 29
Vectorscope

monitor, substitute for 455, 457
using 80

Vertical interval timecode, decoding with 
Media Reader 86

VHS tape, digitizing from 463
Video

advanced, calibrating 453
input

calibration 76
preparing for 73 to 82

leader
creating 171
using to maintain sync 372

levels, adjusting by eye 82
number of tracks supported 273
output, calibrating 452, 458
syncing 128
test patterns 454
tracks, monitoring 277

Video Input pop-up menu (Video Input tool) 77
Video Input tool

Line Selector slider 79
saving settings 81
vectorscope 80
waveform monitor 78

Video Input Tool command (Tools menu) 73
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Video layer(s)
alpha channel in

graphics 113
background

graphics, imported file specifications for 
113

with alpha channel
key color 125

Video mixdown 478
Video Output tool

less options display 452
more options display 453

Video Output Tool command (Tools menu) 452
Video Slave Driver See Digidesign hardware
Video solo feature 279
Videotape

classification schemes for multicamera 
editing 382

digitizing bars and tone from 171
naming guidelines 22
preparing for output 463
recording digital cut to 470
recording to 463
striping requirements 463

Videotape deck
Avid-controlled, logging with 32
non-Avid-controlled, logging with 36

View, Heads and Tails in the Timeline 271
View Name dialog box 153
View Type command (Timeline Fast menu) 271
VITC (vertical interval timecode), decoding 

with Media Reader 86
Volume adjustment in Audio Mix tool 329
Volume adjustments, ignoring 334
Volume meters

in the Audio tool, defined 65
in the Timeline 338

VTR Emulation command (Special menu) 474
VTR Emulation pop-up menu 474
VTR play emulation 474
VTR See Videotape deck

VU (volume unit) scale (Audio tool), defined 65

W
Waveform monitor

calibrating input with 78
calibrating output with 455

Waveform plots (audio) 324
White flag option 88
Wide-screen format (16 x 9) 52
Wipes 416
Workflow, film scene 134

X
Xinet K-AShare 522
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